
QGIS User Guide
Versão 2.14

QGIS Project

08/08/2017





Contents

1 Preâmbulo 1

2 Convenções 3
2.1 Convenções da Interface Gráfica . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.2 Convenções do Texto ou Teclado . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.3 Instruções especificas da Plataforma . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

3 Preâmbulo 5

4 Feições 7
4.1 Visualização de dados . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
4.2 Exploração de dados e compositores de mapas . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
4.3 Criar, editar, gerir e exportar dados . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.4 Analyze data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.5 Publicação de mapas na internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.6 Extend QGIS functionality through plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.7 Console Python . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
4.8 Problemas conhecidos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

5 O que há de novo no QGIS 2.14 11

6 Iniciando 13
6.1 Instalação . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
6.2 Launching QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
6.3 Sample Session: Load raster and vector layers . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
6.4 Projetos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
6.5 Arquivo de Saída . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

7 Interface do QGIS 21
7.1 Barra de Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
7.2 Panels and Toolbars . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
7.3 Visualização do mapa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
7.4 Barra de Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

8 Ferramentas Gerais 37
8.1 Atalhos de teclado . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
8.2 Conteúdo da ajuda . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
8.3 Renderização . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
8.4 Color Selector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
8.5 Modos de Mistura . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
8.6 Zooming and Panning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
8.7 Medição . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
8.8 Selecionar e desselecionar feições . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

i



8.9 Data defined override setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
8.10 Identificar feições . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
8.11 Ferramentas de anotação . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
8.12 Favoritos Espaciais . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
8.13 Projetos animados . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
8.14 Decorações . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
8.15 Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
8.16 Save layer into file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
8.17 Use of variables for dynamic content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

9 QGIS Configuration 55
9.1 Propriedades do Projeto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
9.2 Opções . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
9.3 Personalização . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

10 Trabalhando com Projeções 69
10.1 Visão geral do Suporte a Projeções . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
10.2 Especificação de Projeção Global . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
10.3 Definir Reprojeção Dinâmica Voo Livre (OTF) . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
10.4 Sistema de Referência de Coordenadas personalizado . . . . . . . . . . . . . . . . . . . . . . . 72
10.5 transformações de datum padrão . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

11 Navegador QGIS 75
11.1 QGIS Browser widget . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
11.2 QGIS Browser as a standalone application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

12 Trabalhando com Dados Vetoriais 79
12.1 Formatos de dados suportados . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
12.2 A Biblioteca de Símbolos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
12.3 Janela de Propriedades de Vetor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
12.4 Expressões . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
12.5 Trabalhando com a Tabela de Atributos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
12.6 Editando . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
12.7 Camadas virtuais . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

13 Trabalhando com Dados Raster 177
13.1 Trabalhando com dados raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
13.2 Diálogo de propriedades do Raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
13.3 Análise Raster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

14 Trabalhando com dados OGC 191
14.1 QGIS as OGC Data Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
14.2 QGIS as OGC Data Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

15 Trabalhando com dados GPS 213
15.1 Complemento GPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
15.2 Rastreio GPS em tempo real . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217

16 Sistema de Autenticação 223
16.1 Authentication System Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
16.2 Fluxos de trabalho de autenticação de usuário . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
16.3 Security Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

17 Integração com SIG GRASS 245
17.1 Demo dataset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
17.2 Carregando camadas raster e vetorial GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
17.3 Importing data into a GRASS LOCATION via drag and drop . . . . . . . . . . . . . . . . . . . 245
17.4 Managing GRASS data in QGIS browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.5 Opções do GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.6 Iniciando o complemento GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246

ii



17.7 Opening GRASS mapset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
17.8 Localização e MAPSET GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
17.9 Importando dados para uma localização GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . 247
17.10 O modelo de dados vetorial do GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
17.11 Criando uma nova camada vetorial GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
17.12 Digitalizando e editando uma camada vetorial GRASS . . . . . . . . . . . . . . . . . . . . . . . 251
17.13 A ferramenta região GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
17.14 Ferramentas GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

18 QGIS estrutura de processamento 261
18.1 Introdução . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
18.2 A caixa de ferramentas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
18.3 O modelador gráfico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
18.4 A interface de processamento em lote . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
18.5 Usando os algoritmos do processamento a partir do Terminal Python. . . . . . . . . . . . . . . . 283
18.6 Gerenciador do histórico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
18.7 Escrevendo novos algoritmos de processamento com scripts python . . . . . . . . . . . . . . . . 290
18.8 Entregando os dados produzidos pelo algoritmo . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.9 Comunicação com o usuário . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.10 Documentando seus scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.11 Exemplos de scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
18.12 Melhores práticas para algoritmos de script escrito . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.13 Pré e pós-execução de ganchos de script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.14 Configurando as aplicações externas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
18.15 O QGIS Comando . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301

19 Compositor de Impressão 303
19.1 Visão Geral do Compositor de Impressão . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303
19.2 Itens do Compositor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
19.3 Criando um arquivo de Saída . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

20 Complementos 347
20.1 Complementos QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347
20.2 Using QGIS Core Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
20.3 Complemento de Captura de Coordenadas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353
20.4 Complemento Gerenciador BD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353
20.5 Complemento dxf2shp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
20.6 Complemento eVis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356
20.7 Complemento fTools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366
20.8 Complemento Ferramentas GDAL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 369
20.9 Complemento Verificador de Geometria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
20.10 Geometry Snapper Plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375
20.11 Complemento Georreferenciador . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375
20.12 Complemento Mapa de Densidade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 380
20.13 Complemento de Interpolação . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
20.14 Catálogo do Cliente MetaBusca . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385
20.15 Complemento Edição Offiine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
20.16 Complemento GeoRaster Espacial Oracle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
20.17 Complemento Análise do Terreno . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
20.18 Complemento Menor Distância . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
20.19 Complemento de Consulta Espacial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395
20.20 Complemento Verificador de Topologia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395
20.21 Complemento Estatística Zonal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398

21 Ajuda e Suporte 399
21.1 Listas de Discurssão . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
21.2 IRC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
21.3 Rastreador de Erros . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
21.4 Blog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401

iii



21.5 Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
21.6 Wiki . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401

22 Apêndice 403
22.1 Licença Pública Geral GNU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 403
22.2 GNU Licença de Documentação Gratuíta . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 406

23 Referências Bibliográficas e Web 413

Índice 415

iv



CHAPTER 1

Preâmbulo

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

Os detalhes, dados e resultados neste documento podem ter sido escritos e verificados para melhorar o conheci-
mento e a responsabilidade dos autores e editores. No entanto, erros relativos ao conteúdo são possíveis.

Portanto, os dados não estão sujeitos a quaisquer direitos ou garantias. Os autores, editores e editoras não têm
qualquer responsabilidade por falhas e suas consequências. Você é sempre bem-vindo para relatar possíveis erros.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://qgis.org/en/site/getinvolved/index.html.

Links neste Documento

Este documento contém links internos e externos. Clicando sobre um link interno move-se dentro do documento,
ao clicar em um link externo abre um endereço de internet. Em formato PDF, links internos e externos são
mostradas em azul e são tratados pelo navegador do sistema. Em formato HTML, o navegador exibe e trata ambos
de forma idêntica.

Usuário, Instalação e Código Guia dos Autores e Editores:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 QGIS Development Team

Internet: http://www.qgis.org

Licença deste documento

Permissão é garantida para cópia, distribuição e/ou modificação deste documento sobre os termos da Licença
de Documentação Livre GNU, Versão 1.3 ou versão mais recente publicada pela Fundação Software Livre; sem
Seções Invariantes, sem textos de Capa e sem textos de Contra-Capa. A cópia da licença é incluída no Apêndice
GNU Licença de Documentação Gratuíta.
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2 Chapter 1. Preâmbulo



CHAPTER 2

Convenções

Esta seção descreve os estilos uniformes que serão utilizados ao longo deste manual.

2.1 Convenções da Interface Gráfica

Os estilos convenção da GUI, são destinados a similar a aparência gráfica. Em geral, um estilo vai refletir a
aparência, para que um usuário possa verificar visualmente a GUI e encontrar algo semelhante com as instruções
no manual.

• Menu Opções: Camada → Adicionar uma camada Raster ou Configurações → Barra de Ferramentas →
Digitalizar

• Tool: Add a Raster Layer

• Botão : [Salvar como padrão]

• Caixa de diálogo Título: Propriedades da camada

• Aba: Geral

• Caixa de seleção: Renderizar

• Radio Button: Postgis SRID EPSG ID

• Select a number:

• Select a string:

• Browse for a file:

• Select a color:

• Barra deslizante:

• Input Text:

Uma sombra indica um componente GUI clicável.

2.2 Convenções do Texto ou Teclado

This manual also includes styles related to text, keyboard commands and coding to indicate different entities, such
as classes or methods. These styles do not correspond to the actual appearance of any text or coding within QGIS.

• Hyperlinks: http://qgis.org

• A Combinação das teclas: Press Ctrl+B, ou seja, pressione e segure a tecla Ctrl e, em seguida, pressione
a tecla B.

3
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• Nome de um arquivo: lakes.shp

• Nome de uma classe: NewLayer

• Método: classFactory

• Servidor: myhost.de

• Texto de Usuário: qgis --help

Linhas de código serão indicadas por uma fonte de tamanho fixo:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instruções especificas da Plataforma

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on Macintosh OS X platforms, you should click the QGIS menu first, then Quit.

Grandes quantidades de texto podem ser formatados com uma lista:

• Faz isso

• Faz aquilo

• Faz outro

ou um parágrafo:

Faz isso, isso e isso. Então faz isso, isso e isso e isso, isso e isso, e isso, isso e isso.

Faz aquilo. E faz aquilo e aquilo e aquilo, e aquilo e aquilo e aquilo, e aquilo e aquilo e aquilo, e aquilo e aquilo
e aquilo, e aquilo e aquilo e aquilo.

Imagens que aparecem ao longo do guia do usuário foram criadas em diferentes plataformas, a plataforma é
indicada pelo ícone específico da plataforma no final da legenda da figura.
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CHAPTER 3

Preâmbulo

Bem vindo ao mundo maravilhoso dos Sistemas de Informação Geográficas (SIG)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(https://www.qt.io) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS aims to be a user-friendly GIS, providing common functions and features. The initial goal of the project
was to provide a GIS data viewer. QGIS has reached the point in its evolution where it is being used by many for
their daily GIS data-viewing needs. QGIS supports a number of raster and vector data formats, with new format
support easily added using the plugin architecture.

QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license means that
you can inspect and modify the source code, and guarantees that you, our happy user, will always have access to
a GIS program that is free of cost and can be freely modified. You should have received a full copy of the license
with your copy of QGIS, and you also can find it in Appendix Licença Pública Geral GNU.

Dica: Atualização da Documentação
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.
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CHAPTER 4

Feições

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Visualização de dados

Pode ver ou sobrepor dados vetoriais e matriciais em diferentes formatos e projeções sem conversão para um
formato interno ou comum. Os formatos suportados incluídos são:

• Tabelas ativadas espacialmente e visualização usando PostGIS, SpatiaLite e MS SQL Spatial, Oracle Spa-
tial, formatos vetoriais suportados pela biblioteca OGR instalada, incluindo arquivos de forma ESRI, Map-
Info, SDTS, GML e muitos mais. Consulte a seção Trabalhando com Dados Vetoriais.

• Formatos de imagens e Raster suportados pela biblioteca GDAL instalada (Geospatial Data Abstraction
Library), como GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG e muitos mais. Consulte a
seção Trabalhando com Dados Raster.

• Dados vetoriais e raster GRASS para base de dados GRASS (location.mapset). Ver seção Integração com
SIG GRASS.

• Servidores de dados espaciais online como Serviços Web OGC, incluem WMS, WMTS, WCS, WFS, e
WFS-T. Ver seção Trabalhando com dados OGC.

4.2 Exploração de dados e compositores de mapas

Você pode compor mapas e interativamente explorar dados espaciais com uma interface gráfica amigável. As
muitas ferramentas úteis disponíveis na GUI incluem:

• QGIS browser

• Reprojeção On-the-fly

• Gerenciador BD

• Compositor de Mapas

• Painel de Vista Global

• Marcadores espaciais

• Ferramentas de anotação

• Identificar/selecionar feições

• Editar/ver/procurar atributos

• Data-defined feature labelling

7



QGIS User Guide, Versão 2.14

• Ferramentas de simbologia raster e vetorial dado definido

• Compositor de Atlas com camada grade

• rótulos de Norte, barra de escala e copyright para o mapa

• Suporte para salvamento e restauração de projetos

4.3 Criar, editar, gerir e exportar dados

You can create, edit, manage and export vector and raster layers in several formats. QGIS offers the following:

• Ferramentas de digitalização para formatos suportados OGR e camadas vetoriais GRASS

• Habilitado para criar e editar camadas vetoriais shapefile e GRASS

• Complemento Georreferenciador para geocodificar imagens

• Ferramentas de GPS para importar e exportar formatos GPX, e converter outros formatos GPS para GPX
ou baixar/carregar diretamente para uma unidade GPS (No Linux, usb: pode ser adicionado na lista de
dispositivos GPS.)

• Suporte para visualização e edição de dados OpenStreetMap

• Habilitado para criar tabelas de base de dados espaciais a partir de shapefiles com complemento Gerenciador
BD

• Tratamento melhorado de tabelas de bases de dados espaciais

• Ferramentas para gerenciamento de tabelas de atributos vetoriais

• Opção para salvar as imagens como imagens georreferenciadas

• ferramenta de exportação DXF com recursos aprimorados para exportar estilos e complementos para exe-
cutar funções CAD-like

4.4 Analyze data

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use
the integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See
section Integração com SIG GRASS.) Or, you can work with the Processing Plugin, which provides a power-
ful geospatial analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA,
GRASS, fTools and more. (See section Introdução.)

4.5 Publicação de mapas na internet

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server.
(See section Trabalhando com dados OGC.) Additionally, you can publish your data on the Internet using a
webserver with UMN MapServer or GeoServer installed.

4.6 Extend QGIS functionality through plugins

QGIS can be adapted to your special needs with the extensible plugin architecture and libraries that can be used
to create plugins. You can even create new applications with C++ or Python!
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4.6.1 Complementos Core

Complementos incluídos no programa

1. Captura de Coordenadas (Captura coordenadas com o mouse em diferentes SRC’s)

2. DB Manager (Exchange, edit and view layers and tables from/to databases; execute SQL queries)

3. Conversor Dxf2Shp (Converte arquivos DXF para shapefiles)

4. eVIS (Visualiza eventos)

5. fTools (Analiza e gerencia dados vetoriais)

6. GDALTools (Integrate GDAL Tools into QGIS)

7. Georeferenciador GDAL (Adiciona a informação de projeção usando raster GDAL)

8. Ferramentas de GPS (Carrega e importa dados de GPS)

9. GRASS (Integra o SIG GRASS)

10. Mapa de calor (Gera uma mapa de calor raster a partir de dados de pontos)

11. Complemento Interpolação (Interpolação baseada em vértices de uma camada vetorial)

12. Cliente do Catalogo Metabusca

13. Edição Offline (Permitir a edição offline e sincronização com bancos de dados)

14. Oracle GeoRaster Espacial

15. Processamento (anteriormente chamado SEXTANTE)

16. Análise de terreno (Análise de terreno baseada em raster)

17. Caminho mais curto (Analisa uma rede com caminho mais curto)

18. Complemento de Consulta Espacial

19. Verificador de topologia (Encontra os erros topológicos em camadas vetoriais)

20. Complemento Estatística Zonal (Calcule contagem, soma e média de um raster para cada polígono de uma
camada vetorial)

4.6.2 Complementos Externos Python

QGIS offers a growing number of external Python plugins that are provided by the community. These plugins
reside in the official Plugins Repository and can be easily installed using the Python Plugin Installer. See Section
Diálogo de Complementos.

4.7 Console Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.
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4.8 Problemas conhecidos

4.8.1 Limitação no número de arquivos abertos

Se você está abrindo um grande projeto QGIS e você tem certeza de que todas as camadas são válidas, mas
algumas camadas são sinalizadas como ruim, você provavelmente irá se confrontar com esta questão. O Linux
(e outros sistemas operacionais, da mesma forma) tem um limite de arquivos abertos por processo. Limites de
recursos por processo e hereditária. O comando ulimit, que é um shell integrado, muda os limites apenas para
o processo de shell atual; o novo limite será herdado por quaisquer processos filhos.

Você pode ver todos os atuais limites de informações digitando

user@host:~$ ulimit -aS

You can see the current allowed number of opened files per process with the following command on a console

user@host:~$ ulimit -Sn

Para alterar os limites para uma sessão existente, você pode ser capaz de usar algo como

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Para fixar isso sempre

Na maioria dos sistemas Linux, limites de recursos são definidos no login pelo módulo
pam_limits de acordo com as definições contidas no /etc/security/limits.conf ou
/etc/security/limits.d/*.conf. Você será capaz de editar os arquivos, se você tem privilégios
de root (também via sudo), mas você vai precisar fazer login novamente para que as alterações tenham efeito.

Mais informações:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

O que há de novo no QGIS 2.14

Esta versão contém novas características e se estende a interface de programação com respeito as versões anteri-
ores. Se recomenda que utilize esta versão sobre as versões anteriores.

This release includes hundreds of bug fixes and many new features and enhancements over QGIS 2.8 that will be
described in this manual. You may also review the visual changelog at:

• http://qgis.org/en/site/forusers/visualchangelog210/index.html

• http://qgis.org/en/site/forusers/visualchangelog212/index.html

• http://qgis.org/en/site/forusers/visualchangelog214/index.html
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CHAPTER 6

Iniciando

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Instalação

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and Mac OS X. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Instalação à partir da fonte

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Instalação no dispositivo de armazenamento externo

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section Menu Sistema for additional
information.

6.1.3 Amostra de Dados

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• Usar dados SIG que já possuo

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Uninstall QGIS and reinstall with the data download option checked (only recommended if the above solu-
tions are unsuccessful)

For GNU/Linux and Mac OS X, there are not yet dataset installation packages available as rpm,
deb or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data/ and unzip the archive on your system.
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The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.2 Launching QGIS

6.2.1 Starting and Stopping QGIS

Starting QGIS is done as you usually do for any other application on your platform. It means that you can launch
QGIS by:

• typing qgis at a command prompt, assuming that QGIS is added to your PATH or you’re in its installation
folder

• using the Applications menu if using a precompiled binary, the Start menu or the Dock

• double clicking the icon in your Applications folder or desktop shortcut

• double clicking an existing QGIS project (.qgs) file. Note that this will also open the project

To stop QGIS, click:

• the menu option Project → Exit QGIS or use the shortcut Ctrl+Q

• QGIS → Quit QGIS, or use the shortcut Cmd+Q

• or use the red cross at the right top corner of the main interface of the application.

6.2.2 Opções da Linha de Comandos

In previous section you learned how to start QGIS. You will see that QGIS also provides further command line
options.

QGIS supports a number of options when started from the command line. To get a list of the options, enter qgis
--help on the command line. The usage statement for QGIS is:
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qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Dica: Exemplo do Uso dos argumentos da linha de comandos
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Opção da linha de comandos --snapshot

Esta opção permite que possa criar uma captura de ecrã no formato PNG da visão atual. Isto vem a calhar quando
tem vários projetos e quer gerar capturas de tela dos seus dados.

Currently, it generates a PNG file with 800x600 pixels. This can be adjusted using the --width and --height
command line arguments. A filename can be added after --snapshot.

Opção da linha de comandos --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, qgis --lang it starts QGIS in Italian localization.

Opção da linha de comandos --projeto

Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Opção da linha de comandos --extent
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Use esta opção para iniciar com uma extensão de mapa específica. Necessita adicionar uma quadro delimitador
da sua extensão na seguinte ordem, seguido por uma vírgula:

--extent xmin,ymin,xmax,ymax

Opção da linha de comandos --nologo

This command line argument hides the splash screen when you start QGIS.

command line option --noversioncheck

Don’t check for new version of QGIS at startup.

Opção da linha de comandos --noplugins

Se você tiver problemas ao iniciar os complementos, poderá evitar iniciar-los com essa opção. Estarão sendo
disponíveis depois no gerenciador de complementos. Opção de linha de comando --customizationfile

Usando este argumento de linha de comando, você pode definir um arquivo GUI personalizado, que será aplicado
ao iniciar.

Opção da linha de comandos --nocustomization

Usando este argumento de linha de comando, um arquivo GUI personalizado existente, não será aplicado ao
iniciar.

Opção da linha de comandos --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Opções to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use
option:

--optionspath /path/to/config/

Opção da linha de comandos --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Command line option --authdbdirectory

Again, this option is similar to the one above but define the path to the directory where the authentication database
will be stored.

Opção de linha de comandos --código

This option can be used to run a given python file directly after QGIS has started.

Por exemplo, quando se tem um arquivo python chamado load_alaska.py com o seguinte conteúdo:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

Command line options --dxf-*
These options can be used to export QGIS project into a DXF file. Several options are available:

• –dxf-export: the DXF filename into which to export the layers;

• –dxf-extent: the extent of the final DXF file;
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• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);

• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: the file encoding;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Layers Panel.

6.3 Sample Session: Load raster and vector layers

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short and simple
QGIS sample session. We will visualize a raster and a vector layer. We will use:

• the landcover raster layer i.e., qgis_sample_data/raster/landcover.img

• and the lakes vector layer i.e., qgis_sample_data/gml/lakes.gml.

1. Start QGIS as seen in Starting and Stopping QGIS

2. Click on the Add Raster Layer icon.

3. Navegue até a pasta qgis_sample_data/raster/, selecione o arquivo ERDAS IMG
landcover.img e clique [Abrir].

4. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case Erdas Imagine Images (*.img *.IMG).

5. Now click on the Add Vector Layer icon.

6. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.

7. Browse to the folder qgis_sample_data/gml/, select Geography Markup Language [GML]
[OGR] (*.gml *.GML) from the Filter combo box, then select the GML file lakes.gml and
click [Open]. In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog
opens with NAD27 / Alaska Alberts selected, click [OK].

8. Zoom in a bit to your favourite area with some lakes.

9. De duplo clique na camada lakes da legenda do mapa para abrir o diálogo Propriedades

10. Clique na janela Estilo e selecione um preenchimento de cor azul.

11. Click on the Labels tab and select Show labels for this layer in the drop-down menu to enable labeling.
Then from the Label with list, choose the NAMES field as the field containing labels.

12. To improve readability of labels, you can add a white buffer around them by clicking Buffer in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

13. Clique [Aplicar]. Confira se o resultado ficou bom e clique finalizar [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Projetos

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opções). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
As.... If the loaded project file on disk was meanwhile changed, by default, QGIS will ask you if you want to
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overwrite the changes into the project file. This behavior is set by checking Prompt to save project and data
source changes when required under Settings → Options → General menu .

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

At startup, a list of screenshot with the name and path of each of the most recent projects (up to ten) is shown
instead of a white and empty map canvas. This is a handy and quicker way to remember what a project was about
and double-click a row opens the selected project. If you’re willing to create a new project, just add new layers
and the list disappears.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

O tipo de informação salva num arquivo de projeto inclui:

• Camadas adicionadas

• Which layers can be queried

• Layer properties, including symbolization and styles

• Projeção para a vista do mapa

• Última extensão visualizada

• Compositores de Impressão

• Print Composer elements with settings

• Print Composer atlas settings

• Digitizing settings

• Table Relations

• Project Macros

• Project default styles

• Configurações de complementos

• QGIS Server settings from the OWS settings tab in the Project properties

• Queries stored in the DB Manager

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly any more. To be made aware of this, in the General tab under Settings

→ Options you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a project in QGIS a backup of the project file is made with the extension .qgs~.

6.5 Arquivo de Saída

There are several ways to generate output from your QGIS session. We have discussed one already in section
Projetos, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image... opens a file dialog where you select the name, path and type
of image (PNG, JPG and many other formats). A world file with extension PNGW or JPGW saved in the
same folder georeferences the image.

• Menu option Project → DXF Export... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.
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• Menu option Project → New Print Composer... opens a dialog where you can layout and print the
current map canvas (see section Compositor de Impressão).
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CHAPTER 7

Interface do QGIS

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Nota: Suas decorações de janela (barra de título, etc) podem parecer diferentes dependendo do seu sistema
operacional e gerenciador de janelas.

The QGIS GUI is divided into five areas:

1. Barra de Menu

2. Toolbars

3. Panels

4. Visualização do mapa

5. Barra de Status

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Barra de Menu

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Embora a maioria das opções de menu tem uma ferramenta correspondente e vice-versa, os menus não são orga-
nizados exatamente como as barras de ferramentas. A barra de ferramentas que contém as ferramentas que estão
listadas depois de cada opção habilitada no menu de entrada. Algumas opções de menu aparecem somente se o
complemento correspondente for carregado. Para mais informações sobre as ferramentas e barras de ferramentas,
consulte a seção :ref: label_toolbars.

Nota: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Projeto

Opção de menu Atalho Referência Barra de Ferramentas

New Ctrl+N ver Projetos Projeto

Open Ctrl+O ver Projetos Projeto
Novo a partir do modelo → ver Projetos
Open Recent → ver Projetos

Save Ctrl+S ver Projetos Projeto

Save As... Ctrl+Shift+S ver Projetos Projeto

Save as Image... ver Arquivo de Saída
DXF Export... ver Arquivo de Saída

Project Properties... Ctrl+Shift+P ver Projetos

New Print Composer Ctrl+P ver Compositor de Impressão Projeto

Composer manager... ver Compositor de Impressão Projeto
Imprimir Compositores → ver Compositor de Impressão

Exit QGIS Ctrl+Q

Under Mac OSX, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Editar

Opção de menu Atalho Referência Barra de
Ferramentas

Undo Ctrl+Z ver Digitalização Avançada Digitalização
Avançada

Redo Ctrl+Shift+Zver Digitalização Avançada Digitalização
Avançada

Cut Features Ctrl+X ver Digitalizar uma camada
existente

Digitalização

Copy Features Ctrl+C ver Digitalizar uma camada
existente

Digitalização

Paste Features Ctrl+V ver Digitalizar uma camada
existente

Digitalização

Colar feição como → Veja Trabalhando com a Tabela de
Atributos

Add Feature Ctrl+. ver Digitalizar uma camada
existente

Digitalização

Move Feature(s) ver Digitalizar uma camada
existente

Digitalização

Delete Selected ver Digitalizar uma camada
existente

Digitalização

Rotate Feature(s) ver Digitalização Avançada Digitalização
Avançada

Simplify Feature ver Digitalização Avançada Digitalização
Avançada

Add Ring ver Digitalização Avançada Digitalização
Avançada

Add Part ver Digitalização Avançada Digitalização
Avançada

Fill Ring ver Digitalização Avançada Digitalização
Avançada

Delete Ring ver Digitalização Avançada Digitalização
Avançada

Delete Part ver Digitalização Avançada Digitalização
Avançada

Reshape Features ver Digitalização Avançada Digitalização
Avançada

Offset Curve ver Digitalização Avançada Digitalização
Avançada

Split Features ver Digitalização Avançada Digitalização
Avançada

Split Parts ver Digitalização Avançada Digitalização
Avançada

Merge Selected Features ver Digitalização Avançada Digitalização
Avançada

Merge Attr. of Selected
Features

ver Digitalização Avançada Digitalização
Avançada

Node Tool ver Digitalizar uma camada
existente

Digitalização

Rotate Point Symbols ver Digitalização Avançada Digitalização
Avançada
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Editar (extra)

Opção de menu Atalho Referência Barra de Ferramentas

Add Feature ver Digitalizar uma camada existente Digitalização

Add Feature ver Digitalizar uma camada existente Digitalização

Add Feature ver Digitalizar uma camada existente Digitalização

7.1.4 Ver

Opção de menu Atalho Referência Barra de Ferramentas

Pan Map see Zooming and Panning Navegação no Mapa

Pan Map to Selection Navegação no Mapa

Zoom In Ctrl++ see Zooming and Panning Navegação no Mapa

Zoom Out Ctrl+- see Zooming and Panning Navegação no Mapa
Selecionar → ver Selecionar e desselecionar feições Atributos

Identify Features Ctrl+Shift+I see Identificar feições Atributos
Medir → ver Medição Atributos

Statistical Summary see Statistical Summary Panel Atributos

Zoom Full Ctrl+Shift+F Navegação no Mapa

Zoom To Layer Navegação no Mapa

Zoom To Selection Ctrl+J Navegação no Mapa

Zoom Last Navegação no Mapa

Zoom Next Navegação no Mapa

Zoom To Native Resolution Navegação no Mapa
Decorações → ver decorações
Preview mode →

Map Tips see Menu Visualização Atributos

New Bookmark... Ctrl+B ver Favoritos Espaciais Atributos

Show Bookmarks Ctrl+Shift+B ver Favoritos Espaciais Atributos

Refresh F5 Navegação no Mapa
Painéis → veja Panels and Toolbars
Barra de Ferramentas → veja Panels and Toolbars
Toggle Full Screen Mode F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under Mac OS X.
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7.1.5 Camada

Opção de menu Atalho Referência Barra de
Ferramentas

Create Layer → veja Criando novas camadas
Vetoriais

Gerenciar camadas

Add Layer → see Formatos de dados suportados Gerenciar camadas
Embed Layers and
Groups...

ver Projetos animados

Add from Layer Definition
File...

Copy style see Save and Share Layer Properties

Paste style see Save and Share Layer Properties

Open Attribute Table Veja Trabalhando com a Tabela de
Atributos

Atributos

Toggle Editing ver Digitalizar uma camada existente Digitalização

Save Layer Edits ver Digitalizar uma camada existente Digitalização

Current Edits → ver Digitalizar uma camada existente Digitalização
Save As... see Save layer into file
Save As Layer Definition
File...

Remove Layer/Group Ctrl+D

Duplicate Layers (s)
Set Scale Visibility of
Layers
Set CRS of Layer(s) Ctrl+Shift+C
Set project CRS from Layer
Properties... see Janela de Propriedades de Vetor
Filter... see Query Builder

Labeling see Menu Rótulos

Add to Overview Ctrl+Shift+O Gerenciar camadas

Add All To Overview

Remove All From
Overview

Show All Layers Ctrl+Shift+U Gerenciar camadas

Hide All Layers Ctrl+Shift+H Gerenciar camadas

Show selected Layers

Hide selected Layers
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7.1.6 Configurações

Opção de menu Atalho Referência Barra de
Ferramentas

Custom CRS... ver Sistema de Referência de Coordenadas
personalizado

Gerenciador de
estilos...

ver O Gerenciador de Estilos

Configure
shortcuts...

Customization... ver Personalização
Options... ver Opções

Snapping Options... see Configurando a Tolerância de Atracção e Raio
de Pesquisa

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars →
and Toggle Full Screen Mode.

7.1.7 Complementos

Opção de menu Atalho Referência Barra de Ferramentas

Manage and Install Plugins... ver Diálogo de Complementos
Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vetor

Opção de menu Atalho Referência Barra de
Ferramentas

Open Street Map → veja Carregando vetores
OpenStreetMap

Ferramenta de Análise → ver Complemento fTools

Ferramenta de pesquisa → ver Complemento fTools

Ferramenta de Geoprocessamento
→

ver Complemento fTools

Ferramenta de Geometria → ver Complemento fTools

Ferramenta de Gerenciamento de
Dados →

ver Complemento fTools

When starting QGIS for the first time not all core plugins are loaded.

7.1.9 Raster

Opção de menu Atalho Referência Barra de Ferramentas
Raster calculator... see Calculadora Raster
Align Raster... see Raster Alignment

When starting QGIS for the first time not all core plugins are loaded.
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7.1.10 Base de dados

Opção de menu Atalho Referência Barra de Ferramentas
Database → see Complemento Gerenciador BD Database

When starting QGIS for the first time not all core plugins are loaded.

7.1.11 Web

Opção de menu Atalho Referência Barra de Ferramentas
Metasearch see Catálogo do Cliente MetaBusca Web

When starting QGIS for the first time not all core plugins are loaded.

7.1.12 Processamento

Opção de menu Atalho Referência Barra de
Ferramentas

Toolbox veja A caixa de ferramentas

Graphical
Modeler...

veja O modelador gráfico

History and
log...

veja Gerenciador do histórico

Options... veja Configurando a infraestrutura do
processamento

Results viewer... veja Configurando as aplicações externas

Commander Ctrl+Alt+M veja O QGIS Comando

When starting QGIS for the first time not all core plugins are loaded.

7.1.13 Ajuda

Opção de menu Atalho Referência Barra de Ferramentas

Help Contents F1 Ajuda

What’s This? Shift+F1 Ajuda
API Documentation
Report an Issue
Need commercial support?

QGIS Home Page Ctrl+H

Check QGIS Version

About

QGIS Sponsors

7.1.14 QGIS

This menu is only available under Mac OS X and contains some OS related commands.
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Opção de menu Atalho Referência
Preferences
About QGIS
Hide QGIS
Show All
Hide Others
Quit QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.

7.2 Panels and Toolbars

From the View menu (Settings under KDE), you can switch on and off QGIS widgets (Panels →) or toolbars
(Toolbars →). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item
you want. Each panel or toolbar can be moved and placed wherever you feel comfortable with in QGIS interface.
The list can also be extended with the activation of Core or external plugins.

7.2.1 Toolbars

A barra de ferramentas permite o acesso à maioria das mesmas funções dos menus, além de ferramentas adicionais
para interagir com o mapa. Cada item da barra de ferramentas pop-up tem ajuda disponível. Mantenha o mouse
sobre o item e uma breve descrição a respeito da ferramenta será exibida.

Every toolbar can be moved around according to your needs. Additionally, they can be switched off using the
right mouse button context menu, or by holding the mouse over the toolbars.

Figure 7.2: The Toolbars menu
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Dica: Restaurar barra de ferramentas
If you have accidentally hidden a toolbar, you can get it back by choosing menu option View → Toolbars → (or
Settings → Toolbars → under Linux KDE). If for some reason a toolbar (or any other widget) totally disappears
from the interface, you’ll find tips to get it back at restoring initial GUI.

7.2.2 Panels

QGIS provides by default many panels to work with.

Figure 7.3: The Panels menu

Some of these panels are described below while others may be found in different parts of the document, namely:

• the Browser Panel

• the Advanced Digitizing Panel

• the Spatial Bookmarks Panel

• the GPS Information Panel

• the Tile Scale Panel

• the Identify Panel

• the User Input Panel

Layers Panel

The layers panel lists all the layers in the project. The checkbox in each legend entry can be used to show or hide
the layer. The toolbar in the layers panel allows you to:

• Add new group

• Manage Visibility: control visibility of layers and preset layers combination
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• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.

• Expand All or Collapse All layers and groups in the layers panel.

• and Remove Layer/Group currently selected.

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

Todos os preestabelecidos adicionados estarão presentes no desenho de impressão afim de permitir a criação de
um desenho de mapa de mapa com base em seus pontos de visão específicos (ver Propriedades principais).

Nota: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Uma camada pode ser selecionada e arrastada para cima ou para baixo na legenda para mudar a Z-ordenação. Z-
ordenação significa que as camadas listadas mais perto do topo da legenda são desenhadas sobre camadas listadas
mais abaixo na legenda.

Nota: This behavior can be overridden by the Layer Order panel.

Layers in the legend window can be organized into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Selecione algumas camadas, clique direito na janela de legenda e escolha Grupo selecionado. As camadas
selecionadas serão automaticamente colocadas em um novo grupo.

Para trazer uma camada de um grupo, você pode arrastá-la de fora, ou clique direito sobre ela e escolha Faça o
item toplevel. Os grupos também podem ser aninhados dentro de outros grupos.

A caixa de seleção de um grupo vai mostrar ou ocultar todas as camadas do grupo com apenas um clique.

The content of the right mouse button context menu depends on whether the selected legend item is a raster or a

vector layer. For GRASS vector layers, Toggle editing is not available. See section Digitalizando e editando uma
camada vetorial GRASS for information on editing GRASS vector layers.

Below are listed available options in context menu depending on the selected item.
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Option Vector Layer Raster Layer Group

Zoom to Layer/Group

Show in Overview

Zoom to Native Resolution (100%)

Stretch Using Current Extent

Remove

Duplicate

Estabelecer escala de visibilidade da camada

Set Layer/Group CRS

Definir SRC do projeto a partir da Camada

Styles →
Copy Style

Paste Style

Open Attribute Table

Toggle Editing

Current Edits → (in Edit mode)

Save As...

Save As Layer Definition File...

Filtrar

Show Feature Count

Propriedades...

Move to Top-level

Renomear

Agrupar Selecionados

Propriedades...

Set Group WMS Data

Mutually Exclusive Group

Add Group

Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

É possível selecionar mais de uma camada ou grupo ao mesmo tempo segurando a tecla Ctrl enquanto seleciona
as camadas com o botão esquerdo do mouse. Pode mover todas as camadas selecionadas para um novo grupo ao
mesmo tempo.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Editando o estilo da camada vetorial

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles –> in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer
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• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Nota: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the The symbol Selector dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Color Selector widget with a Color Wheel from which you can click a color and have it automatically
update the symbol fill color. For convenience, Recent colors are available at the bottom of the color wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Dica: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

Trabalhando com a Ordem da legenda de camada independente

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate it in
the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.

Figure 7.4: Define a legend independent layer order
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Statistical Summary Panel

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;

• filter statistics to selected features;

• refresh the informations;

• the statistics information to display with the bottom right button;

QGIS Overview Panel

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

Log Messages Panel

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

Undo/Redo Panel

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above.

7.3 Visualização do mapa

Also called Map canvas, this is the “business end” of QGIS — maps are displayed in this area. The map displayed
in this window will depend on the vector and raster layers you have chosen to load (see sections that follow for
more information on how to load layers). The map view can be panned, shifting the focus of the map display
to another region, and it can be zoomed in and out. Various other operations can be performed on the map as
described in the label_toolbars description above. The map view and the legend are tightly bound to each other —
the maps in view reflect changes you make in the legend area.

Dica: Ampliando o mapa com a roda do mouse
Você pode usar a roda do mouse para zoom in e out no mapa. Coloque o cursor do mouse dentro da área do mapa
e gire a roda para a frente (longe de você) para ampliar e para trás (para você) para diminuir o zoom. A posição
do cursor do mouse é o centro onde o zoom ocorre. Você pode personalizar o comportamento do zoom roda do
mouse usando o :guilabel: aba Ferramentas do mapa sob o menu Configurações → Opções.

Dica: Percorrendo o mapa com as setas e a barra de espaço
Você pode usar as setas do teclado para se deslocar no mapa. Coloque o cursor do mouse dentro da área do mapa
e clique na seta para a direita para pan Leste, seta para a esquerda para pan Oeste, seta para cima para pan Norte
e para baixo seta para deslocar Sul. Você também pode deslocar o mapa utilizando a barra de espaço ou clique na
roda do mouse.

34 Chapter 7. Interface do QGIS



QGIS User Guide, Versão 2.14

7.4 Barra de Status

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

To the right of the scale display you can define a current clockwise rotation for your map view in degrees.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Renderização).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Dica: Calculando a escala correta do seu Mapa da tela/visualização
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Ferramentas Gerais

8.1 Atalhos de teclado

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra de Menu. Addi-
tionally, the menu option Settings → Configure Shortcuts... allows you to change the default keyboard shortcuts
and add new keyboard shortcuts to QGIS features.

Figure 8.1: Define shortcut options

Configuration is very simple. Just select a feature from the list and click on :

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Conteúdo da ajuda

Quando precisar de ajuda num tópico específico, pode acessar a ajuda de contexto [Help], através do botão
disponível na maioria dos diálogos– por favor, veja que plugins de terceiras partes podem apontar para páginas
web específicas.
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8.3 Renderização

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Adicionar uma camada

• Pan ou zoom

• Resizing the QGIS window

• Mudanças na visibilidade de uma camada ou camadas

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Escala dependente da renderização

A representação dependente da escala, permite especificar as escalas mínima e máxima as quais a camada será
visível. Para definir uma visualização dependente da escala, abra o diálogo Propriedades, clicando duas vezes

sobre a legenda da camada. Na aba Geral, clique na caixa Visibilidade dependente da Escala para ativar a
função, depois coloque os valores de escala mínimo e máximo.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Controlando a renderização do mapa

Map rendering can be controlled in various ways, as described below.

Suspensão de edição

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Renderização. Examples of when you might want to suspend rendering include:

• Adicionando várias camadas e simbolizando antes do desenho.

• Adicionando uma ou mais camadas grandes e definindo a dependência de escala antes do desenho.

• Adicionando uma ou várias camadas grandes e definindo a escala de visualização antes do desenho.

• Qualquer combinação dos anteriores

Caixa de seleção :guilabel: caixa de seleção Renderizar permite renderização e causa uma atualização imediata
na tela do mapa.

Opções de adicionar configurações da camada

Pode-se definir uma opção para que possa carregar novas camadas sem visualizá-las. Isto implica que a camada
será adicionada ao mapa, mas a caixa de visibilidade na legenda estará desmarcada por padrão. Para definir esta

opção, escolha o menu de opções Definições → Opções e clique em Representação. Desmarque a caixa Por
Padrão novas camadas adicionadas ao mapa serão visualizadas. Qualquer camada adicionada depois ao mapa
estará deligada (invisível) por padrão.
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Parar rendirização

Para parar o desenho no mapa, pressione a tecla ESC. Isto irá parar a atualização da tela do mapa e deixar o mapa
parcialmente desenhado. Pode levar um pouco de tempo entre pressionar ESC e o tempo que o desenho do mapa
será interrompido.

Nota: No momento não é possível parar a representação ou visualização — isto foi desabilitado no porta Qt4
devido a que a Interface do usuário (UI) ocasiona problemas e colapsa.

Influência da qualidade da edição

QGIS has an option to influence the rendering quality of the map. Choose menu option Settings → Options, click

on the Rendering tab and select or deselect Make lines appear less jagged at the expense of some drawing
performance.

Acelerando a visualização

There are some settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• :guilabel:‘ Usar o cache de visualização quando possível para agilizar re-desenhos‘

• Render layers in parallel using many CPU cores and then set the Max cores to use.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Color Selector

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

This dialog has four different tabs which allow you to select colors by color ramp, color wheel, color swatches

or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

Dica: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the General Settings to have the color applied to your
items as you change color parameters in the QGIS custom color chooser dialog.

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is populated
with one of three methods:
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Figure 8.2: Color selector ramp tab

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.

Figure 8.3: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.

Dica: quick color picker + copy/paste colors
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the

drop-down arrow that follows the color box.
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Figure 8.4: Quick color selector menu

8.5 Modos de Mistura

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with the
pixel beneath it. The colors aren’t mixed.

• Lighten: This selects the maximum of each component from the foreground and background pixels. Be
aware that the results tend to be jagged and harsh.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (e.g., you can use a hillshade to texture
another layer).

• Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works best
if the top pixels aren’t too bright; otherwise the effect is too extreme.

• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge. This
is supposed to emulate shining a soft light onto an image.

• Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.
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8.6 Zooming and Panning

QGIS provides tools to zoom and pan to your area of interest.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

8.6.1 Zooming and panning with the mouse wheel

You can press the mouse wheel to pan inside of the main window, and you can roll the mouse wheel to zoom
in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward (away from
you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the center of the
zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map tools tab under
the Settings → Options menu.

8.6.2 Panning with the arrow keys

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow key to pan
south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out.

8.7 Medição

QGIS provides four means of measuring geometries:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Identificar feições tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. The first three measuring
tools behave equally to global project settings:

If “on the fly” CRS transformation is enabled, the default measurement metric is - different from most other GIS -
ellipsoidal, using the ellipsoid defined in File → Project properties → General. This is true both when geographic
and projected coordinate systems are defined for the project. If you want to calculate the projected / planimetric
area or distance using cartesian maths, the measurement ellipsoid has to be set to “None / Planimetric” (File →
Project properties → CRS). However, with a geographic (= unprojected) CRS defined for the data and project, area
and distance measurement will be ellipsoidal. If “on the fly” CRS transformation is disabled, the measurement
metric is planimetric when the project coordinate system is projected and ellipsoidal when the project coordinate
system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.
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8.7.1 Measure length, areas and angles interactive

All measuring modules use the snapping settings from the digitizing module. This is useful, if you want to measure
along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
You can define a rubberband color and your preferred measurement units (meters or feet) and angle units (degrees,
radians and gon) in the menu option Settings → Options → Map Tools. The tool then allows you to click points
on the map. Each segment length, as well as the total, shows up in the measure window. To stop measuring,
click your right mouse button. Note that you can interactively change the measurement units in the measurement
dialog. It overrides the Preferred measurement units in the options. There is an info section in the dialog that
shows which CRS settings are being used during measurement calculations.

Figure 8.5: Measure Distance

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Configurando a Tolerância de Atracção e Raio de Pesquisa). So, if you want to measure exactly
along a line feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now, when
using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.

Figure 8.6: Measure Area

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.7: Measure Angle
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8.8 Selecionar e desselecionar feições

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Features by area or single click to select feature(s) either by simple click or by rectangle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

To deselect all selected features, click on Deselect Features from All Layers.

Select features using an expression allows user to select features using expression dialog. See Expressões chapter for
some example.

Users can save selected features into a New Memory Vector Layer or a New Vector Layer using Edit → Copy
Features and Edit → Paste Features as in the wanted format.

8.9 Data defined override setup

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows:

• a Description ... that indicates if it is enabled, which input expected, valid input type and the current
definition,

• an entry to list the Field type available,

• an entry to list the Variable available,

• Edit ... button to create or edit the expression to use,

• Paste and Copy buttons,

• Clear button to remove the setup.

Dica: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken, the
icon is red or .

Parameters that can be used with data-defined tools are:

• Style and symbols parameters

• Labels parameters

• Composer parameters
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8.10 Identificar feições

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click the Identify features

icon on the Attributes toolbar.

QGIS offers two ways to identify features with the Identify features tool:

• left click will identify features according to the mode set in the Identify results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.

If you click on feature(s), the Identify results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Properties → Display.
Then follows all the other information about the feature.

Essa janela pode ser personalizada para exibir campos personalizados, mas por padrão ele irá exibir apenas três
tipos de informação:

• Actions: Actions can be added to the identify feature windows. The action is run by clicking on the action
label. By default, only one action is added, namely view feature form for editing. You can define
more actions in the layer’s properties dialog.

• Derived: This information is calculated or derived from other information. This includes the feature id,
its length or perimeter and area in map units depending on its geometry, the count of spatial parts and the
number of the clicked part in case of multi-geometry, the count of vertices in the feature and the number of
the closest one to the point clicked. It also reports the X and Y (and Z/M if available) coordinate values of
both clicked point and feature closest vertex.

• Data attributes: This is the list of attribute fields and values for the feature that has been clicked.

Figure 8.8: Identify features dialog

No topo da janela, há sete ícones:

• Expand tree

• Collapse tree

• Default behavior to define whether next identified features information should be collapsed or expanded

• View the feature form

• Clear Results

8.10. Identificar feições 45



QGIS User Guide, Versão 2.14

• Copy selected feature to clipboard

• Print selected HTML response

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• ‘Current layer’ : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• ‘Top down, stop at first’: for only features from the upper visible layer.

• ‘Top down’: for all features from the visible layers. The results are shown in the panel.

• and ‘Layer selection’: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

The View can be set as ‘Tree’, ‘Table’ or ‘Graph’. ‘Table’ and ‘Graph’ views can only be set for raster layers.

The identify tool allows you to auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Outras funções podem ser encontrados no menu de contexto do item identificado. Por exemplo, do menu de
contexto, você pode:

• Ver o formulário da feição

• Zoom para feição

• Copiar feição: Copiar todos os atributos e a geometria da feição

• Toggle feature selection: Adds identified feature to selection

• Copiar o valor do atributo: Copiar apenas o valor do atributo que clicou.

• Copy feature attributes: Copy the attributes of the feature

• Limpar resultados: apaga os resultados na janela

• Limpar destaques: Remover feiçõesdestacadas no mapa

• Destaque todos

• Destaque a camada

• Ativar camada: escolha uma camada a ser ativada

• Propriedades da camada: Abre a janela de propriedades da camada

• Estender tudo

• Encolher tudo

8.11 Ferramentas de anotação

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Dê um duplo clique no item para abrir o diálogo com várias opções. Tem um editor de texto para entrar texto for-
matado e definir outros itens. Por exemplo, tem uma forma de colocar um item numa posição do mapa (mostrada
por um símbolo marcador) or para ter um item numa posição da tela (não relacionada ao mapa).O artigo pode ser
movido pela posição do mapa (arrastando o marcador do mapa) ou movendo apenas o balão. Os ícones são parte
do tema GIS e podem ser usados como padrão em outros temas também.

The Move Annotation tool allows you to move the annotation on the map canvas.
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Figure 8.9: Annotation text dialog

8.11.1 Anotações HTML

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.11.2 Anotações SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.11.3 Anotação de formulário

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.

Nota: Se você pressionar Ctrl+T enquanto uma ferramenta Anotação está ativa (mover anotação, texto de
anotação, formulário de anotação), os estados de visibilidade dos itens serão invertidos.

8.12 Favoritos Espaciais

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later. Bookmarks are saved on
the computer, meaning that they are available from any project in the same computer.

8.12.1 Novo Favorito

Para criar um novo favorito:
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Figure 8.10: Customized qt designer annotation form

1. Zoom ou pan na área de interesse.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Adicione um nome descritivo para o favorito (no máximo 255 caracteres).

4. Press Enter to add the bookmark or click elsewhere.

Note que você pode ter vários favoritos com o mesmo nome.

8.12.2 Trabalhando com favoritos

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Zoom to a Bookmark: select the desired bookmark and then click Zoom To Bookmark. You can also zoom
to a bookmark by double-clicking on it.

• Delete a Bookmark: select the bookmark and click Delete Bookmark. Confirm your choice.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.13 Projetos animados

Se deseja incorporar conteúdo de outros arquivos de projetos no seu projeto, pode escoler Camada →Incorporar
Camadas e Grupos.

8.13.1 Incorporando camadas

Os siguientes diálogos permitem incorporar camadas de outros projetos. Aqui um pequeno exemplo:

1. Press to look for a project from the Alaska dataset.
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2. Select the project file relations.qgs. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers airports and regions. Press [OK]. The selected layers are em-
bedded in the map legend and the map view now.

Figure 8.11: Select layers and groups to embed

Enquanto as camadas incorporadas são editáveis, não podem ser mudadas suas propriedades de estilo e rotulação.

8.13.2 Removendo camadas incorporadas

Right-click on the embedded layer and choose Remove.

8.14 Decorações

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.14.1 Malha

Grid allows you to add a coordinate grid and coordinate annotations to the map canvas.

Figure 8.12: The Grid Dialog

1. Selecionar do menu Ver → Decorações → Malha. O diálogo abre (veja figure_decorations_1).
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2. Marque a guia Abilitar Malha e coloque as definições da malha de acordo as camadas carregadas na tela
do mapa.

3. Marque a guia Desenhar anotações e coloque as definições de anotações, de acordo as camadas car-
regadas na tela do mapa.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.14.2 Rótulo Copyright

Copyright label adds a copyright label using the text you prefer to the map.

Figure 8.13: The Copyright Dialog

1. Selecionar no menu Ver → Decorações → Etiqueta de Propriedade Intelectual. O diálogo abre (veja
figure_decorations_2).

2. Confirme que a caixa Abilitar Etiqueta Direito de Cópia está selecionada.

3. Entre o texto que deseja colocar no mapa. Pode usar HTML como mostrado no exemplo.

4. Choose the placement of the label from the Placement combo box.

5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.14.3 Seta Norte

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.
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Figure 8.14: The North Arrow Dialog

8.14.4 Barra de Escala

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labelling of the bar.

Figure 8.15: The Scale Bar Dialog

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Para adicionar uma barra de escala:

1. Seleccione a partir do menu: menuselection: Ver -> Decorações -> Barra de Escala. O diálogo abre (veja
figure_decorations_4).

2. Confirme que a caixa Abilitar barra escala, está clicada.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.

5. Set the Size of bar .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Choose the placement from the Placement combo box.

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
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the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Dica: Configurações de Decorações
Quando salva um projeto .qgs, qualquer mudança que tenha efetuado ao Gride, Seta do Norte, Barra de Escala
e Direitos de Cópia, serão salvos no projeto e restaurados na próxima vez que carregue o projeto.

8.15 Authentication

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Sistema de Autenticação.

A master password needs to be set up when initializing the authentication system and its portable database.

8.16 Save layer into file

Layers (raster or vector) can be saved in another format with the Save As... feature in the layer contextual menu
(by right-clicking in the layer in the layer tree) or in the Layer → Save As... menu.

The Save As dialog shows several parameters to change the behaviour when saving the layer. Common parameters
(raster and vector) are:

• Format

• Filename

• CRS

• Add save file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or custom extent)

• Create (for raster), Layer or Custom (for vector) Options which allow you to change some advanced options.
Advanced user can see the driver documentation in gdal-ogr documentation.

However, some parameters are specific to raster and vector formats:

• Raster specific parameters:

– Resolution (horizontal and vertical)

– Pyramid creation

– Output mode (raw data or rendered image)

• Vector specific parameters:

– Encoding

– Save only selected features

– Skip attribute creation

– Symbology export: can be used mainly for DXF export and for all file formats who manage OGR
feature styles (see note below) as DXF, KML, tab file formats:

* No symbology: default style of the application that reads the data

* Feature symbology: save style with OGR Feature Styles (see note below)

* Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used
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– Geometry:

* force to multi-geometry,

* add z-dimension,

* add or remove a geometry column with the drop-down list. This is not linked with the current
geometry type of the layer. You can add an empty geometry column to an attribute table, remove
the geometry column of a spatial layer.

Nota: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some format
can handle this kind of information. KML, DXF and TAB files format are such format. For advanced user, you
can read the OGR Feature Styles specification document.

Nota: About DXF files
Vector layers can be exported to DXF files using another tool, the DXF Export ... in Project. The windows allow
the user to choose the layer file, the symbology mode (see the note above), the symbology scale, the encoding, the
visibility preset and the layers to include in the DXF file.

As an option, you can Use the layer title as name if set or Export features intersecting the current map extent.

8.17 Use of variables for dynamic content

You can define custom variables for use in expressions. Variables can be defined at the application global level,
project level, layer level and composition level. Just like CSS cascading rules, variables can be overwritten - eg,
a project level variable will overwrite any application level variables set. You can use these variables to build
text strings or other custom expressions using @ character before the variable name. For example in composer
creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Will render the label like this:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

You can manage global variables from the Settings → Options menu, and project level variables from Project
properties (including adding your own custom variables).

Nota: you can read more information and find examples here Exploring variables in QGIS 2.12, part 1, part 2
and part 3.
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Figure 8.16: Edit variable at the project level
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Project Properties, Options and Cus-
tomization.

Nota: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Propriedades do Projeto

In the properties window for the project under Settings → Project Properties (kde) or Project →
Project Properties (Gnome, OS X or Windows), you can set project-specific options.

• In the General menu, the general settings let you:

– give a title to the project beside the project file path

– choose the color to use for features when they are selected

– choose the background color: the color to use for the map canvas

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:

* Attribute table field update bar

* Field calculator calculations

* Identify tool derived length, perimeter and area values

* Default unit shown in measure dialog
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The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.1: General tab of Project Properties dialog

• O menu SRC permite que escolha o Sistema de Coordenadas Referência para o projeto, e para ativar a
reprojeção on-the-fly das camadas matricias e vetoriais na exibição de camadas de diferentes SRC.

• With the Identify layers menu, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• O menu Macros é para editar macros Python para os projetos. Atualmente, apenas estão disponíveis três
macros: openProject(), saveProject() e closeProject().

• O menu Relations é usado para definir relações 1:n. As relações são definidas no diálogo das propriedades
do projeto. Quando existirem relações para uma camada, um novo elemento de interface do utilizador na
vista de formulário (p. ex. quando identificar um elemento e abrir o seu formulário) irá listar os elementos
relacionados. Isto fornece uma maneira poderosa para expressar p. ex. o histórico de inspeção ao longo de
um segmento de tubagem ou estrada. Poderá encontrar mais informação sobre suporte de relações 1:n na
Seção Creating one to many relations.
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Figure 9.2: Macro settings in QGIS

9.2 Opções

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.

9.2.1 Menu Geral

Aplicação

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Define the Icon theme . Currently only ‘default’ is possible.

• Define the Icon size .

• Define the Font. Choose between Qt default and a user-defined font.

• Change the Timeout for timed messages or dialogs .

• Não exibir a janela inicial

• Mostrar dicas ao iniciar

• Títulos da caixa de grupos a negrito

• QGIS-estilo das caixas de grupo

• Use o diálogo nativo de escolha de cores

• Usar auto-atualizar nas caixas de diálogo de seletor de cores

• Estilo da barra lateral personalizado

• Suporte de rotação de tela experimental (é necessário reiniciar)

Arquivos de projeto
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• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Criar um novo projeto como projeto padrão. Tem a possibilidade de carregar em Usar projeto atual com
padrão ou em Resetar padrão. Pode navegar através dos seus arquivos e definir um diretório onde encontra
os modelos de projeto definidos pelo usuário. Isto será adicionado a Projeto → Novo do modelo. Primeiro

ative Criar novo projeto como projeto padrão e a seguir salve o projeto dentro da pasta de modelos de
projeto.

• Avisar para salvar projeto e alterações de fontes de dados quando necessário

• Solicitar confirmação quando uma camada for ser removida

• Avisar quando abrir um projeto salvado com uma versão antiga do |qg|

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.2.2 Menu Sistema

Ambiente

Variáveis de ambiente do sistema podem ser vistas agora, e muitas configuradas, no grupo Environment (ver
figure_environment_variables). Isto é útil para plataformas, tais como Mac, onde um aplicativo GUI não herda
necessariamente o ambiente do utilizador da linha de comandos. Também é útil para configuração e visualização
de variáveis de ambiente para os conjuntos de ferramentas externas controlados pela caixa de ferramentas de
Processamento (p. ex., SAGA, GRASS), e para ativar a saída de depuração (“debugging”) para seções específicas
do código-fonte.

• Utilize variáveis personalizadas (Reinício necessário - incluem separadores). Você pode [Adicionar]
e [remover] variáveis. Variáveis de ambiente já definidas são exibidos em variáveis de ambiente atual, e é

possível filtrá-las ativando Mostrar somente variáveis específicas-QGIS.

Diretórios dos complementos

[Adicionar] ou [Remover] Caminho(s) para pesquisar bibliotecas de complementos C++ adicionais

9.2.3 Menu Fonte de Dados

Atributos dos elementos e tabela

• Abre a tabela de atributos na janela principal (Necessário reiniciar o QGIS)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behavior . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representação para valores NULL. Aqui, pode definir um valor para os campos de dados que contêm
valores NULL.

Manipulação das fontes de dados
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Figure 9.3: System environment variables in QGIS
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• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Solicitar subcamadas raster ao abrir. Alguns rasters suportam subcamadas — elas são chamadas de sub-
datasets no GDAL. Um exemplo são os arquivos netCDF — se há muitas variáveis netCDF, GDAL verá
cada variável como um subdataset. A opção permite que você controle como lidar com subcamadas quando
um arquivo é aberto com subcamadas. Você tem as seguintes opções:

– ‘Sempre’: Perguntar sempre (se existem subcamadas)

– ‘Se necessário’: Perguntar se a camada não tem bandas, mas tem subcamadas

– ‘Nunca’: Nunca pede, não irá carregar nada

– ‘Carregar tudo’: Nunca pede, mas carrega todas as subcamadas

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Adicionar camadas PostGIS com duplo clique e seleciona no modo estendido

• Adicione camadas Oracle com duplo clique e selecione em modo extendido

• Execute expressions on server-side if possible

• create transaction groups automatically whenever possible (Experimental). When this mode is turned
on, all (postgres) layers from the same database are synchronised in their edit state, i.e. when one layer is
put into edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which gets
committed when the user clicks save layer.

Hidden Browser Path

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.2.4 Menu de Renderização

Rendering behavior

• Por padrão novas camadas adicionadas ao mapa devem ser exibidas

• Use tornar cache sempre que possível para acelerar redesenhos

• Representação de camadas em paralelo utilizando muitos núcleos CPU

• Máximo de núcleos para utilizar

• Intervalo de atualização do mapa (por padrão 250 ms)

• Enable feature simplification by default for newly added layers

• Simplificação de limiar

• Simplifique no provedor ao lado se possível

• Escala máxima a que a camada deve simplificar

Qualidade de renderização

• Faz com que as linhas apareçam menos irregulares, em detrimento de algum desempenho do desenho
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Matriciais

• Com a Seleção de banda RGB pode definir o número para a banda Vermelha, Verde e Azul.

Melhora de contraste

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limites de contagem cumulativa de pixeis de corte

• Multiplicador do desvio-padrão

Corrigindo Erros

• Atualiza o mapa da tela

9.2.5 Menu de Cores

Esse menu permite adicionar cores personalizadas que poderão ser encontradas em cada caixa de diálogo de
renderização. É apresentado um conjunto de cores predefinidas na tab: você pode deletar ou editar todas. Mais
ainda, você pode adicionar as cores que quiser e realizar algumas operações de copia e cola. Finalmente, você
pode importar ou exportar o conjunto de cores como um arquivo gpl.

9.2.6 Menu de Janela e Legenda

Aparência padrão do mapa (reescrita pelas propriedades do projeto)

• Define a Cor da seleção e a Cor de fundo.

Legenda da camada

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• As seguintes Estilos de itens de legenda são possíveis:

– Tornar maiúsculo os nomes da camada

– Tornar negrito os nomes da camada

– Tornar negrito os nomes dos grupos

– Mostrar nomes de atributos de classificação

– Criar ícones matriciais (pode ser lento)

9.2.7 Menu Ferramentas de Mapa

This menu offers some options regarding the behavior of the Identify tool.
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• Raio de busca para identificar e visualizar avisos no mapa é um fator de tolerância expressada como uma
percentagem do eixo do mapa. Isto significa que a ferramenta de identificação representara os resultados
sempre e quando clicar dentro desta tolerância.

• Cor de realce lhe permite eleger com que cor devem ser identificados os objetos espaciais que estão desta-
cados.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.

• Minimum width determines how thick should the outline of a highlighted object be.

Ferramenta de medida

• Define Cor do elástico para as ferramentas de medida

• Define Casas decimais

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Feet’, ‘Nautical Miles’, ‘Degrees’ or ‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square feet’, ‘Square yards’, ‘Hectares’, ‘Map Units’ ...)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’ ...)

Movendo e ampliando

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Define o factor de aproximação/ afastamento para a roda do mouse

Escalas pré-definidas

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.2.8 Menu do Compositor

Composição padrão

Você pode definir a Fonte padrão aqui.

Aparência do Gride

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Define a Cor da grade

Configurações de guia e grade

• Define the Grid spacing

• Define the Grid offset for x and y

• Define the Snap tolerance

9.2.9 Menu Digitalizar

Criação de elementos

• Suprimir atributos de janelas pop-up depois de cada elemento criado

• Reutilizar últimos valores de atributos inseridos
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• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Elástico

• Define a Borracha Espessura da linha e Cor da linha

Ajuste

• Abrir opções de atração na janela principal (necessário reiniciar o QGIS)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Define Tolerância de atração pré-definida em unidades de mapa ou pixeis

• Define o Raio de pesquisa para editar vértices em unidades de mapa ou pixeis

Marcadores de Vértices

• Mostrar marcadores apenas para elementos selecionados

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Definir o vértice Tamanho do Marcador

Ferramenta de curva de afastamento

The next 3 options refer to the Offset Curve tool in Digitalização Avançada. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Juntar estilo

• Quadrante do Segmento

• Limite quadrante

9.2.10 Menu GDAL

GDAL é uma biblioteca de troca de dados para arquivos raster. Neste guia, você pode Edite criar opções e:
guilabel: Editar Opções Pirâmides dos formatos raster. Definir que drive GDAL está sendo utilizado para um
formato raster, como em alguns casos, mais do que um drive GDAL está disponível.

9.2.11 Menu SRC

SRC padrão para novos projetos

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Selecione um SRC em Iniciar sempre um novo projeto com este SRC

SRC para novas camadas

Esta área permite que você defina a ação a ser tomada quando uma nova camada é criada, ou quando uma camada
sem SRC é carregada.

• Prompt for CRS

• Use project CRS

• Use default CRS
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Transformação de datum padrão

• Pergunte pela transformação do datum quando nenhum padrão for definido

• Se você trabalhou com a transformação SRC ‘on-the-fly’ você pode ver o resultado da transformação na
janela abaixo. Você pode encontrar informações sobre ‘Fonte da SRC’ e ‘Destino do SRC’, bem como
‘Transformação de Datum Fonte’ e ‘Transformação de Datum de Destino’.

9.2.12 Menu local

• Sobrepor idioma do sistema e Idioma a utilizar em alternativa

• Informação sobre a região do sistema ativo local

9.2.13 Authentication

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Sistema de
Autenticação for more details.

9.2.14 Menu rede

Geral

• Define Pesquisa de endereço WMS, padrão como http://geopole.org/wms/search?search=\%1\&type=rss

• Define Tempo esgotado para pedidos de rede (ms) - o padrão é 60000

• Define Período padrão de validade para a quadrícula WMSC/WMTS (horas) - o padrão é 24

• Define Máxima repetição no caso de erros na requisição de mosaico

• Define Usuário-Agente

Configurações de cache

Define a Pasta e Tamanho para o cache.

• Usar proxy para acessar à web e define ‘Máquina’, ‘Porta’, ‘Usuário’, e ‘Palavra-chave’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy é determinado baseando-se na definição do proxy da aplicação em uso

– Socks5Proxy: Proxy genérico para qualquer tipo de ligação. Suporta TCP, UDP, unindo a uma porta
(ligações de entrada) e autenticação.

– HttpProxy: Implementado usando o comando “LIGAR” , apenas suporta ligações TCP de saída; su-
porta autenticação.

– HttpCachingProxy: Implementado usando comandos HTTP normais, é útil apenas em pedidos no
contexto do HTTP.

– FtpCachingProxy: Implementado usando um proxy FTP, é útil no contexto de pedidos FTP.

Alguns URLs excluídos podem ser adicionados na caixa de texto debaixo das configurações de proxy (veja Fig-
ure_Network_Tab).

Se você precisar de informações mais detalhadas sobre as diferentes configurações de proxy, consulte o manual da
documentação da biblioteca QT subjacente a http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Dica: Usando Proxies
Usando proxies, por vezes, pode ser complicado. É útil proceder por “tentativa e erro”, com os tipos de proxy
acima, verifique para ver se eles conseguem no seu caso.
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Figure 9.4: Proxy-settings in QGIS
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You can modify the options according to your needs. Some of the changes may require a restart of QGIS before
they will be effective.

• A configuração é salva em arquivo de texto: $HOME/.config/QGIS/QGIS2.conf

• pode encontrar as configurações em: $HOME/Library/Preferences/org.qgis.qgis.plist

• As configurações são armazenadas no registo em: HKEY\CURRENT_USER\Software\QGIS\qgis

9.3 Personalização

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
panels they need.

Nota: Before your changes are applied, you need to restart QGIS.

Figure 9.5: The Customization dialog

Ticking the Enable customization checkbox is the first step on the way to QGIS customization. This enables
the toolbar and the widget panel from which you can uncheck and thus disable some GUI items.

The configurable item can be:

• a Menu or some of its sub-menus from the Barra de Menu

• a whole Panel (see Panels and Toolbars)

• the Status bar described in Barra de Status or some of its items

• a Toolbar: the whole bar or some of its icons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.
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Dica: Easily restore predefined QGIS
The initial QGIS GUI configuration can be restored by one of the methods below:

• unchecking Enable customization option in the Customization dialog or click the Check All button

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• launching QGIS at a command prompt with the following command line qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab.

In most cases, you need to restart QGIS in order to have the change applied.
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CHAPTER 10

Trabalhando com Projeções

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Visão geral do Suporte a Projeções

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Sistema de Referência de
Coordenadas personalizado for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Especificação de Projeção Global

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

As opções mostradas na figure_projections_1 são:

• Prompt for CRS

• Use project CRS
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Figure 10.1: CRS tab in the QGIS Options Dialog

• Use default CRS displayed below

If you want to define the coordinate reference system for a certain layer without CRS information, you can also do
that in the General tab of the raster and vector properties dialog (see Menu Geral for rasters and Menu Geral for
vectors). If your layer already has a CRS defined, it will be displayed as shown in General menu in vector layers
properties dialog.

Dica: SRC na Legenda do Mapa
Clicando com o botão direito num tema na Legenda do Mapa (seção Layers Panel) mostra dois atalhos SRC.
Definir SRC do tema abre a janela de Seleção de Sistema de Referência de Coordenadas (ver figure_projection_2).
Definir SRC do projeto a partir do Tema redefine o SRC do projeto usando o SRC do tema.

10.3 Definir Reprojeção Dinâmica Voo Livre (OTF)

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Há três formas de fazer isto:

1. Select Project Properties from the Project (Gnome, OSX) or Settings (KDE, Windows) menu.

2. Clique no ícone estado SRC no canto inferior direito da barra de estado.

3. Ative a projeção dinâmica por omissão no separador SRC da janela Opções selecionando a Ativar
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reprojeção dinâmica por omissão ou Automaticamente ativar a reprojeção dinâmica se temas têm diferentes
SRC.

Se tem já carregado um tema e quer ativar a projeção dinâmica, a melhor prática é abrir o separador SRC na janela

Propriedades do Projeto, selecionar um SRC, e ativar a caixa de seleção Ativar transformação dinâmica

de SRC. O ícone Estado SRC deixará de estar desativado (cinzento), e todos os temas serão dinamicamente
reprojetados para o SRC mostrado junto ao ícone.

Figure 10.2: Project Properties Dialog

O separador SC na janela Propriedades do Projeto contem cinco componentes importantes, como mostrado na
Figure_projections_2 e descritos abaixo:

1. Aivar transformção ‘dinâmica’ de SRC — Esta caixa de seleção é usada para ativar ou desativar a pro-
jeção dinâmica. Quando desligada, cada tema é desenhado usando as coordenadas lidas dos seus dados, e
os componentes descritos abaixo estão inativos. Quando ligada, as coordenadas de cada tema são projetadas
para o sistema de coordenadas definido para o mapa.

2. Filtro — Se conhece o código EPSG, o identificador, ou o nome para um sistema de coordenadas, pode
usar a função de pesquisa para o encontrar. Introduza o código EPSG, o identificador ou o nome.

3. Sistemas de coordenadas usados recentemente — Se tem certos SRCs que usa frequentemente no seu
trabalho SIG diário, estes serão mostrados nesta lista. Clique num destes itens para selecionar o SRC
correspondente.

4. Coordinate reference systems of the world — This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

5. Texto PROJ.4 — Este é um texto de SRC usado pelo motor de projeções PROJ.4. Este texto é de apenas
leitura e fornecido para fins de informação.

Dica: Janela de Propriedades do Projeto
Se abrir a janela Propriedades do Projeto a partir do menu :menuselecion:‘Projeto‘, deve clicar no separador
SRC para ver as definições de SRC.
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Abrindo a janela a partir do ícone Estado SRC abrirá automaticamente o separador SRC.

10.4 Sistema de Referência de Coordenadas personalizado

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Figure 10.3: Custom CRS Dialog

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

A janela Definição de Sistema de Referência de Coordenadas personalizado exige apenas dois parâmetros para
definir um SRC ao usuário:

1. Um nome descritivo

2. Os parâmetros cartográficos do formato PROJ.4
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To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.

Note-se que o: guilabel: Parâmetros deve começar com um bloco + proj=, para representar o novo sistema de
referência de coordenadas.

Você pode testar os parâmetros SRC para ver se eles dão bons resultados. Para fazer isso, digite valores conhecidos
de latitude e longitude em WGS 84 Norte e :guilabel: Campos Leste, respectivamente. Clique em [Calcular], e
comparar os resultados com os valores conhecidos em seu sistema de referência de coordenadas.

10.5 transformações de datum padrão

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• editar uma lista dos padrões do usuário para transformações.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

Navegador QGIS

• QGIS Browser widget
• QGIS Browser as a standalone application

QGIS Browser is available as a standalone application and as a panel in QGIS Desktop. It lets you easily navigate
in your filesystem and manage geodata. You can have access to common vector files (e.g., ESRI shapefiles
or MapInfo files), databases (e.g., PostGIS, Oracle, SpatiaLite or MS SQL Spatial) and OWS/WCS|WMS|WFS
connections. You can also view your GRASS data (to get the data into QGIS, see Integração com SIG GRASS).

11.1 QGIS Browser widget

To activate QGIS Browser, right-click on QGIS toolbar and check Browser Panel or select it from View →
Panels or Settings → Panels (kde). In the Browser panel, you can now browse in your filesystem, databases and
web services and get your data into the map view with a simple drag-and-drop or double-click.

You can also open a QGIS project directly from the Browser panel by double-clicking its name or by drag-and-
drop into the map view.

At the top of the panel, you find some icons that help you to:

• Add Selected Layers. You can also add data into the map view by selecting Add Layer or Add selected
layers in the context menu.

• Refresh the browser tree

• search for specific data. Enter a search word or wildcard and the browser will filter the tree to only
show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed. See the
Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or not. It
can also be set to:

– normal: return any item containing the search text

– using wildcard(s): fine tune the search using ? and/or * characters to specify the position of the search
text

– using a regular expression

• Collapse the whole tree

• Enable and disable properties widget. When toggled on, a new widget is added at the bottom of the
panel showing, if applicable, metadatas of the selected item

Right-click an item in the browser tree helps you to:
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• in case of file or table, display its metadata or open it in your project. Tables can even be renamed, deleted
or truncated

• in case of folder, bookmark it into your favourites, hide it from the browser tree. Hidden folders can be
managed from the Settings → Options → Data Sources tab

• refresh, rename or delete schema.

You can also import files into databases or copy tables from one schema/database to another one with a simple
drag-and-drop. There is a second browser panel available to avoid long scrolling while dragging. Just select the
file and drag-and-drop from one panel to the other.

Figure 11.1: QGIS Browser panels side-by-side

11.2 QGIS Browser as a standalone application

It’s also possible to run the QGIS Browser as a standalone application. Like the Browser panel, the standalone
Browser helps you navigate through your filesystem and manage your geodata. It also helps you preview or create
them and open them in a QGIS project by drag-and-drop.

Iniciar o Pesquisador qgis

• Escreva na linha de comando “qbrowser” .

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the standalone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Menu Metadados). With the Preview tab, you can
have a look at your files without importing them into your QGIS project. It’s also possible to preview the attributes
of your files in the Attributes tab.
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Figure 11.2: QGIS Browser as a standalone application
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CHAPTER 12

Trabalhando com Dados Vetoriais

12.1 Formatos de dados suportados

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69
vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Referências Bibliográficas e
Web). The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

Procedimentos com dados vetoriais GRASS são descritos na Seção Integração com SIG GRASS.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labelling and
attributes functions.

Nota: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some driver doesn’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

12.1.1 Loading a layer from a file

To load a layer from a file (like a Shapefile, a Mapinfo or a dxf layer), click on the Add Vector Layer toolbar
button; or type Ctrl+Shift+V. This will bring up a new window (see figure_vector_1).

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the file if desired.

Selecting a file from the list and clicking [Open] loads it into QGIS. Figure_vector_3 shows QGIS after loading
the alaska.shp file.

Dica: Cores das camadas
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Figure 12.1: Add Vector Layer Dialog

Figure 12.2: Open an OGR Supported Vector Layer Dialog
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Figure 12.3: QGIS with Shapefile of Alaska loaded

Quando você adiciona uma camada ao mapa, é atribuída uma cor aleatória. Na adição de mais de uma camada de
uma vez, são atribuídas cores diferentes para cada camada.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the context menu. See section Menu Estilo for more information on setting
symbology of vector layers.

Dica: Carregando camadas e armazenando projetos em unidades externas no OS X
No OS X, unidades portáteis que são armazenadas além do disco rígido principal não aparecem no File →Open
Project ‘como esperado. Para resolver isso estamos trabalhando em uma forma mais nativa do OS X com caixa
de diálogo abrir/salvar. Como alternativa, você pode digitar ‘/Volumes’ no campo Nome do arquivo e pressione
:kbd:‘Voltar. Depois, você pode navegar para unidades externas ou armazenadas em rede.

Nota: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

Nota: You can also drag and drop the file(s) into the Layers Panel from either the files browser or the QGIS
Browser panel. If the layer contains several geometry types, a new windows will ask you to select the sublayer.
This often occurs with GPX, Mapinfo or DXF files format.

Loading specific directory based layer

To load some specific format like ArcInfo Binary Coverage, UK. National Transfer Format, as well as the raw
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TIGER format of the US Census Bureau or OpenfileGDB, click on the Add Vector Layer toolbar button or press
Ctrl+Shift+V to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type

filter Files of type to the format you want to open, for example ‘Arc/Info Binary Coverage’. Navigate to the
directory that contains the coverage file or the file, and select it.

Shapefiles ESRI

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library (http://www.gdal.org/ogr/).

Um shapefile consiste na verdade de um conjunto de vários arquivos. Os três seguintes são necessários:

1. .shp arquivo que contém as formas vetoriais.

2. .dbf arquivo que contém os atributos no formato dBase..

3. .shx arquivos index.

Shapefiles também podem incluir um arquivo com a extensão .prj que contém as informações de pro-
jeção. Embora seja muito útil um arquivo de projeção, não é obrigatória. Um conjunto de dados
shapefile pode conter arquivos adicionais. Para mais detalhes veja a especificação técnica ESRI em:
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Siga estes passos para criar o índice:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Abra a caixa de diálogo Propriedades da camada clicando duas vezes sobre o nome do shapefile na legenda
ou com o botão direito do mouse e escolha Propriedades a partir do menu de contexto.

• Na guia :guilabel:’Geral’, clique no botão [Criar índice espacial].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Arquivos de texto delimitado

Dados em tabelas é um formato muito comum e amplamente utilizado devido à sua simplicidade e facilidade
de acesso - os dados podem ser visualizados e editados até mesmo em um editor de texto simples. Um arquivo
de texto delimitado é uma tabela de atributos com cada coluna separados por um caracter definido e cada linha
separada por uma quebra de linha. A primeira linha geralmente contém os nomes das colunas. Um tipo comum
de arquivo de texto delimitado é um arquivo CSV (Comma Separated Values), com cada coluna separado por uma
vírgula.

Esses arquivos de dados também podem conter informações sobre a posição em duas formas principais:

• Coordenadas de ponto separadas por colunas

• Texto bem conhecido (WKT) representado por geometria
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QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. O arquivo deve ter uma linha de cabeçalho delimitada de nomes de campo. Esta deve ser a primeira linha
do arquivo de texto.

2. A linha de cabeçalho deve conter campo (s) com a definição da geometria. Estes campo (s) pode ter qualquer
nome.

3. As coordenadas X e Y (se a geometria for definida pelas coordenadas) deverá ser especificada como
números. O sistema de coordenadas não é importante.

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Amostra de Dados):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Alguns itens a serem observados sobre o arquivo de texto:

1. O arquivo de texto exemplo usa ; (ponto e vírgula) como delimitador. Qualquer caractére pode ser usado
para delimitar os campos.

2. A primeira linha é a linha de cabeçalho. Ela contém os campos X, Y e ELEV.

3. Sem aspas (") são usados para delimitar os campos de texto.

4. A coordenada X está contida no campo X.

5. A coordenada Y está contida no campo Y.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

Carregando um arquivo de texto delimitado

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).
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Figure 12.4: Delimited Text Dialog

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

Há também uma opção de ajuda que permite cortar espaços iniciais e finais dos campos no guilabel: ‘campos da
guarnição’. Além disso, é possível no guilabel: descartar campos vazios. Se necessário, você pode forçar uma
vírgula para ser o separador decimal ativando no guilabel: ‘separador decimal por vírgula’.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionally, you can enable:

• Utilize índice espacial para melhorar o desempenho de exibição e espacialmente a seleção das feições.

• Utilize índice de subconjunto.

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.3 Dados OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides support for OSM
data.

Carregando vetores OpenStreetMap

QGIS integrates OpenStreetMap import as a core functionality.
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• Para conectar-se aos dados do servidor OSM e de download, abra o menu: ‘Vetor -> OpenStreetMap ->
Carregar dados’. Você pode pular esta etapa se você já obteve um arquivo XML usando .osm, JOSM, API
ou qualquer outra fonte.

• No menu ‘Vetor -> OpenStreetMap -> Importar topologia de um arquivo XML’ irá converter o seu: arquivo
.osm em um banco de dados SpatiaLite e criar uma conexão de banco de dados correspondente.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Camadas SpatiaLite).

12.1.4 Camadas PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Criando uma conexão armazenada

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Nome: Um nome para esta conexão. Pode ser o mesmo que o da Base de dados.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf. Check the Service connection file section for more details.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Porta: Número da porta do servidor de banco de dados PostgreSQL atende. A porta padrão é 5432.

• Banco de dados: Nome do banco de dados.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speed-ups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Desabilitar: tenta apenas conexão SSL não criptografada.

– Permitir: tenta uma conexão não-SSL. Se isso não funcionar, tenta uma conexão SSL.

– Preferir: tenta uma conexão SSL. Se isso não funcionar, tenta uma conexão não-SSL.

– Requer: tenta apenas conexão SSL.

• Usuário: Nome do usuário usado para logar na base de dados.

• Senha: Senha usada com Nome do Usuário para conectar ao banco de dados.

Opcionalmente, você pode ativar as seguintes caixas de seleção:

• Salvar nome do usuário

• Salvar Senha

12.1. Formatos de dados suportados 85



QGIS User Guide, Versão 2.14

• Apenas olhar na tabela geometry_columns

• : guilabel: Não resolve tipo de colunas sem restrições (geometria)

• :guilabel:‘Apenas olhar no esquema ‘público’

• Também listar tabelas sem geometrias

• Usar metadados atribuidos da tabela

Uma vez que todos os parâmetros e as opções estão configuradas, você pode testar a conexão clicando no botão
[Testar Conexão].

Dica: Use estimated table metadata to speed up operations
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Carregando uma camada PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importação de dados no PostgreSQL for a discussion
on importing data into the database.

Para colocar uma camada no PostGIS, execute os seguintes passos:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Escolha a conexão a partir da lista solta a baixo e clique em [Conectar].

• Marque ou desmarque Também listar tabelas sem geometrias

• Opcionalmente, use Opções de busca para definir quais recursos serão carregados a partir da camada ou
use o botão de [Definir Filtro] para iniciar Ferramenta de Consulta.

• Encontre a camada(s) que deseja adicionar na lista de camadas disponíveis.

• Selecione-a clicando sobre ela. Você pode selecionar várias camadas pressionando a tecla Shift enquanto
clica. Consulte a Seção Query Builder para obter informações sobre como usar o Query Builder PostgreSQL
para melhor definição da camada.

• Clique no botão [Add] para adicionar a camada ao mapa.

Dica: Camadas PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Service connection file

The service connection file allows PostgreSQL connection parameters to be associated with a single service name.
That service name can then be specified by a client and the associated settings will be used.
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It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Nota: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Nota: You can find all the parameters here

Nota: If you don’t want to save the passwords in the service file you can use the .pg_pass option.

On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing it at pg_config
--sysconfdir‘‘**/.pg_service.conf** or by adding the ‘‘PGSYSCONFDIR environ-
ment variable to specify the directory containing the service file. If service definitions with the same name exist
in the user and the system file, the user file takes precedence.

Aviso: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit -> EOL Conversion -> UNIX Format -> File save.
• After adding an environment variable you may also need to restart the computer.

Alguns detalhes sobre as camadas PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
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key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Dica: Backup de banco de dados PostGIS com camadas salvas pelo QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

QGIS allows to filter features already on server side. Check the Execute expressions on postgres server-side if
possible (Experimental) checkbox to do so. Only supported expressions will be sent to the database. Expressions
using unsupported operators or functions will gracefully fallback to local evaluation.

12.1.5 Importação de dados no PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the DB Manager plugin and the
command line tools shp2pgsql and ogr2ogr.

Gerenciador BD

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Complemento Gerenciador BD for more information.

shp2pgsql

PostGIS inclui um utilitário chamado shp2pgsql que pode ser usado para importar arquivos em um banco de
dados habilitado para PostGIS. Por exemplo, para importar um arquivo denominado ‘lakes.shp’ em um banco de
dados PostgreSQL chamado “gis_data”, use o seguinte comando:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Isso cria uma nova camada chamada lakes_new no banco de dados gis_data. A nova camada terá um
identificador de referência espacial (SRID) de 2964. Consulte a Seção Trabalhando com Projeções para mais
informações sobre os sistemas de referência espacial e projeções.

Dica: Exportando conjuntos de dados do PostGIS
Assim como a ferramenta de importação shp2pgsql, há também uma ferramenta para exportar conjuntos de dados
PostGIS como shapefiles: pgsql2shp. Este é enviado dentro de sua distribuição PostGIS.

ogr2ogr

Além de shp2pgsql e de SPIT existe uma outra ferramenta para a inserção de dados geográficos no PostGIS:
ogr2ogr. Essa é parte da instalação do GDAL.

Para importar um shapefile no PostGIS, faça o seguinte :
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ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Isto irá importar o shapefile alaska.shp para o banco de dados PostGIS postgis usando o usuário postgres com
a senha topsecret no servidor myhost.de.

Note que o OGR deve ser construído com PostgreSQL para suportar PostGIS. Você pode ver isso digitando (in
)

ogrinfo --formats | grep -i post

Se você preferir usar o PostgreSQL com o comando COPY em vez do padrão INSERT INTO, você pode exportar

a seguinte variável de ambiente (pelo menos disponível em e ):

export PG_USE_COPY=YES

ogr2ogr não cria índices espaciais como shp2pgsl. Você precisa criá-los manualmente, usando o comando SQL
CREATE INDEX como um passo extra (como descrito na próxima seção melhorando o Desempenho).

melhorando o Desempenho

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Dica: You can use the DBManager to create an index to your layer. You should first select the layer and click on
Table > Edit table, go to Indexes tab and click on [Add spatial index].

A sintaxe para criar um índice GiST é:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Observe que para grandes tabelas, a criação do índice pode levar um longo tempo. Uma vez que o índice é
criado, você deve realizar um VACUUM ANALYZE. Consulte a documentação do PostGIS (PostGIS-PROJECT
Referências Bibliográficas e Web) para mais informações.

A seguir um exemplo de criação de um índice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$
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12.1.6 Camadas vetoriais que ultrapassam 180 |graus| de longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

Figure 12.5: Map in lat/lon crossing the 180° longitude line

A solução alternativa é transformar os valores de longitude utilizando o PostGIS e a função ST_Shift_Longitude.
Esta função lê cada ponto/vértice de cada componente de cada feição em uma geometria e se a longitude é < 0°, ela
acrescenta 360° a ela. O resultado é uma versão 0° - 360° dos dados a serem plotados em um mapa centralizado
em 180°.

Figure 12.6: Cruzando 180 | graus | longitude aplicação da função ** ST_Shift_Longitude **

Uso

• Importar dados para o PostGIS (Importação de dados no PostgreSQL), utilizando, por exemplo, o comple-
mento “Gerenciador BD”.

• Use a interface do PostGIS para emitir o seguinte comando (neste exemplo,
“TABELA” é o nome da sua tabela PostGIS): gis_data=# update TABELA set
the_geom=ST_Shift_Longitude(the_geom);

• Se tudo correu bem, você deve receber uma confirmação sobre o número de feições que foram atualizadas.
Então você vai ser capaz de carregar o mapa e ver a diferença (Figura_vetor_5).

12.1.7 Camadas SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
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Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

Se você quiser salvar uma camada do vetor para o formato SpatiaLite, você pode fazer isso com um clique direito
na legenda. Em seguida, clique em ‘Salvar como...’, defina o nome do arquivo final, e selecione ‘SpatiaLite’ como
formato e oSRC. Além disso, você pode selecionar ‘SQLite’ como formato e, em seguida, adicionar “SpatiaLite
= SIM” no campo opção da fonte de dados OGR. Isto diz OGR para criar um banco de dados SpatiaLite. Veja
também http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Criando uma nova camada SpatiaLite

Se você quiser criar uma nova camada SpatiaLite, consulte a seção Criando uma nova camada SpatialLite.

Dica: Gestão complementos de dados SpatiaLite
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.8 Camadas Espaciais MSSQL

QGIS also provides native MS SQL support. The first time you load MSSQL Spatial data, begin by clicking

on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option from the
Layer menu, or by typing Ctrl+Shift+M.

12.1.9 Camadas Espaciais Oracle

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.

Criando uma conexão armazenada

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Oracle Spatial Layer toolbar button, selecting the Add Oracle
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Nome: Um nome para esta conexão. Pode ser o mesmo que base de dados

• Base de dados: SID ou SERVICE_NAME da instância Oracle.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: número da porta do servidor de banco de dados Oracle. A porta padrão é a 1521.

• Usuário: Nome de usuário usado para acessar o banco de dados.

• Senha: Senha usada com Nome do Usuário para conectar ao banco de dados.

Opcionalmente, você pode ativar caixas de seleção a seguir:

12.1. Formatos de dados suportados 91

http://www.gdal.org/ogr/drv_sqlite.html


QGIS User Guide, Versão 2.14

• Salvar Nome de Usuário Indica salvar o nome de usuário do banco de dados na configuração da conexão.

• Salvar senha Indica se é para salvar a senha do banco de dados nas configurações de conexão.

• : guilabel: Olhe somente na tabela de metadados Restringe as tabelas exibidas para aqueles que estão
na visão all_sdo_geom_metadata. Isso pode acelerar a exibição inicial de tabelas espaciais.

• Verificar apenas as tabelas do usuário Ao procurar tabelas espaciais, restringir a pesquisa para tabelas
que são de propriedade do usuário.

• :guilabel: Também lista tabelas sem geometria Indica que tabelas sem geometria também devem ser
listados por padrão.

• Usar estatísticas das tabelas na camada de metadados Quando a camada está configurada, vários
metadados são necessários para a tabela Oracle. Isso inclui informações como o número de linhas
da tabela, tipo de geometria e escalas espaciais na coluna de geometria. Se a tabela contiver um
grande número de linhas, determinando estes metadados pode ser demorado. Ao ativar esta opção, as
seguintes operações de metadados de tabela são feitos: contagem de linhas é determinado a partir do
comando all_tables.num_rows. Tabelas com extensões são sempre determinadas com a função
SDO_TUNE.EXTENTS_OF, mesmo se um filtro de camada é aplicado. Geometria é determinada a partir
das primeiras 100 linhas de não-nulas da tabela.

• : guilabel: Somente tipos de geometria existente listar apenas os tipos de geometria existentes e não
oferecem para adicionar outros.

Aviso: In the Authentication tab, saving username and password will keep unprotected credentials in the
connection configuration. Those credentials will be visible if, for instance, you shared the project file with
someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead (configu-
rations tab). See Sistema de Autenticação for more details.

Uma vez que todos os parâmetros e as opções estão configuradas, você pode testar a conexão clicando no botão
[Testar Conexão].

Dica: QGIS Configurações do Usuário e Segurança
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• As configurações são armazenadas em seu diretório home em ~/.qgis2.

• As configurações são armazenadas no registro.

Carregando uma camada Espacial Oracle

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Para carregar uma camada Espacial Oracle, execute os seguintes passos:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Escolha a conexão a partir da lista solta a baixo e clique em [Conectar].

• Marque ou desmarque Também listar tabelas sem geometrias

• Opcionalmente, use Opções de busca para definir quais recursos serão carregados a partir da camada ou
use o botão de [Definir Filtro] para iniciar Ferramenta de Consulta.
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• Encontre a camada(s) que deseja adicionar na lista de camadas disponíveis.

• Selecione-o clicando sobre ele. Você pode selecionar várias camadas, mantendo pressionada Shift en-
quanto clica. Consulte a seção Query Builder para obter informações sobre o uso de Oracle Consultas para
definir a camada.

• Clique no botão [Add] para adicionar a camada ao mapa.

Dica: Camada Espacial Oracle
Normalmente, uma camada Espacial Oracle é definida por uma entrada na tabela USER_SDO_METADATA.

12.2 A Biblioteca de Símbolos

12.2.1 O Gerenciador de Estilos

The Symbol Library is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• criar, editar e remover símbolos

• organize symbols in custom groups

• export and import symbols.

Figure 12.7: O Gerenciador de Estilos

Grupos e grupos inteligentes

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_symbol_2:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.
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Figure 12.8: Creating a Smart Group

To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

Add, Edit, Remove Symbol

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and Color Ramp

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See The Symbol Selector for further information.

Share symbols

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exporting symbols

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importing symbols

You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :
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• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Observe que as opções de importar e exportar estão disponíveis também através do clique com o botão direito do
mouse.

Figure 12.9: Importing symbols

Color Ramp

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type: Gradient, Random, colorBrewer, or cpt-city.

The first three have options for number of steps and/or multiple stops in the color ramp. You can use the Invert
option while classifying the data with a color ramp. See figure_symbol_4 for an example of custom color ramp
and figure_symbol_4a for the cpt-city dialog.

A opção cpt-city abrirá um novo diálogo com centenas de temas incluídos ‘fora da caixa’

12.2.2 The symbol Selector

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Para cada tipo de símbolos, você encontrará sempre a mesma estrutura de diálogo:

• at the top left side a dynamic symbol representation, updated as soon as symbol properties evolve

• under the symbol representation, the symbol tree shows symbol layers that are combined afterwards to shape
a new global symbol. A symbol can consist of several Symbol layers. Settings will be shown later in this
chapter.

• at the right you can setup some parameters that apply to the global symbol:

– unit: it can be millimeter, pixel or map unit

– transparency
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Figure 12.10: Example of custom gradient color ramp with multiple stops

Figure 12.11: cpt-city dialog with hundreds of color ramps
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Figure 12.12: Designing a Marker symbol

– color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols
color

– size and rotation for marker symbol

– width for line symbol

Note that the Data-defined override button beside the last layer-related parameters is inactive until the
symbol is applied to a layer. Once the symbol is connected to a layer, this button offers access to the size
assistant dialog which helps to create proportional or multivariate analysis rendering.

• under these parameters are displayed items of the symbols library you can choose from. This list of symbols
can be filtered by selecting a group in the drop-down list just above.

According to the level selected in the symbol tree, you’ll get enabled different tools at the bottom of the dialog to
:

• add new symbol layer: you can imbricate as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level

• duplicate a (group of) symbol layer(s)

• move up or down the symbol layer

• apply special effects to the symbol layer

• save the designed symbol into your symbol library

• or choose in the Advanced drop-down list, to clip features to canvas extent.

Dica: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size (for marker symbol) or the Width (for line symbol) menu in the first level
again. The size of the lower levels changes accordingly, while the size ratio is maintained.

More detailed settings can be made when clicking on the lower level in the Symbol tree. You can change each
Symbol layers properties and according to the symbol type, you get different settings.
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Marcador de Símbolos

Marcadores de Símbolos possuem vários tipos símbolo da camada:

• Marcador Elipse

• Marcador da Fonte

• Marcado Simples (padrão)

• Marcadores SVG

• Marcadores de campos vetoriais

For each marker symbol, you can set the following properties:

• : guilabel: Tipo do Símbolo da camada: Você tem a opção de usar marcadores de elipse, marcadores de
fonte, marcadores simples, marcadores SVG e marcadores de campo vetorial.

• cores

• Tamanho

• Estilo de contorno

• Largura do contorno

• Ângulo

• : guilabel: ‘Deslocamento X,Y‘: Você pode mudar o símbolo na direção -x ou -y.

• Ancorar ponto

• Definor propriedades dos dados ...

Símbolos de linha

Símbolos marcador de linha têm apenas dois tipos símbolo da camada:

• Marcadores de linha

• Linha simples (padrão)

The default symbol layer type draws a simple line whereas the other display a marker point regularly on the line.
You can choose different location: vertex, last and first vertex, interval, central point or on every curve point.
Marker line can have offset along the line or offset line. Finally, rotation allows you to change the orientation of
the symbol.

As seguintes configurações estão disponíveis:

• Coloração

• Espessura da caneta

• Deslocamento

• Estilo da caneta

• Estilo da união

• Estilo da capa

• Use custom dash pattern

• Unidade padrão do traço

• Definor propriedades dos dados ...
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Símbolos do polígono

Marcador de Símbolos do Polígono tem também vários tipos símbolo da camada:

• Preenchimento do centroide

• Preenchimento em gradiente

• Preenchimento de linha padrão

• Preenchimento de ponto padrão

• Preenchimento de imagem raster

• Preenchimento SVG

• Preenchimento estourar feição

• Preenchimento Simples (padrão)

• Contorno: linha de marcação (o mesmo que marcador de linha)

• Contorno: linha simples (o mesmo que marcador de linha)

As seguintes configurações estão disponíveis:

• Cores para a borda e o preenchimento.

• Estilo de preenchimento

• Estilo de borda

• Espessura da borda

• Deslocamento X,Y

• Definor propriedades dos dados ...

Using the color combo box, you can drag and drop color for one color button to another button, copy-paste color,
pick color from somewhere, choose a color from the palette or from recent or standard color. The combo box
allows you to fill in the feature with transparency. You can also just click the button to open the palette dialog.
Note that you can import color from some external software like GIMP.

Com o “preenchimento de imagem Raster ‘você pode preencher polígonos uma imagem raster com azulejos. As
opções incluem (dados definidos) nome do arquivo, a opacidade, tamanho da imagem (em pixels, mm ou unidades
de mapa), o modo (recurso ou vista) e rotação de coordenadas.

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer.

Other possibility is to choose a ‘shapeburst fill’ which is a buffered gradient fill, where a gradient is drawn from the
boundary of a polygon towards the polygon’s centre. Configurable parameters include distance from the boundary
to shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets.

É possível apenas desenhar bordas do polígonos dentro do polígono. Usando ‘Contorno: linha simples’ selecio-
nando | caixa |: guilabel: Desenhar linha só dentro polígono.

Note: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (eg centroid fills where the centroid
must always be the actual feature’s centroid).

12.3 Janela de Propriedades de Vetor

The Layer Properties dialog for a vector layer provides general settings to manage appearance of layer features
in the map (symbology, labeling, diagrams), interaction with the mouse (actions, map tips, form design). It also
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provides information about the layer.

To access the Layer Properties dialog, double-click on a layer in the legend or right-click on the layer and select
Properties from the pop-up menu.

Dica: Switch quickly between different layer representations
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.3.1 Menu Geral

Use this menu to make general settings for the vector layer. There are several options available:

Informação da Camada

• Alterar o nome de exibição da camada em: guilabel: apresentado como

• Define o: guilabel: source Camada da camada de vetor

• Defina o: guilabel: codificação de fonte de dados para definir opções específicas do provedor e ser capaz de
ler o arquivo

Sistema de Referência de Coordenadas

• : guilabel: Especificar o sistema de referência de coordenadas. Aqui, você pode visualizar ou alterar a
projeção da camada vetorial específica.

• Crie um índice espacial (somente para formatos OGR suportados)

• : guilabel: informação Atualizar Extensões para uma camada

• Exibir ou alterar a projeção da camada de vetor específico, clicando em: guilabel: Especifique ...

Scale dependent visibility

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which features

will be visible. Out of this range, they are hidden. The Set to current canvas scale button helps you use the current
map canvas scale as boundary of the range visibility.

Query Builder

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

The Query Builder is accessible through the eponym term at the bottom of the General menu in the Layer
Properties. Under Feature subset, click on the [Query Builder] button to open the Query builder. For example, if
you have a regions layer with a TYPE_2 field, you could select only regions that are borough in the Provider
specific filter expression box of the Query Builder. Figure_vector_general_2 shows an example of the Query
Builder populated with the regions.shp layer from the QGIS sample data. The Fields, Values and Operators
sections help you to construct the SQL-like query.
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Figure 12.13: General menu in vector layers properties dialog

Figure 12.14: Query Builder
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The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

12.3.2 Menu Estilo

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
different kinds of vector data. However all types share the following dialog structure: in the upper part, you
have a widget that helps you prepare the classification and the symbol to use for features and at the bottom the
Renderização da camada widget.

Dica: Exportar simbologia vetorial
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files.
Just open the right mouse menu of the layer and click on Save As... to specify the name of the output file and its
format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology → or as
Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Features rendering

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted renderer.

There is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The
categorized and graduated renderers can be created by specifying a symbol and a color ramp - they will set the
colors for symbols appropriately. For each data type (points, lines and polygons), vector symbol layer types are
available. Depending on the chosen renderer, the dialog provides different additional sections.

Nota: Se você alterar o tipo de processador ao definir o estilo de uma camada de vetor as configurações feitas
para o símbolo serão mantidas. Esteja ciente de que este procedimento só funciona para uma mudança. Se você
repetir a alteração do tipo de renderizador as configurações para o símbolo irão se perder.
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Single Symbol Renderer

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. See
The symbol Selector for further information about symbol representation.

Figure 12.15: Single symbol line properties

Dica: edit symbol directly from layer panel
If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and

choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.

Categorized Renderer

The Categorized Renderer is used to render all features from a layer, using an user-defined symbol whose
aspect reflects the value of a selected feature’s attribute. The Categorized menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expressões chapter)

• The symbol (using the The symbol Selector dialog) which will be used as default for each class

• The range of colors (using the Color ramp listbox) from which color applied to the symbol is selected

Then click on Classify button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Dica: Seleção e mudança de símbolos multiplos
A simbologia permite que você selecione vários símbolos e clique no direito para mudar de cor, transparência,
tamanho ou largura das entradas selecionadas.
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Figure 12.16: Categorized Symbolizing options

Dica: Match categories to symbol name
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.

Graduated Renderer

The Graduated Renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, it allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• The symbol (using the Symbol selector dialog)

• The legend format and the precision

• The method to use to change the symbol: color or size

• The colors (using the color Ramp list) if the color method is selected

• The size (using the size domain and its unit

Then you can use the Histogram tab which shows an interactive histogram of the values from the assigned field or
expression. Class breaks can be moved or added using the histogram widget.

Nota: You can use Statistical Summary panel to get more information on your vector layer. See Statistical
Summary Panel.

Back to the Classes tab, you can specify the number of classes and also the mode for classifying features within
the classes (using the Mode list). The available modes are:
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• Intervalo Igual: cada classe tem o mesmo tamanho (por exemplo, valores de 0 a 16 e com 4 classes, cada
classe tem um tamanho 4);

• Quantil: cada classe terá o mesmo número de elementos no interior (a idéia de uma caixa de plotagem);

• Quebras naturais (Jenks): a variância dentro de cada classe é mínima, enquanto a variação entre as classes
é máxima;

• Desvio Padrão: classes são construídas de acordo com os valores do desvio padrão;

• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

A caixa de listagem na parte central da lista do menu Estilo as classes juntamente com as suas faixas, etiquetas e
símbolos que serão renderizados.

Click on Classify button to create classes using the chosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_3 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Figure 12.17: Graduated Symbolizing options

Dica: Mapas Temáticos usando uma expressão
Categorized and graduated thematic maps can be created using the result of an expression. In the properties dialog
for vector layers, the attribute chooser is extended with a Set column expression function. So you don’t need
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to write the classification attribute to a new column in your attribute table if you want the classification attribute
to be a composite of multiple fields, or a formula of some sort.

Proportional Symbol and Multivariate Analysis

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Creating proportional symbol

Proportional rendering is done by first applying to the layer the Single Symbol Renderer. Once you set the symbol,

at the upper level of the symbol tree, the Data-defined override button available beside Size or Width options
(for point or line layers respectively) provides tool to create proportional symbology for the layer. An assistant is

moreover accessible through the menu to help you define size expression.

Figure 12.18: Varying size assistant

The assistant lets you define:

• The attribute to represent, using the Field listbox or the Set column expression function (see Expressões)

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• The minimum and maximum size of the symbol

• The range of values to represent: The down pointing arrow helps you fill automatically these fields with the
minimum (or zero) and maximum values returned by the chosen attribute or the expression applied to your
data.

• An unique size to represent NULL values.

To the right side of the dialog, you can preview the features representation within a live-update widget. This
representation is added to the layer tree in the layer legend and is also used to shape the layer representation in the
print composer legend item.

The values presented in the varying size assistant above will set the size ‘Data-defined override’ with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Creating multivariate analysis

A multivariate analysis rendering helps you evaluate the relationship between two or more variables e.g., one can
be represented by a color ramp while the other is represented by a size.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the The symbol Selector dialog from which, as seen above, you can activate and
set the size assistant option either on size (for point layer) or width (for line layer).
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Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.

Rule-based rendering

The Rule-based Renderer is used to render all the features from a layer, using rule-based symbols whose
aspect reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements.
The dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use
only the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expressões). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

Figure 12.19: Rule-based Symbolizing options

Point displacement

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Nota: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.
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Figure 12.20: Point displacement dialog
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Inverted Polygon

The Inverted Polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As
above you can select subrenderers, namely Single symbol, Graduated, Categorized, Rule-Based or 2.5 D renderer.

Figure 12.21: Inverted Polygon dialog

Heatmap

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

2.5 D

Using the 2.5 D renderer it’s possible to create a 2.5 D effect on your layer’s features. You start by choosing
a Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Dica: Using 2.5 D effect with other renderers
Once you have finished setting the basic style on the 2.5 D renderer, you can convert this to another renderer
(single, categorized, graduated). The 2.5 D effects will be kept and all other renderer specific options will be
available for you to fine tune them (this way you can have for example categorized symbols with a nice 2.5 D
representation or add some extra styling to your 2.5 D symbols). To make sure that the shadow and the “building”
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Figure 12.22: Heatmap dialog

Figure 12.23: 2.5 D dialog
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itself do not interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol
levels...). The 2.5 D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the
variables tab of the layer’s properties dialog.

Renderização da camada

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• : guilabel: Transparência da camada | deslizante |: Você pode fazer a camada subjacente na tela do mapa
visível com esta ferramenta. Use o controle deslizante para se adaptar a visibilidade de sua camada de vetor
para suas necessidades. Você também pode fazer uma definição precisa do percentual de visibilidade no
menu ao lado do controle deslizante.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modos de Mistura.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define
Order dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Once the Define Order dialog is applied, a summary of the expression(s) used to control the layer rendering

is retranscribed in the textbox beside Control feature rendering order option.

Figure 12.24: Layer rendering options

Other Settings

Symbols levels

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below
the saved symbols list and choosing Symbol levels. For the Rule-based rendering the option is directly available
through [Symbols levels] button, while for Point displacement renderer the same button is inside the Rendering
settings dialog.
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To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.

Figure 12.25: Symbol levels dialog

Nota: If symbols levels are deactivated, the complete symbols will be drawn according to their respective features
order. Overlapping symbols will simply obfuscate to other below. Besides, similar symbols won’t “merge” with
each other.

Figure 12.26: Symbol levels activated (A) and deactivated (B) difference

Draw effects

In order to improve layer rendering and avoid (or at least reduce) the resort to other software for final rendering of

maps, QGIS provides another powerful functionality: the Draw Effects options, which adds paint effects for
customizing the visualization of vector layers.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
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that will open the Effect Properties Dialog (see figure_effects_1). The following effect types, with custom options
are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.

Figure 12.27: Draw Effects: Source dialog

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

Figure 12.28: Draw Effects: Blur dialog

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
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color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

Figure 12.29: Draw Effects: Colorize dialog

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

Figure 12.30: Draw Effects: Drop Shadow dialog

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
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Figure 12.31: Draw Effects: Inner Shadow dialog

you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

Figure 12.32: Draw Effects: Inner Glow dialog

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.
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Figure 12.33: Draw Effects: Outer Glow dialog

Figure 12.34: Draw Effects: Transform dialog
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There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Renderização da camada and can be used in all draw effects except for the
transform one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.3.3 Menu Rótulos

The Labels core application provides smart labeling for vector point, line and polygon layers, and only requires
a few parameters. This application also supports on-the-fly transformed layers. The following menus are used to
configure the labeling of vector layers:

• Texto

• Formatação

• Buffer

• Pano de fundo

• Sombra

• Localização

• Desenhando

To label a layer start QGIS and load a vector layer. Activate the layer in the legend and click on the
Layer Labeling Options icon in the QGIS toolbar menu or activate the Labels tab in the layer properties dialog.

The first step is to choose the labeling method from the drop-down list. There are four options available:

• No labels

• Show labels for this layer

• Rule-based labeling

• and Discourage other labels from covering features in this layer: allows to set a layer as just an obstacle
for other layer’s labels without rendering any labels of its own.

Select the Show labels for this layer option and then select an attribute column to use for labeling from the Label
with drop-down list. Click if you want to define labels based on expressions - See Define labels based on
expressions.

The following steps describe simple labeling without using the Data defined override functions, which are situated
next to the drop-down menus - see Using data-defined override for labeling for an use-case.

Text menu

You can define the text style in the Text menu (see Figure_labels_1). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the Modos de Mistura to create effects known from graphics programs.
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Figure 12.35: Smart labeling of vector point layers
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Formatting menu

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’
function. You can format the Line Height and the alignment. For the latter typical values are available plus Follow
label placement. When set to this mode, text alignment for labels will be dependent on the final placement of the
label relative to the point. E.g., if the label is placed to the left of the point then the label will be right aligned, and
if it is placed to the right of the point then the label will be left aligned.

For line vector layers you can include line directions symbols. There are options specifying the type of symbol
and the symbol placement.

Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places may be
inserted. If you enable this option, three decimal places are initially set by default.

Buffer menu

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.

Here, you can also use blend modes. If the color buffer’s fill checkbox is activated, it will interact with partially
transparent text and give mixed color transparency results. Turning off the buffer fill fixes that issue (except where
the interior aspect of the buffer’s stroke intersects with the text’s fill) and also allows you to make outlined text.

Background menu

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Modos de Mistura).

Shadow menu

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.

Placement menu

Choose the Placement menu for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Placement for point layers

With the Cartographic placement mode, point labels are generated with best visual relationship with the point
feature, following ideal cartographic placement rules. Labels can be placed at a set Distance either from the
point feature itself or from the bounds of the symbol used to represent the feature. The latter option is especially
useful when the symbol size isn’t fixed, e.g. if it’s set by a data defined size or when using different symbols in a
categorized renderer.

By default, placements are prioritised in the following order:
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1. top right

2. top left

3. bottom right

4. bottom left

5. middle right

6. middle left

7. top, slightly right

8. bottom, slightly left.

Placement priority can however be customized or set for an individual feature using a data defined list of prioritised
positions. This also allows only certain placements to be used, so e.g. for coastal features you can prevent labels
being placed over the land.

The Around point setting places the label in an equal radius (set in Distance) circle around the feature. The
placement of the label can even be constrained using the Quadrant option.

In the Offset from point placement, labels are placed at a fixed offset from the point feature. You can select the
Quadrant in which to place your label. You are also able to set the X and Y offset distances between the points
and their labels and can alter the angle of the label placement with the Rotation setting. Thus, placement in a
selected quadrant with a defined rotation is possible.

Placement for line layers

Label options for line layers include Parallel, Curved or Horizontal. For the Parallel and Curved

options, you can set the position to Above line, On line and Below line. It’s possible to select several
options at once. In that case, QGIS will look for the optimal label position. For Parallel and curved placement
you can also use the line orientation for the position of the label. Additionally, you can define a Maximum angle
between curved characters when selecting the Curved option (see Figure_labels_2 ).

For all three placement options you can set up a minimum distance for repeating labels. The distance can be in
mm or in map units.

Placement for polygon layers

You can choose one of the following options for placing labels in polygons: Offset from centroid, Horizontal
(slow), Around centroid, Free and Using perimeter.

In the Offset from centroid settings you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label within a specific quadrant, and define offset and rotation. The Around centroid setting places the label at
a specified distance around the centroid. Again, you can define visible polygon or whole polygon for the
centroid.

With the Using perimeter settings, you can define a position and a distance for the label. For the position,

Above line, On line, Below line and Line orientation dependent position are possible. You can specify
the distance between the label and the polygon outline, as well as the repeat interval for the label.

In the priority section you can define the priority with which labels are rendered for all three vector layer types
(point, line, polygon). This placement option interact with labels of the other vector layers in the map canvas. If
there are labels from different layers in the same location, the label with the higher priority will be displayed and
the others will be left out.
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Figure 12.36: Smart labeling of vector line layers

12.3. Janela de Propriedades de Vetor 121



QGIS User Guide, Versão 2.14

Figure 12.37: Smart labeling of vector polygon layers

Rendering menu

In the Rendering menu, you can tune when the labels can be rendered and their interaction with other labels and
features.

Under Label options, you find the scale-based and the Pixel size-based visibility settings.

The Label z-index determines the order in which labels are rendered, as well in relation with other feature labels in
the layer (using data-defined override expression), as with labels from other layers. Labels with a higher z-index
are rendered on top of labels (from any layer) with lower z-index.

Additionally, the logic has been tweaked so that if 2 labels have matching z-indexes, then:

• if they are from the same layer, the smaller label will be drawn above the larger label

• if they are from different layers, the labels will be drawn in the same order as their layers themselves (ie
respecting the order set in the map legend).

Note that this setting doesn’t make labels to be drawn below the features from other layers, it just controls the
order in which labels are drawn on top of all the layer’s features.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
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Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.

For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:

• over the feature’s interior: avoids placing labels over interior of polygon (prefers placing labels totally
outside or just slightly inside polygon)

• or over the feature’s boundary: avoids placing labels over boundary of polygon (prefers placing labels
outside or completely inside the polygon). It can be e.g. useful for regional boundary layers, where the
features cover an entire area. In this case it’s impossible to avoid placing labels within these features, and it
looks much better to avoid placing them over the boundaries between features.

Define labels based on expressions

QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function $area in combination with format_number()
to make it look nicer.

Figure 12.38: Using expressions for labeling

Expression based labeling is easy to work with. All you have to take care of is that:

• you need to combine all elements (strings, fields and functions) with a string concatenation function such as
concat, + or ||. Be aware that in some situations (null or numeric value involved) not all of these tools
will fit your need

• strings are written in ‘single quotes’

• fields are written in “double quotes” or without any quote.
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Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a comma as separator
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with other texts
’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with other texts
# combining different concatenation functions
concat(’My name is ’, name, ’ and I live in ’ || place)

-> My name is John Smith and I live in Paris
-> My name is John Smith # if the field ’place’ is NULL

# multi-line label based on two fields ’name’ and ’place’ with a descriptive text
concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")
-> My name is John Smith

I live in Paris

# label based on a field and the $area function
# to show the place name and its rounded area size in a converted unit.
’The area of ’ || "place" || ’ has a size of ’ || round($area/10000) || ’ ha’

-> The area of Paris has a size of 10500 ha

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
concat(’This place is a ’, CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

-> This place is a town

As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Expressões chapter for more information and examples on
expressions.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoom em um lago

5. Set editable the layer using the Toggle Editing button.
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6. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

Figure 12.39: Labeling of vector polygon layers with data-defined override

Figure 12.40: Move labels

Rule-based labeling

With Rule-based labeling multiple label configurations can be defined and applied selectively on the base of
expression filters, as in Rule-based rendering.

Rules can be set selecting the corresponding option at the top of the Labels panel (see figure_labels_7 ).

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. Within
the panel you can set the filter expression and the related label configurations.
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Figure 12.41: Rule based labeling panel

Figure 12.42: Rule settings
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12.3.4 Menu campos

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.

Edição de Widget

Figure 12.43: Dialog to select an edit widget for an attribute column

No: guilabel: Menu Campos, você também encontrará uma coluna ** ferramenta de edição ** . Esta coluna pode
ser utilizada para definir os valores ou variedade de valores que são permitidos para serem adicionados à coluna
da tabela de atributos específicos. Se você clicar no ** [edit widget] ** botão, uma janela se abre, onde você pode
definir diferentes elementos. Estes elementos são:

• ** Caixa de seleção **: Exibe uma caixa de seleção e você pode definir qual atributo é adicionado na coluna
quando a caixa de seleção é ativada ou não.

• ** Classificação **: Exibe uma caixa de combinação com os valores utilizados para a classificação, se
você tiver escolhido “valor único” como o tipo de lenda no: guilabel: Estilo menu da caixa de diálogo
propriedade

• Cor: Exibe um botão de cor permitindo que o usuário escolha uma cor na janela de diálogo de cor.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• ** Enumeração **: Abre uma caixa de combinação com valores que podem ser usados dentro no tipo de
colunas. Atualmente é suportado apenas por provedores de PostgreSQL.

• ** Nome do Arquivo **: Simplifica a seleção, adicionando uma janela de seleção de arquivos.

• ** Oculto **: Uma coluna de atributo oculto é invisível. O usuário não é capaz de ver o seu conteúdo.

• Foto: Campo que contém o nome do arquivo para a imagem. A largura e altura do campo podem ser
definidos.

• Tamanho: Permite definir valores numéricos de um tamanho específico. A edição do Widget pode ser um
controle deslizante ou uma caixa de rotação.
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• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

• ** Edição de texto ** (padrão): Isto abre um campo de edição de texto que permite que o texto simples ou
múltiplas linhas a sejam utilizados. Se você escolher várias linhas você também pode escolher o conteúdo
html.

• ** Valores únicos **: O usuário pode selecionar um dos valores já utilizados na tabela de atributos. Se
editável é ativado, uma linha de edição é mostrada com suporte para autocompletar, caso contrário, uma
caixa de combinação é utilizada.

• ** Gerador UUID **: Gera um campo UUID (identificador exclusivo universal) somente para leitura, se
vazio.

• ** Mapa de Valor **: uma caixa de combinação com itens pré-definidos. O valor é armazenado no atributo,
a descrição é mostrada na caixa de combinação. Você pode definir valores manualmente ou carregá-los a
partir de uma camada ou um arquivo CSV.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Webview: Campo que contém o nome do arquivo para a imagem. A largura e altura do campo podem ser
definidos.

Nota: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

Dica: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is useful for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’.

• ‘Autogenerate’ just creates editors for all fields and tabulates them.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment (for example in startup.py or from a plugin)

• load from an external file, a file chooser will appear in that case to allow you to select a Python file from
your filesystem

• load from inline code, a Python editor will appear where you can directly type your form code
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In all cases you must enter the name of the function that will be called (open in the example below).

An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: open

Figure 12.44: Diálogo para criar categorias com o ** |Editor Disposição Atributo **

12.3.5 Menu Juntar

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Além disso, o diálogo juntar vetor adicionado permite:

• Cache join layer in virtual memory

• Create attribute index on the join field
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Figure 12.45: Resulting built-in form with tabs and named groups

Figure 12.46: Join an attribute table to an existing vector layer
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• Choose which fields are joined

• Create a Custom field name prefix

12.3.6 Menu Diagramas

The Diagrams menu allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

For each type of diagram, the menu is divided into five tabs:

Attributes

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expressões can also be used.

You can move up and down any row with click and drag, sorting how atributes are displayed. You can also change
the label in the ‘Legend’ column or the attibute color by double-clicking the item.

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.47: Vector properties dialog with diagram menu

Appearance

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts
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• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

In this menu, you can also manage the diagram visibility:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by setting the scale visibility

Size

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.

Figure 12.48: Vector properties dialog with diagram menu, Size tab

Localização

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.

• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.
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Options

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.

Dica: Switch quickly between diagrams
Given that almost all the settings above are common to the different types of diagram, when designing your
diagram, you can easily change the diagram type and check which one is more appropriate to your data without
any loss.

Case Study

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Amostra de
Dados).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Dê um clique duplo na camada clima na legenda do mapa para abrir a aba de diálogo ‘Propriedades da
camada ‘.

3. Click on the Diagrams menu, activate Show diagrams for this layer, and from the Diagram type
combo box, select ‘Text diagram’.

4. Na guia Aparência, escolhemos um azul claro como cor de fundo, e na guia Tamanho, montamos um
tamanho fixo de 18 mm.

5. Na guia Posição, a colocação pode ser definida como ‘em torno do ponto’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

So, in the Attributes tab first select T_F_JAN and click the button, then repeat with T_F_JUL and
finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Activate the Scaled size and set the size of the diagrams on
the basis of the maximum value of an attribute and the Size option. If the diagrams appear too small on the

screen, you can activate the Increase size of small diagrams checkbox and define the minimum size of
the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_3 gives an idea of the result.

10. Finalmente, clique [Ok].

Lembre-se que no: guilabel: guia ‘ Posição‘, a | checkbox |: guilabel: Dados posição definida dos diagramas
é possível. Aqui você pode usar atributos para definir a posição do diagrama. Você também pode definir a
visibilidade dependente escala no: guilabel: guia ‘ Aparência‘.

The size and the attributes can also be an expression. Use the button to add an expression. See Expressões
chapter for more information and example.

12.3.7 Menu de Ações

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.
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Figure 12.49: Diagram from temperature data overlayed on a map

Figure 12.50: Overview action dialog with some sample actions

134 Chapter 12. Trabalhando com Dados Vetoriais



QGIS User Guide, Versão 2.14

Ações são úteis quando você frequentemente deseja executar uma aplicação externa ou visualizar uma página web
com base em um ou mais valores em sua camada de vetor. Elas são divididas em seis tipos e pode ser usadas
assim:

• Iniciar ações genéricas, Mac, Windows e Unix em um processo externo.

• Executar ações Python uma expressão Python.

• Ações genéricas e Python são visíveis em toda parte.

• Ações Mac, Windows e Unix são visíveis apenas na respectiva plataforma (ou seja, você pode definir ações
de três “Editar” para abrir um editor e os usuários só podem ver e executar a ação “Editar” na sua plataforma
para executar o editor) .

Existem vários exemplos incluídos na caixa de diálogo. Você pode carregá-los clicando no [Adicionar ações
padrão]. Um exemplo é a realização de uma pesquisa com base em um valor de atributo. Este conceito é usado
na discussão a seguir.

Defining Actions

Atributo ações são definidas a partir do vetor: guilabel: diálogo ‘Propriedades da Camada . Para: índice: ‘Definir
uma Ação, abra o vetor: guilabel: ‘Propriedades da Camada ‘ de diálogo e clique no: guilabel: Menu‘ Ações .
Vá para o: guilabel: ‘propriedades Ação. Selecione ‘genérico’ como tipo e fornecer um nome descritivo para
a ação. A própria ação deve conter o nome do aplicativo que será executado quando a ação é invocado. Você
pode adicionar um ou mais valores de campos de atributos como argumentos para a aplicação. Quando a ação
é chamada, qualquer conjunto de caracteres que começam com um ‘‘% ‘‘, seguido do nome de um campo será
substituído pelo valor desse campo. Os caracteres especiais: índice: %% será substituído pelo valor do campo
que foi selecionado da tabela identificam resultados ou atributo (ver using_actions abaixo). Aspas duplas podem
ser usadas ao texto do grupo em um único argumento para o programa, script ou comando. Aspas duplas serão
ignoradas se precedido por uma barra invertida.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by proceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Dois: índice: ações exemplo são mostradas abaixo:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

No primeiro exemplo, o navegador Konqueror é consultado e passou uma URL para abrir. A URL ex-
ecuta uma pesquisa no Google sobre o valor do campo ‘‘ nam‘‘ da nossa camada vetorial. Note-se
que a aplicação ou script chamado pela ação devem estar no caminho, ou você deve fornecer o caminho
completo. Para ter certeza, poderíamos reescrever o primeiro exemplo como: ‘‘ /opt/kde3/bin/konqueror
http://www.google.com/search?q=%nam ‘‘. Isto irá assegurar que a aplicação konqueror será executado quando a
ação é consultada.

O segundo exemplo usa a notação % % , que não depende de um campo específico para o seu valor. Quando a
ação é consultado, o % % será substituído pelo valor do campo selecionado na tabela de identificar resultados ou
atributo.
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Using Actions

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

Se você está chamando uma ação que usa o ‘‘% ‘‘% notação, clique com o botão direito sobre o valor do campo
na: guilabel: ‘‘ Identificar resultados de diálogo ou o: guilabel: ‘Tabela de atributos‘ diálogo que você deseja
passar para a aplicação ou script.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Depois de selecionar algumas localidades e executar a ação em cada um, a abertura do arquivo de saída irái mostrar
algo como isto:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Como um exercício, criamos uma ação que faz uma pesquisa no Google sobre o a camada lagos. Primeiro,
precisamos determinar o URL necessário para realizar uma pesquisa sobre a palavra-chave. Isso póde ser realizado
facilmente indo ao Google e realizando uma pesquisa simples, em seguida, pegar a URL na barra de endereços do
seu navegador. A partir deste pequeno esforço, vemos que o formato é: http://google.com/search?q=qgis , onde
QGIS é o termo de pesquisa. Armado com esta informação, podemos prosseguir:

1. Verifique se a camada lagos está carregada.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Clique em :guilabel: menu ‘Ações’.

4. Digite um nome para a ação, por exemplo ‘‘ Google Search ‘‘.

5. Para a ação, precisamos fornecer o nome do programa externo a ser executado. Neste caso, podemos usar o
Firefox. Se o programa não estiver em seu caminho, você precisará fornecer o caminho completo.

6. Seguindo o nome da aplicação externa, adicione a URL usada para fazer uma pesquisa no Google, mas não
inclua o termo de busca: ‘‘ http://google.com/search?q=‘‘

7. O texto no campo de ação será mostrado como este: ‘‘ firefox http://google.com/search?q =‘‘

8. Clique na caixa oculta que contém os nomes dos campos para camada ” lagos”. Ele está localizado logo ao
lado esquerdo do botão [Inserir Campo] .

9. A partir da caixa drop-down, selecione ‘NOMES’ e clique ** [Inserir campo]. **

10. Seu texto ação agora se parecerá como este:

firefox http://google.com/search?q=%NAMES

11. Para finalizar a ação, clique no botão [Adicionar à lista de ações].

Isso completa a ação, e ele está pronto para usar. O texto final da ação deve ser semelhante a este:

firefox http://google.com/search?q=%NAMES
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Agora podemos utilizar a ação. Feche a: aba de diálogo: ‘Propriedades da camada ‘ e aplique um zoom em uma
área de interesse. Certifique-se que a camada lagos está ativa e identifique um lago. Na caixa o resultado que
você poderá visualizar que a nossa ação está visível:

Figure 12.51: Select feature and choose action

Quando clicamos sobre a ação, ela faz o Firefox e navegar para o URL
http://www.google.com/search?q=Tustumena. Também é possível adicionar outros campos de atributo para
essa açao. Para isso basta um + ao final do texto de ação, selecionar outro campo e clicar em [Inserir Campo].
Nesse exemplo não temos outro campo disponível para efetuarmos a busca.

Você pode definir várias ações para uma camada, e cada um vai aparecer no diálogo Identificar resultados.

You can also invoke actions from the attribute table by selecting a row and right-clicking, then choosing the action
from the pop-up menu.

Há todos os tipos de usos para as ações. Por exemplo, se você tem uma camada de pontos que contém as lo-
calizações de imagens ou fotos, juntamente com um nome de arquivo, você pode criar uma ação para lançar um
visualizador para exibir a imagem. Você também pode usar ações para lançar relatórios baseados na web para um
campo de atributo ou combinação de campos, especificando-as da mesma forma que fizemos no nosso exemplo
de busca Google.

Nós também podemos fazer exemplos mais complexos, por exemplo, usando ações Python.

Normalmente, quando nós criamos uma ação para abrir um arquivo com uma aplicação externa, podemos usar
caminhos absolutos, ou, eventualmente, caminhos relativos. No segundo caso, o caminho é relativo ao local do
arquivo executável do programa externo. Mas o que dizer se precisamos usar caminhos relativos, em relação à
camada selecionada (um baseado em arquivo, como um shapefile ou SpatiaLite)? O código a seguir irá fazer o
truque:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )
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Nós apenas temos que lembrar que a ação é um do tipo variáveis Python e o comando e imagerelpath devem ser
alteradas para atender as necessidades.

Mas o que dizer se o caminho relativo deve ser relativo ao arquivo de projeto (salvo)? O código da ação Python
seria:

command="firefox"
imagerelpath="images/test_image.jpg"
projectpath=qgis.core.QgsProject.instance().fileName()
import os.path
path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image=os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Outro exemplo de ação Python é a que nos permite adicionar novas camadas ao projeto. Por exemplo, os exemplos
a seguir irão adicionar ao projeto, respectivamente, um vetor e raster. Os nomes dos arquivos a serem adicionados
ao projeto e os nomes a serem indicados para as camadas são conduzidos de dados (nome do arquivo e nome da
camada são nomes da tabela de atributos do vetor, onde a ação foi criada coluna):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)

Para adicionar um raster (uma imagem TIF neste exemplo), ele se torna:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.3.8 Menu Visualização

This menu is specifically created for Map Tips. It includes a nice feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is also possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → Map Tips.

Figure Display 1 and 2 show an example of HTML code and how it behaves in map canvas.

Figure 12.52: HTML code for map tip
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Figure 12.53: Map tip made with HTML code

12.3.9 Menu Renderizador

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing many

complex features at small scales. This feature can be enabled or disabled in the layer settings using the Simplify
geometry option. There is also a global setting that enables generalisation by default for newly added layers (see
section Opções).

Figure 12.54: Layer Geometry Simplification dialog

Nota: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.
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12.3.10 Menu Metadados

The Metadata menu consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title
from an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalogue.

In MetadataUrl, you can define the general path to the XML metadata catalogue. This information will be saved
in the QGIS project file for subsequent sessions and will be used for QGIS server.

In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Metadata menu in vector layers properties dialog

12.3.11 Save and Share Layer Properties

Managing Custom Styles

When a layer is added to map canvas, QGIS uses by default a random symbol/color to render its features. You can
however set a default symbol in Project → Properties → Default styles that will be applied to each newly added
layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.
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A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings).

Figure 12.56: Style combobox options

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Add: A new style is created using the current options.

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked. Once
you have more than one style defined for a layer, a Remove Current option can help you delete those you no
longer want.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Dica: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style. You can also edit feature symbols.

Storing Style in a File or a Database

While these styles are saved inside the project and can be copied and pasted from layer to layer in the project,
it’s also possible to save them outside the project so that they can be loaded in another project. Clicking the

Style → Save Style saves the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can also save your layer style
inside a table of the database. Just click on Save Style combobox and choose Save in database item then fill in the
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dialog to define a style name, add a description, an ui file if applicable and check if the style is the default style.
You can add several style in the database. However each table can have only one default style.

When loading a layer in QGIS, if a default style already exists for this layer, QGIS will load the layer and its style.
After you modified the layer style, you can Save as Default, creating a new style that becomes the default one or
Restore Default style if you’re not satisfied.

Figure 12.57: Save Style in database Dialog

Dica: Quickly share a layer style within the project
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).

12.4 Expressões

The Expressions feature is available from many parts in QGIS. It can be accessed using the Expression Builder, the
Select By Expression..., the Geometry generator symbol layer option, the Field calculator or the Data defined override

tool. Based on layer data and prebuilt or user defined functions, it offers a powerful way to manipulate attribute
value, geometry and variables in order to dynamically change the geometry style, the content or position of the
label, the value for diagram, the height of a composer item, select some features, create virtual field ...

Alguns exemplos:

• From Field Calculator, calculate a “pop_density” field using existing “total_pop” and “area_km2” fields:

"total_pop" / "area_km2"

• Update the field “density_level” with categories according to the “pop_density” values:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Apply a categorized style to all the features according to whether their average house price is smaller or
higher than 10000C per square metre:

"price_m2" > 10000

• Using the “Select By Expression...” tool, select all the features representing areas of “High population
density” and whose average house price is higher than 10000C per square metre:
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"density_level" = ’High population density’ and "price_m2" > 10000

Likewise, the previous expression could also be used to define which features should be labeled or shown in the
map. Using expressions offers you a lot of possibilities.

The Expressions feature offers access to the:

• Expression tab which lists functions to use

• Function Editor tab which helps to create custom functions to use in the expressions.

12.4.1 Lista de funções

Figure 12.58: The Expression tab

The Expression tab contains functions as well as layer’s fields and values. It contains widgets to:

• type expressions using functions and/or fields. A preview of the expression’s result is displayed at the
bottom of the dialog.

• select the appropriate function among a list. A search box is available to filter the list and quickly find a
particular function or field. Double-clicking on the item’s name adds it to the expression being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.

To help to quickly find a function, they are organized in groups. In Operators, you find mathematical operators.
Look in Math for mathematical functions. The Conversions group contains functions that convert one data type
to another. The String group provides functions for data strings, such as Date and Time handles date and time
data. In the Geometry group, you find functions for geometry objects. With Record group functions, you can add
a numeration to your data set while Fields and Values group helps view all attributes of the attribute table. The
Customs group lists the functions created or imported by the user. There are many other groups, listed below.
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Operadores

This group contains operators (e.g., +, -, *). Note that for most of the mathematical functions below, if one of the
inputs is NULL then the result is NULL.

Function Description
a + b Addition of two values (a plus b)
a - b Subtraction of two values (a minus b).
a * b Multiplication of two values (a multiplied by b)
a / b Division of two values (a divided by b)
a % b Remainder of division of a by b (eg, 7 % 2 = 1, or 2 fits into 7 three times with remainder

1)
a ^ b Power of two values (for example, 2^2=4 or 2^3=8)
a < b Compares two values and evaluates to 1 if the left value is less than the right value (a is

smaller than b)
a <= b Compares two values and evaluates to 1 if the left value is less than or equal to the right

value
a <> b Compares two values and evaluates to 1 if they are not equal
a = b Compares two values and evaluates to 1 if they are equal
a != b a and b are not equal
a > b Compares two values and evaluates to 1 if the left value is greater than the right value (a

is larger than b)
a >= b Compares two values and evaluates to 1 if the left value is greater than or equal to the

right value
a ~ b a matches the regular expression b
|| Joins two values together into a string. If one of the values is NULL the result will be

NULL
‘\n’ Inserts a new line in a string
LIKE Returns 1 if the first parameter matches the supplied pattern
ILIKE Returns 1 if the first parameter matches case-insensitive the supplied pattern (ILIKE can

be used instead of LIKE to make the match case-insensitive)
a IS b Tests whether two values are identical. Returns 1 if a is the same as b
a OR b Returns 1 when condition a or b is true
a AND b Returns 1 when condition a and b are true
NOT Negates a condition
column name
“column name”

Value of the field column name, take care to not be confused with simple quote, see
below

‘string’ a string value, take care to not be confused with double quote, see above
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN
(value[,value])

a is below the values listed

a NOT IN
(value[,value])

a is not below the values listed

Alguns exemplos:

• Juntando um texto e um valor a partir de um nome de coluna:

’My feature’’s id is: ’ || "gid"

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
character):

"description" LIKE ’Hello%’

Condicionais

Este grupo contém funções para lidar com verificações condicionais em expressões.
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Function Description
CASE WHEN ... THEN ...
END

Evaluates an expression and returns a result if true. You can test multiple
conditions

CASE WHEN ... THEN ...
ELSE ... END

Evaluates an expression and returns a different result whether it’s true or
false. You can test multiple conditions

coalesce Returns the first non-NULL value from the expression list
if Tests a condition and returns a different result depending on the conditional

check
regexp_match Returns true if any part of a string matches the supplied regular expression

Alguns exemplos:

• Enviar de volta um valor se a primeira condição é verdade, outra coisa manda outro valor:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Funções Matemáticas

Este grupo contém funções matemáticas (por exemplo, raiz quadrada, sen e cos).

Function Description
abs Returns the absolute value of a number
acos Returns the inverse cosine of a value in radians
asin Returns the inverse sine of a value in radians
atan Returns the inverse cosine of a value in radians
atan2(y,x) Returns the inverse tangent of y/x by using the signs of the two arguments to determine the

quadrant of the result
az-
imuth(a,b)

Returns the north-based azimuth as the angle in radians measured clockwise from the vertical
on point a to point b

ceil Rounds a number upwards
clamp Restricts an input value to a specified range
cos Returns the cosine of a value in radians
graus Converts from radians to degrees
exp Returns exponential of a value
floor Rounds a number downwards
ln Returns the natural logarithm of the passed expression
log Returns the value of the logarithm of the passed value and base
log10 Returns the value of the base 10 logarithm of the passed expression
max Returns the largest value in a set of values
min Returns the smallest value in a set of values
pi Returns the value of pi for calculations
radians Converts from degrees to radians
rand Returns the random integer within the range specified by the minimum and maximum argument

(inclusive)
randf Returns the random float within the range specified by the minimum and maximum argument

(inclusive)
round Rounds to number of decimal places
scale_exp Transforms a given value from an input domain to an output range using an exponential curve
scale_linear Transforms a given value from an input domain to an output range using linear interpolation
sin Returns the sine of an angle
sqrt Returns the square root of a value
tan Returns the tangent of an angle

Funções Cor

Este grupo contém funções para manipulação de cores.
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Function Description
color_cmyk Returns a string representation of a color based on its cyan, magenta, yellow and black

components
color_cmyka Returns a string representation of a color based on its cyan, magenta, yellow, black and alpha

(transparency) components
color_hsl Returns a string representation of a color based on its hue, saturation, and lightness attributes
color_hsla Returns a string representation of a color based on its hue, saturation, lightness and alpha

(transparency) attributes
color_hsv Returns a string representation of a color based on its hue, saturation, and value attributes
color_hsva Returns a string representation of a color based on its hue, saturation, value and alpha

(transparency) attributes
color_part Returns a specific component from a color string, eg the red component or alpha component
color_rgb Returns a string representation of a color based on its red, green, and blue components
color_rgba Returns a string representation of a color based on its red, green, blue, and alpha (transparency)

components
darker Returns a darker (or lighter) color string
lighter Returns a lighter (or darker) color string
project_color Returns a color from the project’s color scheme
ramp_color Returns a string representing a color from a color ramp
set_color_partSets a specific color component for a color string, eg the red component or alpha component

Conversões

Este grupo contém funções para converter um tipo de dado para outro (por exemplo, texto para inteiro, inteiro para
texto).

Function Description
to_date Converts a string into a date object
to_datetime Converts a string into a datetime object
to_int Converts a string to integer number
to_interval Converts a string to an interval type (can be used to take days, hours, months, etc. of a date)
to_real Converts a string to a real number
to_string Converts number to string
to_time Converts a string into a time object

Custom functions

This group contains functions created by the user. See function_editor for more details.

Funções Data e hora

Este grupo contém funções para trabalhar datas e hora data.

Function Description
age Returns as an interval the difference between two dates or datetimes
day Extracts the day from a date or datetime, or the number of days from an interval
day_of_week Returns a number corresponding to the day of the week for a specified date or datetime
hour Extracts the hour from a datetime or time, or the number of hours from an interval
minute Extracts the minute from a datetime or time, or the number of minutes from an interval
month Extracts the month part from a date or datetime, or the number of months from an interval
now() Returns current date and time
second Extracts the second from a datetime or time, or the number of seconds from an interval
week Extracts the week number from a date or datetime, or the number of weeks from an interval
year Extracts the year part from a date or datetime, or the number of years from an interval

Alguns exemplos:

• Obter o mês e o ano de hoje no formato “02/2015”
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month(now()) || ’/’ || year(now())

Campo e Valores

Contains a list of fields from the layer.

Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.

To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

Sample values can also be accessed via right-click. Select the field name from the list, then right-click to access a
context menu with options to load sample values from the selected field.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Fuzzy Matching Functions

This group contains functions for fuzzy comparisons between values.

Function Description
ham-
ming_distance

Returns the number of characters at corresponding positions within the input strings where
the characters are different

levensheim Returns the minimum number of character edits (insertions, deletions or substitutions)
required to change one string to another. Measure the similarity between two strings

longest_common_substringReturns the longest common substring between two strings
soundex Returns the Soundex representation of a string

General Functions

This group contains general assorted functions.

Function Description
eval Evaluates an expression which is passed in a string. Useful to expand dynamic parameters

passed as context variables or fields
layer_propertyReturns a property of a layer or a value of its metadata. It can be layer name, crs, geometry

type, feature count...
var Returns the value stored within a specified variable. See variable functions below

Funções Geometria

Este grupo contém funções que operam na geometria dos objetos (por exemplo, comprimento, área).

Function Description
$area Returns the area size of the current feature
$geometry Returns the geometry of the current feature (can be used for processing with other functions)
$length Returns the length of the current line feature
$perimeter Returns the perimeter of the current polygon feature
$x Returns the x coordinate of the current feature
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Returns the y coordinate of the current feature
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
area Returns the area of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry

Continuação na próxima página
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Table 12.1 – continuação da página anterior
Function Description
bounds Returns a geometry which represents the bounding box of an input geometry. Calculations are in the Spatial Reference System of this Geometry
bounds_height Returns the height of the bounding box of a geometry. Calculations are in the Spatial Reference System of this Geometry
bounds_width Returns the width of the bounding box of a geometry. Calculations are in the Spatial Reference System of this Geometry
buffer Returns a geometry that represents all points whose distance from this geometry is less than or equal to distance. Calculations are in the Spatial Reference System of this geometry
centroid Returns the geometric center of a geometry
closest_point Returns the point on a geometry that is closest to a second geometry
combine Returns the combination of two geometries
contains(a,b) Returns 1 (true) if and only if no points of b lie in the exterior of a, and at least one point of the interior of b lies in the interior of a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
crosses Returns 1 (true) if the supplied geometries have some, but not all, interior points in common
difference(a,b) Returns a geometry that represents that part of geometry a that does not intersect with geometry b
disjoint Returns 1 (true) if the geometries do not share any space together
distance Returns the minimum distance (based on spatial ref) between two geometries in projected units
end_point Returns the last node from a geometry
exterior_ring Returns a line string representing the exterior ring of a polygon geometry. If the geometry is not a polygon then the result will be null
extrude(geom,x,y) Returns an extruded version of the input (Multi-)Curve or (Multi-)Linestring geometry with an extension specified by x and y
geom_from_gml Returns a geometry created from a GML representation of geometry
geom_from_wkt Returns a geometry created from a well-known text (WKT) representation
geom_to_wkt Returns the well-known text (WKT) representation of the geometry without SRID metadata
geometry Returns a feature’s geometry
geometry_n Returns the nth geometry from a geometry collection, or null if the input geometry is not a collection
interior_ring_n Returns the geometry of the nth interior ring from a polygon geometry, or null if the geometry is not a polygon
intersection Returns a geometry that represents the shared portion of two geometries
intersects Tests whether a geometry intersects another. Returns 1 (true) if the geometries spatially intersect (share any portion of space) and 0 if they don’t
intersects_bbox Tests whether a geometry’s bounding box overlaps another geometry’s bounding box. Returns 1 (true) if the geometries spatially intersect (share any portion of space) their bounding box and 0 if they don’t
is_closed Returns true if a line string is closed (start and end points are coincident), false if a line string is not closed and null if the geometry is not a line string
length Returns length of a line geometry feature (or length of a string)
m Returns the m value of a point geometry
make_line Creates a line geometry from a series of point geometries
make_point(x,y,z,m) Returns a point geometry from x and y values (and optional z and m values)
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Creates a polygon geometry from an outer ring and optional series of inner ring geometries
nodes_to_points Returns a multipoint geometry consisting of every node in the input geometry
num_geometries Returns the number of geometries in a geometry collection, or null if the input geometry is not a collection
num_interior_rings Returns the number of interior rings in a polygon or geometry collection, or null if the input geometry is not a polygon or collection
num_points Returns the number of vertices in a geometry
num_rings Returns the number of rings (including exterior rings) in a polygon or geometry collection, or null if the input geometry is not a polygon or collection
order_parts Orders the parts of a MultiGeometry by a given criteria
overlaps Tests whether a geometry overlaps another. Returns 1 (true) if the geometries share space, are of the same dimension, but are not completely contained by each other
perimeter Returns the perimeter of a geometry polygon feature. Calculations are in the Spatial Reference System of this geometry
point_n Returns a specific node from a geometry
point_on_surface Returns a point guaranteed to lie on the surface of a geometry
relate Tests or returns the Dimensional Extended 9 Intersection Model (DE-9IM) representation of the relationship between two geometries
reverse Reverses the direction of a line string by reversing the order of its vertices
segments_to_lines Returns a multi line geometry consisting of a line for every segment in the input geometry
shortest_line Returns the shortest line joining two geometries. The resultant line will start at geometry 1 and end at geometry 2
start_point Returns the first node from a geometry
sym_difference Returns a geometry that represents the portions of two geometries that do not intersect
touches Tests whether a geometry touches another. Returns 1 (true) if the geometries have at least one point in common, but their interiors do not intersect
transform Returns the geometry transformed from the source CRS to the destination CRS
translate Returns a translated version of a geometry. Calculations are in the Spatial Reference System of this geometry
union Returns a geometry that represents the point set union of the geometries
within (a,b) Tests whether a geometry is within another. Returns 1 (true) if geometry a is completely inside geometry b
x Returns the x coordinate of a point geometry, or the x coordinate of the centroid for a non-point geometry
x_min Returns the minimum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry

Continuação na próxima página
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Table 12.1 – continuação da página anterior
Function Description
x_max Returns the maximum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y Returns the y coordinate of a point geometry, or the y coordinate of the centroid for a non-point geometry
y_min Returns the minimum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Returns the z coordinate of a point geometry

Alguns exemplos:

• Return the x coordinate of the current feature’s centroid:

x($geometry)

• Send back a value according to feature’s area:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Funções Registro

Este grupo contém funções que operam na identificação da registros.

Function Description
$current-
feature

Returns the current feature being evaluated. This can be used with the ‘attribute’ function to
evaluate attribute values from the current feature.

$id Returns the feature id of the current row
$map Returns the id of the current map item if the map is being drawn in a composition, or “canvas” if

the map is being drawn within the main QGIS window
$rownum Returns the number of the current row
$scale Returns the current scale of the map canvas
attribute Returns the value of a specified attribute from a feature.
get_feature Returns the first feature of a layer matching a given attribute value.
uuid Generates a Universally Unique Identifier (UUID) for each row. Each UUID is 38 characters long

Alguns exemplos:

• Return the first feature in layer “LayerA” whose field “id” has the same value as the field “name” of the
current feature (a kind of jointure):

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Calculate the area of the joined feature from the previous example:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Funções String

Este grupo contém funções que operam em textos (por exemplo, quer substituir, converter para maiúsculas).
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Function Description
concat Concatenates several strings to one
format Formats a string using supplied arguments
for-
mat_date

Formats a date type or string into a custom string format

for-
mat_number

Returns a number formatted with the locale separator for thousands (also truncates the number
to the number of supplied places)

left(string,
n)

Returns a substring that contains the n leftmost characters of the string

length Returns length of a string (or length of a line geometry feature)
lower converts a string to lower case
lpad Returns a string with supplied width padded using the fill character
reg-
exp_replace

Returns a string with the supplied regular expression replaced

reg-
exp_substr

Returns the portion of a string which matches a supplied regular expression

replace Returns a string with the supplied string replaced
right(string,
n)

Returns a substring that contains the n rightmost characters of the string

rpad Returns a string with supplied width padded using the fill character
strpos Returns the index of a regular expression in a string
substr Returns a part of a string
title Converts all words of a string to title case (all words lower case with leading capital letter)
trim Removes all leading and trailing white space (spaces, tabs, etc.) from a string
upper Converts string a to upper case
wordwrap Returns a string wrapped to a maximum/ minimum number of characters

Recent Functions

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Variables Functions

This group contains dynamic variables related to the application, the project file and other settings. It means that
some functions may not be available according to the context:

• from the Select by expression dialog

• from the Field calculator dialog

• from the layer properties dialog

• from the print composer

To use these functions in an expression, they should be preceded by @ character (e.g, @row_number). Are
concerned:

Function Description
atlas_feature Returns the current atlas feature (as feature object)
atlas_featureid Returns the current atlas feature ID
atlas_featurenumber Returns the number of pages in composition
atlas_filename Returns the current atlas file name
atlas_geometry Returns the current atlas feature geometry
atlas_pagename Returns the current atlas page name
atlas_totalfeatures Returns the total number of features in atlas
grid_axis Returns the current grid annotation axis (eg, ‘x’ for longitude, ‘y’ for latitude)

Continuação na próxima página
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Table 12.2 – continuação da página anterior
Function Description
grid_number Returns the current grid annotation value
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Returns the composer item unique ID
layer_id Returns the ID of current layer
layer_name Returns the name of current layer
layout_dpi Returns the composition resolution (DPI)
layout_numpages Returns the number of pages in the composition
layout_pageheight Returns the composition height in mm
layout_pagewidth Returns the composition width in mm
map_id Returns the ID of current map destination. This will be ‘canvas’ for canvas renders, and the item ID for composer map renders
map_extent_center Returns the point feature at the center of the map
map_extent_height Returns the current height of the map
map_extent_width Returns the current width of the map
map_rotation Returns the current rotation of the map
map_scale Returns the current scale of the map
project_filename Returns the filename of current project
project_folder Returns the folder for current project
project_path Returns the full path (including file name) of current project
project_title Returns the title of current project
qgis_os_name Returns the current Operating system name, eg ‘windows’, ‘linux’ or ‘osx’
qgis_platform Returns the QGIS platform, eg ‘desktop’ or ‘server’
qgis_release_name Returns the current QGIS release name
qgis_version Returns the current QGIS version string
qgis_version_no Returns the current QGIS version number
symbol_angle Returns the angle of the symbol used to render the feature (valid for marker symbols only)
symbol_color Returns the color of the symbol used to render the feature
user_account_name Returns the current user’s operating system account name
user_full_name Returns the current user’s operating system user name
row_number Stores the number of the current row

12.4.2 Function Editor

With the Function Editor, you are able to define your own Python custom functions in a comfortable way.

Figure 12.59: The Function Editor tab
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The function editor will create new Python files in .qgis2\python\expressions folder and will auto load
all functions defined when starting QGIS. Be aware that new functions are only saved in the expressions
folder and not in the project file. If you have a project that uses one of your custom functions you will need to also
share the .py file in the expressions folder.

Aqui há um breve exemplo de como criar suas próprias funções:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

The short example creates a function ‘myfunc’ that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number of
arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)

Your function will be implemented in the Custom functions group of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found in the PyQGIS-Developer-Cookbook.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions.

12.5 Trabalhando com a Tabela de Atributos

O :index: atributo da tabela exibe características de uma camada selecionada. Cada linha na tabela representa
um recurso do mapa, e cada coluna contém uma determinada parte das informações sobre o recurso. Recursos na
tabela podem ser pesquisados, selecionados, movidos ou mesmo editados.

Para abrir a tabela de atributos de uma camada do vetor, fazer a camada ficar ativa clicando sobre ela na área de
legenda do mapa. Então, a partir do principal: menu de seleção: menu de Camada, escolha | mActionOpenTable
|: menu de seleção: ‘Abrir Tabela de Atributos‘. Também é possível fazer um clique direto sobre a camada e
escolha | mActionOpenTable |: menu de seleção: ‘Abrir Tabela de Atributos‘ a partir do menu suspenso, e clique
no | mActionOpenTable |: guilabel: botão Abrir Tabela de Atributos na barra de ferramentas.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figure 12.60: Attribute Table for regions layer

The buttons at the top of the attribute table window provide the following functionality:
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• Toggle editing mode to enable editing functionalities (also with Ctrl+e)

• Save Edits (also with Ctrl+s)

• Reload the table

• Add feature

• Delete selected features (also with Ctrl+d)

• Select features using an Expression

• Select all (also with Ctrl+a)

• Invert selection (also with Ctrl+r)

• Unselect all (also with Ctrl+u)

• Move selected to top (also with Ctrl+t)

• Pan map to the selected rows (also with Ctrl+p)

• Zoom map to the selected rows (also with Ctrl+j)

• Copy selected rows to clipboard (also with Ctrl+c)

• Paste from clipboard to a new row (also with Ctrl+v)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+l)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+w)

• Open field calculator (also with Ctrl+i)

Below these buttons is the Field Calculator bar (enabled only in editing mode), which allows calculations to be
quickly applied to either all or selected features attributes in the table. This bar uses the same expressions as the

Field Calculator (see Field Calculator).

Dica: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

12.5.1 Selecting features in an attribute table

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.
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The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Field Calculator). The query result can then be saved as a new vector layer. For example, if you want to find
regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and Values
menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all unique
values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Query Builder.

To show selected records only, use Show Selected Features from the menu at the bottom left. See next section for
more information on filter feature.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the layer regions.shp with the expression

ID+5

as shown in figure_attributes_1 .

12.5.2 Filter features

At the bottom of the attribute table, you have a dropdown list of different filter:

• Show All Features;

• Mostra feições selecionadas;

• Show Features visible on map;

• Show Edited and New Features;

• Field Filter;

• Advanced filter (Expression);

The first four are self explanatory, the two last are expression filters. Field Filter allows user to choose a column
name in the list and add a simple form to the right of the drop-down list to filter with a like expression parameter.
This filter will create an expression filter as an Advanced filter. The last kind of filter will open an expression
window, see Expressões for more information.

12.5.3 Tab/form mode

By default the attribute window displays a table layout. In some case one should prefer to use a form layout to
help edit some features more easily.

You can switch to form layout by clicking in the bottom right, on and switch back to table layout with .
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12.5.4 Zoom to feature

To zoom into a feature, without having to select it, right-click on the feature you want to zoom in, within the
attribute table, and select Zoom to feature.

12.5.5 Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). Just open the right mouse menu of the layer and click on Save as to define the name

of the output file, its format and CRS (see section Layers Panel). To save the selection ensure that the Save
only selected features is selected. It is also possible to specify OGR creation options within the dialog.

12.5.6 Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

12.5.7 Editing attribute values

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Nota: Use of Virtual Fields
• Virtual fields are not permanent in the layer attributes, meaning that they’re only saved and available in the

project file they’ve been created.

• A field can be set virtual only at its creation and the expression used can’t be changed later: you’ll need to
delete and recreate that field.

The field calculator is available on any layer that supports edit. When you click on the field calculator icon the
dialog opens (see figure_attributes_2). If the layer is not in edit mode, a warning is displayed and using the field
calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is in edit mode.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on [Update All], [Update Selected] or [Update Filtered]
button according to your need.

Field Calculator

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.
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Figure 12.61: Field Calculator
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If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_2). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Complete the expression by typing / 1000 in the Field calculator expression box and click [Ok].

7. You can now find a new field length in the attribute table.

12.5.8 Working with non spatial attribute tables

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Menu campos to find out more.

12.5.9 Conditional formatting of Table Cells

You can enable the conditional formatting panel clicking on at the top right of the attributes window in table
view (not available in form view).

The new panel allows user to add new rules for conditional formatting of field or full row in regard of the expression
on field. Adding new rule open a form to define:

• the name of the rule,

• a condition from expression window,

• a preset formatting

• some other parameters to improve, change or setup the formatting:

– background and text colors,

– use of icon,

– bold, italic underline, or strikeout,

– text field,

– font.
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Figure 12.62: Conditional Formatting of an attribute table

12.5.10 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

Figure 12.63: Alaska region with airports

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).
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This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.

Camadas

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demonstrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in Project
→ Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Figure 12.64: Relation Manager
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Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Figure 12.65: Identification dialog regions with relation to airports

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.
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Figure 12.66: Identification dialog airport with relation to regions

12.6 Editando

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Nota: O procedimento para editar camadas do GRASS é diferente - consulte a seção Digitalizando e editando
uma camada vetorial GRASS para mais detalhes.

Dica: Edições Simultâneas
This version of QGIS does not track if somebody else is editing the same feature at the same time as you are. The
last person to save its edits wins.

12.6.1 Configurando a Tolerância de Atracção e Raio de Pesquisa

For an optimal and accurate edit of the vector layer geometries, we need to set an appropriate value of snapping
tolerance and search radius for features vertices.

Tolerância de Atração

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_1 ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.
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• Advanced: if you need to edit a layer and snap its vertices to another layer, ensure the target layer
is checked and increase the snapping tolerance to a greater value. Furthermore, snapping will never
occur to a layer that is not checked in the snapping options dialog, regardless of the global snapping
tolerance. So be sure to mark the checkbox for those layers that you need to snap to.

Figure 12.67: Edit snapping options on a layer basis (Advanced mode)

Dica: Control the list of layers to snap
The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.

Raio de pesquisa

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. Snap
tolerance and search radius are set in map units or pixels, so you may find you need to experiment to get them set
right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are dealing with
a large number of vertices in close proximity. Set search radius too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project-wide snapping tolerance.

12.6.2 Edição Topológica

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Ativar edição topológica

The option Enable topological editing is for editing and maintaining common boundaries in features mosaics.
QGIS ‘detects’ shared boundary by the features, so you only have to move a common vertex/segment once, and
QGIS will take care of updating the neighboring features.
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Evitar intersecções de novos polígonos

A second topological option called Avoid intersections prevents you to draw new features that overlap an
existing one. It is for quicker digitizing of adjacent polygons. If you already have one polygon, it is possible
with this option to digitize the second one such that both intersect, and QGIS then cuts the second polygon to
the boundary of the existing one. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Nota: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.

Aviso: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.

Activar atracção nas intersecções

Outra opção é usar |caixa| :guilabel: Habilitar encaixe em intersecção. Ele permite que você encaixe em uma
intersecção de camadas de fundo, mesmo se não há nenhum vértice na interseção.

Verificador de Geometria

A core plugin can help the user to find the geometry invalidity. You can find more information on this plugin at
Complemento Verificador de Geometria.

12.6.3 Digitalizar uma camada existente

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitalização Avançada. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Ícone Finalidade Ícone Finalidade

Edições actuais Alternar edição

Add Feature: Capture Point Add Feature: Capture Line

Add Feature: Capture Polygon Mover Elemento

Adicionar feição circular Adicionar Feição Circular pelo Raio

Ferramenta de Nós Apagar Selecionados

Cortar Elementos Copiar Elementos

Colar Elementos Salvar edições da camada

Edição da Tabela: Edição básica da camada vectorial pela barra de ferramentas

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.
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Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.

Dica: Salvar Regularmente

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Adicionando Elementos

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Nota: Curved geometries are stored as such only in compatible data provider
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Dica: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• Suppress attributes pop-up windows after each created feature to avoid the form opening

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

With the Move Feature(s) icon on the toolbar, you can move existing features.

Ferramenta de Nós

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.
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Figure 12.68: Enter Attribute Values Dialog after digitizing a new vector feature

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.

Dica: Marcadores de Vértice
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Operações Básicas

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl when clicking to toggle the selection state of vertices (vertices
that are currently unselected will be selected as usual, but also vertices that are already selected will become
unselected).

• Adicionando vértices: Para adicionar um vértice, basta clicar duas vezes perto de uma borda e um novo
vértice aparecerá na borda perto do cursor. Note-se que o vértice aparecerá na borda, não na posição do
cursor; por conseguinte, deve ser transferida, se necessário.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Dica: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.
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The Vertex Editor

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Figure 12.69: Vertex editor panel showing selected nodes

Cortando, Copiando e Colando Elementos

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Dica: Transform polygon into line and vice-versa using copy/paste
Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT features from outside QGIS
can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

Como exemplo, vamos copiar alguns lagos para uma nova camada:

1. Carregue a camada que quer copiar a partir (camada de origem)

2. Carregue ou crie a camada que quer copiar para (camada de destino)

3. Começar a editar a camada de destino

4. Ative a camada de origem clicando nela na legenda

5. Use the Select Features by area or single click tool to select the feature(s) on the source layer

6. Click on the Copy Features tool
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7. Ative a camada de destino clicando na legenda

8. Click on the Paste Features tool

9. Parar a edição e salvar as alterações

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Nota: Congruência dos Elementos Colados
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Dica: Copy string attribute into another
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accommodate for the length of the data to be inserted.

Apagando os Elementos Selecionados

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Salvando as Camadas Editadas

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Dica: Integridade dos dados
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.
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Saving multiple layers at once

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

As mesmas funções estão disponíveis para a edição de todas as camadas do projeto.

12.6.4 Digitalização Avançada

Ícone Finalidade Ícone Finalidade

Enable Advanced Digitizing Tools Enable Tracing

Retroceder Retomar

Rodar Elemento(s) Simplificar elemento

Adicionar Anel Adicionar Parte

Preenchimento Anel Apagar Anel

Apagar Parte Refazer elementos

Curva de Afastamento Dividir Elementos

Dividindo partes Juntar Elementos Selecionados

Juntar Atributos dos Elementos Selecionados Rodar Símbolos de Pontos

Tabela de edição avançada: Barra de ferramentas de edição avançada de camadas vetoriais

Retroceder e Retomar

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_4). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Figure 12.70: Redo and Undo digitizing steps

When Undo is hit or Ctrl+z (or Cmd+z) pressed, the state of all features and attributes are reverted to the
state before the reverted operation happened. Changes other than normal vector editing operations (for example,
changes done by a plugin) may or may not be reverted, depending on how the changes were performed.
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Para usar a tela histórico de desfazer / refazer, basta clicar para selecionar uma operação na lista de histórico.
Todas as feições serão revertidas para o estado em que estavam depois da operação selecionada.

Rodar Elemento(s)

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.

If you hold Shift before clicking on the map, the rotation will be done in 45 degree steps, which can be modified
afterwards in the user input widget.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Simplificar elemento

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Nota: unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool really modifies feature’s geometry in data source.

Adicionar Parte

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the
attribute table and digitize the new geometry with the Add Part tool.

Apagar Parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.
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Adicionar Anel

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Preenchimento Anel

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Apagar Anel

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Refazer elementos

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

Por exemplo, pode editar o limite de um polígono com esta ferramenta. Primeiro, clique na área interna do
polígono junto do ponto onde pretende adicionar o novo vértice. Depois, atravesse o limite e adicione os vértices
no exterior do polígono. Para finalizar, clique com o botão direito na área interna do polígono. A ferramenta vai
adicionar um nó automaticamente no ponto onde a linha atravessa o limite. Também é possível remover parte da
área do polígono, começa-se a nova linha no exterior do polígono, adicionam-se vértices no interior e termina-se
a linha no exterior do polígono com um clique no botão direito.

Nota: A ferramenta de mudança de forma pode alterar a posição inicial de um anel ou de uma linha poligonal
fechada. Assim, o ponto que está representada ‘duas vezes’ não será o mesmo mais. Isto pode não ser um
problema para a maioria das aplicações, mas é algo a considerar.

Curvas de Afastamento

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input

widget. Your changes may then be saved with the Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.
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Dividir Elementos

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Dividindo partes

In QGIS it is possible to split the parts of a multi part feature so that the number of parts is increased. Just draw a

line across the part you want to split using the Split Parts icon.

Juntar elementos selecionados

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Juntar os atributos dos elementos selecionados

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their

boundaries. First, select several features. Then press the Merge Attributes of Selected Features button. Now QGIS asks
you which attributes are to be applied to all selected objects. As a result, all selected objects have the same attribute
entries.

Rodar Símbolos de Pontos

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.71: Rodar Símbolos de Pontos

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_5). When you release the left mouse button
again, the value will be updated in the attribute table.

Nota: Se segurar a tecla Ctrl premido, a rotação irá ser feita em passos de 15 graus.
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Automatic Tracing

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Nota: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.

Dica: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.6.5 The Advanced Digitizing panel

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geometry.

Figure 12.72: The Advanced Digitizing panel

Nota: As ferramentas não são habilitadas se a visão do mapa está em coordenadas geográficas.

12.6.6 Criando novas camadas Vetoriais

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Criando uma nova camada vetorial GRASS for more information on creating GRASS vector layers.
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Criando uma nova camada Shapefile

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_6. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 12.73: Creating a new Shapefile layer Dialog

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Digitalizar uma
camada existente above.

Criando uma nova camada SpatialLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_7.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
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Figure 12.74: Creating a New SpatiaLite layer Dialog
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attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitalizar uma camada existente above.

O tratamento adicional das camadas SpatiaLite pode ser feito com o Gerenciador BD. Veja Complemento Geren-
ciador BD.

Criando uma nova camada GPX

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

Criando uma nova Camada Rascunho Temporária

Empty, editable memory layers can be defined using Layer → Create Layer → New Temporary Scratch Layer.
Here you can even create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon Layers. Temporary Scratch Layers are not saved and will be discarded when QGIS is closed. See also
Paste into new layer.

12.7 Camadas virtuais

A special kind of vector layer allows you to define a layer as the result of an advanced query, using the SQL
language on any number of other vector layers that QGIS is able to open. These layers are called virtual layers:
they do not carry data by themselves and can be seen as views to other layers.

12.7.1 Criando uma camada virtual

Open the virtual layer creation dialog by clicking on Add Virtual Layer in the Layer menu or from the correspond-
ing toolbar.

The dialog allows you to specify an SQL query. The query can use the name (or id) of existing vector layers as
well as field names of these layers.

For example, if you have a layer called regions, you can create a new virtual layer with an SQL query like
SELECT * FROM regions WHERE id < 100. The SQL query will be executed, whatever the underlying
provider of the regions layer is and even if this provider does not directly support SQL queries.

Joins and complex queries can also be created simply by directly using the names of the layers that are to be
joined.

12.7.2 Supported language

The underlying engine uses SQLite and Spatialite to operate.

It means you can use all of the SQL your local installation of SQLite understands.

Functions from SQLite and spatial functions from Spatialite can also be used in a virtual layer query. For in-
stance, creating a point layer out of a attribute-only layer can be done with a query similar to: SELECT id,
MakePoint(x, y, 4326) as geometry FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.
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Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

12.7.3 Performance issues

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

The creation dialog allows to specify different parameters:

• unique identifier column: this option allows to specify which field of the query represents unique inte-
ger values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used.
Specifying a unique identifier column allows to speed up selection of rows by id.

• no geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• geometry column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• geometry type: this option allows to specify the type of the geometry of the virtual layer.

• geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

12.7.4 Special comments

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

The type of a particular column can be specified directly in the query by using some special comments.

The syntax is the following: /*:type*/. It has to be placed just after the name of a column. type can be either
int for integers, real for floating point numbers or text.

For instance: SELECT id+1 as nid /*:int*/ FROM table

The type and coordinate reference system of the geometry column can also be set thanks to special comments
with the following syntax /*:gtype:srid*/ where gtype is the geometry type (point, linestring,
polygon, multipoint, multilinestring or multipolygon) and srid an integer representing the
EPSG code of a coordinate reference system.

12.7.5 Use of indexes

When requesting a layer through a virtual layer, indexes of this source layer will be used in the following ways:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)

• for any other predicates (>, <=, !=, etc.) or on a column without primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.

A specific syntax exists to handle spatial predicates in requests and trigger the use of a spa-
tial index: a hidden column named _search_frame_ exists for each virtual layer. This col-
umn can be compared for equality to a bounding box. Example: select * from vtab where
_search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are greatly sped up when used in conjunction with this spatial
index syntax.
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CHAPTER 13

Trabalhando com Dados Raster

13.1 Trabalhando com dados raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

A partir da data deste documento, mais de 100 formatos raster são suportados pela biblioteca GDAL (ver
GDAL-SOFTWARE-SUITE em Referências Bibliográficas e Web). A lista completa está disponível em
http://www.gdal.org/formats_list.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Trabalhando com dados raster GRASS é descrita na seção Integração com SIG GRASS.

13.1.1 O que são dados raster?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.

Uma vez que uma camada raster é carregada na legenda do mapa, você pode clicar sobre o nome da camada com o
botão direito do mouse para selecionar e ativar feições específicas da camada ou para abrir um diálogo para definir
as propriedades raster para a camada.

Menus do Botão direito do mouse para camadas raster
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• Zoom para extensão da camada

• Zoom para melhor escala (100%)

• Estenda usando a extensão atual

• Mostrar em visão geral

• Remover

• Duplicado

• Definir SRC da camada

• Definir SRC do projeto para camada

• Salvar como ...

• Propriedades

• Renomear

• Copiar Estilo

• Adicionar novo Grupo

• Expandir tudo

• Fechar tudo

• Atualização da ordem do desenho

13.2 Diálogo de propriedades do Raster

Para visualizar e definir as propriedades da camada de um layer, dê um duplo clique no nome da camada na
legenda do mapa, ou clique com botão direito no nome da camada e escolha:Propriedades a partir do menu de
contexto. Isto vai abrir o diálogo :guilabel:‘Propriedades da camada Raster ‘ (ver figura_raster_1).

Existem vários menus na janela de dialogo:

• Geral

• Estilo

• Transparência

• Pirâmides

• Histograma

• Metadados

13.2.1 Menu Geral

Informação da camada

O menu Geral apresenta informação básica do raster selecionado, incluindo o caminho da camada origem, o nome
que aparece na legenda (que pode ser modificado), e o número de colunas, linhas e valores nulos do raster.

Sistema de Referência de Coordenadas

Aqui encontra-se a informação do Sistema de Referencia de Coordenadas (SRC), impressa na linha PROJ.4. Se
esta definição no é a correta, pode-se modificar, clicando no botão [Especifique]
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Figure 13.1: Raster Layers Properties Dialog

Visibilidade dependente da escala

Também nesta aba pode acertar a visibilidade dependente da escala. Será necessária clicar a caixa de checagem e
colocar uma escala apropriada, na qual seus dados serão visualizados na tela do mapa.

Na parte inferior, pode-se ver uma miniatura da camada, a simbologia da legenda e o mapa de cores.

13.2.2 Menu de Estilos

Representar a banda

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Color multibanda - se o arquivo vem como multibanda, com várias bandas (por exemplo, usado para ima-
gens de satélite com várias bandas)

2. Mapa de Cores - se um arquivo de banda única vem com um mapa de cores indexado (por exemplo, usado
para mapas topográficos digitais)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continuous palette (e.g., used with a shaded relief
map)

4. Banda única Falsa Cor - este método de representação é usado em arquivos com mapa de cores contínuos
ou com mapa de cores (por exemplo, para mapa de elevações)

Multibanda Colorida

Para representar em color multibanda, selecione três bandas da imagem que vai representar, cada banda representa
respectivamente, a componente vermelha, verde e azul, que serão usadas para criar a cor da imagem. Podem-se
escolher vários métodos para Melhora do contraste : ‘Sem melhora’, ‘Estique para MinMax’, ‘Estique e corte no
MinMax’ e ‘Corte no min max’.

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
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Figure 13.2: Raster Renderer - Multiband color
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included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Dica: Visualizando uma única banda do Raster Multibanda
Se deseja ver uma única banda de uma imagem multibanda (por exemplo apenas a Vermelha), pode-se colocar
as bandas Verde e Azul como “Não definidas”, mas isto não é a forma correta. Para mostrar apenas a banda
Vermelha, coloque o tipo da imagem como ‘Banda única Cinza’, depois selecione o Vermelho como a banda para
usar no Cinza.

Mapa de Cores

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS it’s
possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Figure 13.3: Raster Renderer - Paletted

Melhora do contraste

Nota: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to stretch
to min max, regardless of if this is set to another value in the QGIS general options.

Banda única cinza
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This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Renderer - Singleband gray

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Singleband pseudocolor

This is a render option for single-band files, including a continuous palette. You can also create individual color
maps for the single bands here. Existem três tipos de interpolação de cores:

1. Método Discreto

2. Método Linear

3. Método Exato

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max values
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Figure 13.5: Raster Renderer - Singleband pseudocolor
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can be done with the help of the Load min/max values section. A lot of images have a few very low and high data.
These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set from
2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image can
disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Representação das cores

Em cada Representação da banda, é possível encontrar uma Representação da cor

Podem-se fazer efeitos especias de representação para seus arquivo(s) raster, usando um dos modos de combinação
(veja Janela de Propriedades de Vetor).

Further settings can be made in modifying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Reamostragem

A opção Reamostragem, faz a representação da imagem quando se dá mais ou menos zoom nela. Os modos
de reamostragem podem melhorar a apariência do mapa. Eles calculam um novo valor de cinza através de uma
transformação geométrica.

Figure 13.6: Raster Rendering - Resampling

Quando aplicamos o método ‘Vizinho mais próximo’, o mapa pode ter uma estrutura tipo pixelada, quando damos
mais zoom. Essa apariència pode ser melhorada usando os métodos ‘Bilinear’ ou ‘Cúbico’., o qual causa que as
feições mais afiadas, se suavizem.

13.2.3 Menu de transparência

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Além disso pode-se colocar um valor de pixel que será considerado como SEMDADOS no menu Valor adicional
sem dados
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Uma maneira ainda mais flexível de modificar a banda de transparência poder ser feita no :guilabel: Modificações
das opções de transparência. Aqui podemos definir a transparência de cada pixel.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are necessary:

1. Carregar o arquivo raster: Arquivo:landcover.tif.

2. Abra o diálogo Propriedades fazendo clique duplo no nome do raster na legenda, o clicando com botão e
selecionando:Propriedades do menu pop-up.

3. Selecione o menu Transparência

4. No menu Transparência da banda, escolher ‘Nenhum’.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Entre o valor raster na coluna ‘De’ e ‘Até’ (usamos 0 aqui), e ajuste a transparência a 20%.

7. Pressione o botão [Aplicar] e visualize no mapa as modificações feitas.

Podemos repetir os passos 5 e 6 para definir mais valores com a transparência desejada.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.2.4 Menu de Pirâmides

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

Você deve pode ter direito de gravação no diretório onde os dados originais são armazenados para construir
pirâmides.

Vários métodos de reamostragem podem ser usados para calcular as piramides.

• Vizinho mais próximo

• Média

• Gauss

• Cúbico

• Modo

• Nenhum

If you choose ‘Internal (if possible)’ from the Overview format menu, QGIS tries to build pyramids internally.
You can also choose ‘External’ and ‘External (Erdas Imagine)’.

Note que o cálculo de pirâmides pode modificar o arquivo original de dados, e uma vez criado, não pode ser
apagado. Se deseja preservar uma versão ‘sem pirâmides’ de seu raster, faça uma copia de segurança antes do
cálculo das pirâmides.

13.2.5 Menu Histograma

The Histogram menu allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram menu. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
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Figure 13.7: The Pyramids Menu

to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

Figure 13.8: Raster Histogram

13.2.6 Menu Metadados

O menu Metadados, mostra o estado da informação da camada do raster, incluindo estatísticas de cada banda
na camada do raster em uso. A partir deste menu, podem ser definidas entradas na guia Descrição, Atribuição,
MetadadosUrl e Propriedades. Na guia:guilabel:Propriedades, são geradas estatísticas na base de ‘é preciso
saber’ ou seja é possível que uma determinada e específica estatística da camada, no tenha sido ainda coletada.
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Figure 13.9: Raster Metadata

13.3 Análise Raster

13.3.1 Calculadora Raster

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_10). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

Examples

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:

"elevation@1" * 3.28

Using a mask

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.
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Figure 13.10: Calculadora Raster
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("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

If you want to classify a raster – say, for instance into two elevation classes, you can use the following expression
to create a raster with two values 1 and 2 in one step.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

13.3.2 Raster Alignment

This tool is able to take several rasters as input and to align them perfectly, that means:

• reproject to the same CRS,

• resample to the same cell size and offset in the grid,

• clip to a region of interest,

• rescale values when required.

All rasters will be saved in another files.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools

need to Rescale values according to the cell size. You can Edit file settings and Remove an existing file from the list.

Then in the main Align raster window, you can choose one or more options:

• Select the Reference Layer,

• Transform into a new CRS,

• Setup a different Cell size,

• Setup a different Grid Offset,

• Clip to Extent,

• Output Size,

• Add aligned raster to the map canvas.
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CHAPTER 14

Trabalhando com dados OGC

14.1 QGIS as OGC Data Client

O Consórcio Geoespacial Aberto (OGC), é uma organização internacional como mais de 300 organizações em
todo mundo do tipo comerciais, sem fins lucrativos e de investigação. Os membros desenvolvem e implementam
padrões para os conteúdos e serviços geoespaciais, processamento e troca de dados SIG.

Descrevendo um modelo básico de dados para elementos geográficos e um número crescente de específicações
estão desenvolvidos para servir necessidades específicas para localização interoperável e tecnologia geoespacial,
incluindo o SIG. Mais informação é encontrada em http://www.opengeospatial.org/.

Important OGC specifications supported by QGIS are:

• WMS — Serviço de Mapas Web (Cliente WMS/WMTS)

• WMTS — Serviço de Mosaicos de Mapa Web (Cliente WMS/WMTS)

• WFS — Serviços de Elementos Web (WFS e WFS-T Cliente)

• WFS-T — Serviços de Elementos Web - Transacionais (WFS e WFS-T Cliente)

• WCS — Serviços de Cobertura Web (WCS Cliente)

• SFS — Elementos Simples para SQL (Camadas PostGIS)

• GML — Linguagem de Marcadores Geográfico

OGC services are increasingly being used to exchange geospatial data between different GIS implementations and
data stores. QGIS can deal with the above specifications as a client, being SFS (through support of the PostgreSQL
/ PostGIS data provider, see section Camadas PostGIS).

14.1.1 Cliente WMS/WMTS

Visão Global do Suporte WMS

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. In particular, it has
been tested against publicly accessible servers such as DEMIS.

A WMS server acts upon requests by the client (e.g., QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS, this format would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a full-blown Web service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
server on the market and they all have their own interpretation of the WMS standard.
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As camadas WMS podem ser adicionadas facilmente, desde que conheça o acesso URL para o servidor WMS,
tenha uma ligação de serviço a esse servidor, e o servidor compreenda HTTP como um mecanismos de transporte
de dados.

Additionally, QGIS will cache your WMS responses (i.e. images) for 24h as long as the GetCapabilities request is
not triggered. The GetCapabilities request is triggered everytime the [Connect] button in the [Add layer(s) from
WMS(T)S Server] dialog is used to retrieve the WMS server capabilities. This is an automatic feature meant to
optimize project loading time. If a project is saved with a WMS layer, the corresponding WMS tiles will be loaded
from the cache the next time the project is opened as long as they are no older than 24H.

Visão Global do Suporte WMTS

QGIS can also act as a WMTS client. WMTS is an OGC standard for distributing tile sets of geospatial data.
This is a faster and more efficient way of distributing data than WMS because with WMTS, the tile sets are pre-
generated, and the client only requests the transmission of the tiles, not their production. A WMS request typically
involves both the generation and transmission of the data. A well-known example of a non-OGC standard for
viewing tiled geospatial data is Google Maps.

De maneira a exibir os dados a várias escalas perto do que o utilizador queira ver, os conjuntos de mosaicos WMTS
são produzidos em vários diferentes níveis de escala e são disponibilizados para o cliente SIG a seu pedido.

Este diagrama ilustra o conceito dos conjuntos de mosaicos

Figure 14.1: Conceito dos conjuntos de mosaicos do WMTS

The two types of WMTS interfaces that QGIS supports are via Key-Value-Pairs (KVP) and RESTful. These two
interfaces are different, and you need to specify them to QGIS differently.

1. In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Um exemplo deste tipo de endereço é

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

A camada topo2 funciona lindamente para testar neste WMTS. Adicionando esta linha e texto indica que é
um serviço web WMTS que deverá ser usado em vez de o serviço WMS.

2. O serviço WMTS RESTful torna-se uma forma diferente, é um URL simples, a forma recomendada pela
OGC é:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml
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This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by
simply adding its address in the WMS setup in the URL field of the form. An example of this type of address
for the case of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Nota: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just add
?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Quando lê o WMTS pode muitas vezes pensar em WMS-C.

Selecionando os Servidores WMS/WMTS

The first time you use the WMS feature in QGIS, there are no servers defined.

Begin by clicking the Add WMS layer button on the toolbar, or selecting Layer → Add WMS Layer....

A janela Adicionar Camada(s) do Servidor para adicionar camadas dos servidores WMS aparecem. Pode
adicionar alguns servidores para brincar clicando no botão [Adicionar servidores padrões] . Isto irá adicionar
dois servidores WMS demonstração para que possa usar, os servidores WMS do DM Solutions Group e
Lizardtech. Para definir uma novo servidor WMS no separador Camadas, selecione o botão [Novo] . De
seguida introduza os parâmetros de ligação que deseja para o Servidor WMS, como está listado na table_OGC_1:

Nome Um nome para esta ligação. Este nome será usado para a lista de Ligações do Servidor para
que possa distingui-la de outros Servidores WMS.

URL URL do servidor que fornece os dados. Isto deverá ser um nome de alojamento válido – o
mesmo formato que irá usar para abrir a ligação telnet ou o ping a um alojamento.

Usuário Nome de Utilizador para aceder a um Servidor WMS protegido. Este parâmetro é opcional.
Senha Senha para autenticação básica no Servidor WMS. Este parâmetro é opcional.

Ignorar
GetMap URI

Ignorar GetMap URI reportado nas capacidades. Use um URI dado em cima para o
campo URL.

Ignorar
GetFeatureInfo
URI

Ignorar GetMap URI reportado nas capacidades, use um URI dado em cima para o
campo URL.

Tabela 1 OGC : Parâmetros de Ligação do WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

Once the new WMS server connection has been created, it will be preserved for future QGIS sessions.

Dica: Ligar URLs dos Servidores WMS
Certifique-se, que quando introduzir o URL do servidor WMS, seja o URL base. Por exemplo, não deve ter
fragmentos como request=GetCapabilities ou version=1.0.0 no seu URL.

Aviso: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

Carregando as camadas WMS/WMTS

Uma vez preenchido os parâmetros com sucesso pode usar o botão [Ligar] para responder às capacidades do
servidor selecionado. Isto inclui a codificação da imagem, Camadas, Estilos de Camadas, e Projeções. Uma vez
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que isto é uma operação de rede, a velocidade de resposta depende da qualidade da ligação da sua rede ao servidor
WMS. Enquanto faz a transferência de dados do servidor WMS, o progresso da transferência é visualizada no
canto inferior esquerdo da janela do WMS.

Sua tela deverá estar parecendo com a figure_OGR_1, que mostra a resposta apresentada pelo servidor WMS do
portal European Soil.

Figure 14.2: Dialog for adding a WMS server, showing its available layers

Codificação da Imagem

A seção Codificação de Imagem agora apresenta uma lista de formatos suportados pelo cliente e servidor. Escolha
de acordo com as exigências de precisão da sua imagem.

Dica: Codificação da Imagem
Tipicamente irá encontrar servidores WMS que oferecem a escolha da codificação de imagem JPEG ou PNG. O
JPEG é um formato de perda de compressão, enquanto que o PNG reprodução fielmente os dados raster brutos.

Use JPEG se espera dados WMS para fotografia na natureza e/ou não se importa da perda de alguma qualidade na
imagem. Este típico trade-off reduz em 5 vezes o requerimento de transferência comparado ao PNG.

Use o PNG se necessitar representações precisas dos dados originais, e não se importa dos requerimentos de
transferência de dados.

Opções

O campo Opções fornece um campo de texto onde pode adicionar Nome da Camada para a camada WMS. Este
nome irá ser apresentado na legenda após carregamento da camada.
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Em baixo do nome da camada pode definir Tamanho do mosaico, se quiser configurar os tamanhos do mosaico
(ex.: 256x256) para dividir o pedido do WMS em pedidos múltiplos.

O Limite de elementos para GetFeatureInfo define quais os elementos do servidor para consulta.

Se selecionou um WMS da lista, um campo com a projeção padrão, fornecida pelo mapserver, aparece. Se o
botão [Change...] está ativo, pode clicar e mudar para a projeção padrão do WMS para outro SRC fornecido pelo
Servidor WMS.

Finalmente você pode ativar Usar Legenda WMS contextual se o servidor WMS suportar essa característica.
Então, somente as legendas relevantes para a extensão visível de seu mapa serão apresentadas e não serão incluídos
itens de legenda para elementos que não podem ser vistos no mapa corrente.

Ordem das Camadas

O separador Ordem de Camada tem uma lista das camadas selecionadas disponíveis do WMS actual ligado.
Poderá reparar que algumas camadas expansíveis, isto significa que a camada pode ser exibida na escolha dos
estilos de imagem.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS server and transmitted to QGIS in one go.

Dica: Ordenação das Camadas WMS
As camadas WMS renderizadas por um servidor são sobrepostas na ordem da lista da seção de Camadas, de cima
para baixo da lista. Se quiser alterar a ordem de sobreposição, pode usar o separador Ordem de camadas.

Transparência

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Dica: Transparência da Camada WMS
Disponibilidade da transparência da imagem do WMS depende da codificação da imagem usada: PNG e GIF
suportam transparência enquanto que o JPEG deixa como não suportado.

Sistema de Referência de Coordenadas

A coordinate reference system (CRS) is the OGC terminology for a QGIS projection.

Cada Camada WMS pode ser apresentada em múltiplos SRC, depedendo da capacidade do servidor WMS.

Para escolher o SRC selecione [Alterar...] e a janela semelhante à da Figura Projeção 3 na Trabalhando com
Projeções aparecerá. A diferença principal com a versão do WMS do ecrã é que neste apenas os SRC suportados
apareceram no Servidor WMS.

Pesquisa de servidor

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Basicamente esta opção é um dianteira para a API do http://geopole.org.
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Figure 14.3: Dialog for searching WMS servers after some keywords

Mosaicos

Ao usar Serviços WMTS (WMS em cache) como

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE) or View → Panels (Gnome, Windows and MacOSX), then choosing Tile Scale
Panel. This gives you the available scales from the tile server with a nice slider docked in.

Usando a Ferramenta Identificar

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Seleção do formato

Se múltiplos formatos são suportados pelo servidor, uma caixa de combinação com os formatos suportados é
automaticamente adicionado aos resultados da janela de identificação e o formato selecionado irá armazenar no
projeto para a camada. Suporte do formato GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.
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# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Propriedades de Visualização

Uma vez ter adicionado o servidor WMS, pode ver as suas propriedades clicando com o direito do mouse na
legenda, e selecionando Propriedades. Separador de Metadados

O separador Metadados exibem a riqueza de informação sobre o servidor WMS, geralmente recolhidos a partir
da declaração de de Capacidades devolvidos a partir desse servidor. Muitas das definições podem ser removidas
através da leitura dos padrões WMS (veja OPEN-GEOSPATIAL-CONSORTIUM Referências Bibliográficas e
Web), mas aqui estão algumas definições úteis:

• Propriedades do Servidor

– Versão do WMS — Versão do WMS suportada pelo servidor.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Propriedades da Camada

– Selecionado — Querendo ou não esta camada selecionado quando o seu servidor foi adicionado a este
projeto.

– Visible — Whether or not this layer is selected as visible in the legend (not yet used in this version of
QGIS).

– Pode Identificar — Camada que retorna ou não resultados através do uso da ferramenta Identificar.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency.

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Contagem em cascata — Os servidores WMS pode funcionar como proxy para outros servidores
WMS para obter dados raster para uma camada. Esta entrada mostra quantas vezes o pedido para esta
camada é avançada por peer nos servidores WMS para o resultado.
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– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– SRC disponíveis — As projeções desta camada podem ser renderizadas pelo servidor WMS. Os
mesmos estão listados num formato nativo WMS.

– Disponível em estilo — Os estilos da imagem desta camada podem ser renderizadas pelo o servidor
WMS.

Mostra a legenda gráfica do WMS na tabela de conteúdos e compositor

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

Se uma legendGraphic está disponível, será mostrada abaixo da camada. É pequena, e você tem que clicar sobre
ela para abrir na dimensão real (devido à limitação arquitetônica QgsLegendInterface). Clicando sobre a legenda
da camada abrirá um quadro com a legenda em resolução máxima.

In the print composer, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend –> WMS LegendGraphic to match your printing
requirements

A legenda irá exibir informações contextuais com base em sua escala atual. A legenda WMS será exibida somente
se o servidor WMS tiver capacidade GetLegendGraphic e a camada getCapability url for especificada, então você
tem que selecionar um estilo.

Limitações do Cliente WMS

Not all possible WMS client functionality had been included in this version of QGIS. Some of the more noteworthy
exceptions follow.

Editando as Configurações da Camada WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

Servidores WMS que Requerem Autenticação

Atualmente o acesso público e serviços WMS protegidos são suportados. Os servidores WMS protegidos podem
ser acedidos pela autenticação pública. Pode adicionar credenciais (opcionais) quando adiciona o servidor WMS.
Veja a seção Selecionando os Servidores WMS/WMTS para detalhes.

Dica: Acedendo a camadas protegidas OGC
Se necessitar de proteger camadas com outros métodos seguros além da autenticação básica, pode usar o InteProxy
como proxy transparente, que suporta vários métodos de suporte. Mais informação pode ser encontrada no manual
InteProxy no sítio na internet http://inteproxy.wald.intevation.org.

Dica: QGIS WMS Mapserver
Since Version 1.7.0, QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this in
chapter QGIS as OGC Data Server.
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14.1.2 WCS Cliente

O Serviço Web de Cobertura (WCS) fornecem acesso aos dados matriciais de forma a serem úteis à render-
ização cliente, como entrada a modelos científicos, e para outros clientes. O WCS pode ser comprado ao WFS e
ao WMS. Como as instâncias WMS e WFS, o WCS permite aos clientes escolher porções de informação salvadas
de servidores baseados condicionantes espaciais e outros critérios de consulta.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

The native WCS provider handles all network requests and uses all standard QGIS network settings (especially
proxy). It is also possible to select cache mode (‘always cache’, ‘prefer cache’, ‘prefer network’, ‘always net-
work’), and the provider also supports selection of time position, if temporal domain is offered by the server.

Aviso: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

14.1.3 WFS e WFS-T Cliente

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features, and
view the attribute table. Since QGIS 1.6, editing WFS-T is also supported.

De uma forma geral adicionar uma camada WFS é muito semelhante ao procedimento usado com o WMS. A
diferença é que não existe servidores padrões definidos, portanto nós teremos de adicionar o nosso.

Carregando uma camada WFS

Como exemplo nós usaremos o servidor WFS DM Solutions e exibiremos uma camada, O URL é:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clique na ferramenta Adicionar Camada WFS na barra de ferramentas Camadas, a janela Adicionar Camada
WFS do Servidor aparecerá.

2. Clique em [Novo].

3. Introduza ‘DM Solutions’ como nome.

4. Introduza o URL (veja em cima).

5. Clique [OK].

6. Choose ‘DM Solutions’ from the Server Connections drop-down list.

7. Clique [Ligar].

8. Espera pela lista de camadas a ser preenchida.

9. Selecione a camada Parques da lista.

10. Clique [Aplicar] para adicionar a camada ao mapa.

Repare que as configurações proxy que definiu nas suas preferências são também reconhecidas.

Aviso: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.
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Figure 14.4: Adding a WFS layer

Apenas o WFS 1.0.0 é suportado. Até este momento não houve muitos testes contra versões WFS implementadas
em outros servidores WFS. Se encontrar problemas com outros servidores WFS, por favor não hesite em contatar
a equipe de desenvolvimento. Por favor dirija-se à Seção Ajuda e Suporte para mais informação sobre as listas de
discussões.

Dica: Encontrando Servidores WFS
You can find additional WFS servers by using Google or your favourite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

14.2 QGIS as OGC Data Server

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. The
original development of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in
Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For user contributed installation instructions on other platforms or distributions, we recommend reading
one of the following URLs:

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://www.itopen.it/qgis-server-python-plugins-ubuntu-setup/
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14.2.1 QGIS Server installation on Debian/Ubuntu

At this point, we will give a short and simple sample installation how-to for a minimal working configuration using
Apache2 on Debian Squeeze (or with negligible variations on Ubuntu 14.04). Many other OSs provide packages
for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

Firstly, add the following debian GIS repository:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --keyserver keyserver.ubuntu.com --recv-key 3FF5FFCAD71472C4
$ sudo gpg --export --armor 3FF5FFCAD71472C4 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS Server:

$ sudo apt-get install qgis-server python-qgis

Installation of a HelloWorld example plugin for testing the servers. You create a directory to hold server plugins.
This will be specified in the virtual host configuration and passed on to the server through an environment variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>
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RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Now enable the virtual host and restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Test the server with the HelloWorld plugin:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCapabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Dica: If you work with a feature that has many nodes then modifying and adding a new feature will fail. In this
case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Creating a WMS/WFS/WCS server from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

Aviso: If you’re using the QGIS project with styling based on SVG files using relative paths then you should
know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file). So, if you
deploy a project on the server and the SVG files are not placed accordingly, the output images may not re-
spect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to the
qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides that points
to the directory containing the SVG files (on Linux/Unix).

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current
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Figure 14.5: Definitions for a QGIS Server WMS/WFS/WCS project
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Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

QGIS supports the following requests for WMS service:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (SLD profile)

• DescribeLayer (SLD profile)

• GetStyles (custom QGIS profile)

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

QGIS supports the following requests for WFS service:

• GetCapabilities

• DescribeFeatureType

• GetFeature

• Transaction
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WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Agora salve a sessão em um arquivos de projeto alaska.qgs. Para fornecer ao projeto como um WMS/WFS,
nós criamos uma nova pasta /usr/lib/cgi-bin/project com privilégios de administrador e adicionamos
o arquivo do projeto alaska.qgs e a cópia do arquivo do qgis_mapserv.fcgi - e é tudo.

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Carregando as
camadas WMS/WMTS, WFS e WFS-T Cliente and WCS Cliente to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS supports the following requests for WCS service:

• GetCapabilities

• DescribeCoverage

• GetCoverage

GetCapabilities Caching

In order to improve response time, QGIS Server caches the responses to the GetCapabilities requests.
When such a request comes, QGIS Server is caching the response and marking the cache valid. At the same time,
it watches if the project file changes. If the project is changed then the cache is marked as invalid and QGIS Server
waits for a new request in order to recreate the cache.

Afinando o seu OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Annotation Tools section in Ferramentas Gerais for instructions on creating annotations.
For annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the
Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of
the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths
(in the General menu of the Project → Project Properties dialog) or to manually modify the path to the SVG
image so that it represents a valid relative path.

14.2.3 Server configuration and supported parameters

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.
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Exemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Nota: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.

Os parâmetros extra suportados pelo pedido WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• Parâmetro DPI : O parâmetro DPI pode ser usado para especificar o pedido de saída da resolução.

Exemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• Parâmetro OPACIDADE: A opacidade pode se definida numa camada ou ao nível do grupo. O intervalo de
valores permitido vai de 0 (totalmente trasnaprente) a 255 (totalmente opaco).

Exemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: (Available in QGIS 1.8 and above). Subsets of layers can be selected with the
FILTER parameter. Syntax is basically the same as for the QGIS subset string. However, there
are some restrictions to avoid SQL injections into databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes)
A space between each word / special character is mandatory. Allowed Keywords and special char-
acters are ‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not
allowed

Exemplo:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: (Available in QGIS 1.8 and above) Vector features can be selected by passing
comma separated lists with feature ids in GetMap and GetPrint.

Exemplo:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...

Extra parameters supported by the WMS GetFeatureInfo request

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.
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GetPrint request

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Exemplo:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.

• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

GetLegendGraphics request

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)
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• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

GetProjectSettings request

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS

DXF Export

It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parâmetros:

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.

• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

Extra parameters supported by the WFS GetFeature request

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.
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• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with the first feature, skipping none.

QGIS Server logging

To log requests sent to the server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that the server has proper permis-
sions for writing to file. File should be created automatically, just send some requests to server. If it’s not
there, check permissions.

• ** QGIS_SERVER_LOG_LEVEL **: Especifique o nível de log desejado. Os valores disponíveis são:

– 0 INFO (log todos os pedidos),

– 1 AVISO,

– 2 CRÍTICO (log apenas erros críticos, adequado para fins de produção).

Exemplo:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Nota:
• Ao usar o módulo Fcgid usar FcgidInitialEnv em vez de SetEnv!

• Server logging is also enabled if executable is compiled in release mode.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server supports:

• short name line edits to layers properties

• WMS data dialog to layer tree group (short name, title, abstract) By right clicking on a layer group and
selecting the Set Group WMS data option you will get:

• short name line edits to project properties- add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method

• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups and project it is used by QGIS Sever as the layer name.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the Service connection file section) you need to
make your *.conf file look like:
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SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

• On Fedora based systems:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v
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Variáveis ambientais

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• ** QGIS_SERVER_LOG_FILE **: Especifique o caminho e o nome do arquivo. Certifique-se de que o
servidor tem permissões adequadas para escrever no arquivo. Arquivo deve ser criado automaticamente,
basta enviar algumas solicitações ao servidor. Se ele não estiver lá, verifique as permissões.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See QGIS Server logging

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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CHAPTER 15

Trabalhando com dados GPS

15.1 Complemento GPS

15.1.1 O que é GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Carregando dados GPS de um arquivo

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• GPS Tools

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Amostra de Dados for more infor-
mation about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Navegue até a pasta qgis_sample_data/gps/, selecione o arquivo GPX
national_monuments.gpx e clique ** [Abrir]. **

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX

213



QGIS User Guide, Versão 2.14

Figure 15.1: The GPS Tools dialog window

file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importando dados GPS

Para importar dados de GPS de um arquivo que não é GPX, você irá usar a ferramenta: guilabel: na caixa de
diálogo Ferramentas GPS. Aqui, você seleciona o arquivo que deseja importar (e o tipo de arquivo), e onde você
deseja armazenar o arquivo GPX convertido e qual o nome da nova camada. Note-se que nem todos os formatos
de dados GPS irá suportar todos os três tipos de recurso, portanto, para muitos formatos você só será capaz de
escolher entre um ou dois tipos.

15.1.5 Descarregando dados de um receptor GPS

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

O tipo de dispositivo que você selecionar no menu do aparelho GPS determina como GPSBabel tenta se comunicar
com o seu dispositivo GPS. Se nenhum dos tipos disponíveis funcionar com o seu dispositivo GPS, você pode criar
um novo tipo (ver seção ref: definindo-novo-dispositivo).

A porta pode ser um nome de arquivo ou algum outro nome que o seu sistema operacional utiliza como referência
para a porta física em seu computador que o dispositivo GPS está conectado. Também pode ser simplesmente
USB, para unidades de GPS habilitados para USB.

• On Linux, this is something like /dev/ttyS0 or /dev/ttyS1.

• No Windows, é “COM1” ou “COM2”.

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.
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Figure 15.2: Ferramenta de download

15.1.6 Carregando dados no receptor GPS

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Definindo novos tipos de dispositivo

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

“% type” será substituído por “-w” se você estiver baixando “Locais”, “-r” para “Rotas” e “-t” para “Trilhas”.
Estas são as opções de comando que o GPSBabel possui para download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

Os comandos indicados nas linhas de ‘Carregar’ são aqueles utilizados para carregar os dados no dispositivo. As
mesmas palavras-chave são utilizadas, porém %in é substituído pelo nome do arquivo GPS que é utilizado e %out
é substituído pelo nome da porta.

Você pode aprender mais sobre GPSBabel e as opções de linha de comando disponíveis em
http://www.gpsbabel.org.

Depois de ter criado um novo tipo de dispositivo, ele aparecerá na lista de dispositivos para baixar e atualizar as
ferramentas.
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15.1.8 Download de pontos/trilhas para GPS

Conforme descrito nas seções anteriores, o QGIS usa GPSBabel para baixar pontos / caminhos diretamente no
projeto. QGIS abre a caixa com um perfil pré-definido para baixar de dispositivos Garmin. Infelizmente há um
bug #6318 que não permite criar outros perfis, por isso o download diretamente no QGIS usando as ferramentas
de GPS está no momento limitado a unidades USB Garmin.

Garmin GPSMAP 60cs

MS Windows

Instalar os drivers USB da Garmin através do link http://www8.garmin.com/support/download_details.jsp?id=591

Ligue o aparelho de GPS, abra e digite “type = serial Garmin” e “port = usb”. Preencha os campos guilabel:
‘Nome da Camada’ e: guilabel: ‘Arquivo de Saída’. Às vezes, parece ter problemas em uma determinada pasta,
use algo como “c:temp” que geralmente funciona.

Ubuntu/Mint GNU/Linux

É necessário em primeiro lugar discutir sobre as permissões do dispositivo, conforme descrito no site:
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Você pode tentar criar um arquivo: ‘/ etc /
udev / rules.d / 51 garmin.rules’ contendo esta regra

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Depois disso, é necessário ter certeza de que o módulo do kernel “garmin_gps” não está carregando.

rmmod garmin_gps

e, em seguida, você pode usar as ferramentas de GPS. Infelizmente, não parece ser um bug#7182 e, geralmente, o
QGIS congela várias vezes antes do bom trabalho de operação.

Registro de dados BTGP-38KM (somente Bluetooth)

MS Windows

O erro já referido não permite fazer o download dos dados a partir do QGIS, por isso é necessário utilizar o
GPSBabel a partir do comando ou usando a sua interface.

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Use o mesmo comando (ou as configurações do GPSBabel GUI) no Windows. No Linux de alguma forma pode
obter uma mensagem

skytraq: Too many read errors on serial port

seria a questão de desligar e ligar o registro de dados novamente.

Registro de dados BlueMax GPS-4044 (BT e USB).

MS Windows

Nota: Precisa instalar os drivers antes de usá-lo no Windows 7. Veja no site do fabricante qual o download
adequado.

Baixando com GPSBabel, ambos com USB e BT retorna sempre um erro.

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1
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Ubuntu/Mint GNU/Linux

Com USB

Depois de ter ligado o cabo e utilizar o comando “dmesg” para a porta que está sendo usada, digite por exemplo
“/dev/ttyACM3”. Então,será usado o GPSBabel para CLI ou GUI.

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Com Bluetooth

Use Blueman como gerenciador de dispositivos para associar o dispositivo e disponibilizá-lo através de uma porta
do sistema executando o GPSBabel.

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

15.2 Rastreio GPS em tempo real

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

Existem quatro telas possíveis nesta janela de monitoramento GPS

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Aviso: Se você quer gravar a sua posição para a tela, você tem que criar uma nova camada vetorial primeiro e
mudar para o estado editável para gravar o seu caminho.

15.2.1 Posição e atributos adicionais

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 Força do sinal GPS

Here, you can see the signal strength of the satellites you are receiving signals from.

15.2.3 Posiçao polar GPS

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Figure 15.3: GPS tracking position and additional attributes

Figure 15.4: GPS tracking signal strength
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Figure 15.5: GPS tracking polar window

15.2.4 Opções GPS

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

Um clique sobre ** [Conectar] ** reinicia a ligação ao receptor GPS.

Você pode ativar |caixa| salvar automaticamente feições adicionadas quando você está em modo de edição. Ou
você pode ativar |caixa| :guilabel:’Adicionar pontos automaticamente‘ para a tela mapa com uma determinada
largura e cor.

Ativando |caixa| Cursor, você pode usar um controle deslizante |barra| para diminuir e aumentar a posição do
cursor na tela.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finalmente, você pode ativar |caixa| Arquivo Log e definir um caminho e um arquivo onde as mensagens de log
sobre o rastreamento GPS serão registradas.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Conectar um GPS com Bluetooth para rasteamento ao vivo

Com QGIS você pode conectar um GPS via Bluetooth para a coleta de dados em campo. Para executar esta tarefa,
você precisa de um dispositivo GPS com Bluetooth e um receptor Bluetooth em seu computador.

Em primeiro lugar você deve deixar seu aparelho de GPS ser reconhecido e emparelhado com o computador.
Ligue o GPS, vá até o ícone Bluetooth na área de notificação e busca de um novo dispositivo.

No lado direito da máscara de Seleção do aparelho certifique-se que todos os dispositivos são selecionados para
que a sua unidade de GPS provavelmente aparecerá entre os disponíveis. Na próxima etapa, um serviço de conexão
serial deve estar disponível, selecione-o e clique no botão [Configurar].

Lembre-se o número da porta COM atribuído à conexão GPS como resultante pelas propriedades Bluetooth.

After the GPS has been recognized, make the pairing for the connection. Usually the authorization code is 0000.
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Figure 15.6: GPS tracking options window
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Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

Se QGIS não pode receber dados do GPS, então você deve reiniciar seu dispositivo GPS, espere 5-10 segundos,
em seguida, tente se conectar novamente. Normalmente este trabalho soluciona. Se você receber um erro de
conexão novamente certifique-se que você não tem outro receptor Bluetooth perto de você, emparelhado com a
mesma unidade GPS.

15.2.6 Utilizando GPSMAP 60cs

MS Windows

Maneira mais fácil de fazer o trabalho é a utilização de um middleware (freeware, não aberto) chamado GPSGate
<http://update.gpsgate.com/install/GpsGateClient.exe> _.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Como para Windows a maneira mais fácil é usar um servidor no meio, neste caso GPSD, assim

sudo apt-get install gpsd

Em seguida, carregar o módulo do kernel garmin_gps

sudo modprobe garmin_gps

E, em seguida, ligue a unidade. Em seguida, verifique com dmesg o dispositivo real que está sendo utilizado bu
da unidade, por exemplo /dev/ttyUSB0. Agora você pode iniciar gpsd

gpsd /dev/ttyUSB0

E, finalmente, conectar-se com a ferramenta de acompanhamento ao vivo do QGIS.

15.2.7 Usando BTGP-38KM datalogger (somente Bluetooth)

Usando GPSD (no Linux) ou GPSGate (no Windows) é fácil.

15.2.8 Usando datalogger BlueMax GPS-4044 (ambos BT e USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

Para USB

O acompanhamento ao vivo funciona tanto com GPSD

gpsd /dev/ttyACM3
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ou sem ela, ligando a ferramenta de acompanhamento ao vivo QGIS diretamente para o dispositivo (por exemplo,
/dev/ttyACM3).

Para Bluetooth

O acompanhamento ao vivo funciona tanto com GPSD

gpsd /dev/rfcomm0

ou sem ela, ligando a ferramenta de acompanhamento ao vivo QGIS diretamente para o dispositivo (por exemplo,
/dev/rfcomm0).
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CHAPTER 16

Sistema de Autenticação

16.1 Authentication System Overview

Figure 16.1: Anatomia do sistema de autenticação

16.1.1 Authentication database

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at:

<user home>\.qgis2\qgis-auth.db

This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.
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Nota: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.

16.1.2 Master password

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 16.2: Input new master password

Nota: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Gerenciando a senha mestre

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 16.3: Redefinindo a senha mestre

If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.
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Figure 16.4: Password prompt after three invalid attempts

16.1.3 Authentication Configurations

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Figure 16.5: Configurations editor

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Authentication Methods).
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Figure 16.6: Adding config from within Configuration editor

Figure 16.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons
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16.1.4 Authentication Methods

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings – > Option and, in the Authentication tab, click the Installed plugins button.

Figure 16.8: Available method plugins list

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Figure 16.9: Basic HTTP authentication configs

Nota: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

16.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password — Opens the master password input dialog, independent of performing any auth db
command. Clear cached master password—Unsets the master password if it has been set via input dialog.
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Figure 16.10: PKI paths authentication configs

Figure 16.11: PKI PKCS#12 file paths authentication configs

Figure 16.12: Stored Identity authentication configs
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Figure 16.13: Utilities menu

Reset master password—Opens a dialog to change the master password (the current password must be
known) and optionally back up the current database.

• Clear cached authentication configurations — Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password - Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations — Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database — Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 16.14: DB erase verification menu

16.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

16.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Security Considerations concerning Python access.
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Figure 16.15: Auth config selector with no autentication

Figure 16.16: Auth config selector with config selected

16.2 Fluxos de trabalho de autenticação de usuário

Figure 16.17: Fluxos de trabalho de usuário genérico

16.2.1 Autenticação HTTP(S)

One of the most common resource connections is via HTTP(S), e.g. web mapping servers, and authentication
method plugins often work for these types of connections. Method plugins have access to the HTTP request
object and can manipulate both the request as well as its headers. This allows for many forms of internet-based
authentication. When connecting via HTTP(S) using the standard username/password authentication method will
attempt HTTP BASIC authentication upon connection.
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Figure 16.18: Configurando uma conexão WMS para um HTTP básico

16.2.2 Autenticação de Base de Dados

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9

16.2.3 PKI authentication

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Nota: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Authorities

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.
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Figure 16.19: Configuring a Postgres SSL-with-PKI connection

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Aviso: Changing the default trust policy may result in problems with secure connections.

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

232 Chapter 16. Sistema de Autenticação



QGIS User Guide, Versão 2.14

Figure 16.20: PKI configuration workflow
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Figure 16.21: Opening the Certificate Manager

Figure 16.22: Authorities editor
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Figure 16.23: Certificate info dialog

Figure 16.24: Saving the trust policy changes

Figure 16.25: Authorities options menu
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Figure 16.26: Import certificates dialog

Nota: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identities

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

16.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.
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Figure 16.27: Identities editor

Figure 16.28: PEM/DER identity import
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Figure 16.29: PKCS#12 identity import

Figure 16.30: Handle bad layers with authentication
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If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

Figure 16.31: Edit bad layer’s authentication config ID

16.2.5 Changing authentication config ID

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid - This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files - If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

Figure 16.32: Changing a layer’s authentication config ID (unlocked yellow text field)
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Aviso: Changing the auth config ID is considered an advanced operation and should only be done with full
knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock the ID’s
text field prior to editing the ID.

16.2.6 QGIS Server support

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Authentication database needs to be available

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Nota: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing

16.2.7 SSL server exceptions

Figure 16.33: SSL server exception

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Aviso: You should not create an SSL server configuration unless you have complete knowledge of the entire
SSL setup between the server and client. Instead, report the issue to the server administrator.

Nota: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.
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You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 16.34: Manually adding configuration

Once an SSL configuration is saved to the database, it can be edited or deleted.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

16.3 Security Considerations

Once the master password is entered, the API is open to access authentication configs in the authentication
database, similar to how Firefox works. However, in the initial implementation, no wall against PyQGIS ac-
cess has been defined. This may lead to issues where a user downloads/installs a malicious PyQGIS plugin or
standalone app that gains access to authentication credentials.

The quick solution for initial release of feature is to just not include most PyQGIS bindings for the authentication
system.
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Figure 16.35: Adding configuration during SSL error

Figure 16.36: Existing SSL configuration
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Figure 16.37: Editing an existing SSL configuration

Another simple, though not robust, fix is to add a combobox in Settings → Options → Authentication (defaults to
“never”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Such an option’s setting would need to be saved in a location non-accessible to Python, e.g. the authentication
database, and encrypted with the master password.

• Another option may be to track which plugins the user has specifically

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

16.3.1 Restrições

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
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ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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CHAPTER 17

Integração com SIG GRASS

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Refer-
ências Bibliográficas e Web). The integration consists of two parts: provider and plugin. The provider allows to
browse, manage and visualize GRASS raster and vector layers. The plugin can be used to create new GRASS
locations and mapsets, change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data
with more than 400 GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and
give some examples of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

17.1 Demo dataset

As an example, we will use the QGIS Alaska dataset (see section Amostra de Dados). It includes
a small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS ‘Alaska’ dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

17.2 Carregando camadas raster e vetorial GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Dica: Carregando dados GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

17.3 Importing data into a GRASS LOCATION via drag and drop

This section gives an example of how to import raster and vector data into a GRASS mapset.

1. In QGIS browser navigate to the mapset you want to import data into.
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2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The imported may take some time for larger layers, you will
see animated icon in front of new layer item until the import finishes.

Where raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS and
the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab in
Opções do GRASS.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

17.4 Managing GRASS data in QGIS browser

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

17.5 Opções do GRASS

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

17.6 Iniciando o complemento GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the toolbar menu when you start the GRASS plugin:

• Open Mapset

• New Mapset

• Close Mapset

• Open GRASS Tools

• Display Current GRASS Region

• GRASS Options

17.7 Opening GRASS mapset

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.
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17.8 Localização e MAPSET GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Referências Bibliográficas e Web). In
order to analyse vector and raster layers with GRASS modules, you generally have to import them into a GRASS
LOCATION. (This is not strictly true – with the GRASS modules r.external and v.external you can
create read-only links to external GDAL/OGR-supported datasets without importing them. This is not the usual
way for beginners to work with GRASS, therefore this functionality will not be described here.)

Figure 17.1: Dados GRASS em LOCATION alaska

17.9 Importando dados para uma localização GRASS

See section Importing data into a GRASS LOCATION via drag and drop to find how data can be easily imported
by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Amostra de Dados).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section Ferramentas GRASS) dialog
appears.

5. Para importar o mapa raster: arquivo: landcover.img, clique no módulo: arquivo:‘ r.in.gdal‘ no: guilabel:
guia módulos em árvore. Este módulo GRASS permite importar arquivos raster GDAL que suporta GRASS:
arquivo: ‘local’. O módulo para: arquivo: aparece r.in.gdal.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.
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7. Como nome de saída raster, definir: arquivo: landcover_grass e clique ** [Rodar] **. Na: guilabel: guia
Saída, você vê o comando GRASS atualmente em execução‘ ‘r.in.gdal -o input=/path/to/landcover.img
output= landcover_grass

8. When it says Successfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. Para importar o arquivo vetorial GML: arquivo lakes.gml, clique no módulo: arquivo:‘ v.in.ogr‘ no: guilabel:
módulos em árvores. Este módulo GRASS permite importar arquivos vetoriais OGR apoiados na GRASS:
arquivo: local. A caixa de diálogo para o arquivo aparece v.in.ogr.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. Como o nome de saída do vetor, defina: arquivo: lakes_grass e clique ** [Ir] **. Você não tem de se
preocupar com as outras opções neste exemplo. No: guilabel: saídat você vê o comando GRASS atualmente
em execução‘ v.in.ogr -o dsn = / path / to / lakes.gml output = lagos _grass‘.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

17.9.1 Criando uma nova Localização GRASS

As an example, here is the sample GRASS LOCATION alaska, which is projected in the Albers Equal Area
projection using feet as units. This sample GRASS LOCATION alaska will be used for all examples and exer-
cises in the following GRASS-related sections. It is useful to download and install the dataset on your computer
(see Amostra de Dados).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section Loading a layer from a file) from the QGIS Alaska
dataset (see Amostra de Dados).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Selecione uma pasta existente do banco de dados GRASS (GISDBASE) :arquivo:‘grassdata‘, ou criar
uma para o novo :arquivo:‘local‘ usando um gerenciador de arquivos em seu computador. Em seguida,
clique [Próximo].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Adicionando
um novo MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_location_2).

6. Digite um nome para o :arquivo‘local‘ – que usa ‘alaska’ - e clique [Próximo].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Trabalhando com Projeções)).

9. Na Filtro, insira 2964 para selecionar a projeção.

10. Clique [Próximo].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Clique [Próximo].

13. Também precisamos definir um: arquivo: ‘CONJUNTO DE MAPAS’ dentro do novo: arquivo: local (isto
é necessário quando criar um novo: arquivo: LOCAL). Você pode nomeá-lo o que quiser - foi utilizado
‘demonstração’. GRASS cria automaticamente um arquivo: CONJUNTO DE MAPAS chamado: arquivo
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‘PERMANENTE’, projetado para armazenar os dados básicos para o projeto, a sua extensão padrão e
coordenar as definições do sistema (ver Neteler & Mitasova 2008 em: ref:‘ literature_and_web‘).

14. Confira o resumo para ter certeza que está correto e clique [Fim].

15. O novo: arquivo ‘LOCALIZAÇÃO’: ‘Alaska’, e dois: arquivos: CONJUNTO DE MAPAS, demonstração
e” permanente ”, são criados. O conjunto de trabalho aberto no momento é ‘demonstração’, como você
definiu.

16. Note que algumas das ferramentas na barra de ferramentas GRASS que foram desativadas estão agora
habilitadas.

Figure 17.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importando dados para uma localização GRASS).
You can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included
in the QGIS ‘Alaska’ dataset Amostra de Dados, and move on to section O modelo de dados vetorial do GRASS.

17.9.2 Adicionando um novo MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

Todos: arquivos: ‘CONJUNTO DE MAPAS’ inclui um arquivo ‘WIND’ que armazena as coordenadas dos
valores e a resolução selecionada (ver Neteler & Mitasova de 2008, em: ref:‘ literatura web‘ e seção: ref:
sec_regiao_grass) .

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Selecione a pasta do banco de dados GRASS (GISDBASE): arquivo grassdata com o arquivo:‘ local‘
‘Alaska’, onde queremos adicionar mais um: arquivo: CONJUNTO DE MAPAS chamado ‘teste’.

4. Clique [Próximo].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and
click [Next].

6. Digite o nome: arquivo: texte para o novo: arquivo:‘ CONJUNTO DE MAPAS‘. Abaixo no assistente, você
verá uma lista existente arquivo: CONJUNTO DE MAPAS e seus proprietários

7. Clique [Próximo], confira o resumo para se certificar de que está tudo correto e clique [Fim].
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17.10 O modelo de dados vetorial do GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.

Além de limites e centróides, um mapa vetor também pode conter pontos e linhas. Todos estes elementos de
geometria podem ser misturados em um vetor e será representado em diferentes ‘camadas’ dentro de um GRASS
vetor. Então, no GRASS, uma camada não é um vetor ou raster, mas um nível dentro de uma camada vetorial. Isso
é importante para distinguir cuidadosamente. (Embora seja possível misturar elementos de geometria, é incomum
e, mesmo no GRASS, utilizado somente em casos especiais, tais como rede de análise vetorial. Normalmente,
você deve preferir armazenar diferentes elementos geométricos em diferentes camadas.)

É possível armazenar várias “camadas” em um conjunto de dados vetoriais. Por exemplo, campos, florestas e
lagos pode ser armazenado em um vetor. Uma floresta adjacente e um lago podem compartilhar o mesmo limite,
mas eles têm tabelas de atributos separados. Também é possível fixar atributos limites. Um exemplo pode ser o
caso em que a fronteira entre um lago e uma floresta é um caminho, para que ele possa ter uma tabela de atributos
diferentes.

A “camada” do recurso é definido pela “camada” dentro do GRASS. ‘Camada’ é o número que define, se houver
mais do que uma camada interior do conjunto de dados (por exemplo, se a geometria for uma floresta ou lago).
Por enquanto, ele pode ser apenas um número. No futuro, o GRASS também apoiará nomes como campos na
interface do usuário.

Attributes can be stored inside the GRASS LOCATION as dBase, SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Atributos em tabelas de base de dados estão ligados a elementos geométricos usando um valor ‘categoria’.

‘Categoria’ (chave, ID) é um número inteiro ligado a geometrias primitivas, e que é usada como ligação a uma
coluna chave na tabela de base de dados.

Dica: Aprendendo um Modelo Vetor GRASS
A melhor maneira de aprender os modelos de vetores GRASS, e as suas capacidades é baixando
um dos muitos tutoriais GRASS onde o modelo de vetor é descrito mais profundamente. Veja
http://grass.osgeo.org/documentation/manuals/ Para mais informações, livros e tutoriais em várias línguas.

17.11 Criando uma nova camada vetorial GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• New Point Layer

• New Line Layer

• New Polygon Layer

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Criando novas camadas Vetoriais).
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17.12 Digitalizando e editando uma camada vetorial GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Aviso: All the changes done during editing are immediately written to vector map and related attribute tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barra de Ferramentas

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Ícone Ferramenta Propósito

Novo Ponto Digitaliza novo ponto

Nova Linha Digitaliza nova linha

Nova Fronteira Digitize new boundary

Novo Centróide Digitaliza novo centróide (etiqueta da área existente)

New Closed Boundary Digitize new closed boundary

GRASS Digitalização de Tabela 1: GRASS Ferramentas de Digitalização

Dica: Digitalizando polígonos no GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.
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Attributes

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Dica: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Field Calculator),
and there are features without category which you don’t want to update (typically boundaries), you can filter them
out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Dica: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’ which has no
meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Dica: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible because the
renderer is based on that column.

Snapping

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Dica: Use layer’s CRS also for canvas when editing.

Limitations

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and Mac OSX only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Dica: GRASS Edita Permissões
Você deve ser o proprietário do GRASS: arquivo: ‘CONJUNTO DE MAPAS’ que deseja editar. É impossível
editar camadas de dados em: arquivo: ‘CONJUNTO DE MAPAS’ que não é seu, mesmo que você tenha permissão
de gravação.

17.13 A ferramenta região GRASS

A região (definição de uma janela de trabalho espacial) no GRASS é importante para trabalhar com camadas.
Análise Vetorial é, por padrão, não se limitando a quaisquer definições de região definida. Mas todos os vetores
recém-criados terá a extensão espacial e a resolução da região GRASS atualmente definido, independentemente
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da sua extensão e da resolução original. A região GRASS atual é armazenado no: arquivo: ‘$ LOCAL / $ mapset
/ WIND’, e define o norte, sul, leste e oeste como limites, o número de colunas e linhas, resolução espacial
horizontal e vertical.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

O módulo GRASS: arquivo: g.região fornece muito mais parâmetros para definir uma medida para a região e
resolução adequados para sua análise. Você pode usar esses parâmetros com as Ferramentas GRASS, descrito na
seção: ref: subseção_grass_ferramentas.

17.14 Ferramentas GRASS

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

Figure 17.3: GRASS Toolbox and Module Tree

17.14.1 Trabalhando com módulos GRASS

O comando GRASS dentro do GRASS Ferramentas fornece acesso a quase todos os módulos (mais de 300) grass
em uma interface de linha de comando. Para oferecer um ambiente de trabalho mais amigável, cerca de 200 dos
módulos GRASS disponíveis e funcionalidades também são fornecidos por gráficos dentro do plugin Ferramentas
GRASS.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.14 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.
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Também é possível personalizar o conteúdo Ferramentas GRASS. Este procedimento é descrito na seção: ref:
sec_customizacao_ferramentas.

Como mostrado na figura_grass_ferramentas_1, você pode olhar para o módulo GRASS apropriado usando o
temática agrupada: guilabel: Módulos em Árvores ou pesquisar: guilabel: ‘Lista de Modelos’.

Clicando em um ícone do módulo gráfico, uma nova aba será adicionada ao diálogo da caixa de ferramentas,
oferecendo três novas sub-abas :guilabel: ‘Opções’, :guilabel:’Saída’ e :guilabel:’Manual’.

Opções

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 17.4: GRASS Toolbox Module Options

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Saída

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

A: guilabel: ‘Manual’ mostra a página de ajuda em HTML do módulo grass. Você pode usá-lo para verificar
outros parâmetros do módulo e sinalizadores ou para obter um conhecimento mais profundo sobre o objetivo do
módulo. No final de cada página do manual, você vê outras ligações a: arquivo: ‘Ajuda’, o arquivo: ‘Temática’ e
do: arquivo: ‘Completo’. Estas ligações fornecem a mesma informação que o módulo: arquivo: g.manual.

Dica: Mostra Resultados Imediatamente
Se você quiser exibir os resultados de cálculo imediatamente em sua tela do mapa, você pode usar o botão “Ver
Saída” na parte inferior da aba módulo.
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Figure 17.5: GRASS Toolbox Module Output

Figure 17.6: GRASS Toolbox Module Manual
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17.14.2 Exemplos de módulos GRASS

Os exemplos seguintes demonstrarão o poder de alguns dos módulos grama.

Criando linhas de contorno

O primeiro exemplo cria um mapa de contorno vetorial de elevação (DEM). Aqui, presume-se que você tem o
Alasca: arquivo: ‘local’ configurado como explicado na seção: ref:‘ sec_import_loc_data

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• Na lista de categorias de ferramentas, clique duas vezes no: menu: ‘Raster -> Gestão de Superfície -> Gerar
linhas de contorno do vetor’.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Trabalhando com
módulos GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Digite no :guilabel: Nome para a saída do vetor mapa o nome ctour_100.

• Clique [Rodar] para iniciar o processo. Aguarde alguns instantes até que a mensagem Terminado com
sucesso apareça na janela de saída. Então, clique [Ver saída] e [fechar].

Como se trata de uma grande região, vai demorar um pouco para exibir. Depois de terminar a renderização,
você pode abrir a janela de propriedades da camada para alterar a cor da linha para que os contornos apareçam
claramente sobre o raster elevação, como em: ref: vector_properties_dialog.

Em seguida, amplie uma pequena área montanhosa no centro do Alasca. Aproxima-se, você vai notar que os
contornos têm cantos afiados. GRASS oferece a ferramenta v.generalize para alterar ligeiramente mapas vetoriais,
mantendo sua forma original. A ferramenta usa diversos algoritmos diferentes, com finalidades diferentes. Alguns
dos algoritmos (ie, Douglas Peuker e redução da Vertex) simplificam a linha removendo alguns dos vértices. O
vetor resultante irá carregar mais rápido. Este processo é útil quando você tem um vetor altamente detalhado, mas
você está criando um mapa muito pequena em escala, de modo que o detalhe é desnecessário.

Dica: A ferramenta simplificar
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

No entanto, o objetivo do exemplo é diferente. As linhas de contorno criado pelo “r.contour” têm ângulos agudos
que devem ser suavizadas. Entre o algoritmo ** v.generalize ** , há Chaiken que faz exatamente isso (também
ranhuras de Hermite). Esteja ciente de que estes algoritmos podem ** adicionar vértices** ao vetor, fazendo-a
carregar ainda mais lentamente.

• Abra o GRASS Ferramentas e clique duas vezes na categoria: menu: ‘Vetor -> Desenvolver mapa -> Geral’,
em seguida, clique no módulo v.generalize para abrir a janela de opções.

• Verifique se o vetor ‘ctour_100’ aparece como Nome do vetor de entrada.

• A partir da lista de algoritmos, escolha Chaiken. Deixe todas as outras opções em padrão, e desça até a
última fila para entrar no campo: guilabel: ‘Nome de saída do vetor mapa’ ‘ctour_100_smooth ‘, e clique
** [Ir] **.

• O processo leva vários minutos. Após o “Finalizado com Sucesso”‘ aparece as janelas de saída, clique **
[Saída] ** e ** [Fechar] **.
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• É possível mudar a cor do vetor para apresentar claramente o fundo matricial e para contrastar com as linhas
de contorno originais. Você notará que as novas linhas de contorno têm cantos mais suaves do que o original,
enquanto permanecer fiel à forma geral de origem.

Figure 17.7: GRASS module v.generalize to smooth a vector map

Dica: Outros usos para r.contour
O processo descrito acima pode ser utilizado em outras situações equivalentes. Se você tem um mapa de dados de
precipitação, por exemplo, então o mesmo método será utilizado para criar um mapa de vetor de linhas (chuvas
constantes).

Criando um efeito de sombreamento 3D

Vários métodos são usados para exibir as camadas de elevação e dar um efeito 3-D para mapas. O uso de curvas
de nível, como mostrado acima, é um método popular, muitas vezes escolhido para produzir mapas topográficos.
Outra forma de apresentar um efeito 3-D é de sombreamento. O efeito Sombra é criado a partir de um DEM
(elevação) que calcula a inclinação e o aspecto de cada célula, em seguida, simula a posição do sol no céu dando
um valor de reflexo para cada célula. Assim, você tem pistas virada para o sol; as encostas viradas longe do sol
(na sombra) são escurecidas.

• Comece este exemplo carregando o ‘raster de elevação gtopo30’. Inicie o GRASS Ferramentas, e sob a
categoria Raster, clique duas vezes para abrir: menu: ‘Análise espacial -> Análise do Terreno’.

• Então, clique r.shaded.relief para abrir o módulo.

• Change the azimuth angle 270 to 315.

• Digite gtopo30_shade para o novo raster sombreado e clique [rodar].

• Quando o processo termina, adicione o raster sombreado ao mapa. Você deve vê-lo exibido em escala de
cinza.

• Para visualizar tanto o sombreamento da colina e as cores do “gtopo30”, mova o mapa sombreado abaixo
“mapa gtopo30” na tabela de conteúdo, em seguida, abra o: menu: ‘Propriedades de’ ‘“GTOPO30”, mude
para o: guilabel: ‘transparência’: e defina seu nível de transparência a cerca de 25%.

Agora você deve ter a elevação gtopo30 com o seu mapa de cores e configuração de transparência apresen-
tada acima o tons de cinza mapa sombreado. Para ver os efeitos visuais do sombreamento, desligue o mapa
gtopo30_shade em seguida, ligue-o novamente.

Usando a linha de comando GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
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do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Figure 17.8: The GRASS shell, r.shaded.relief module

O módulo ** r.shaded.relief ** pode ter um parâmetro “zmult”, que multiplica os valores de elevação em relação
ao XY unidades de coordenadas de modo a que o efeito de sombreamento é ainda a mais usada.

• Coloque o “raster elevação gtopo30”, e depois inicie o GRASS Ferramentas e clique no comando grass. Na
janela de comando, digite: “mapa r.shaded.relief = sombra GTOPO30 = gtopo30_shade2 azimute = 315 =
zmult 3” e pressione ** [Entrar] **.

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• Como explicado acima, mova o raster com o relevo sombreado abaixo da tabela de conteúdo “raster
gtopo30” em seguida, verifique a transparência da “camada gtopo30” colorida. Você deverá ver que o
efeito 3-D se destaca mais fortemente em relação ao primeiro mapa com relevo sombreado.

Estatísticas Raster em um mapa vetor

O próximo exemplo mostra como um módulo GRASS pode agregar dados raster e adicionar colunas de estatísticas
para cada polígono em um mapa vetor.
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Figure 17.9: Displaying shaded relief created with the GRASS module r.shaded.relief

• Novamente usando os dados do Alasca, consulte a: ref: sec_import_loc_data para importar o shapefile
árvores do diretório shapefiles no GRASS.

• Agora, um passo intermediário é necessária: centroides deve ser adicionado ao mapa importando as árvores
para torná-lo num vetor de área de grass completo (incluindo os limites e centróide).

• Na caixa de ferramentas, escolha: menu: ‘Vetor -> Gerenciar recursos, e abra o módulo ** v.centroids **.

• Digite como mapa vetor de saída ‘forest_areas’ e rode o módulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Menu Estilo of the vector section.)

• Em seguida, reabrir o GRASS Ferramentas no: menu: ‘Vetor -> Atualização do Vetor’ para outros mapas.

• Clique no módulo v.rast.stats. Digite “gtopo30” e “forest_areas”.

• Apenas um parâmetro adicional é necessária: Entra no: guilabel: ‘prefixo’ coluna ‘elev’‘ e clique ** [Ir] **.
Esta é uma operação computacionalmente pesada, que será executado por um longo tempo (provavelmente
até duas horas).

• Finalmente, abra o “areas_floresta” na tabela de atributos, e verifique que várias novas colunas foram
adicionadas, incluindo ‘ elev_min‘‘, ‘‘ elev_max‘‘, ‘‘ elev_média‘‘, etc, para cada polígono florestal.

17.14.3 Personalizando a caixa de ferramentas GRASS

Quase todos os módulos de GRASS podem ser adicionados a caixa de ferramentas. Uma interface XML é
fornecido para analisar os arquivos mais simples que configuram a aparência e os parâmetros dos módulos dentro
da caixa de ferramentas.

Um exemplo de arquivo XML para gerar o módulo v.buffer (v.buffer.qgm) se parece com isto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>
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The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 18

QGIS estrutura de processamento

18.1 Introdução

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

Nas seções seguintes, vamos analisar como usar os elementos gráficos deste quadro e tirar o máximo proveito de
cada um deles.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item. (You will see more than four entries. The remaining ones are not used to execute algorithms and will be
explained later in this chapter.)

• A caixa de ferramentas. O elemento principal do GUI, é usado para executar um algoritmo único ou rodar
um processo batch baseado nesse algoritmo.

• O modelador gráfico. Vários algoritmos podem ser combinados graficamente usando o modelador para
definir um fluxo de trabalho, a criação de um único processo que envolve vários subprocessos.

• O gerenciador do histórico. Todas as ações realizadas usando qualquer um dos elementos acima menciona-
dos são armazenados em um arquivo de histórico e pode ser facilmente reproduzida mais tarde usando o
gerenciador do histórico.

• A interface de processamento batch. Esta interface permite que possa executar processos batch e automati-
camente a execução de um único algoritmo num múltiplo conjunto de dados.

Nas seções seguintes, vamos analisar cada um desses elementos em detalhe.

18.2 A caixa de ferramentas

A Caixa de ferramenta é o elemento principal da GUI de processamento, e o que você mais usará provável em
seu trabalho diário. Ele mostra a lista de todos os algoritmos disponíveis agrupados em diferentes blocos, e é o
ponto de acesso para executá-los, seja como um processamento único ou em lote que envolve várias execuções do
mesmo algoritmo em diferentes conjuntos de entradas.

The toolbox contains all the available algorithms, divided into so-called “Providers”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.
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Figure 18.1: Processing Toolbox
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Figure 18.2: Processing Modeler

Figure 18.3: Histórico de Processamento
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Figure 18.4: Batch Processing interface

By default only, providers that do not rely on third-party applications (that is, those that only require QGIS el-
ements to be run) are active. ALgorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

Na parte superior da caixa de ferramentas, você vai encontrar uma caixa de texto. Para reduzir o número de
algoritmos mostrados na caixa de ferramentas e tornar mais fácil de encontrar o que você precisa, você pode
digitar qualquer palavra ou frase na caixa de texto. Observe que, enquanto você digita, o número de algoritmos na
caixa de ferramentas é reduzido para apenas aqueles que contêm o texto que introduziu o nome.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

Para executar um algoritmo, de duplo clique no seu nome na caixa de ferramentas.

18.2.1 O diálogo do algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the ‘Polygon centroids’ algorithm).

This dialog is used to set the input values that the algorithm needs to be executed. It shows a list of input values
and configuration parameters to be set. It of course has a different content, depending on the requirements of the
algorithm to be executed, and is created automatically based on those requirements.

Embora o número e tipo de parâmetros dependerem das características do algoritmo, a estrutura é semelhante para
todos eles. Os parâmetros encontrados na tabela podem ser de um dos seguintes tipos.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.
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Figure 18.5: Processing Toolbox
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Figure 18.6: Processing Toolbox showing search results
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Figure 18.7: Processing Toolbox showing search results
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Figure 18.8: Parameters Dialog

Irá ver um botão por cada selecionador de camada vetorial, como é exibido na figura em baixo.

Figure 18.9: Vector iterator button

Se o algoritmo contém vários deles, você será capaz de alternar apenas um deles. Se o botão que corresponde a um
vetor de entrada é alternado, o algoritmo será executado de forma iterativa em cada uma de suas características,
em vez de apenas uma vez para toda a camada, produzindo o maior número de saídas em vezes do algoritmo ser
executado. Isto permite a automatização do processo quando todas as características de uma camada ter que ser
tratada separadamente.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Uma opção, para escolher de uma lista de seleção de uma lista de opções possíveis.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

• Um intervalo, com valores min e máx para serem introduzidos em duas caixas de texto.

• Uma cadeia de texto, para ser introduzida na caixa de texto.

• Um campo, para escolher a partir de uma tabela de atributos de uma camada vetorial ou uma tabela única
de outro parâmetro.
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Figure 18.10: Number Selector

• Um sistema de coordenadas de referência. Você pode digitar o código EPSG diretamente na caixa de texto,
ou selecione-o na janela de seleção de SRC que aparece quando você clica com o botão do lado direito.

• Uma medida, a ser celebrada por quatro números que representam os seus limites xmin, xmax, ymin,
ymax. Clicando no botão no lado direito do seletor de valor, um menu pop-up será exibido, dando-lhe
duas opções: para selecionar o valor de uma camada ou a extensão da tela atual, ou defini-la arrastando
diretamente na mapa de lona.

Figure 18.11: Extent selector

Se selecione a primeira opção, irá ver uma janela igual a próxima.

Figure 18.12: Extent List

Se selecionar o segundo, os parâmetros da janela irão esconder-se, para que possa clicar e arrastar para o
enquadramento. Uma vez definido o retângulo selecionado, o diálogo irá reaparecer, contendo os valores
na caixa de texto da extensão.

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.
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Figure 18.13: Extent Drag

Figure 18.14: Multiple Selection

270 Chapter 18. QGIS estrutura de processamento



QGIS User Guide, Versão 2.14

• Uma pequena tabela para ser editada pelo utilizador. Estes são usados para definir os parâmetros como
tabelas lookup ou kernels de convolução, entre outros.

Clique no botão do lado direito para ver a tabela e editar os seus valores.

Figure 18.15: Fixed Table

Dependendo do algoritmo, o número de linhas pode ser modificado ou não, utilizando os botões do lado
direito da janela.

Along with the parameters tab, you will find another tab named ‘Log’. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.

On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

Uma nota nas projeções

Algorithms that are run from the processing framework — this is also true of most of the external applications
whose algorithms are exposed through it— do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Note that, due to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match,
that might not be true if their original coordinates are used without reprojecting them onto a common coordinate
system. That reprojection should be done manually, and then the resulting files should be used as input to the
algorithm. Also, note that the reprojection process can be performed with the algorithms that are available in the
processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

Se você tentar executar um algoritmo utilizando como entrada duas ou mais camadas com sem correspondência
de SRC, um diálogo de aviso será exibido.
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Pode continuar a executar o algoritmo, mas tenha atenção que na maioria dos casos irá produzir resultados errados,
tais como, camadas vazias devido à falta de sobreposição das camadas usadas como arquivos de entrada.

18.2.2 Objetos de dados gerados por algoritmos

Objetos de dados gerado por um algoritmo podem ser dos seguintes tipos:

• Uma camada raster

• Uma camada vetorial

• Uma tabela

• Um arquivo HTML (usado para arquivo de saída de texto e gráficos)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Processing
menu), and in the General group, you will find a parameter named Output folder. This output folder is used as the
default path in case you type just a filename with no path (i.e., myfile.shp) when executing an algorithm.

Ao executar um algoritmo que usa uma camada de vetor no modo interativo, o caminho do arquivo digitado é
utilizado como o caminho de base para todos os arquivos gerados, que são nomeados com o nome de base e
acrescentando-se um número que representa o índice da iteração. A extensão do arquivo (e formato) é usado para
todos esses arquivos gerados.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Para todos os outros tipos de saída, você encontrará uma caixa de verificação que você pode usar para dizer o
algoritmo para saber se carregará o arquivo, uma vez que é gerado pelo algoritmo ou não. Por padrão, todos os
arquivos são abertos.
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Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

18.2.3 Configurando a infraestrutura do processamento

Como foi mencionado, o menu de configuração dá acesso a um novo diálogo onde pode configurar a forma
como o algoritmo trabalha. Os parâmetros de configuração são estruturados em blocos separados que podem ser
seleccionados no lado esquerdo do diálogo.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas,
it will be rendered with that style.

Os estilos de renderização podem ser configurados individualmente para cada algoritmo e cada um para os seus
arquivos de saída. Apenas clique com o direito do mouse no nome do algoritmo na caixa de ferramentas e selecione
Editar estilos de renderização. Irá ver um diálogo como o que é exibido a seguir.

Figure 18.16: Rendering Styles

Selecione o arquivo de estilo (.qml) que quer para cada arquivo de saída e pressione [OK].

Os outros parâmetros de configuração no grupo Geral estão em baixo referidos:

• Use nome da camada como nome do arquivo. O nome de cada camada resultante criada por um algoritmo
é definido pelo próprio algoritmo. Em alguns casos, um nome fixo pode ser utilizado, o que significa que
o mesmo nome de saída vai ser usado, não importa qual a camada de entrada é usada. Em outros casos,
o nome pode depender do nome da camada de entrada ou de alguns dos parâmetros usados para executar
o algoritmo. Se esta opção for assinalada, o nome será retirado o nome do arquivo de saída em seu lugar.
Observe que, se a saída é salvo em um arquivo temporário, o nome deste arquivo temporário é geralmente
uma longo e sem sentido que se destina a evitar a conflito com outros nomes de arquivos já existentes.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option
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• Use somente recursos selecionados. Se essa opção for selecionada, sempre que uma camada de vetor é
usada como entrada para um algoritmo, apenas suas feições selecionadas serão usadas. Se a camada não
tiver feições selecionadas, todas as feições serão utilizadas.

• arquivo de pré-execução do script e arquivo de script pós-execução. Estes parâmetros se referem aos scripts
escritos usando a funcionalidade de script de processamento e são explicados na seção cobertura scripting e
do terminal.

Além de o bloco Geral na caixa de diálogo de configurações, você também vai encontrar um bloco para prove-
dores de algoritmo. Cada entrada neste bloco contém um ítem Ativar que você pode usar para fazer algoritmos
aparecer ou não na caixa de ferramentas. Além disso, alguns provedores de algoritmo têm seus próprios itens de
configuração, que explicaremos mais tarde, quando cobrindo determinados provedores de algoritmo.

18.3 O modelador gráfico

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead. Us-
ing the graphical modeler, that chain of processes can be wrapped into a single process, so it is as more convenient
to execute as a single process later on a different set of inputs. No matter how many steps and different algorithms
it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger models.

O modelador pode ser aberto a partir do menu processamento.

O modelador tem uma área de trabalho onde a estrutura do modelo e o sue fluxo de trabalho são representados
como está exibido. Na parte esquerda da janela, um painel com dois separadores podem ser usados para adicionar
novos elementos ao modelo.

Figure 18.17: Modeler

A criação de um modelo envolve dois passos:

274 Chapter 18. QGIS estrutura de processamento



QGIS User Guide, Versão 2.14

1. Definição dos dados de entrada necessários. Estes dados de entrada serão adicionados na janela de parâmet-
ros, para que o utilizador possa configurar os seus valores quando executa o modelo. O modelo por si é um
algoritmo, portanto os parâmetros da janela é gerado automaticamente como acontece em todos os algorit-
mos disponíveis na infraestrutura de processamento.

2. Definição do fluxo de trabalho. Usando os dados de entrada do modelo, o fluxo de trabalho é definido
adicionando algoritmos e selecionando como vão usar esses arquivos de entrada ou de saída gerados por
outros algoritmos que já existem no modelo

18.3.1 Definição das entradas

O primeiro passo para criar um modelo é definir as entradas que necessita. Os seguintes elementos são encontrados
no separador Entradas no lado esquerdo da janela do modelador:

• Camada raster

• Camada vetorial

• Cadeia de texto

• Campo da tabela

• Tabela

• Extensão

• Número

• Booleano

• Arquivo

Faça duplo clique em qualquer um, e será exibido um diálogo para definir as suas características. Dependendo do
parâmetro, o diálogo irá conter apenas um elemento básico (a descrição, que será o que o usuário irá ver quando
executar o modelo) ou outros. Por exemplo, quando quer adicionar um valor numérico, como aparece na próxima
figura, além da descrição do parâmetro tem um conjunto de valor por defeito e um intervalo de valores válidos.

Figure 18.18: Model Parameters

Para cada entrada adicionada, um novo elemento é adicionado ao enquadramento do modelador.
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Figure 18.19: Model Parameters

Pode também adicionar arquivos de entrada arrastando o tipo de entrada a partir de uma lista e largar no enquadra-
mento do modelador, na posição onde quer que fique.

18.3.2 Definição do fluxo de trabalho

Uma vez as entradas definidas, é tempo de definir os algoritmos que vamos aplicar. Os algoritmos podem ser
encontrados no separador Algoritmos, agrupados na mesma forma que estão na caixa de ferramentas.

Figure 18.20: Model Parameters

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm.

Como pode ver, existem algumas diferenças. Em vez da caixa de saída do arquivo ser usada para configurar o
caminho do arquivo para as camadas e tabelas de saída, é usado apenas uma caixa de texto simples. Se a camada
gerada pelo algoritmo é apenas um resultado temporário, este será usado como o arquivo de entrada de outro
algoritmo e não será mantido como resultado final, mas não edite essa caixa de texto. Introduzindo alguma coisa
nela, significa que o resultado é final, e o texto que forneceu será a descrição para o arquivo de saída, que será
aquele que o usuário irá ver quando executar o modelo.

A seleção do valor para cada parâmetro é também um pouco diferente, uma vez que existem diferenças importantes
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Figure 18.21: Model Parameters

entre o contexto do modelador e a caixa de ferramentas. Vamos ver como é introduzido os valores para cada tipo
de parâmetro.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Valores numéricos. Valores literais podem ser introduzidos diretamente na caixa de texto. Mas esta caixa de
texto é também uma lista que pode ser usada para selecionar qualquer valor numérico de entrada do modelo.
Nesse caso, o parâmetro irá tomar o valor introduzido pelo utilizador quando executado o modelo.

• Cadeia de texto. Como no caso dos valores numéricos, as cadeias de texto podem ser introduzidas, ou uma
cadeia de texto de entrada pode ser selecionada.

• Campo da Tabela. Os campos de uma tabela origem ou camada não podem ser conhecidas na altura do
seu desenho, uma vez que dependem da seleção do usuário cada vez que o modelo é executado. Para
definir o valor para este parâmetro, introduza o nome do campo diretamente na caixa de texto, ou usa a lista
para selecionar a entrada do campo de tabela que já está adicionada no modelo. A validade de um campo
selecionado irá ser verificado no seu processo de execução.

Em todos os casos, irá encontrar um parâmetro adicional denominado de Algoritmos Parentes que não está
disponível quando é chamado o algoritmo a partir da caixa de ferramentas. Este parâmetro permite que possa
definir a ordem de como os algoritmos são executados, definindo explicitamente um algoritmo como parente do
atual, que irá força-lo a executá-lo antes.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes a SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Uma vez todos os parâmetros estiver relacionados a valores válidos, clique no botão [OK] e o algoritmo irá ser
adicionado ao enquadramento. Será ligado a todos os outros elementos do enquadramento, sejam eles algoritmos
ou arquivos de entrada, o que irá fornecer objetos que foram usados como arquivos de entrada para esse algoritmo.

Os elementos podem ser arrastados para diferentes posições dentro do enquadramento, para alterar a forma como
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é exibida a estrutura do módulo e tornar mais claro e intuitivo. As ligações entre os elementos são atualizadas
automaticamente. Pode ampliar ou afastar usando a roda do mouse.

You can run your algorithm any time by clicking on the [Run] button. However, in order to use the algorithm
from the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

18.3.3 Salvando e carregando os modelos

Use o botão [Salvar] para salvar o modelo atual e o [Abrir] para abrir qualquer modelo anteriormente salvo. Os
modelos são salvos com a extensão .model. Se o modelo for previamente salvo da janela do modelador, não lhe
irá ser solicitado por um nome de arquivo, uma vez que já existe um arquivo associado ao modelo, e será usado.

Antes de salvar o modelo, necessita de introduzir o nome e o grupo do modelo, usando as caixas de texto para
parte superior da janela.

Os modelos salvos na pasta modelos (a pasta padrão quando é pedido o nome do arquivo para salvar o modelo)
irá aparecer na caixa de ferramentas na ligação correspondente. Quando a caixa de ferramentas é chamada, ele
procura na pasta modelos por arquivos com a extensão .model e carrega os modelos salvos. Uma vez que o
modelo é um próprio algoritmo, este pode ser adicionado na caixa de ferramentas como qualquer outro algoritmo.

The models folder can be set from the Processing configuration dialog, under the Modeler group.

Os modelos carregados a partir da pasta modelos aparecem na caixa de ferramentas, mas também na árvore de
algoritmos do separador Algoritmos da janela do modelador. Isto significa que pode incorporar o modelo como
parte de um modelo maior, tal como adiciona qualquer outro algoritmo.

18.3.4 Editando um modelo

Pode editar o modelo que criou, redefinindo o fluxo de trabalho e as relações entre os algoritmos e os dados de
entrada que defeniu no modelo.

Se clicar com o direito do mouse num algoritmo na área que representa o modelo, irá ver o menu contexto como
é mostrado a seguir:

Figure 18.22: Modeler Right Click

Selecionando a opção Remover irá fazer com que o algoritmo seja removido. Um algoritmo só pode ser removido
apenas se existir outros algoritmos dependentes dele. Isto é, se não estiver sendo usado num arquivo de saída de
um algoritmo usado como arquivo de entrada diferente. Se tentar remover um algoritmo que tenha outros que
dependam dele, uma mensagem de aviso igual à que vê aqui em baixo:

Figure 18.23: Cannot Delete Algorithm

Selecting the Edit option will show the parameters dialog of the algorithm, so you can change the inputs and
parameter values. Not all input elements available in the model will appear in this case as available inputs. Layers
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or values generated at a more advanced step in the workflow defined by the model will not be available if they
cause circular dependencies.

Selecione novos valores e de seguida clique no botão [OK] como comum. As ligações entre os elementos do
modelo irão alterar de acordo com o enquadramento do modelador.

A model can be run partially, by deactivating some of its algorithms. To do it, select the Deactivate option in the
context menu that appears when right-clicking on an algorithm element. The selected algorithm, and all the ones
in the model that depend on it will be displayed in grey and will not be executed as part of the model.

Figure 18.24: Model With Deactivated Algorithms

When right-clicking on an algorithm that is not active, you will instead see a Activate menu option that you can
use to activate it back.

18.3.5 Editando os arquivos de ajuda do modelo e a meta-informação

Pode documentar os seus modelos a partir do próprio modelador. Basta apenas clicar no botão [Editar ajuda do
modelo] e o diálogo como aquele que irá aparecer.

Figure 18.25: Help Edition

No lado direito irá ver uma página simples HTML, criada usando a descrição dos parâmetros de entrada e de saída
do algoritmo, juntamente com itens adicionais como uma descrição geral do modelo ou o seu autor. A primeira
vez que abre o editor da ajuda, todas as ajudas estão vazias, mas pode editá-los usando os elementos do lado
esquerdo do diálogo. Selecione um elemento na parte superior e escreva a descrição na caixa de texto em baixo.

Model help is saved as part of the model itself.
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18.3.6 Exporting a model as a Python script

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new
Processing algorithms can be created as well using Python. A quick way of creating such a Python script is to
create a model and then to export is as a Python file.

To do so, click on the Export as Python script button. Select the output file in the file chooser dialog, and
Processing will write in it the Python commands that perform the same operations defined in the current model.

18.3.7 Sobre os algoritmos disponíveis

Poderá notar que alguns algoritmos podem ser executados a partir da caixa de ferramentas mas não aparecem na
lista de algoritmos disponíveis quando está a desenhar o modelo. Para ser incluído no modelo, o algoritmo deve
ter uma semântica correta, assim como ligações apropriadas a outros fluxos de trabalho. Se um algoritmo não tiver
uma boa semântica bem definida (por exemplo, se o número de camadas de saída não são conhecidas), portanto
não é possível usá-lo dentro do modelo, e não aparece na lista na janela do diálogo do modelador.

Adicionalmente, irá ver algoritmos no modelador que não se encontram na caixa de ferramentas. Esses algoritmos
são para ser usados exclusivamente como parte do modelo, e eles não têm interesse em outro contexto diferente.
O algoritmo ‘Calculadora’ é um exemplo disso. É apenas uma simples calculadora aritmética que pode usar
para modificar valores numéricos (introduzidos pelo utilizador ou gerados por outro tipo de algoritmo). Estas
ferramentas são realmente úteis dentro do modelo, mas fora do contexto, não fazem sentido.

18.4 A interface de processamento em lote

18.4.1 Introdução

Todos os algoritmos (incluindo modelos) podem ser executados como um processo descontínuo. Isto é, eles podem
ser executados não utilizando apenas um único conjunto de entradas, mas alguns delas, a execução do algoritmo
tantas vezes quanto necessário. Isto é útil quando se processa grandes quantidades de dados, uma vez que não será
necessário iniciar o algoritmo várias vezes na caixa de ferramentas.

Para executar um algoritmo como um processamento em lote, clique com o direito do mouse na caixa de ferra-
mentas e selecione a opção Executar como processamento em lote no balão de opções que irá aparecer.

Figure 18.26: Batch Processing Right Click

If you have the execution dialog of the algorithm open, you can also start the batch processing interface from
there, clicking on the Run as batch process... button.

18.4.2 Os parâmetros da tabela

A execução de um processamento em lote é semelhante à execução única de um algoritmo. Os valores do
parâmetro têm de ser definidos, mas neste caso nós necessitamos um conjunto de parâmetros, uma para cada
vez que o algoritmo é executado. Os valores são introduzidos usando uma tabela como é mostrada a seguir.

Cada linha desta tabela representa uma única execução do algoritmo, e cada célula contém o valor de um dos
parâmetros. É semelhante aos parâmetros do diálogo que vê quando executa o algoritmo a partir da caixa de
ferramentas, mas com uma diferente disposição.

Por defeito, a tabela contém apenas duas linhas. Pode adicionar ou remover linhas usando os botões na parte
inferior da janela.
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Figure 18.27: Batch Processing From Algorithm Dialog

Figure 18.28: Batch Processing

18.4. A interface de processamento em lote 281



QGIS User Guide, Versão 2.14

Uma vez que o tamanho da tabela for configurado, terá de ser preenchido com os valores desejados.

18.4.3 Preenchendo os parâmetros da tabela

Para a maioria dos parâmetros, a configuração do valor é trivial. Basta digitar o valor ou selecioná-lo na lista de
opções disponíveis, dependendo do tipo de parâmetro.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Layer identifiers can be directly typed in the parameter text box. You can enter the full path to a file or the name of
a layer that is currently loaded in the current QGIS project. The name of the layer will be automatically resolved
to its source path. Notice that, if several layers have the same name, this might cause unexpected results due to
ambiguity.

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving
to a temporary file or database is not permitted. You can type the name directly or use the file chooser dialog that
appears when clicking on the accompanying button.

Um vez selecionado o arquivo, um novo diálogo será exibido para permitir que faça o auto-preenchimento das
outras células na mesma coluna (o mesmo parâmetro).

Figure 18.29: Salvar Processamento em Lote

Se o valor padrão (‘Não efetuar auto-preenchimento’) é selecionado, irá apenas por o nome do arquivo selecionado
na célula selecionada da tabela de parâmetros. Se alguma das outras opções estiver selecionada, todas as células
abaixo da selecionada irão automaticamente ser preenchidas baseando-se no critério definido. Desta forma, é mais
fácil preencher a tabela, e o processamento em lote pode ser definido com menor esforço.

O preenchimento automático pode ser feito simplesmente adicionando números relativos ao caminho do arquivo
selecionado, ou acrescentando o valor de outro campo na mesma linha. Isto é particularmente útil para nomear
objetos de dados de saída de acordo com os de entrada.

Figure 18.30: Batch Processing File Path
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18.4.4 Executando o processo em lote

Após a introdução de todos os valores necessários pode executar o processamento em lote, apenas clicando em
[OK]. O progresso global da tarefa de processamento será exibido na barra de progresso na parte inferior do
diálogo.

18.5 Usando os algoritmos do processamento a partir do Terminal
Python.

O terminal permite que usuários avançados aumente sua produtividade e execute operações complexas que não
podem ser utilizados através dos outros elementos GUI da caixa de processamento. Modelos envolvendo vários
algoritmos podem ser definidos usando a interface de linha de comando e operações adicionais como loops e
sentenças condicionais podem ser adicionados para criar fluxos de trabalho mais flexíveis e poderosos.

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

O código que pode executar a partir do Terminal Python, mesmo quando não chama nenhum método específico
do processamento, pode ser convertido num novo algoritmo que pode mais tarde chamar da caixa de ferramentas,
o modelador gráfico ou qualquer outro componente, como faz para outro algoritmo. De fato, alguns algoritmos
que encontra na caixa de ferramentas são scripts simples.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

18.5.1 Chamando os algoritmos a partir do Terminal Python

A primeira coisa que tem de fazer é importar as funções do processamento com a seguinte linha:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the alglist()
method. Type the following line in your console:

>>> processing.alglist()

Irá ver algo como isto.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
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B-Spline Approximation------------------------>saga:b-splineapproximation
...

Esta é a lista de todos os algoritmos disponíveis, ordenados alfabeticamente, juntamente com os seus nomes da
linha de comandos correspondentes.

É possível usar uma cadeia de texto como parâmetro para este método. Em vez de retornar a lista completa de
algoritmo , ele só irá exibir aqueles que incluem esta cadeia. Se, por exemplo, está procurando um algoritmo para
calcular a inclinação de um MDE, digite alglist("slope") para obter o seguinte resultado:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Este resultado pode mudar dependendo dos algoritmos que estão disponíveis.

Assim é mais fácil encontrar o algoritmo que procura e o seu nome da linha de comandos, neste caso
saga:slopeaspectcurvature.

Uma vez conhecido o nome da linha de comandos do algoritmo, a próxima coisa a fazer é determinar a sintaxe
correta para executá-lo. Isto significa saber quais os parâmetros necessários e a ordem que devem passar quando
chamado pelo método runalg(). Existe um método para descrever um algoritmo em detalhe, o qual pode ser
usado para obter uma lista de parâmetros que requer uns algoritmos e os arquivos de saída que irão gerar. Para
fazer isso, pode usar o método alghelp(name_of_the_algorithm). Use o nome do algoritmo na linha
de comando, não o nome descritivo completo.

Chamado o método saga:slopeaspectcurvature como parâmetro, você terá a seguinte descrição.

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Agora tem tudo o que necessita para correr qualquer algoritmo. Como já tínhamos mencionado, existe apenas um
comando para executar algoritmos: runalg(). A sua síntaxe é como está descrito a seguir:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

A lista de parâmetros e arquivos de saída para adicionar dependem do algoritmo que quer correr, e é exatamente a
lista que o método alghelp() lhe dá, na mesma ordem que é exibido.

Dependendo do tipo de parâmetro, os valores são introduzidos diferentemente. A próxima explicação é uma rápida
revisão de como introduzir valores para cada tipo de parâmetro de entrada:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Seleção. Se algum algoritmo tiver um parâmetro de seleção, o valor desse parâmetro deve ser introduzido
usando um valor inteiro. Para saber as opções disponíveis, pode usar o comando algoptions(), como é
exibido no seguinte exemplo:
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>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

Neste caso, o algoritmo tem um dos referidos parâmetros com 7 opções e sua ordenação é iniciada em zero.

• Múltiplas entradas. O valor é uma cadeia de texto com descritores de entrada separados por ponto e vírgula
(;). Como no caso das camadas ou tabelas únicas, cada descritor de entrada pode ser o nome do objeto ou
o caminho do arquivo.

• Campo da Tabela de XXX. Use uma cadeia de texto com o nome do campo a usar. O parâmetro é caso
sensitivo.

• Tabela Fixa. Digite a lista de todos os valores da tabela separadas por vírgulas (,) e feche entre aspas (").
Os valores começam na linha superior e vai da esquerda para a direita. Pode também usar uma matriz 2D
de valores que representam a tabela.

• SRC. Introduza o número do código EPSG do SRC desejado.

• Extensão. Deve usar uma cadeia de texto com xmin, xmax, ymin e ymax valores separados por vírgulas
(,).

Os parâmetros booleanos, de arquivo, cadeia de texto e numéricos não necessitam de explicações adicionais.

Os parâmetros de entrada, como textos, booleanos, ou valores numéricos têm valores padrão. Para usá-los, es-
pecificar None na entrada do parâmetro correspondente.

Para objetos de saída de dados, digite o caminho de arquivo a ser utilizado para salvá-lo, como é feito a partir
da caixa de ferramentas. Caso queira salvar o resultado em um arquivo temporário, use None. A extensão do
arquivo determina o formato do arquivo. Se você digitar uma extensão de arquivo não suportada pelo algoritmo,
será utilizado o formato de arquivo padrão para esse tipo de saída e a sua extensão correspondente anexado ao
conjunto de arquivos de dados.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

O método runalg retorna um dicionário com os nomes de saída (os que são exibidos na descrição do algoritmo)
como chaves ou caminhos de arquivo dessas saídas como valores. Pode carregar essas camadas passando o seu
caminho de arquivo correspondente pelo método load().

18.5.2 Funções adicionais para a manipulação dos dados

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Layers List

• values(layer,fields): Retorna os valores da tabela de atributos de uma camada vetorial para os
campos validados. Os campos podem ser validados como nomes de campos ou índices de campo iniciados
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em zero. Retorna um dicionário de listas com campos de identificadores validados como chaves. Considera
a seleção existente.

• features(layer): Retorna um iterador sobre as feições de uma camada vetorial, considerando a se-
leção existente.

• UniqueValues (layer, field): Retorna uma lista de valores exclusivos para um determinado
atributo. Os atributos podem ser passado como um nome de campo ou um índice de campo baseado em
zero. Ele considera a seleção existente.

18.5.3 Criando scripts e correndo-os a partir da caixa de ferramentas

Pode criar os seus próprios algoritmos através da escrita do código Python correspondente e adicionar algumas lin-
has extras para fornecer informação adicional necessária para definir as semânticas do algoritmo. Pode encontrar
um Criar novo script menu sob o :guilabel: Tools no grupo Script bloco de algoritmos da caixa de ferramentas.
Faça duplo clique nele e irá abrir um diálogo de edição do script. É onde deverá digitar o código. Guarde o
script na pasta scripts (a pasta padrão quando abre o diálogo de guardar ficheiro), com a extensão .py, irá
automaticamente criar o algoritmo correspondente.

O nome do algoritmo (aquele que irá ver na caixa de ferramentas) é criado a partir do nome do arquivo, removendo
a extensão e substituindo os hífens inferiores com espaços em branco.

Vamos ter o seguinte código, que calcula o Índice Topográfico de Umidade (ITW) diretamente do MDE.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Como pode ver, o cálculo envolve 3 algoritmos, todos eles provêem do SAGA. O último deles calcula o ITW, mas
necessita da camada de dados do declive e outra de acumulação de escoamento. Nós não temos estas camadas,
mas uma vez que temos o MDE, podemos calculá-los chamando os algoritmos SAGA correspondentes.

A parte do código onde este processamento tem lugar não é difícil de perceber se leu-o as seções anteriores deste
capítulo. Contudo, as primeiras linhas, necessitam de uma explicação adicional. Eles fornecem a informação que
é necessária para tornar o código num algoritmo que possa ser corrido a partir qualquer componente do GUI, como
por exemplo a caixa de ferramentas ou o modelador gráfico.

Estas linhas começam com o símbolo de duplo comentário Python (##) e tem a seguinte estrutura:

[parameter_name]=[parameter_type] [optional_values]

Aqui está uma lista de todos os tipos de parâmetros que são suportados nos scripts de processamento, sua sintaxe
e alguns exemplos.

• raster. Uma camada raster.

• vector. Uma camada vetorial.

• table. Uma tabela.

• number. Um valor numérico. Um valor padrão deve ser fornecido. Por exemplo, depth=number 2.4

• string. Um campo de texto. Como no caso de valores numéricos, um valor por padrão deve ser adi-
cionado. Por exemplo, name=string Victor

• boolean. Um valor booleano. Adicione True ou False depois de definir o valor padrão. Por exemplo,
verbose=boolean True

• múltiplos raster. Um conjunto de camadas rasters de entrada.

• vetores múltiplos. Um conjunto de camadas vetoriais de entrada.
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• campo. Um campo da tabela de atributos de uma camada vetorial. O nome da camada tem de ser
adicionada depois da etiqueta campo. Por exemplo, se declarou um arquivo de entrada vetorial com
mylayer=vector, poderá usar myfield=field mylayer para adicionar o campo a partir dessa
camada como parâmetro.

• folder‘. Uma pasta.

• file‘. Nome do arquivo

O nome do parâmetro é o nome que será exibido ao utilizado quando executa o algoritmo, e também o nome da
variável a usar no código do script. O valor introduzido pelo usuário para esse parâmetro será atribuído à variável
com esse nome.

Quando é exibido o nome do parâmetro ao usuário, o nome irá ser editado para melhorar a aparência, substituindo
o hífen inferior com espaços. Portanto, por exemplo, se quer que o usuário veja o parâmetro chamado Um valor
numérico, pode usar o nome da variável A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Os arquivos de saída são definidos numa maneira semelhante, usando as seguintes etiquetas:

• raster de saída

• vetor de saída

• tabela de saída

• html de saída

• arquivo de saída

• número de saída

• cadeia de texto de saída

O valor atribuído às variáveis de saída sempre são conjuntos de caracteres que representam o caminho dos ar-
quivos. Corresponderá a um caminho de arquivos temporários, caso o usuário não inserir um nome de arquivo de
saída.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Não use a o método load() nos algoritmos, mas apenas quando se trabalha com a linha do terminal. Se a
camada é criada como saída de um algoritmo, deve ser declarado como tal. Caso contrário, você não será capaz
de usar adequadamente o algoritmo no modelador, desde sua sintaxe (como definido pelas tags, explicado acima)
não coincidirá com o que o algoritmo realmente produz.

Saídas ocultas (números e textos) não têm um valor. Em vez disso, o usuário tem que atribuir um valor a eles.
Para isso, basta definir o valor de uma variável com um nome para declarar a saída. Por exemplo, se você usou
esta declaração,

##average=output number

a linha seguinte irá configurar o valor de saída para 5:

average = 5

Em adição às etiquetas para os parâmetros e arquivos de saída, pode também definir o grupo onde o algoritmo será
exibido, usando a etiqueta group.

Se o algoritmo leva um longo tempo para processar, é uma boa ideia informar ao usuário. Você tem uma chamada
global progress disponível, com dois métodos: setText(text) e ‘‘setPercentage(percent)‘ para modificar
o texto de progresso e a barra de progresso.
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Vários exemplos são apresentados. Por favor, verifique-os para ver exemplos reais de como criar algoritmos
usando as classes do quadro de processamento. Pode clicar com o botão direito do mouse em qualquer script do
algoritmo e selecionar Editar script para editar o seu código ou apenas para vê-lo.

18.5.4 Documentando os seus scripts

Como no caso dos modelos, você pode criar documentação adicional para o seu script, para explicar o que fazem
e como são usados. No diálogo de edição do script irá encontrar um botão [Editar ajuda do script]. Clique nele
e irá levá-lo para o diálogo de edição da ajuda. Verifique o capítulo sobre o modelador gráfico para saber mais
sobre este diálogo e como usá-lo.

Os arquivos de ajuda são salvos na mesma pasta como o próprio script, adicionando a extensão .help ao nome
do ficheiro. Note que, você pode editar a ajuda do seu script antes de guardá-lo pela primeira vez. Se fechar
mais tarde o diálogo de ajuda do script sem salvar o script (ex.: descartá-lo) o conteúdo da ajuda que escreveu
será perdido. Se o seu script já estiver salvo e associado ao nome do arquvio, o conteúdo de ajuda será salvo
automaticamente.

18.5.5 Pré- e pós-execução de encaixe da script

Os scripts podem também ser usados para definir um encaixe de pré- e pós-execução que correm antes e depois do
algoritmo correr. Isto pode ser usado para automatizar tarefas que serão executados quando qualquer algoritmo é
executado.

A sintaxe é identica à sintaxe explicada em cima, mas uma variável global alg está disponível, representando o
algoritmo que foi (ou está prestes a ser) executado.

No grupo General do diálogo de configuração do processamento irá encontrar duas entradas denominados de Pré-
execução do arquivo script e Post-execution script filet onde os nomes do arquivo dos scripts a serem executados
em cada caso podem ser inseridos.

18.6 Gerenciador do histórico

18.6.1 O histórico do processamento

Cada vez que executa um algoritmo, a informação do processo é armazenado no gerenciador do histórico. Junta-
mente com os parâmetros usados, a data e o tempo de execução são também salvos.

This way, it is easy to track and control all the work that has been developed using the Processing framework, and
to reproduce it.

O gerenciador do histórico é um conjunto de entradas de registro agrupados de acordo com sua data de execução,
tornando-o mais fácil de encontrar informações sobre um algoritmo executado a qualquer momento particular.

A informação do processo é mantida como uma expressão de linha de comandos, mesmo se o algoritmo seja
lançado a partir da barra de ferramentas. Isto permite ser útil para aqueles que querem aprender como se usa a
interface da linha de comandos, uma vez que podem chamar o algorítimo usando a barra de ferramentas e verificar
o gerenciador do histórico para ver como o mesmo algorítimo pode ser chamado a partir da linha de comandos.

Além de navegar nas entradas no registro, você também pode re-executar os processos, basta um duplo clique
sobre a entrada correspondente.

18.6.2 The processing log

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log, in a Processing tab.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is written to the log each time you
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Figure 18.31: Histórico
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run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each provider,
looking for the corresponding option in the provider entry of the settings dialog.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to log if they detect potential problems with the data, in order to warn you. Make sure you check
those messages in the log if you are having unexpected results.

18.7 Escrevendo novos algoritmos de processamento com scripts
python

Você pode criar seus próprios algoritmos escrevendo com o código Python correspondente e adicionando algumas
linhas extras para fornecer informações adicionais necessárias para definir a semântica do algoritmo. Você pode
encontrar um menu Criar um novo script no grupo Ferramentas no bloco algoritmo Script da caixa de ferramentas.
Dê um duplo clique sobre ele para abrir o diálogo edição script. É onde você deve digitar seu código. Salvando
o script na pasta:‘ scripts‘ (o padrão quando você abrir o diálogo de salvar o arquivo), com: file:‘ extensão .py‘,
criará automaticamente o algoritmo correspondente.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing underscores with blank spaces.

Vamos ter o seguinte código, que calcula o índice de vertente topográfica (TWI) diretamente de um MDE

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these, but since we have the DEM, we
can calculate them by calling the corresponding SAGA algorithms.

A parte do código onde esta transformação substitui não é difícil de entender se você já leu o capítulo anterior.
As primeiras linhas, no entanto, precisam de alguma explicação adicional. Eles fornecem a informação que é
necessário para transformar o seu código em um algoritmo que pode ser executado a partir de qualquer um dos
componentes da GUI, como a caixa de ferramentas ou o modelador gráfico.

Estas linhas de começo com um comentário símbolo duplo Python (##) e tem a seguinte estrutura

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. Uma camada raster

• vetor. Uma camada vetor

• tabela. Uma tabela

• número. Um valor numérico. Um valor padrão deve ser fornecido. Por exemplo,
profundidade=número 2.4

• string. Uma cadeia de texto. Como no caso de valores numéricos, um valor padrão deve ser adicionado.
Por exemplo, nome=texto Vitor

• longstring. Igual um texto, mas uma caixa de texto maior será mostrado, por isso, é mais adequado
para textos longos, como para um script esperam um trecho de código pequeno.

• ‘‘ booleano‘‘. Um valor booleano. Adicionar Verdadeiro ou ‘‘ Falso‘‘ depois dele, para definir o valor
padrão. Por exemplo, verbose=booleano Verdadeiro.
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• raster multiplo. Um conjunto de camadas raster de entrada.

• vetor multiplo. Um conjunto de camadas vetor de entrada.

• Campo. Um campo na tabela de atributos de uma camada de vetor. O nome da camada tem
que ser adicionado após a tag Campo. Por exemplo, se você declarou um vetor de entrada com
minhacamada=vetor, você poderia usar o minhacamada=campo minhacamada para adicionar
um campo a partir dessa camada como parâmetro.

• extent. A spatial extent defined by xmin, xmax, ymin, ymax

• pasta. Um pasta

• arquivo. Um arquivo

• src. Um Sistema de Referência de Coordenada

• selection. A dropdown menu that allows the user to select from a pre-populated list. For example
units=selection sq_km;sq_miles;sq_degrees

• name. Name of the script. This will be displayed as the algorithm name in the processing toolbox. For
example My Algorithm Name=name

• group. Folder name where the script will appear in the Processing Toolbox. For Example, adding
Utils=groups will put the script within a Utils folder within Scripts.

O nome do parâmetro é o nome que será mostrado para o usuário durante a execução do algoritmo, e também o
nome da variável a ser usado no código de script. O valor digitado pelo usuário para esse parâmetro será atribuído
a uma variável com esse nome.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
underscores with spaces. So, for instance, if you want the user to see a parameter named A numerical value,
you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Saídas são definidas de forma semelhante, usando as seguintes etiquetas:

• raster de saída

• vetor de saída

• tabela de saída

• html de saída

• arquivo de saída

• número de saída

• texto de saída

• extensão de saída

O valor atribuído às variáveis de saída é sempre um texto com um caminho de arquivo. Ele vai corresponder a um
caminho de arquivo temporário, caso o usuário não informe qualquer arquivo de saída.

Além das marcas para os parâmetros e saídas, você também pode definir o grupo em que o algoritmo será
mostrado, usando a etiqueta groupo.

A última marca que você pode usar em seu cabeçalho roteiro é ##nomodeler. Use isso quando você não quer
que seu algoritmo seja mostrado na janela de modelador. Isto deve ser utilizado para algoritmos que não têm uma
sintaxe clara (por exemplo, se o número de camadas a serem criadas não é conhecido antecipadamente, a tempo
de desenho), o que os torna inadequados para a modelagem gráfica
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18.8 Entregando os dados produzidos pelo algoritmo

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Não use o método load() em seus algoritmos de script, mas apenas quando se trabalha com a linha de console.
Se uma camada é criada como saída de um algoritmo, que deve ser declarada como tal. Caso contrário, você não
será capaz de usar corretamente o algoritmo no modelador, desde a sua sintaxe (como definido pelas etiquetas
explicadas acima) não coincidir com o que o algoritmo realmente cria.

Saídas ocultas (números e textos) não tem um valor. Em vez disso, é você quem tem que atribuir um valor a elas.
Para isso, basta definir o valor de uma variável com o nome usado para declarar que a saída. Por exemplo, se você
usou esta declaração,

##average=output number

a seguinte linha foi definido o valor de saída para 5:

average = 5

18.9 Comunicação com o usuário

Se o algoritmo leva um longo tempo para processar, é uma boa idéia informar ao usuário. Você tem um chamado
progresso global disponível, com dois métodos disponíveis: setText(texto) e setPercentage(por
cento) para modificar o progresso do texto e a barra de progresso.

Se você tiver que fornecer algumas informações para o usuário, não relacionada com a evolução do algoritmo,
você pode usar o método SetInfo (texto), também o progresso do objeto.

Se o seu script tiver algum problema, a maneira correta de propagação é para levantar uma exceção do tipo
GeoAlgorithmExecutionException(). Você pode passar uma mensagem como argumento para o con-
strutor da exceção. Processing vai cuidar de manuseá-lo e se comunicar com o usuário, dependendo de onde o
algoritmo estiver sendo executado a partir da (caixa de ferramentas, modelador, console do Python ...)

18.10 Documentando seus scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to find out more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Note that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated with a filename, saving is done automatically.

18.11 Exemplos de scripts

Vários exemplos estão disponíveis na coleção on-line de scripts, que podem ser acessados selecionando o script
Adquirir script da coleção on-line a ferramenta sob o Scripts/ferramentas entrada na caixa de ferramentas.

Por favor, verifique-os para ver exemplos reais de como criar algoritmos usando as classes de estrutura de proces-
samento. Você pode clicar o botão direito do mouse em qualquer algoritmo de roteiro e escolha: guilabel: Editar
script para editar o seu código ou apenas para vê-lo.
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18.12 Melhores práticas para algoritmos de script escrito

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Não coloque resultados das camadas. Vamos trabalhar o Processamento com seus resultados e carregar suas
camadas se necessárias.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Não mostrar caixas de mensagens ou usar qualquer elemento GUI do script. Se você
quer se comunicar com o usuário, use o método SetInfo()‘‘ou lançar uma
‘‘GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

18.13 Pré e pós-execução de ganchos de script

Os scripts também pode serem usados para definir ganchos pré e pós-execução que são executados antes e depois
que algoritmo seja executado. Esta pode ser usada para automatizar as tarefas que devem ser executadas sempre
que um algoritmo é executado.

A sintaxe é idêntica à sintaxe explicada acima, mas uma variável global adicional chamado alg está disponível,
que representa o algoritmo que acaba de ser (ou está prestes a ser) executado.

No grupo Geral da janela de configuração de processamento, você vai encontrar duas entradas com o nome
Arquivo de script de pré-execução e Arquivo de script de pós-execução onde o nome do arquivo dos scripts a
serem executado em cada caso, podem ser inseridos.

18.14 Configurando as aplicações externas

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external applications are managed by their own algorithm provider.

Este capítulo irá mostrar como configurar a infraestrutura do processamento para incluir estas aplicações adi-
cionais, e irá explicar algumas características particulares baseado nos algoritmos. Uma vez feita a correta con-
figuração do sistema, terá possibilidade de executar algoritmos externos a partir de qualquer componente como a
caixa de ferramentas ou o modelador gráfico, assim como faz para outro geoalgoritmo.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.
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18.14.1 Uma nota para usuários Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms from these providers will be ready to be run without needing any further configuration. If
installing through OSGeo4W application, make sure you select for installation SAGA, GRASS and OTB as well.

Se desejar saber mais sobre como os fornecedores trabalham, ou deseja usar alguns algoritmos que não estão
incluídos na caixa de ferramentas simplificada (como por exemplo os scripts R), continue a leitura.

18.14.2 Uma nota para os formatos dos arquivos

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Usando as camadas raster GRASS, por exemplo, um dos casos em que pode ter problema e não seja possível
completar o seu trabalho é se chamar um algoritmo externo usando uma camada como arquivo de entrada. Por
esta razão, essas camadas não irão aparecer como disponíveis para os algoritmos.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

18.14.3 Uma nota para as seleções da camada vetorial

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

Noutros casos, exportando apenas os elementos seleccionados é necessário, o que em alguns casos os tempos de
execução serão mais longos.

18.14.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.
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If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

Sobre as limitações do sistema de grid do SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

A definição do sistema de projeção comum é controlado pelo usuário, você vai encontrar vários parâmetros no
grupo SAGA da janela de configuração para definí-lo. Existem duas maneiras de definir o sistema de projeção:

• Configure-o manualmente. Você define a extensão configurando os valores dos seguintes parâmetros:

– Reamostragem do X min

– Reamostragem do X máx

– Reamostragem do Y min

– Reamostragem do Y máx

– Reamostragem do tamanho da célula

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Configurando automaticamente a partir das camadas de entrada. Para selecionar esta opção, verifique a
opção:guilabel:Use min covering grid system for resampling. Todas as outras configurações irão ser igno-
radas e a extensão mínima que cobre todas as camadas de entrada serão usadas. O tamanho de célula da
camada de destino é o máximo de tamanho de célula de todas as camadas de entrada.

Para algoritmos que não usam camadas raster múltiplas, ou para aquelas que não necessitam de um único sistema
de grid de entrada, não será feito uma reamostragem antes de chamar o SAGA, e esses parâmetros não serão
usados.

Limitações para camadas multi-banda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

Limitações na resolução espacial

O SAGA pressupõe que as camadas raster têm o mesmo tamanho de célula no eixo X e Y. Se estiver trabalhando
com uma camada com diferentes valores para o tamanho de célula horizontal e vertical, deverá obter resultados
inesperados. Nesse caso, um aviso será adicionado ao registo do processamento, indicando que a camada de
entrada não se adapta de forma a ser processado pelo SAGA.

Registrando

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
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percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

A maioria dos outros fornecedores que usam uma aplicação externa e chamam a partir da linha de comandos têm
opções semelhantes, portanto irá encontrar noutros sítios da lista de configurações do processamento.

18.14.5 R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Nota: for Windows user, usually the R executable file is in the C:Program FilesRR-3.2 folder. Add just
the folder and NOT the binary!

Uma vez mais, isto é diferente no Linux, e só tem de ter certeza que a pasta do R está incluída na variável de
ambiente PATH. Se conseguir iniciar o R, apenas introduza R na consola, e estará pronto a começar.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

Os arquivos de script R têm a extensão .rsx e é fácil criá-los se tiver o conhecimento básico da sintaxe do R e
do código R. Eles devem ficar armazenados na pasta scripts R. Pode definir esta pasta no grupo de configurações
R (disponível a partir do diálogo de configurações do processamento), como faz com a pasta para scripts normais
do processamento.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of
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a parameter is also the name of the variable that we can use in R for accessing the value of that parameter (thus,
you should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tabelas são abertas usando o comando read.csv(). Se uma tabela inserida pelo usuário não está no formato
CSV, será convertida antes de importá-la para R.

Adicionalmente, os arquivos raster pode ser lidos usando o comando readGDAL() em vez de brick(), usando
o ##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilenames tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Com a informação em cima, podemos agora perceber a primeira linha do nosso primeiro script exemplo (a primeira
linha que não começa com o comentário Python).

pts=spsample(polyg,numpoints,type="random")

A variável polygon já contém o objecto SpatialPolygonsDataFrame, portanto pode ser usado para
chamar o método spsample, tal como o numpoints, que indica o número de pontos a ser adicionados ao
grid de amostra criada.

Desde que declarado uma saída do tipo vetor chamado out, temos que criar uma variável chamada out e ar-
mazenar um ‘ Spatial*DataFrame objeto nele (neste caso, um SpatialPointsDataFrame). Você pode
usar qualquer nome para as variáveis intermediárias. Apenas certifique-se de que a variável que armazena o
resultado final tem o mesmo nome que você usou para declará-la, e que contém um valor adequado.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

Se o seu algoritmo não gera qualquer camada, mas sim um resultado de texto no console em vez disso, você tem
que indicar que deseja que o console seja exibido uma vez que a execução seja concluída. Para isso, basta começar
as linhas de comando que produzem os resultados que você deseja imprimir com a > (‘greater’) sign. A saída de
todas as outras linhas não serão mostradas. Por exemplo, aqui está o arquivo de descrição de um algoritmo que
realiza um teste de normalidade em um determinado campo (coluna) dos atributos de uma camada vetorial:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Se o seu algoritmo criar qualquer tipo de gráficos (usando o método ‘‘plot()), adicione a seguinte linha:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Tanto os gráficos como os resultados do console serão exibidos no gestor de resultados do processamento.
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For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Nota: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.

18.14.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionally, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Se está a trabalhar em Linux, só necessita de ter a certeza que o GRASS está corretamente instalado, e pode ser
executado sem problema a partir do console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

18.14.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

18.14.8 Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Em seguida, configure o caminho para a pasta onde estão as ferramentas da linha de comandos OTB e as bibliote-
cas estão instaladas:

• normalmente OTB applications folder encaminha para /usr/lib/otb/applications e OTB com-
mand line tools folder é /usr/bin

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.
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18.14.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.

TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Nota: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Instalando TauDEM no Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Nota: Se você quiser usar TauDEM 5.0.6

Instalando TauDEM no Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Nota: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Abra o arrquivo linearpart.h e depois a linha

#include "mpi.h"
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adicione uma nova linha com

#include <stdint.h>

e irá obter

#include "mpi.h"
#include <stdint.h>

Salve as alterações e feche o arquivo. Agora abra o arquivo tiffIO.h, encontre a linha #include
"stdint.h" e substitua as entre aspas (“”) com ‘‘<>, para que possa obter

#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configuring TauDEM provider

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Nota: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.
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18.15 O QGIS Comando

A transformação inclui uma ferramenta prática que permite a execução de algoritmos sem ter que usar a caixa de
ferramentas, mas apenas digitando o nome do algoritmo que você deseja executar.

Esta ferramenta é conhecida como o comando QGIS, e é apenas uma caixa de texto simples para autocompletar
onde você digita o comando que você deseja executar.

Figure 18.32: O QGIS Comando

The Commander is started from the Processing menu or, more practically, by pressing Shift + Ctrl + M
(you can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). To close
it, just press ESC. Apart from executing Processing algorithms, the Commander gives you access to most of the
functionality in QGIS, which means that it gives you a practical and efficient way of running QGIS tasks and
allows you to control QGIS with reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

18.15.1 Comandos disponíveis

Os comandos disponíveis no Comando entram nas seguintes categorias:

• Algoritmos de processamento. Estes são mostrados como ‘‘ algoritmo de processamento: <name of the
algorithm> ‘‘.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Funções Python. Você pode criar funções Python curtas que serão depois incluídas na lista de comandos
disponíveis. Elas são mostradas como Função: <nome da função>.

Para executar qualquer um dos acima, basta começar a digitar e, em seguida, selecione o elemento correspondente
da lista de comandos disponíveis que aparece depois de filtrar toda a lista de comandos com o texto que você
digitou.

In the case of calling a Python function, you can select the entry in the list, which is prefixed by Function:
(for instance, Function: removeall), or just directly type the function name (removeall in the previous
example). There is no need to add brackets after the function name.

18.15.2 Criando funções personalizadas

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis2/processing/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.
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The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favourite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Por exemplo, pode adicionar a seguinte função, que remove todas as camadas:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Depois de adicionar a função, ele estará disponível no Comando, e você pode chamá-lo digitando removeall.
Não há necessidade de fazer nada além de escrever a própria função.

As funções podem receber parâmetros. Adicionar *args para a sua definição de função para receber argumentos.
Ao chamar a função do Comando, os parâmetros têm de ser passados separados por espaços.

Aqui está um exemplo de uma função que carrega uma camada e que tome como parâmetro o nome do arquivo da
camada para carregar.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type in the Commander text box:

‘‘load /home/myuser/points.shp‘‘
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CHAPTER 19

Compositor de Impressão

Com o Compositor de Impressão, você pode criar bons mapas e atalhos que podem ser impressos ou salvos
como arquivo PDF, uma imagem ou um arquivo SVG. Esta é uma maneira poderosa de compartilhar informações
geográficas produzidas com o QGIS que podem ser incluídas nos relatórios ou publicadas.

19.1 Visão Geral do Compositor de Impressão

O Compositor de Impressão fornece recursos crescentes de layout e impressão. Ele permite que você adicione
elementos como a tela do mapa do QGIS, rótulos de texto, imagens, legendas, barras de escala, formas básicas,
setas, tabelas de atributos e quadros HTML. Você pode dimensionar, agrupar, alinhar, posicionar e girar cada
elemento e ajustar suas propriedades para criar seu layout. O layout pode ser impresso ou exportado para formatos
de imagem, PostScript, PDF ou para SVG (exportar para o SVG não está funcionando corretamente com algumas
versões recentes do Qt4, você deve tentar verificar individualmente seu sistema). Você pode salvar o layout como
um modelo e carregá-lo novamente em outra sessão. Finalmente, gerar vários mapas com base em um modelo
pode ser feito através do gerador de atlas.

19.1.1 Sessão de Amostra

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

To demonstrate how to create a map please follow the next instructions.

1. On the left side, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

303



QGIS User Guide, Versão 2.14

7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.

8. Finally, you can save your print composition within the project file with the Save Project button.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

19.1.2 The Composer Manager

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 19.1: The Print Composer Manager

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.
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19.1.3 Menus, tools and panels of the print composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items: the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 19.2: Print Composer

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.

• The Items tab provides a list of all map composer items added to the canvas.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
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select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_1.

The toolbars and the tabs can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.
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Tools

Icon Purpose Icon Purpose

Save Project New Composer

Duplicate Composer Composer Manager

Load from template Save as template

Print or export as PostScript Export to an image format

Export print composition to SVG Export as PDF

Revert last change Restore last change

Zoom to full extent Zoom to 100%

Zoom in Zoom out

Refresh View

Pan Zoom to specific region

Select/Move item in print composition Move content within an item

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add scale bar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Add an HTML frame

Group items of print composition Ungroup items of print composition

Lock Selected Items Desbloquear todos os itens

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composer 1: Print Composer Tools

Composer Menu

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one

• Open the Composer Manager...
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• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Settings Menu

From Settings → Composer Options you can set some options that will be used as default on any composer during
your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

Edit Menu

Copy/Cut and Paste Items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Nota: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties tab.

View Menu

Navigation Tools

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom In

• Zoom Out

• Zoom Full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Show Grid behind items.

• Snap Grid to snap items on the grid.

• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.
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• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Hide and Show Panels

To maximise the space available to interact with a composition you can use View → Hide panels or press F10.

Nota: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Tab

Page size and settings

In the Composition tab, you can define the global settings of the current composition.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Data Defined Override Buttons).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).

Export settings

You can define a resolution to use for all exported maps in Export resolution. This setting can however be overrid-

den each time you are exporting a map. When checked, print as raster means all elements will be rasterized
before printing or saving as PostScript or PDF.
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Figure 19.3: Composition settings in the Print Composer

While exporting to an image file format, you can choose to generate a world file by checking World file on and
select a map item. The world file is created beside the exported map, has same name and contains information to
easily georeference it.

Figure 19.4: Export Settings in the Print Composer

Grid and guides

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.
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Figure 19.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Command History Tab: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change

This can also be done by mouse click within the Command history tab (see figure_composer_1). The History tab
lists the last actions done within the composer. Just select the point you want to revert to and once you do new
action all the actions done after the selected one will be removed.

Figure 19.6: Command history in the Print Composer

Items Tab

The Items tab offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

For any selected item, you can :

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.
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Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items tab and
unchecking the tickbox or you can use the icons on the toolbar.

19.2 Itens do Compositor

19.2.1 Composer Items Common Options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Rotation, Frame, Background, Item ID and Rendering (See figure_composer_common_1).

Figure 19.7: Common Item properties Dialogs

• The Position and size dialog lets you define the size and position of the frame which contains the item. You
can also choose which Reference point will be set at the X and Y coordinates previously defined.

• The Rotation sets the rotation of the element (in degrees).

• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.
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• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed.

Nota:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map
item or use expressions. These are particularly helpful with atlas generation (See Data Defined Override
Buttons).

Modo de renderização

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 19.8: Modo de renderização

• Blending mode: With this tool you can achieve effects which would otherwise only be achieved using
graphic rendering software. The pixels of your overlaying and underlaying items can be mixed according
to the mode set (see Modos de Mistura for description of each effect).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item invisible in all exports. After activating this
checkbox, the item will not be included in export to PDF, print etc..

Size and position

Each item inside the Composer can be moved and resized to create a perfect layout. For both operations the

first step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse
while holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just
hold the Shift button on the keyboard while moving the mouse. If you need better precision, you can move
a selected item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by
holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.
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You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

Alignment

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items tab. You can also raise or lower objects
in the Items tab by clicking and dragging an object’s label in this list.

Figure 19.9: Alignment helper lines in the Print Composer

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_3). To use an alignment function, you first select the elements then click on the matching
alignment icon. All selected elements will then be aligned to their common bounding box. When moving items
on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.
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19.2.2 Ítem do Mapa

Clique na barra de ferramentas no botão |mActionAddMap| Adicionar novo Mapa, na barra de ferramentas do compos-
itor de impressão para adicionar o mapa à tela do QGIS. Agora, arraste um retângulo na tela do Compositor com o
botão esquerdo do mouse para adicionar uma janela de mapa. Para exibir o mapa atual, você pode escolher entre
três modos diferentes na guia do mapa Propriedades do item:

• Retângulo é a configuração padrão. Apenas exibe uma caixa vazia com a mensagem ‘O mapa será impresso
aqui’.

• Cache carrega o mapa na resolução da tela atual. Se você ampliar a janela Compositor dentro ou para fora,
o mapa não é processado novamente, mas a imagem será redimensionada.

• Edição significa que, se você aumentar o zoom da janela do Compositor para dentro ou para fora, o mapa
será processado novamente, mas por razões de espaço, apenas até uma resolução máxima.

Cache é o modo de visualização padrão para mapas do compositor de impressão recém adicionados.

Para mover camadas dentro do elemento do mapa, selecione o elemento desejado, clique no ícone |mAction-
MoveItemContent| Mover conteúdo do item e mova as camadas dentro do quadro do item do mapa com o botão es-
querdo do mouse. Depois de ter encontrado o lugar certo para o item, você pode bloquear a posição do item
dentro da tela do compositor de impressão. Selecione o item do mapa e use a barra de ferramentas |bloqueado|
Bloquear itens Selecionados ou a guia itens para bloquear o item. Um item bloqueado só podem ser selecionado usando
a guia itens. Uma vez selecionado, você pode usar a guia itens para desbloquear itens individuais. O ícone
|desbloqueado| Desbloquear todos os itens vai desbloquear todos os itens bloqueados do compositor.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button.

Propriedades principais

The Main properties dialog of the map Item Properties tab provides the following functionalities (see fig-
ure_composer_map_1):

Figure 19.10: Map Item properties Tab

19.2. Itens do Compositor 315



QGIS User Guide, Versão 2.14

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• The field Scale sets a manual scale.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on the
button you will see the list of all the preset views: just select the preset you want to display. The map

canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you want

to unselect the preset, just uncheck the and press the button. See Layers Panel to find out how to
create presets views.

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Extents

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_map_2):

Figure 19.11: Map Extents Dialog

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

316 Chapter 19. Compositor de Impressão



QGIS User Guide, Versão 2.14

Grids

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• With the plus and minus button you can add or remove a selected grid.

• With the up and down button you can move a grid in the list and set the drawing priority.

When you double click on the added grid you can give it another name.

Figure 19.12: Map Grids Dialog

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.

Figure 19.13: Draw Grid Dialog

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and its
rendering mode can be chosen. See Modo de renderização. Furthermore, you can define an interval in the X and
Y directions, an X and Y offset, and the width used for the cross or line grid type.

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘Latitude/Y only’ and ‘Longitude/X only’ setting in the divisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids.
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Figure 19.14: Grid Frame Dialog

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the
annotation numeric format, the options range from decimal to degrees, minute and seconds, with or without
suffix, aligned or not and a custom format using the expression dialog. You can choose which annotation
to show. The options are: show all, latitude only, longitude only, or disable(none). This is useful when the
map is rotated. The annotation can be drawn inside or outside the map frame. The annotation direction can
be defined as horizontal, vertical ascending or vertical descending. Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Overviews

The Overviews dialog of the map Item Properties tab provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview
is named ‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the
overview item in the list named ‘Overview 1’ and change it to another name.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.
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Figure 19.15: Grid Draw Coordinates dialog

Figure 19.16: Map Overviews Dialog
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19.2.3 The Label Item

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 19.17: Label Item properties Tab

Main properties

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Appearance

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.
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19.2.4 O Item Legenda

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_legend_1):

Figure 19.18: Legend Item properties Tab

Main properties

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_2):

Figure 19.19: Legend Main properties Dialog

In Main properties you can:

• Change the title of the legend.

• Define o alinhamento do título para Esquerda, Centro ou Direita.

• You can choose which Map item the current legend will refer to in the select list.

• You can wrap the text of the legend title on a given character.
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Legend items

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_legend_3):

Figure 19.20: Legend Legend Items Dialog

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Use the [Add group] button to add a legend group.

– Use the [plus] and [minus] button to add or remove layers.

– The [Edit] button is used to edit the layer, groupname or title. First you need to select the legend item.

– The [Sigma] button adds a feature count for each vector layer.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonts, Columns, Symbol

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• You can change the font of the legend title, group, subgroup and item (layer) in the legend item. Click on a
category button to open a Select font dialog.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths sets how legend columns should be adjusted.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can also change the width and height of the legend symbol,set a color and a thickness in case of raster
layer symbol.
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Figure 19.21: Legend Fonts, Columns and Symbol Dialogs

WMS LegendGraphic and Spacing

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

When you have added a WMS layer and you insert a legend composer item, a request will be sent to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

19.2.5 Item da Barra de Escala

Para adiciona uma barra de escala, clique no ícone |mActionScaleBar| Adicionar nova barra de escala, clicando com o
botão esquerdo do mouse sobre a tela do compositor de impressão, posicionando e personalizando a aparência na
guia da barra de escala na aba Propriedades do ítem.

A Propriedades do item de uma barra de escala apresentam as seguintes funcionalidades (veja fig-
ure_composer_scalebar_1):

Propriedades Principais

O diálogo Propriedades principais da guia Barra de escala Propriedades do item apresenta na aba as seguintes
funcionalidades (veja figure_composer_scalebar_2):

• Primeiro, escolha o mapa ao qual a barra de escala será ligada.

• Em seguida, escolha o estilo da barra de escala. Seis estilos estão disponíveis:
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Figure 19.22: WMS LegendGraphic and Spacing Dialogs

Figure 19.23: Aba propriedades do item da Barra de Escala

Figure 19.24: Propriedades do item da Barra de Escala
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– Estilos Box simples e Box duplo, que contêm uma ou duas linhas de caixas de cores alternadas.

– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).

Unidades e Segmentos

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_scalebar_3):

Figure 19.25: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar.

• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Height is used to define the height of the bar.

Display

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

You can define how the scale bar will be displayed in its frame.

• Box margin : space between text and frame borders

• Labels margin : space between text and scale bar drawing

• Line width : line width of the scale bar drawing
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Figure 19.26: Scale Bar Display

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fonts and colors

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 19.27: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.

• Use the [Font] button to set the font of scale bar label

• Font color: set the font color

• Fill color: set the first fill color

• Secondary fill color: set the second fill color

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

19.2.6 Item da Tabela de Atributos

É possível adicionar partes de uma tabela de atributos vetoriais à tela do Compositor de Impressão: clique no
ícone | openTable | : Sup: ‘Adicionar tabela de atributo’, clique e arraste com o botão esquerdo do mouse na tela
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do Compositor de Impressão para colocar e dimensionar o item. Você pode posicionar e personalizar melhor sua
aparência na guia: guilabel: ‘Propriedades do item ‘.

The Item properties tab of an attribute table provides the following functionalities (see figure_composer_table_1):

Figure 19.28: Attribute table Item properties Tab

Propriedades Principais

The Main properties dialog of the attribute table‘ provides the following functionalities (see fig-
ure_composer_table_2):

Figure 19.29: Diálogo propriedades principais da Tabela de Atributos

• For Source you can normally select only ‘Layer features’.

• With Layer you can choose from the vector layers loaded in the project.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
layer. Choosing ‘Relation children’, an option with the relation names will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and the table
will show the children rows of the atlas coverage layer’s current feature (for further information about the
atlas generation, see Generate an Atlas).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.
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Figure 19.30: Attribute table Main properties for ‘Current atlas feature’

Figure 19.31: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table. The upper part of the window shows the list of the attributes to display and the lower part helps to
set the way the data is sorted.

Figure 19.32: Attribute table Select attributes Dialog

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.
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– Use the up and down arrows to change the order of the attributes in the table.

– Select a cell in the Headings column and, to change the heading, just type in a new name.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

In the Sorting section you can:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– use the minus button to remove an attribute from the sort order list.

Feature filtering

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_4):

Figure 19.33: Attribute table Feature filtering Dialog

Você pode:

• Define the Maximum rows to be displayed.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the airports that have a letter ‘i’ in the attribute field ‘USE’.
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Appearance

The Appearance dialog of the attribute table provides the following functionalities (see figure_composer_table_5):

Figure 19.34: Attribute table appearance Dialog

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have chosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_6)

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Show grid

The Show grid dialog of the attribute table provides the following functionalities (see figure_composer_table_7):

• Activate Show grid when you want to display the grid, the outlines of the table cells.
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Figure 19.35: Attribute table Advanced Background Dialog

Figure 19.36: Attribute table Show grid Dialog
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• With Line width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Fonts and text styling

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_8):

Figure 19.37: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_3 ).

Frames

The Frames dialog of the attribute table provides the following functionalities (see figure_composer_table_9):

Figure 19.38: Attribute table Frames Dialog

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.
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• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

19.2.7 Item Imagem

Para adicionar uma imagem, clique no ícone |mActionAddImage| Adicionar imagem, coloque o elemento clicando
com o botão esquerdo do mouse sobre a tela do compositor de impressão, posicione e personalize sua aparência
na imagem guia item Propriedades.

A guia figura da Propriedades do item apresenta as seguintes funcionalidades (ver figure_composer_image_1):

Figure 19.39: Aba Propriedades do Item da Imagem

Primeiro você tem que selecionar a imagem que você deseja exibir. Existem várias formas de defini-la fonte da
imagem na área Propriedades principais.

1. Use o botão de navegação da fonte da imagem para selecionar um arquivo de seu computador usando
a janela de navegação. A navegação iniciará na pasta da biblioteca SVG do QGIS. Além do SVG, você
também pode selecionar outros formatos de imagem como .png ou .jpg.

2. Você pode inserir a fonte diretamente no campo de texto fonte da imagem. Você pode até mesmo fornecer
um endereço URL remoto de uma imagem.

3. A partir da área Buscar pastas, você também pode selecionar uma imagem a partir do Caminho de busca
de imagem para definir a origem da imagem.
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4. Use os dados definidos no botão |mIconDataDefine| para definir a fonte de imagem a partir de um registro
ou usando uma expressão regular.

Com a opção modo redimensionar, você pode configurar como a imagem será exibida quando o quadro for alter-
ado, ou optar por redimensionar o quadro para que coincida com o tamanho original da imagem.

Você pode selecionar um dos seguintes modos:

• Zoom: Aumenta a imagem para o quadro, mantendo relação de aspecto da imagem.

• Ampliar: Amplia a imagem para caber dentro do quadro, ignora a relação de aspecto.

• Cortar: Utilize este modo só para imagens raster, ele define o tamanho da imagem ao tamanho da imagem
original, sem escala e usando o quadro para cortar a imagem, portanto, apenas a parte da imagem dentro do
quadro será visível.

• Zoom e redimensionar quadros: Amplia a imagem para ajustar ao quadro, em seguida, redimensiona o
quadro para encaixar imagem resultante.

• Redimensionar quadro para o tamanho da imagem: Configura o tamanho do quadro combinando com o
tamanho original da imagem sem escala.

O Modo redimensionar selecionado pode desabilitar as opções de itens ‘Posição’ e ‘Rotação de imagem’. A
Rotação de imagem está ativa para o modo de redimensionamento ‘Ampliar’ e ‘Zoom’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

It is possible to change SVG fill/outline color and outline width when using parameterized SVG files such as
those included with QGIS. If you add a SVG file you should add the following tags in order to add support for
transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Nota: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

19.2.8 O quadro com item em HTML

É possível adicionar uma moldura que exiba os conteúdos de um site ou mesmo criar e desenhar sua própria página
HTML e exibi-la!

Clique no | addHtml | : Sup: ícone “Adicionar quadro HTML”, coloque o elemento arrastando um retângulo
pressionando o botão esquerdo do mouse na tela do Compositor, posicione e personalize a aparência na guia:
guilabel: Item Properties (veja figura_composer_html_1).

HTML Source

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.
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Figure 19.40: North arrows available for selection in provided SVG library

Figure 19.41: HTML frame, the item properties Tab
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The HTML Source dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_html_2):

Figure 19.42: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• In Source you can enter text in the textbox with some HTML tags or provide a full HTML page.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activate Evaluate QGIS expressions in HTML code to see the result of the expression you have included,
otherwise you will see the expression instead.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Frames

The Frames dialog of the HTML frame Item Properties tab provides the following functionalities (see fig-
ure_composer_html_3):

Figure 19.43: HTML frame, the Frames properties

• With Resize mode you can select how to render the HTML contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.
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– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activate Don’t draw background if frame is empty prevents the HTML frame being drawn if the frame
is empty.

Use smart page breaks and User style sheet

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

Figure 19.44: HTML frame, Use smart page breaks and User stylesheet properties

• Activate Use smart page breaks to prevent the html frame contents from breaking mid-way a line of text
so it continues nice and smooth in the next frame.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

19.2.9 Os Itens Básicos do Shape

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon, place the element holding down
the left mouse. Customize the appearance in the Item Properties tab.
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Figure 19.45: Shape Item properties Tab

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers etcetera.

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Nota: Unlike other items, you can not style the frame or the background color of the frame.

19.2.10 Ítem de Seta

Para adicionar uma seta, clique no ícone |mActionAddArrow| Adicionar seta, para colocar o elemento, mantenha
pressionado o botão esquerdo do mouse e arraste uma linha para desenhar a seta na tela do compositor de im-
pressão, componha e personalize a aparência na guia barra de escala Propriedades do item.

Quando você mantenha a tecla Shift pressionada ao colocar a seta, a mesma fica com em um ângulo de exata-
mente 45|graus|.

O item seta pode ser utilizado para adicionar uma linha ou uma seta simples que pode ser utilizada, por exemplo,
para mostrar a relação entre outros itens do compositor de impressão. Para criar uma seta de norte, o item de
imagem deve ser considerado em primeiro lugar. QGIS tem um conjunto de Setas Norte no formato SVG. Além
disso, você pode conectar um item de imagem com um mapa para que ele possa rodar automaticamente com o
mapa (ver the_image_item_).

Propriedades do Item

O item Seta das Propriedades do item permite a você configurar o tipo da seta.

O botão [Estilo de linha ...] pode ser usado para selecionar o estilo de linha usando o selecionador de símbolos.

Em Marcadores de seta você pode selecionar um dos três botões.

• Padrão: Para desenhar um seta regular, dá-lhe opções para estilizar a ponta da seta

• guilabel:Nenhum: Permite desenhar uma linha de seta sem ponta

• SVG : Permite desenhar uma linha com marcador SVG Marcador inicial e o/ou Marcador final

Por Padrão para os marcadores de Seta você pode usar as seguintes opções de estilo de ponta de seta.

• Cor de contorno da seta : Defina a cor de contorno da cabeça de seta
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Figure 19.46: Aba das propriedades da Seta

• Cor de preenchimento da seta: Defina a cor de preenchimento da seta

• Espessura do contorno da seta : Defina a espessura do contorno da seta

• Espessura da ponta da seta: Defina a espessura da seta

Para marcadores SVG você pode usar as seguintes opções.

• Marcadores iniciais : Escolha uma imagem SVG para desenho no início da linha

• Marcador final : Escolha uma imagem SVG para desenhar no final da linha

• Espessura da ponta da seta: Defina a espessura da ponta e/ou contorno da seta

Imagens SVG são automaticamente rodadas com a linha. A cor da imagem SVG não pode ser alterada.

19.3 Criando um arquivo de Saída

Figure_composer_output_1 mostra o compositor de impressão com um exemplo de layout de impressão, incluindo
cada tipo de item do mapa descrito nas seções anteriores.

Antes de imprimir um layout você tem a possibilidade de visualizar sua composição sem encapsular caixas. Isso

pode ser selecionado desativando: guilabel: Ver -> : guilabel: Mostrar caixas de encadernação ‘ou pression-
ando o atalho: kbd: Ctrl + Shift + B‘.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.
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Figure 19.47: Compositor de Impressão com uma vista do mapa, legenda, imagem, barra de escala, coordenadas,
texto e caixa HTML adicionados

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

19.3.1 Exportar como Imagem

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.

You can then override the print resolution (set in Composition tab) and resize exported image dimensions. By

checking Crop to content option, the images output by composer will include only the area of the composition
with content. There’s also an option for margins to add around the item bounds if required.

If the composition includes a single page, then the output will be sized to include EVERYTHING on the compo-
sition. If it’s a multi-page composition, then each page will be cropped to only include the area of that page with
items.

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will create a world file along the exported image.

Nota: Exporting big rasters can sometimes fail, even if there seems to be enough memory. This is a problem with
the underlying Qt management of rasters.
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Figure 19.48: Image Export Options

19.3.2 Export as SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi_page

composition) and then can apply Crop to content option.

The SVG export options dialog allows also to :

• export map layers as svg groups:

• render map labels as outlines

Figure 19.49: SVG Export Options

Nota: Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying
Qt library. This will hopefully be sorted out in future versions.

19.3.3 Export as PDF

The Export as PDF exports all the composition into a single PDF file.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency
or symbol effects, these cannot be printed as vectors and your effects may be lost. Checking Print as a raster
in Composition tab helps to keep the effects but rasterize the composition. Note that the Force layer to render
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as raster in the Rendering tab of Layer Properties is a layer-level alternative that avoids global composition
rasterization.

19.3.4 Generate an Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation tab. This tab contains the following widgets (see figure_composer_atlas_1):

Figure 19.50: Atlas generation tab

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You also have options to set the output of the atlas:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.
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• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A Margin around feature that allows you to select the amount of space added around each geometry
within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project –> Project Properties –> General –> Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

or, another combination:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. both expressions
would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than its width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END
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Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Use the button of field Height to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use the Data Defined Override option.

Preview and generate

Figure 19.51: Atlas Preview toolbar

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:

• First feature

• Previous feature

• Next feature

• Last feature

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Criando um arquivo de Saída for
more information). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Dica: Print a specific atlas feature
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If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 20

Complementos

20.1 Complementos QGIS

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Many of the features in QGIS are actually implemented as plugins.

20.1.1 Core and External plugins

QGIS plugins are implemented either as Core Plugins or External Plugins.

Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS distribu-
tion. They are written in one of two languages: C++ or Python.

Most of External Plugins are currently written in Python. They are stored either in the ‘Official’ QGIS Repository
at http://plugins.qgis.org/plugins/ or in external repositories and are maintained by the individual authors. Detailed
documentation about the usage, minimum QGIS version, home page, authors, and other important information
are provided for the plugins in the Official repository. For other external repositories, documentation might be
available with the external plugins themselves. In general, external plugins documentation is not included in this
manual.

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user).

Paths to Custom C++ plugins libraries can also be added under Settings → Options → System.

Voce pode gerenciar seus complementos na aba complementos podendo ser aberta em Complementos > Gerenci-
ador e instalar complementos....

When a plugin needs to be updated, and if plugins settings have been set up accordingly, QGIS main interface will
display a blue link in the status bar to inform you that there are updates for your plugins waiting to be applied.

20.1.2 Diálogo de Complementos

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin has some metadata displayed in the right panel:

• information on whether the plugin is experimental

• descrição

• rating vote(s) (you can vote for your preferred plugin!)

• etiquetas

• some useful links to the home page, tracker and code repository

• autor(es)
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• versão disponível

Voce pode usar o filtro para pesquisar um complemento específico.

All

Here, all the available plugins are listed, including both core and external plugins. Use [Upgrade all] to look
for new versions of the plugins. Furthermore, you can use [Install plugin] if a plugin is listed but not installed,
[Uninstall plugin] as well as [Reinstall plugin] if a plugin is installed. An installed plugin can be temporarily
de/activated using the checkbox.

Figure 20.1: The All menu

Installed

Neste menu, você pode encontrar somente os complementos instalados. Os complementos externos podem ser
desinstalados e reinstalados utilizando os botões [Desinstalar complemento] e [Reinstalar complemento]. Você
também pode [Atualizar todos].

Não instalados

This menu lists all plugins available that are not installed. You can use the [Install plugin] button to implement a
plugin into QGIS.

Upgradeable

If you activated Show also experimental plugins in the Settings menu, you can use this menu to look for

more recent plugin versions. This can be done with the [Upgrade plugin] or [Upgrade all] buttons. Settings

Neste menu, você pode definir as seguintes opções:

• Check for updates on startup. Whenever a new plugin or a plugin update is available, QGIS will inform
you ‘every time QGIS starts’, ‘once a day’, ‘every 3 days’, ‘every week’, ‘every 2 weeks’ or ‘every month’.

• Show also experimental plugins. QGIS will show you plugins in early stages of development, which are
generally unsuitable for production use.

• Também mostrar complementos obsoletos. Estes complementos são obsoletos e geralmente inadequados
para uso em produção.
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Figure 20.2: The Installed menu

Figure 20.3: The Not installed menu
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Figure 20.4: The Upgradeable menu

Para adicionar repositórios externos, clique em [Adicionar...] na seção de Repositórios de complementos. Se
você não quer um ou mais repositórios adicionados, eles podem ser desabilitados através do botão [Editar...] ou
remover completamente com o botão **[Excluir].

Note that you can use an authentication (basic authentication, PKI) to access to a plugin repository. The default
QGIS repository is an open repository and you don’t need any authentication. You should deploy your own plugin
repository. You can get more information on QGIS authentication support in Authentication chapter.

The Search function is available in nearly every menu (except Settings). Here, you can look for specific
plugins.
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Figure 20.5: The Settings menu
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20.2 Using QGIS Core Plugins

Ícone Complemento Descrição Referência do Manual

Captura de
Coordenadas

Capture coordenadas com o mouse em
diferentes SRC

Complemento de Captura de
Coordenadas

Gerenciador BD Manage your databases within QGIS Complemento Gerenciador
BD

Conversor DXF2Shape Converte do DXF para o formato de
arquivo SHP

Complemento dxf2shp

eVis Ferramenta de Visualização de Eventos Complemento eVis

fTools Um conjunto de ferramentas vetoriais Complemento fTools

Ferramentas GDAL Funcionalidade matricial GDAL Complemento Ferramentas
GDAL

Geometry Checker Check and repair errors in vector
geometries

Complemento Verificador de
Geometria

Geometry Snapper Snap geometries to a reference layer Geometry Snapper Plugin

Georeferenciador
GDAL

Georeferenciar rasters com GDAL georeferenciar

Ferramentas GPS Ferramentas para carregamento e
importação de dados GPS

Complemento GPS

GRASS Funcionalidade GRASS Integração com SIG GRASS

Mapa de Densidade Criar rasters heatmap para entrar pontos
vetoriais

Complemento Mapa de
Densidade

Complemento de
Interpolação

Interpolação baseada nos vértices da
camada vetorial

Complemento de
Interpolação

Metasearch Catalogue
Client

Interage com os serviços de catálogo de
metadados (CSW)

Catálogo do Cliente
MetaBusca

Edição Offline Edição Offline e sincronização com a
base de dados

Complemento Edição Offiine

Oracle Spatial
GeoRaster

Acesso ao Oracle Spatial GeoRasters Complemento GeoRaster
Espacial Oracle

Gerenciador de
complementos

Gerenciar complementos core e externos Diálogo de Complementos

Processing Spatial data processing framework QGIS estrutura de
processamento

Análise do Terreno
Matricial

Computar características geomorfológicas
a partir de MDE

Complemento Análise do
Terreno

Complemento caminho
mais curto

Análise do Caminho mais curto Complemento Menor
Distância

Interrogação Espacial Interrogação espacial nos vetoriais Complemento de Consulta
Espacial

Verificador de
Topologia

Find topological errors in vector layers Complemento Verificador de
Topologia

Estatísticas Zonal Calcular estatísticas matriciais a partir de
polígonos vetoriais

Complemento Estatística
Zonal
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20.3 Complemento de Captura de Coordenadas

O complemento de captura de coordenadas é fácil de usar e oferece a possibilidade de visualizar as coordenadas
na tela de mapa para dois sistemas de referência de coordenadas selecionados (SRC).

Figure 20.6: Complemento de Captura de Coordenadas

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Clique na caixa de verificação Ativar projeção “on the fly” e selecione o sistema de coordenadas proje-
tado à sua escolha (veja também Trabalhando com Projeções).

3. Ative o complemento captura de coordenadas no Gerenciador de Complementos (veja: ref: manag-
ing_plugins) e garanta-se que o diálogo seja visível, vá para Exibir → Paineis e assegure-se que a |caixa|
:guilabel: Captura de Coordenadas esteja habilitada. A caixa de diálogo de captura de coordenar aparece
como mostrado na Figura figure_coordinate_capture_1. Alternativamente, você também pode ir para
:menuselection: Vetor –> Captura de Coordenadas e ver se a |caixa| Captura de Coordenadas esteja habil-
itada.

4. Clique no ícone Clique para selecionar o SRC para a exibição de coordenadas e selecione um SRC diferente a partir do
que selecionou acima.

5. Para iniciar a capturar coordenadas, clique em [Iniciar captura]. Pode clicar agora em qualquer sítio do
enquadramento do mapa e o módulo irá mostrar as coordenadas em ambos os SRC selecionados.

6. Para habilitar coordenar de rastreamento do mouse, clique no :sup: ícone rastreamento do mouse.

7. Pode também copiar as coordenadas selecionadas para a área de transferência.

20.4 Complemento Gerenciador BD

The DB Manager Plugin is officially part of the QGIS core and is intended to be the main tool to integrate and
manage spatial database formats supported by QGIS (PostGIS, SpatiaLite, Geopackage, Oracle Spatial, Virtual

layers) in one user interface. The DB Manager Plugin provides several features. You can drag layers from the
QGIS Browser into the DB Manager, and it will import your layer into your spatial database. You can drag and
drop tables between spatial databases and they will get imported.

O menu Base de Dados permite ligar a uma base de dados existente, para começar a janela de SQL e sair do
complemento Gerenciador BD. Quando estiver ligado a uma base de dados existente os menus Esquema e Tabela
apareceram adicionalmente.

O menu Esquema inclui ferramentas para criar e apagar esquemas (vazias) e, se estiver topologia disponível (ex.:
PostGIS 2), para iniciar o TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
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Figure 20.7: DB Manager dialog

for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

Se estiver ligado à base de dados, a janela principal do Gerenciador BD oferece três separadores. O separador
Informação fornecem informação sobre a tabela e a sua geometria assim como os campos existentes, restrições
e índices. Permite também correr a Análise de Vácuo e criar um índice espacial na tabela selecionada, se não
estiver atualmente feita. O separador Tabela mostra todos os atributos e o separador Pré-visualização renderiza as
geometrias como pré-visualização.

20.4.1 Trabalhando com a Janela SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

20.5 Complemento dxf2shp

O complemento conversor dxf2shape pode ser usado para converter dados vetoriais DXF para o formato shapefile.
Ele requer os seguintes parâmetros a serem especificados antes de executar:

• Entrada de arquivo DXF: Digite o caminho para o arquivo DXF que será convertido.

• Saída de arquivo Shp: Digite o nome do arquivo shapefile que será criado.

• Tipo de arquivo de saída: Especifique o tipo de geometria do shapefile de saída. Os tipos suportados
atualmente são linha, polígono, e ponto.
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Figure 20.8: Executing SQL queries in the DB Manager SQL window

Figure 20.9: Complemento Conversor Dxf2Shape
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• Exportar rótulos de texto: Se esta opção for ativada, uma camada adicional shapefile tipo ponto será
criada, e a tabela DBF associada, irá conter informações sobre os campos “Texto” encontrados no arquivo
DXF, e as próprias frases do texto.

20.5.1 Usando o Complemento

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see Diálogo de Complementos) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Digite o arquivo de entrada, um nome para o shapefile de saída e o tipo do shapefile.

3. Marque a caixa Export text labels se você deseja criar uma camada extra do tipo pontos com os rótulos.

4. Clique [OK].

20.6 Complemento eVis

(Esta seção é derivada do Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) Guia do usuário.
Museu Americano de História Natura, Centro para Biodiversidade e Conservação. Disponível em
http://biodiversityinformatics.amnh.org/, e liberada sob a licença GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see Diálogo de Complementos).

O Complemento eVis é composto de três módulos: a “ferramenta de Conexão de Banco de Dados”, “ferramenta de
Identificação de Evento”, e o “Navegador de Evento”. Estes trabalham em conjunto para permitir a visualização de
fotografias geocodificadas e outros documentos que estão ligados aos recursos armazenados em arquivos vetoriais,
banco de dados ou planilhas

20.6.1 Navegador de Evento

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Iniciando o módulo Navegador de Evento

Para iniciar o módulo Navegador de Eventos, clique em Banco de Dados→ eVis → eVis Navegador de Evento.
Isto abrirá o Navegador genérico de Evento janela.

A janela Navegador de Evento tem três guias exibidas no topo da janela. A aba Exibir é usado para ver a fotografia
e é associado aos dados atribuídos. A aba Opções fornece um número de ajustes que pode ser ajustado para
controlar o comportamento to plug-in eVis. Por fim a aba Configurar Aplicações Externas é usado para permitir
que o eVis exiba imagens de outros documentos.
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Entendendo a Janela de Exibição

Para ver a janela Exibir , clique na aba Exibir na janela Navegado de Evento . A janela Exibir é usado para ver
fotografias georreferenciadas e suas informações atribuídas associadas.

Figure 20.10: A janela de exibição do “eVis”

1. Display window: A window where the photograph will appear.

2. Botão mais Zoom: Dê Zoom para ver mais detalhes. Se a imagem inteira não pode ser exibida na janela
de exibição, barras de rolagem aparecerão no lado esquerdo e inferior da janela para permitir que você se
movimente pela imagem

3. Botão menos Zoom: Diminua o Zoom para ver mais área

4. Botão Zoom para extensão total: Mostra toda a extensão da fotografia.

5. Janela de informações de atributo: Toda as informações de atributo para o ponto associado com a fo-
tografia que está sendo visualizada é apresentada aqui. Se o tipo do arquivo que está sendo referenciado
no registro exibido não é uma imagem mas é um tipo de arquivo definido na aba Configurar Aplicações
Externas , então quando você clica duas vezes sobre o campo de valor contendo o caminho para o arquivo,
o aplicativo para abrir o arquivo será iniciado para ver ou ouvir o conteúdo do arquivo. Se as extensões do
arquivo são reconhecidas, os dados do atributo serão exibidos em verde.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.
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Figure 20.11: A janela de Opções do “eVis”
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Entendendo a janela Opções

1. Caminho de arquivo: Uma lista suspensa para especificar o campo de atributo que contém o caminho do
diretório ou URL para as fotografias ou outros documentos que estão sendo exibidos. Se a localização é um
caminho relativo, então a caixa de seleção deve ser clicada. O caminho de base para um caminho relativo
pode ser inserido na caixa de texto abaixo Caminho Base . Informação sobre diferentes opiniões para
especificar a localização são anotadas na seção abaixo Especificando o local e o nome de uma fotografia .

2. Bússola: Uma lista suspensa para especificar o campo de atributo que contém a bússola associada com a
fotografia que está sendo exibida. Se a informação da bússola estiver disponível, é necessário clicar na caixa
de seleção abaixo do titulo do menu suspenso

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Caminho Diretório base: O caminho de base para que o caminho relativo definido no Figure_eVis_2 (A)
será anexado.

5. Substituir caminho: Se esta caixa de seleção está selecionada, apenas o nome do arquivo a partir de A será
anexado ao caminho de base.

6. Aplicar regra a todos os documentos: Se marcado, as mesmas regras de caminho que são definidas para
as fotografias serão usadas para os documentos não-imagem, como filmes, documentos de texto e arquivos
de som. Se não marcado as regras de caminho só se aplica a fotografias e os outros documentos irão ignorar
o parâmetro do caminho base.

7. Salve as configurações: Se esta opção estiver marcada, os valores dos parâmetros associados serão salvos
para a próxima sessão, quando a janela é fechada ou quando o botão [Salvar] abaixo é pressionado.

8. Redefinir valores: Redefine os valores nesta linha para a configuração padrão.

9. Restaurar padrões Isto redefinirá todos os campos para suas configurações originais. Tem o mesmo efeito
que clicar no botão [Redefinir]

10. Salvar: Isto salvará as configurações sem fechar o painel Opções

Entendendo a janela Configurar Aplicações Externas

Figure 20.12: A janela de Aplicações Externas do “eVis”

1. **Arquivo tabela de referência **: Uma tabela contendo os tipos de arquivos que podem ser abertos usando
eVis. Cada tipo de arquivo tem uma extensão de arquivo e o caminho para um aplicativo poder abrí-lo. Isso
fornece a capacidade de abrir uma ampla gama de arquivos como filmes, gravações sonoras, e documentos
de texto em vez de apenas imagens.
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2. Adicionar novo tipo de arquivo: Adiciona um novo tipo de arquivo com uma extensão única e o caminho
para o aplicativo poder abrí-lo.

3. ** Excluir linha atual **: Exclui o tipo de arquivo em destaque na tabela e definido por uma extensão de
arquivo e um caminho para um aplicativo associado.

20.6.2 Especificando o local e o nome de uma fotografia

O local e o nome da fotografia podem ser armazenados usando um caminho absoluto ou relativo, ou um URL se
a fotografia está disponível em um servidor web. Exemplos das diferentes abordagens estão listadas na Tabela
eVis_examples ‘‘ _.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

20.6.3 Especificando o local e o nome de outros documentos suportados

Documentos comprovativos tais como documentos de texto, videos e clipes de som podem ser exibidos ou execu-
tados pelo eVis. Para fazer isso, é necessário adicionar uma entrada na tabela de referência do arquivo que pode
ser acessada do :guilabel‘Configurar Aplicação Externa‘ janela no :guilabel‘Navegador de Evento Genérico‘ que
corresponde a extensão da aplicação que pode ser utilizado para abrir o arquivo. É preciso também ter o caminho
da URL ou do arquivo que contém a tabela de atributos para a camada vetorial. Uma regra adicional pode ser
utilizada para URLs que não contém uma extensão de arquivo para o documento. O formato é extension:URL‘‘.
A URL é precedida pela extensão do arquivo e dois pontos; isto é particularmente útil para acessar documentos de
wikis e outros sites da web que usem banco de dados para administrar páginas da web (veja Tabela evis_examples).

20.6.4 Usando o Navegador de Evento

Quando a janela Navegador de Evento abre, uma fotografia aparecerá na janela de exibição se o documento
referenciado no arquivo vetor tabela de atributos é uma imagem e se a informação do local do arquivo na janela
:guilabel‘Opções‘ está configurado corretamente. Se a fotografia é esperada e não aparece, será necessário ajustar
os parâmetros na janela :guilabel‘Opções‘.

Se um documento de apoio (ou uma imagem que não tem uma extensão de arquivo reconhecida pelo eVis) está
referenciada na tabela de atributos, o campo contendo a extensão do arquivo estará destacado em verde na janela
de informação de atributo se esta extensão do arquivo é definido na tabela de referência do arquivo localizado
na janela Configurar Aplicativos Externos. Para abrir o documento, dois cliques na linha destacada em verde na
janela de atributo da informação. Se um documento de apoio é referenciado na janela de informação de atributo
e o arquivo não está destacado em verde, então será necessário adicionar uma entrada para a extensão de arquivo
do arquivo na janela Configurar Apicativos Externos. Se o caminho do arquivo está destacado em verde mas não
abre quando é clicado duas vezes, será necessário ajustar os parâmetros na janela Opções então o arquivo pode ser
localizado pelo eVis

Se nenhuma bússola é fornecida pela janela Opções, um asterisco vermelho será exibido no topo do vetor car-
acterístico que está associado com a fotografia exibida. Se uma bússola é fornecida, então uma seta aparecerá
apontando na direção indicada pelo valor da bússola exibida no campo na janela Navegador de Evento. A seta
será centrada sobre o ponto que é associada com a fotografia ou outro documento.

Para fechar o Event Browser window, clique no botão [Fechar] no Exibir janela.
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20.6.5 Ferramenta ID de Evento

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Iniciando o módulo Identificação de Evento

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the Navegador de Evento section of this guide.

20.6.6 Conexão com o Banco de Dados

O módulo ‘Conexão de Banco de Dados’ fornece ferramentas para conectar e consultar o banco de dados ou outro
recurso ODBC, como uma planilha

eVis pode realizar conexões diretas com os seguintes tipos de bancos de dados: PostgreSQL, MySQL e SQLite;
ele também pode ler a partir de conexões ODBC (por ex., MS Access). Ao ler a partir de um banco de dados
ODBC (como uma planilha do Excel), é necessário configurar o driver ODBC para o sistema operacional que
você está usando.

Inicia o módulo Conexão com a Base de Dados

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectar a um banco de dados

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Digite o local hospedado do banco de dados na caixa de texto :guilabel: ‘Local do Banco de Dados‘. Esta opção
não estará disponível se você tiver selecionado ‘MS Access’ como o tipo de banco de dados. Se o banco de dados
reside em seu desktop, você deve digitar “localhost”.

Entre o nome do banco de dados na caixa de texto Nome Banco de Dados . Se você selecionou ODBC como tipo
de banco de dados, você precisa introduzir o nome da fonte de dados.

Quando todos os parâmetros são preenchidos, clique no botão ** [Connect] **. Se a conexão for bem sucedida,
uma mensagem será gravada na janela :guilabel: Console de saída informando que a conexão foi estabelecida. Se
uma conexão não foi estabelecida, você precisará checar os parâmetros que foram inseridos anteriormente.

1. Tipo de Base de dados: Uma lista suspensa para especificar o tipo de base de dados que será usado.

2. Banco de dados hospedeiro: O nome do banco de dados hospedeiro.

3. Porta: O numero da porta se uma base de dados MySQL ou PostgreSQL for selecionada.
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Figure 20.13: A janela de conexão do banco de dados do “eVis”

4. Nome do banco de dados: O nome do banco de dados.

5. Conectar Um botão para conectar-se a banco de dados usando os parâmetros definidos acima.

6. Console de Saída A janela do console onde as mensagens relacionadas ao processamento são exibidos.

7. Nome de Usuário: Nome de usuário para uso quando uma base de dados é protegida por senha.

8. Senha: Senha para uso quando um banco de dados é protegida por senha.

9. Consultas pré-definidas: Guia para abrir a janela “Consultas pré-definidas”.

10. **Conexão com o banco de dados **: Guia para abrir a janela “Conexão com o Banco de dados”.

11. Consulta SQL: Guia para abrir a janela “Consulta SQL”.

12. Ajuda: Mostra a ajuda online.

13. OK: Fecha a janela principal do “Conexão com o Banco de Dados”.

Execução de consultas SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Clique no botão ** [Executar Consulta] ** para executar o comando. Se a consulta for bem sucedida, a janela
Seleção de Arquivo de Banco de Dados será exibida. Se a consulta não for bem sucedida, uma mensagem de erro
aparecerá na janela Console de Saída.

362 Chapter 20. Complementos

http://www.w3schools.com/sql


QGIS User Guide, Versão 2.14

No Seleção de arquivo do banco de dados‘janela, insira o nome da camada que será criada a partir dos resultados
da consulta na caixa de texto :guilabel:‘Nome da Nova Camada .

Figure 20.14: A tabela de consulta SQL do eVis

1. Janela de Texto de Consulta SQL: Uma tela para escrever consultas SQL.

2. Executar consulta: Botão que executa a consulta no SQL Janela de Consulta.

3. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

4. Ajuda: Mostra a ajuda online.

5. OK: Fecha o principal Conexão banco de dados janela.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Dica: Criando uma camada vetorial a partir de uma planilha do Microsoft Excel
When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.
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Executando consultas pré-definidas

Com consultas predefinidas você pode selecionar consultas previamente escritas e armazenadas no formato XML
em um arquivo. Isto é particularmente útil se você não estiver familiarizado com os comandos SQL. Clique na
guia :guilabel:‘Consultas Predefinidas’ para exibir a interface de consulta pré definida.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Selecione a consulta que você deseja executar no menu suspenso e, então clique em aba Consulta SQL para ver
se a consulta foi carregada na janela Consulta. Se for a primeira vez que você estiver executando uma consulta
predefinida ou estiver migrando bancos de dados, você precisa ter certeza de estar conectado ao banco de dados.

Clique no botão [Executar Consulta] na aba SQL Consulta para executar o comando. Se a consulta é bem
sucedida, a janela Seleção do Banco de Dados do Arquivo será exibida. Se a consulta não for bem sucedida, uma
mensagem de erro aparecerá na janela Console de Saída

Figure 20.15: A guia de Consultas Pré-definidas do “eVis”

1. Abrir Arquivo: Inicia o navegador de arquivos “Abrir Arquivo” para procurar pelo arquivo XML mantendo
as consultas pré-definidas.

2. Consultas Pré-definidas: Uma lista suspensa com todas as consultas definidas pelo arquivo XML de con-
sultas pré-definidas

3. Consulta descrição: Uma breve descrição da consulta. Esta descrição é do arquivo consultas prédefinida
XML.

4. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

5. Ajuda: Mostra a ajuda online.
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6. OK: Fecha a janela principal do “Conexão com o Banco de Dados”.

Formato XML para consultas predefinidas eVis

As marcas XML lidas por eVis

Marcas Descrição
Consulta Define o início e o fim de uma instrução de consulta.
Descrição Breve Uma pequena descrição da consulta que aparece no menu suspenso do eVis
Descrição Uma descrição mais detalhada da consulta exibida na janela de texto Consulta

Predefinida.
Tipo de Base de
Dados

O tipo de banco de dados, definido no menu suspenso Tipo de Banco de Dados na guia
Conexão Banco de Dados

Porta da Base de
Dados

O porto tal como definido na caixa de texto Porto na aba Conexão Banco de Dados

Nome da Base de
Dados

O nome do banco de dados como definido na caixa de texto Nome Banco de Dados na
aba Conexão Banco de Dados

Nome de Usuário
da Base de Dados

O nome de usuário do banco de dados como definido na caixa de texto na aba Conexão
de Banco de Dados

Senha de Base de
Dados

A senha do banco de dados como definida na caixa de texto Senha na aba Conexão
Banco de dados

Instrução SQL O comando SQL.
autoconexão Uma bandeira (“verdadeira” ou “falsa”) para especificar as classificações acima deverá

ser usada para conectar automaticamente o banco de dados sem executar a conexão de
rotina na aba banco de Dados

Um exemplo de arquivo XML completo com três consultas é exibido abaixo:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>
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<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

20.7 Complemento fTools

O objetivo do módulo python fTools é fornecer um recurso único para várias tarefas SIG comuns aos dados
vetoriais, sem a necessidade de software adicional, bibliotecas, ou trabalho complexo. Fornece um conjunto em
crescimento de formas de gestão de dados espaciais e funções de análise que são rápidas e funcionais.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (see Diálogo de Complementos). When enabled, the fTools plugin
adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to Geometry and
Geoprocessing Tools, as well as several useful Data Management Tools.

20.7.1 Ferramentas de análise

ÍconeFerramenta Finalidade

Matriz de
Distância

Medir distâncias entre dois pontos de uma camada, os resultados saem como a)
matriz de distâncias quadrada, b) matriz de distância linear, ou c) Síntese de
distâncias. Pode limitar distâncias com as características mais próximas de k.

Soma de
comprimento
de linhas

Calcular a soma total dos comprimentos das linhas para cada polígono de uma
camada vetorial do tipo polígono.

Pontos no
polígono

Conta o número de pontos que existem em cada polígono de uma camada de entrada
do tipo vetorial poligonal.

Lista valores
únicos

Origina uma lista de valores únicos num campo de uma camada vetorial.

Estatísticas
básicas

Calcular estatísticas básicas (média, std dev, N, soma, CV) em um campo de
entrada.

Análise de
Vizinhança

Calcula as estatísticas de vizinho mais próximo avaliando o nível de agrupamento
numa camada de pontos vetorial

Coordenada(s)
média(s)

Calcular o centro médio ponderado normal ou inteiro de uma camada vetorial, ou de
várias feições com base em um campo exclusivo de identificação.

Interseções de
linhas

Localizar cruzamentos entre as linhas, e as feições de uma outra shapefile. Útil para
localizar cruzamentos ou fluxo, ignora cruzamentos de linha com comprimento > 0.

Table Ftools 1: Ferramentas de análise fTools
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20.7.2 Ferramentas de pesquisa

Ícone Ferramenta Finalidade

Seleção aleatória Seleciona aleatoriamente n números de elementos, ou n percentagem de
elementos.

Seleção aleatória
dentro de
subconjuntos

Selecionar aleatoriamente feições dentro de subconjuntos com base em um
campo exclusivo de identificação.

Pontos aleatórios Gerar pseudo-pontos aleatórios sobre uma camada de entrada.

Pontos regulares Gerar uma grade regular de pontos ao longo de uma região determinada e
exportá-los como um shapefile de pontos.

Grade vetorial Gera uma grelha de linhas ou polígonos baseada num espaçamento específico
dado pelo utilizador.

Selecionar pela
localização

Selecionar feições com base na sua localização em relação a uma outra
camada, para formar uma nova seleção, adicionar ou subtrair da seleção atual.

Polígono a partir da
extensão da camada

Criar uma camada com um único polígono retangular a partir da extensão de
uma camada de entrada raster ou vetorial.

Tabela fTools 2: Ferramentas de Pesquisa fTools

20.7.3 Ferramentas de geoprocessamento

Ícone Ferramenta Finalidade

Forma(s)
convexa(s)

Criar o mínimo de forma(s) convexas em uma camada de entrada, ou com base
em um campo de ID.

|borda|
Borda(s) Criar borda(s) em torno de feições com base em distâncias, ou em um campo de

distância.

|inter-
secção|

Interseção Intersectar sobreposição de camadas de forma que a saída contém áreas onde
ambas as camadas se cruzam.

|união|
União Sobreposição de camadas de forma que a saída contém a interseção e

não-interseção de áreas.

Diferença
simétrica

Sobreposição de camadas de forma que a saída contém tanto as áreas que não se
intersectam da entrada e das camadas de diferença.

|cor-
tar|

Cortar Sobreposição de camadas de forma que a saída contém áreas que se cruzam a
camada de corte.

Diferença Sobreposição de camadas de forma que a saída contém áreas que não cruzam a
camada de corte.

Dissolver Mesclar feições com base no campo de entrada. Todas as feições com valores
idênticos de entrada são combinadas para formar uma única feição.

|elimi-
nar|

Elimine
polígonos
prateados

Merges selected features with the neighboring polygon with the largest area or
largest common boundary.

Tabela fTools 3: Ferramentas de Geoprocessamento fTools
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20.7.4 Ferramentas de Geometria

ÍconeFerramenta Finalidade

Verificar validade
da geometria

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behavior. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Exportar/Adicionar
geometrias de
colunas

Adicionar Informações de geometrias vetoriais em camadas do tipo ponto
(xCoord, yCoord), linha (comprimento), ou polígono (área, perímetro).

Centróides de
polígonos

Calcular os centróides reais para cada polígono em uma camada de entrada do
tipo polígono.

Triangulação de
Delaunay

Calcula e produz uma saída baseada na triangulação de Delaunay (como
polígonos) de uma camada de pontos vetorial.

Polígonos de
Voronoi

Calcula polígonos de Voronoi de uma camada de pontos vetoriais.

Simplificar
geometrias

Generalizar linhas ou polígonos com o algoritmo de Douglas-Peucker.

Densificação de
geometria

Adensa linhas ou polígonos através de adição de vértices.

Densificar
geometrias

Converter feições de várias partes para feições de partes individuais . Cria
polígonos e linhas simples.

Multipartes para
partes simples

Mesclar várias feições para uma única feição multipartes baseada em um campo
exclusivo de identificação.

Polígonos para
linhas

Converte polígonos para linhas, polígonos multipartes para várias linhas de
partes únicas.

Linhas para
polígonos

Converte linhas para polígonos, linhas multipartes para polígonos de partes
simples.

Extração de nós Extrair nós de camadas do tipo linhas e polígonos, de forma a resultar camadas
de pontos.

Tabela fTools 4: ferramentas de Geometrias fTools

Nota: A ferramenta Simplificar geometrias pode ser usada para remover nós duplicados em geometrias de linhas
e polígonos, faça este truque definindo o parâmetro Tolerância de generalização para 0.
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20.7.5 Ferramentas de gerenciamento de dados

ÍconeFerramenta Finalidade

Definir a
projeção atual

Especificar o SRC para o arquivo shape cujo SRC não foi definido.

Unir atributos
por
localização

Unir atributos adicionais a camada vetorial com base na relação espacial. Os
atributos de uma camada vetorial são anexados à tabela de atributos de uma outra
camada e exportados como um shapefile.

Dividir
camada
vetorial

Dividir uma camada de entrada em várias outras camadas distintas com base em um
campo de entrada.

Juntar em um
shapefile

Mesclar várioss shapefiles dentro de uma pasta para um novo shapefile com base no
tipo de camada (ponto, linha, área).

Criar índices
espaciais

Cria um índice espacial para os formatos OGR suportados.

Tabela fTools 5: ferramentas de gerenciamento de dados fTools

20.8 Complemento Ferramentas GDAL

20.8.1 O que são as Ferramentas GDAL?

O complemento Ferramentas GDAL oferece uma coleção GUI de ferramentas da Biblioteca de Abstração de Da-
dos Geoespaciais, http://gdal.osgeo.org . Estas são ferramentas de gerenciamento raster para consultar, reprojetar,
torcer e unir um conjunto variado de formatos raster. Inclui também ferramentas para criar camadas de contornos
(vetor), ou relevos sombreados a partir de MDT matriciais, e para fazer um vrt (Virtual Raster Tile em formato
XML) a partir de uma coleção de um ou mais arquivos raster. Estas ferramentas estão disponíveis quando o
complemento está instalado e ativado.

Biblioteca GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDAL Tools plugin offers an easy interface to the tools, exposing only the most popular options.

20.8.2 Lista das ferramentas GDAL

Figure 20.16: Lista do menu Ferramentas GDAL
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Projeções

Warp
(Reproject)

Este utilitário serve para os mosaicos de imagem, reprojeção e torções. O programa pode
reprojetar para qualquer projeção suportada, e pode também ser aplicado a PC armazenados
na imagem se a imagem tiver dados em “bruto” com controlo da informação. Para mais
informação pode ler no sítio na internet do GDAL http://www.gdal.org/gdalwarp.html.

Assign
projection

Esta ferramenta permite definir uma projeção para os rasters que estão georeferenciados mas
não têm a informação da projeção. Com isto também ajuda na possibilidade de alterar a
definição de uma projeção atual. Tanto o modo arquivo único como o modo batch são
suportados. Para mais informações, visite a página do utilitário no sítio na internet do GDAL,
http://www.gdal.org/gdalwarp.html.

Extract
projection

Este utilitário ajuda-o a extrair a informação da projeção de um arquivo de entrada. Se quiser
extrair a projeção do diretório pode usar o modo Batch. Irá criar os arquivos .prj e .wld .

Conversão

Rasterize
Este programa torna geometrias vetoriais (pontos, linhas e polígonos) em banda(s) de uma
imagem raster. Os vetores são lidos a partir de formatos OGR suportados. Repare que os dados
do vetor devem ser do mesmo sistema de coordenadas que os dados rasters; a projeção
“on-the-fly” não é fornecida. Para mais informação veja http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

Este utilitário cria polígonos vetoriais para todas as regiões de pixeis ligadas num matricial que
partilha um valor comum de pixel. Cada polígono é criado com um atributo que indica o valor do
pixel desse polígono. O utilitário irá criar um vetor de saída se não existir, por defeito em
formato ESRI shapefile. Veja também http://www.gdal.org/gdal_polygonize.html.

Translate
Este utilitário pode ser usado para converter matriciais em diferente formatos, potencialmente
executa algumas operações como subconfigurações, amostragem, reescalonamento de pixeis no
processo. Para mais informações pode ler em http://www.gdal.org/gdal_translate.html

RGB
to PCT

Este utilitário irá computar uma tabela pseudo-cor optimizada para uma dada imagem RBG
usando um algoritmo da mediana cortado num histograma RGB de resolução reduzida. De
seguida converte a imagem numa imagem de pseudo-cor usando tabelas de cor. Esta conversão
utiliza o pontilhado de Floyd-Steinberg (erro de difusão) para maximizar a qualidade visual da
imagem de saída. Este utilitário é também descrito em http://www.gdal.org/rgb2pct.html

PCT
to RGB

Este utilitário irá converter uma banda de pseudo-cor num arquivo de entrada para um arquivo
RGB de saída do formato desejado. Para mais informação veja http://www.gdal.org/pct2rgb.html

Extração

Con-
tour

Este programa gera um arquivo de contornos vetoriais a partir de um modelo digital do terreno
(MDT) matricial. Pode encontrar mais informação em http://www.gdal.org/gdal_contour.html .

Clip-
per

Este utilitário permite o corte (extração de um subconjunto) usando um enquadramento selecionado
ou baseado no limite de um vetor. Mais informação pode ser encontrado em
http://www.gdal.org/gdal_translate.html.
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Análise

Sieve Este utilitário remove polígonos rasters mais pequenos que o tamanho de limiar (em pixeis)
fornecido e substitui-os com o valor do pixel mais alto do vizinho mais próximo. O
resultado pode ser escrito na banda raster existente, ou copiado para um novo arquivo. Para
mais informação veja http://www.gdal.org/gdal_sieve.html .

Near
Black

Este utilitário irá digitalizar a imagem e tentar definir todos os pixeis que existem perto do
preto (ou perto do branco) à volta do limite para exatamente preto (ou branco). Isto é usado
usualmente para “corrigir” perdas em fotos áreas comprimidas para que esses pixeis de cor
possam ser tratadas como transparentes nas operações de mosaico. Veja também
http://www.gdal.org/nearblack.html.

Fill
nodata

Este utilitário preenche as regiões raster selecionadas (usualmente conhecidas com áreas
sem valor) por interpolação de de pixeis validados à volta das bordas da área. Pode
encontrar mais informação em http://www.gdal.org/gdal_fillnodata.html .

Proximity Este utilitário gera um mapa de proximidade raster indicando a distância desde o centro de
cada pixel para o centro do pixel mais próximo identificado como pixel alvo. Os pixeis alvo
são os que estão presentes no raster inicial em que cada valor do pixel é definido como
valores pixeis alvo. Para mais informação veja http://www.gdal.org/gdal_proximity.html .

Grid (In-
terpolation)

Este utilitário cria um grade regular (raster) a partir da leitura de dados dispersos de um
fonte de dados OGR. Os dados de entrada serão interpolados para preencher os nós da grade
com valores, pode escolher vários métodos de interpolação. O utilitário também é descrito
no sítio na internet do GDAL http://www.gdal.org/gdal_grid.html .

DEM
(Terrain
models)

Ferramentas para analisar e visualizar MDT. Podem ser criados, relevos sombreados,
declives, exposições, relevo colorido, indíce de rugosidade do terreno, índice de posição
topográfica e mapas de irregularidades a partir de elevação raster GDAL suportadas. Para
mais informação poderá ler em http://www.gdal.org/gdaldem.html

Diversos

Build Virtual
Raster (Catalog)

Este programa constrói um VRT (Conjunto de Dados Virtual) que é um mosaico da lista
dos conjuntos de dados do GDAL. Veja também http://www.gdal.org/gdalbuildvrt.html .

Merge Este utilitário irá criar mosaicos de imagem a partir de um conjunto. Todas as imagens
devem ter o mesmo sistema de coordenadas e ter o mesmo número de bandas
correspondentes, mas podem ser sobrepostas, e em diferentes resoluções. Nas áreas de
sobreposição, a última imagem será copiada sobre as mais recentes. O utilitário é
também descrito em http://www.gdal.org/gdal_merge.html .

Information Este utilitário cria uma lista com várias informações sobre o conjunto de dados raster
GDAL suportado. Pode encontrar mais informação em
http://www.gdal.org/gdalinfo.html .

Build
Overviews

O utilitário gdaladdo pode ser usado para construir ou reconstruir imagem de
visualização para a maioria dos formatos suportados com um dos algoritmos de redução
de escala. Para mais informação veja http://www.gdal.org/gdaladdo.html .

Tile Index Este utilitário constrói um shapefile com o registo de cada arquivo raster de entrada, um
atributo contendo um nome do arquivo, e a geometria do polígono do limite do raster.
Veja também http://www.gdal.org/gdaltindex.html .

configurações das Ferramentas GDAL

Use este diálogo para incorporar suas variáveis GDAL.
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20.9 Complemento Verificador de Geometria

O “Geometry Checker” é um plugin de núcleo poderoso para verificar e corrigir a validade da geometria de uma
camada. A caixa de diálogo: guilabel: Geometry Checker mostra diferentes configurações agrupadas na primeira
guia (: guilabel:‘ Configurações ‘):

• Input vector layer: to select the layer to check. A Only selected features checkbox can filter the geometry
to the one selected.

• Geometry validity: give to the user the choice between Self intersections, Duplicate nodes, Polygon with
less than 3 nodes.

• Allowed geometry types: to allow only some geometry types like point, multipoint, line, multiline, polygon
and multipolygon.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

The Geometry Checker Plugin can find the following errors:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons

The following figure shows the different checks made by the plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:
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Figure 20.17: The Geometry Checker Plugin
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Figure 20.18: The Differents checks supported by the plugin
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• Merge with neighboring polygon with longest shared edge,

• Merge with neighboring polygon with largest area,

• Merge with neighboring polygon identical attribute value,if any, or leave as it

• Delete feature

• No action

Dica: Fix multiple errors
You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

Finally, you can choose which attribute to use when merging features by attribute value.

20.10 Geometry Snapper Plugin

The Geometry Snapper tool allows to align automatically the edges and vertices of one vector layer to the edges
and vertices of a second layer using a user defined tolerance.

The below interface shows the settings of this plugin. User needs to choose the layer to change (see input vector
layer) and the reference layers to snap to. A Maximum snapping distance (map units) allows to change the
snapping tolerance.

You can snap only selected feature(s) checking the Only selected features.

Output vector layer allows you to choose between Modifying input layer or Create a new layer.

Figure 20.19: The Geometry Snapper Plugin

20.11 Complemento Georreferenciador

O complemento Georreferenciador é uma ferramenta para gerar world files para rasters. Ele possibilita que você
possa referenciar rasters para sistemas de coordenadas projetadas ou geográficas através da criação de um novo
GeoTiff ou adicionando um world file à imagem existente. A georreferenciação do raster passa por uma abordagem
simples de localização de pontos no raster para que possa com precisão determinar as suas coordenadas.

Recursos
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Ícone Propósito Ícone Propósito

Abrir Raster Iniciar georreferenciamento

Gerar scrip GDAL Carregar pontos GCP

Salvar pontos GCP como Configurações de transformação

Adicionar ponto Excluir ponto

Mover ponto GCP Movimentar

Aproximar Afastar

Ver a camada Última visualização

Próxima visualização Link Georeferencer to QGIS

Link QGIS to Georeferencer Esticar totalmente o histograma

Esticar localmente o histograma

Tabela Georreferenciador 1: Ferramentas do georreferenciador.

20.11.1 Procedimento comum

Dois procedimentos alternativos podem ser usados, para adicionar as coordenadas X e Y (DMS (dd mm ss.ss),
DD (dd.dd)) ou coordenadas projetadas (mmmm.mm) que correspondem aos pontos selecionados na imagem:

• O raster as vezes apresenta cruzes, marcas fiduciais, com coordenadas “escritas” na imagem. Neste caso,
você pode introduzir as coordenadas manualmente.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

O procedimento habitual para o georreferenciamento de uma imagem consiste em selecionar múltiplos pontos no
raster, especificar suas coordenadas e escolher o tipo de transformação mais apropriado para o arquivo. Baseado
nos dados e parâmetros de entrada, o complemento irá computar os parâmetros do arquivo world ou então criar
um novo GeoTIFF. Quanto mais pontos de controle (coordenadas) forem informados, melhor será o resultado do
processo.

The first step is to start QGIS, load the Georeferencer Plugin (see Diálogo de Complementos) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.

Para este exemplo, estamos a usar uma carta militar do Sul de Dakota do SDGS. Pode ser visualizada mais tarde
juntamente com a informação proveniente da localização do GRASS spearfish60 . Você pode baixaarr a carta
militar aqui: http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Entrando com pontos de controle GCPs (Ground Control Points)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Clique em determinado ponto da imagem raster e entre com suas coordenadas X e Y manualmente.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.
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Figure 20.20: Janela do Módulo Georeferenciador

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continue inserindo os pontos de controle. São necessários no mínimo 4 pontos ,espalhados pelas 4 pontas da
imagem„ e quanto mais pontos ,coordenadas, forem adicionados, melhor será o resultado obtido. Existem
ferramentas adicionais na caixa de diálogo do complemento para usar o zoom e pan na tela a fim de que seja
possível localizar um conjunto de possíveis GCPs.

Figure 20.21: Adicionar pontos à imagem raster

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.

Definindo as configurações de transformação

Depois que os pontos GCP estão devidamente adicionados à imagem raster, é necessário definir as configurações
de transformação para o processo de georreferenciamento.

20.11. Complemento Georreferenciador 377



QGIS User Guide, Versão 2.14

Figure 20.22: Definindo as configurações de transformação do georeferenciador

Algoritmos de transformação disponíveis

Dependendo da quantidade de pontos de controle capturados, será possível a utilização de diferentes algoritmos de
transformação. A escolha de um desses algoritmos também depende do tipo e da qualidade dos dados de entrada
inseridos e a quantidade de distorção geométrica que se está disposto a introduzir no resultado final.

Atualmente, os seguintes Tipos de transformação estão disponíveis:

• O algoritmo Linear é usado para criar o world-file, e é diferente dos outros algoritmos, e não transforma
verdadeiramente o raster. Este algoritmo provavelmente não será suficiente se estiver trabalhando com
material digitalizado.

• A transformação de Helmert executa um simples escalonamento e transformações de rotação.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves collinearity and allows scaling, translation and rotation only.

• O algoritmo Suavizador em Lâminas Finas (TPS) é o método mais moderno de georreferenciamento, que
permite introduzir deformações locais nos dados. Este algoritmo é útil quando originais de baixa qualidade
estão a ser georreferenciados.

• A transformação Projectiva é uma rotação linear e de translação de coordenadas.

Definindo o método de reamostragem

O tipo de amostragem que escolhe irá depender dos seus dados de entrada e do objetivo do exercício. Se não
quiser mudar as estatísticas da imagem, deverá escolher ‘Vizinho mais próximo´, uma vez que que a ‘Amostragem
cúbica’ irá fornecer um resultado mais suavizado.

No QGIS, é possível escolher entre 5 diferentes métodos de reamostragem:

1. Vizinho mais próximo

2. Linear
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3. Cúbico

4. Cúbico suavizado

5. Lanczos

Definindo as configurações de transformação

Existem várias opções que devem ser definidas para o arquivo raster (georreferenciado) de saída.

• A caixa de verificação Criar world file está apenas disponível se decidir usar o tipo de transformação
linear, pois significa que a sua imagem raster atualmente não será transformada. Nesse caso, o campo Raster
de Saída não está ativo, porque apenas será criado um novo world-file.

• Para outro tipo de transformação você necessita definir um Raster de Saída. Por padrão um novo arquivo
([filename]_modified) será criado na mesma pasta junto da imagem raster original.

• Como próximo passo, necessitamos definir SRC (Sistema de Referência Espacial) para o raster georrefer-
enciado (veja seção Trabalhando com Projeções).

• Também é possível gerar um mapa em pdf e também um Relatório pdf. O relatório inclui informações
sobre os parâmetros de transformação utilizados, além de uma imagem dos resíduos e uma lista com todos
os GCPs e seus erros RMS.

• Além disso, é possível ativar a caixa de diálogo Acertar a definição de saída e definir a resolução dos
pixels do raster de saída. Como padrão, as resoluções horizontal e vertical são iguais a 1.

• A caixa Use 0 para transparência quando necessário pode ser ativada, caso os pixels com valor 0 devam
ser visualizados como transparentes.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Mostrando e adaptando as propriedades do raster

Clicando no menu Propriedades do raster dialog in the Settings abrirá a caixa de diálogo com as propriedades do
raster que será georreferenciado.

Configurando o georreferenciador

• You can define whether you want to show GCP coordinates and/or IDs.

• Podem ser definidas como unidades residuais pixels e unidades do mapa.

• Para o relatório PDF podem ser definidas as margens direita e esquerda e também o tamanho do papel para
o mapa PDF.

• Por último, também pode-se ativar a caixa Mostrar a janela do Georreferenciador ancorada

Iniciando a transformação

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.
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20.12 Complemento Mapa de Densidade

The Heatmap plugin uses Kernel Density Estimation to create a density (heatmap) raster of an input point vector
layer. The density is calculated based on the number of points in a location, with larger numbers of clustered
points resulting in larger values. Heatmaps allow easy identification of “hotspots” and clustering of points.

20.12.1 Ativar o complemento Mapa de Densidade

Primeiro esse complemento nativo precisa ser ativado usando o Gerenciador de Complementos (veja: ref: manag-

ing_plugins). Após a ativação, o ícone heatmap pode ser encontrado na barra de ferramentas Raster, no menu
Raster → Mapa de calor.

Selecione o menu Exibir → Barra de Ferramentas → Raster para exibir a Barra de Ferramentas Raster se não
estiver visível.

20.12.2 Usando o complemento Mapa de Densidade

Ao clicar no botão da ferramenta |hetmap| Mapas de Densidade abre a janela do complemento Mapas de Densi-
dade (veja figure_heatmap_2).

A janela tem as seguintes opções:

• Camada de entrada de pontos: Apresenta todas as camadas de pontos vetoriais no projeto atual e é usado
para selecionar a camada que vai ser analisada.

• Output raster: Allows you to use the button to select the folder and filename for the output raster
the Heatmap plugin generates. A file extension is not required.

• Output format: Selects the output format. Although all formats supported by GDAL can be chosen, in
most cases GeoTIFF is the best format to choose.

• Raio: usado para especificar o raio de pesquisa (ou largura do kernel) do mapa de densidade em metros ou
em unidades de mapa. O raio especifica a distância em torno de um ponto no qual se fará sentir a influência
do ponto. Os valores altos resultam em maior suavização, mas valores pequenos podem mostrar detalhes
finos e a variação da densidade de pontos.

Quando a caixa de verificação Advançada é ativada, opções adicionais serão disponibilizadas:

• Linhas e Colunas: usada para mudar as dimensões do raster de saída. Esses valores estão também ligados
aos valores Tamanho de célula X e Tamanho de célula Y. Aumentando o número de linhas ou colunas irá
diminuir o tamanho de célula e aumenta o tamanho do arquivo de saída. Os valores nas Linhas e Colunas
também estão ligados, portanto duplicando o número de linhas irá automaticamente duplicar o número de
colunas e o tamanho da célula irá passar para metade. A área geográfica do raster de saída irá ser o mesmo!

• Tamanho da célula X e Tamanho da célula Y: controle o tamanho geográfico de cada pixel para o raster
de saída. Alterando estes valores irá também mudar o número de Linhas e Colunas do raster de saída.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Taxa de decaimento: pode ser usado com kerneis triangulares para maior controlo de como a densidade a
partir dos elementos decrescem com a distância a partir do elemento.

– O valor de 0 (=mínimo) indica que a densidade irá ser concentrada no centro do raio dado e será extinto
no borda.

– O valor de 0.5 inca que esses pixeis da borda do raio serão atribuídos metade da densidade dos pixeis
que estão no raio do centro de pesquisa.
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– O valor de 1 refere que a densidade espalha-se por todo o raio do circulo de pesquisa. (Isto é equiva-
lente ao kernel ‘Uniforme’).

– Um valor maior que 1 indica que a densidade é mais alta para a borda do raio de pesquisa, e em
seguida, no centro.

A camada de pontos de entrada pode ter também campos de atributos que podem afetar como influencia o mapa
de densidade:

• Usar o raio a partir do campo: define o raio de pesquisa para cada elemento da camada de entrada.

• Usar o peso a partir do campo: permite a introdução de elementos para ser pesado por um campo de
atributo. Isto pode ser usado para aumentar a influência de certos elementos existente no resultado de mapa
de densidade.

Quando o nome do arquivo raster de saída é especificado, o botão [OK] pode ser usado para criar o mapa de
densidade.

20.12.3 Tutorial: Criando um Mapa de Densidade

For the following example, we will use the airports vector point layer from the QGIS sample
dataset (see Amostra de Dados). Another excellent QGIS tutorial on making heatmaps can be found at
http://www.qgistutorials.com.

Na Figure_Heatmap_1 estão demonstrados os aeroportos do Alaska.

Figure 20.23: Airports of Alaska

1. Selecione o botão da ferramenta |hetmap| Mapa de Densidade para abrir a janela do complemento Mapas
de Densidades (veja Figure_heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).
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4. Deixe o Formato de Saída o formato GeoTIFF como padrão.

5. Altere o Raio para 1000000 metros.

6. Clique em [OK] e carregue o mapa de temperatura dos aeroportos (veja Figure_Heatmap_3).

Figure 20.24: The Heatmap Dialog

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

1. Abra a janela de propriedades da camada do heatmap_airports (selecione a camada
heatmap_airports, abre o menu de contexto com o botão direito do rato e selecione Propriedades).

2. Selecione o separador Estilo.

3. Change the Render type to ‘Singleband pseudocolor’.

4. Select a suitable Color map , for instance YlOrRed.

5. Clique no botão [Carregar] para recolher os valores mínimos e máximos para cada raster, e depois clique
no botão [Classificar].

6. Pressione [OK] para atualizar a camada.

O resultado final é demonstrado na Figure_Heatmap_4.

20.13 Complemento de Interpolação

The Interpolation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.
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Figure 20.25: The heatmap after loading looks like a grey surface

Figure 20.26: Styled heatmap of airports of Alaska
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• Atributo de interpolação: Selecione a coluna do atributo que será usado para interpolação ou habilite a

caixa de seleção Use Z-Coordenada

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’. With the TIN method you can create a surface formed by
triangles of nearest neighbor points. To do this, circumcircles around selected sample points are created
and their intersections are connected to a network of non overlapping and as compact as possible triangles.
The resulting surfaces are not smooth. When using the IDW method the sample points are weighted during
interpolation such that the influence of one point relative to another declines with distance from the unknown
point you want to create. The IDW interpolation method also has some disadvantages: the quality of the
interpolation result can decrease, if the distribution of sample data points is uneven. Furthermore, maximum
and minimum values in the interpolated surface can only occur at sample data points. This often results in
small peaks and pits around the sample data points.

• Configure Interpolation Method: Configure the interpolation method you have chosen. For the TIN
method you can choose between Linear and Clough Toucher (cubic) interpolation methods. You can also
save the triangulation in shapefile format. For IDW interpolation you can set the distance coefficient.

• Número de colunas/linhas: Especifique o número de linhas e colunas para o aquivo raster de saída.

• Arquivo de Saída: Define o nome do arquivo raster de saída.

• :guilabel:‘Adicionar resultado ao projeto ‘ para carregar o resultado na tela do mapa.

Note that using lines as constraints for the interpolation the triangulation (TIN method) you can either use ‘struc-
ture lines’ or ‘break lines’. When using ‘break lines’ you produce sharp breaks in the surface while using ‘structure
lines’ you produce continuous breaks. The triangulation is modified by both methods such that no edge crosses a
breakline or structure line.

Figure 20.27: Complemento de Interpolação

20.13.1 Usando o complemento

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see Diálogo de Complementos) and click on the Raster

→ Interpolation → Interpolation menu, which appears in the QGIS menu bar. The Interpolation plugin
dialog appears as shown in Figure_interpolation_1.

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Selecione um método de interpolação (ex.: ‘Triangulated Irregular Network (TIN)’), e especifique um
tamanho de célula de 5000 e um bom nome de arquivo raster de saída (ex.: elevation_tin).
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5. Clique [OK].

20.14 Catálogo do Cliente MetaBusca

20.14.1 Introdução

MetaBusca é um complemento QGIS para interação com serviços de catálogos de metadados, suportando Serviços
de Catálogo OGC para Web padrão (CSW).

MetaBusca provem um fácil e intuitivo acesso e interface usuária-amiga para pesquisar catálogos de metadados
através do QGIS.

20.14.2 Instalação

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Instale o MetaBusca através do Gerenciador e Instalador de Complementos do QGIS, ou manualmente pelo
http://plugins.qgis.org/plugins/MetaSearch.

20.14.3 Trabalhando com Catálogos Metadado no QGIS

CSW (Catalogue Service for the Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse and query metadata about data, services, and other potential resources.
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Iniciando

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Gerenciador de serviços do Catálogo

Figure 20.28: Gerenciador de serviços do Catálogo

The Services tab allows the user to manage all available catalogue services. MetaSearch provides a default list of
Catalogue Services, which can be added by pressing [Add default services] button.

Para todas as entradas de Serviços do Catálogo listadas, clique para Selecioná-la na caixa suspensa.

To add a Catalogue Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalogue Service entry, select the entry you would like to delete and click the [Delete] button. You
will be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
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<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalogue Service such as service
identification, service provider and contact information. If you would like to view the raw XML response, click
the [GetCapabilities response] button. A separate window will open displaying Capabilities XML.

Buscar Catálogo de Serviços

Figure 20.29: Searching catalogue services

The Search tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

Os seguinte parâmetros de pesquisa estão disponíveis:

• Keywords: free text search keywords

• From: the Catalogue Service to perform the query against

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, guilabel:Ymax, and guil-
abel:Ymin. Click [Set global] to do a global search, click [Map extent] to do a search on the visible area
only or manually enter custom values as desired
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Clicking the [Search] button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Clicking a result will provides the following options:

• se o registo de metadados tem uma caixa delimitadora associada, uma pegada de caixa delimitadora será
exibida no mapa

• duplo clique nos resultados abrirá a tela com o registro de medados com seus links de acesso. Clicando nos
links abrirá o link em seu navegador web

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear

Figure 20.30: Metadata record display

Configurações

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page. Default value
is 10

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10
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Figure 20.31: Metasearch setting

20.15 Complemento Edição Offiine

Para a coleta de dados, é comum a situação de trabalhar com um laptop ou um telefone celular offline no campo.
Ao retornar para a rede, as mudanças precisam ser sincronizadas com a fonte de dados mestre (por exemplo, um
banco de dados PostGIS). Se várias pessoas estão trabalhando simultaneamente no mesmo conjunto de dados, é
difícil de fundir as edições concomitantes, mesmo que as pessoas não mudam as mesmas características.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

20.15.1 Usando o complemento

• Abra algumas camadas de vetoriais (por exemplo, de base de dados PostGIS ou WFS-T).

• Salve isto como um projeto.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Edite as camadas offline.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.

20.16 Complemento GeoRaster Espacial Oracle

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:
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Figure 20.32: Criando de um projeto offline de camadas PostGIS ou WFS

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Isto irá carregar o raster para a tabela padrão GDAL_IMPORT table, como coluna designada de RASTER.

20.16.1 Gerenciando conexões

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Diálogo de Complementos).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains

the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Nome: Entre um nome para a conectar a base de dados.

• Instância base de dados: Entre o nome da base de dados que você irá conectar.

• Nome do usuário: Especifique o seu próprio nome de usuário que você usará para acessar o banco de
dados.

• Senha: Fornecer a senha associada ao seu nome de usuário que é necessário para acessar o banco de dados.

Agora, volte à janela principal Oracle Spatial GeoRaster (veja Figure_oracle_raster_2), use a lista drop-down
para escolher uma conexão, e use o botão [Ligar] para estabelecer a conexão. Pode também [Editar] a conexão,
abrindo a janela anterior e efetuar alterações na informação da ligação, ou usar o botão [Apagar] para remover a
conexão da lista drop-down.
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Figure 20.33: Janela de Criação de Conexão Oracle

20.16.2 Selecionando um GeoRaster

Uma vez que uma conexão foi estabelecida, a janela subconjuntos vai mostrar os nomes de todas as tabelas que
contêm colunas GeoRaster nesse banco de dados no formato de um nome de subconjunto GDAL.

Clique num dos subconjuntos de dados listados em seguida clique em [Selecionar] para escolher o nome da tabela.
Agora, outra lista de subconjunto de dados irá mostrar os nomes das colunas GeoRaster nessa tabela. Geralmente
costuma ser uma lista pequena, uma vez que a maioria dos usuários não irá ter mais de uma ou duas colunas
GeoRaster na mesma tabela.

Clique em algum da lista e subconjuntos e depois clique em [Selecione] para escolher uma combinação de
tabela/coluna. A caixa de diálogo irá agora mostrar todas as linhas que contêm objetos GeoRaster. Note que
a lista subconjuntos irá agora mostrar a Tabela de Dados Raster e pares Id Raster.

A qualquer momento, a entrada de seleção podem ser editadas, a fim de ir diretamente para um GeoRaster con-
hecido ou para voltar ao início e selecionar um outro nome da tabela.

Figure 20.34: Janela de Seleção Oracle GeoRaster

A entrada dos dados de seleção também pode ser usado para inserir uma cláusula ONDE no final da
sequência de identificação (ex.: geor:scott/tiger@orcl,gdal_import,raster,geoid=). Ver
http://www.gdal.org/frmt_georaster.html para mais informações.
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20.16.3 Exibindo o GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

A janela Selecionar Oracle Spatial GeoRaster pode ser fechada agora e da próxima vez que se abrir, ela irá manter
a mesma conexão e irá mostrar a mesma lista de subconjuntos anterior, tornando-o muito fácil de abrir uma outra
imagem do mesmo contexto.

Nota: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated outside
of QGIS using Oracle PL/SQL or gdaladdo.

A seguir está um exemplo usando gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Este é um exemplo usando PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

20.17 Complemento Análise do Terreno

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Descrição das análises:

• Declividade: Calcula o ângulo de inclinação para cada célula em graus (com base na estimativa derivada
de primeira ordem).

• Aspecto: Exposição (começando com o 0 para direção norte, em graus anti-horário).

• Relevo Sombreado: Cria um mapa sombreado usando luz e sombra para proporcionar uma aparência mais
tridimensional para um mapa de relevo sombreado. O mapa de saída é uma única banda de cinza refletindo
o valor de cinza dos pixels.

• Índice de rugosidade: Uma medição quantitativa da heterogeneidade do terreno, tal como descrito por
Riley et al. (1999). É calculado para cada local, resumindo a mudança de altitude dentro da grade de pixeis
3x3.

• **Relevo*: Cria um mapa de relevo sombreado a partir de dados digitais de elevação. Implementado um
método para escolha das cores de elevação analisando a frequência de distribuição. O mapa de saída é uma
multibanda de cor com três bandas refletindo os valores RGB do relevo sombreado.

20.17.1 Usando o complemento

1. Start QGIS and load the gtopo30 raster layer from the GRASS sample location.

2. Carregue o complemento Análise Raster do Terreno no Gerenciador de Complementos (ver Diálogo de
Complementos).
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Figure 20.35: Complemento Modelagem Raster do Terreno (cálculo de declividade)

3. Selecione o método de análise a partir do menu (ex.: Raster → Análise de Terreno → Declividade). O
diálogo Declividade irá aparecer como mostra a Figure_raster_terrain_1.

4. Especifique um caminho de saída do arquivo, e o tipo de arquivo.

5. Clique [OK].

20.18 Complemento Menor Distância

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Figure 20.36: Complemento Menor Distância

Características principais:

• Calcula caminho, assim como o comprimento e tempo de viagem.
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• Otimiza pelo comprimento ou tempo de viagem.

• Exporta o caminho para camada vetorial.

• Destaca estradas direções (isto pode ser lento e usado principalmente para propósitos para o teste de config-
urações).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

Na tabela de atributos da camada, o campo a seguir pode ser usado:

• Velocidade no percurso rodoviário (campo número).

• Direção (qualquer tipo que possa ser convertido para texto). Frente e direções inversas correspondem a uma
via de única mão, ambas as direções indicam uma via de mão dupla.

Se alguns campos não têm qualquer valor ou não existem, os valores padrão serão usados. Você pode alterar os
padrões e algumas configurações do complemento na janela de configuração do complemento.

20.18.1 Usando o complemento

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

Figure 20.37: Road graph plugin settings

Depois de configurar a Unidade de tempo, Unidade de distância e Tolerância da topologia, você pode escolher a
camada vetorial na aba Camada de transporte. Aqui você também pode escolher o Campo de direção e Campo
de velocidade. Na aba Configurações padrão, você pode definir a Direção para o cálculo.

Finalmente, no painel Caminho mais curto, selecione um ponto de início e de fim na camada de rede de caminhos
e clique em [Calcular].
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20.19 Complemento de Consulta Espacial

The Spatial Query Plugin allows you to make a spatial query (i.e., select features) in a target layer with reference to
another layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Operações possíveis:

• Contém

• Igual

• Sobrepõe

• Cruza

• Intersecta

• Disjunto

• Toca

• Dentro

20.19.1 Usando complemento

Como exemplo, nós queremos encontrar as regiões no conjunto de dados do Alaska que contém os aeroportos. Os
seguintes passos são necessários:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see Diálogo de Complementos) and click on the
Spatial Query icon, which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Selecione a camada regions como camada fonte e airports como camada de elementos referência.

4. Selecione ‘Contém’ como operador e clique [Aplicar].

Agora obtém uma lista de elementos ID da consulta e tem várias opções como é mostrado na fig-
ure_spatial_query_1.

• Click on Create layer with list of items.

• Select an ID from the list and click on Create layer with selected.

• Select ‘Remove from current selection’ in the field And use the result to .

• Você pode Zoom no item ou exibição Mensagem de Log.

• Additionally in Result Feature ID’s with the options ‘Invalid source’ and ‘Invalid reference’ you can have a
look at features with geometry errors. These features aren’t used for the query.

20.20 Complemento Verificador de Topologia

Topologia descreve as relações entre pontos, linhas e polígonos que representam as feições de uma região geográ-
fica. Com o complemento Verificador de Topologia, você pode olhar sobre seus arquivos vetoriais e verificar a
topologia com várias regras de topologia. Estas regras verificam com as relações espaciais se suas característi-
cas ‘igual’, ‘contém’, ‘copia’, são ‘copiar para’, ‘Cruzar’, são ‘Disjunção’, ‘Interseção’, ‘Sobreposição’, ‘Toque’
ou são ‘Dentro’ entre si. Tudo depende das suas questões individuais que regras topológicas que você aplicar a
seus dados vetoriais (por exemplo, normalmente você não vai aceitar superação da camadas de linha, mas se eles
retratam ruas sem saída que você não vai removê-los de sua camada vetorial).

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.
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Figure 20.38: Spatial Query analysis - regions contain airports

Figure 20.39: O Complemento Verificador de Topologia

396 Chapter 20. Complementos



QGIS User Guide, Versão 2.14

É muito simples para criar regras topológicas com o complemento Verificador de Topologia

Nas camadas do tipo vetor as seguintes regras estão disponíveis:

• Deve ser coberto por: Aqui você pode escolher uma camada vetorial de seu projeto. Pontos que não forem
cobertos pela camada de dados vetorial ocorrem no campo ‘Erro’.

• Deve ser coberto por pontos finais: Aqui você pode escolher uma camada de linha de seu projeto.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• Não deve haver duplicados: Sempre que um ponto é representado duas vezes ou mais, vai ocorrer no
campo ‘Erro’.

• Não deve haver geometrias inválidas: Verifica se as geometrias são válidas.

• Não deve haver geometrias multi partes: Todos os pontos de multi partes estão escritos no campo ‘Erro’.

Em camadas de linha, as seguintes regras estão disponíveis:

• Pontos finais devem ser cobertos por: Aqui você pode selecionar uma camada de ponto a partir de seu
projeto.

• Não deve haver oscilação: Isto irá mostrar as superações na camada de linha.

• Não deve ter duplicações: Sempre que uma feição de linha for representada duas vezes ou mais, irá acusar
no campo ‘Erro’.

• Não deve haver geometrias inválidas: Verifica se as geometrias são válidas.

• Não deve haver geometrias multi partes: Às vezes, a geometria é realmente uma coleção de geometrias
simples (partes simples). Essa geometria é chamada geometria multi-parte. Se ela contém apenas um tipo
de geometria simples, chamamos isso de multi-ponto, multi-cadeia de linha ou multi-polígono. Todas as
linhas de várias partes estão escritas no campo ‘Erro’.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
pseudo node.

Em camadas de polígono, as seguintes as regras estão disponíveis:

• Deve conter: camada de polígono deve conter geometria em pelo menos um ponto da segunda camada.

• Não deve ter duplicações: Polígonos a partir da mesma camada não deve ter geometrias idênticas. Sempre
que um polígono é representado duas vezes ou mais irá ocorrer no campo ‘Erro’.

• Não deve ter lacunas: polígonos adjacentes não deve formar lacunas entre eles. Limites administrativos
poderiam ser mencionado como um exemplo (polígonos estaduais do BRASIL não possuem lacunas entre
eles...).

• Não deve ter geometrias inválidas: Verifica se as geometrias são válidas. Algumas das regras que definem
uma geometria válida são:

– Os anéis do polígono devem estar fechados.

– Anéis que definem buracos devem estar dentro de anéis que definem os limites exteriores.

– Os anéis não se podem intersectar a si mesmo (nem mesmo tocar ou cruzar um no outro).

– Os anéis não podem tocar outros anéis, à exceção de um ponto.

• Não deve ter geometrias multi partes: Às vezes, a geometria é realmente uma coleção de geometrias
simples (partes simples). Essa geometria é chamada geometria multi-parte. Se ele contém apenas um tipo de
geometria simples, chamamos isso de multi-ponto, multi-cadeia de linha ou multi-polígono. Por exemplo,
um campo constituído por múltiplas ilhas pode ser representado como um sistema multi-polígono.

• Não devem se sobrepor: polígonos adjacentes não devem compartilhar áreas em comum.

• Não deve sobrepor-se: polígonos adjacentes de uma camada não devem compartilhar áreas comuns com
polígonos de outra camada.
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20.21 Complemento Estatística Zonal

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). Choosing a color band, the plugin generates output columns in the vector layer with an
user-defined prefix and calculates for each polygon, statistics on pixels that are within. The available statistics are
:

• Count: to count the number of pixels

• Sum: para somar os valores de pixel

• Mean: to get the mean of pixel values

• Median: to get the median of pixel values

• StDev: to get the standard deviation of pixel values

• Min: to get the minimum of pixel values

• Max: to get the maximum of pixel values

• Range: to get the range (max - min) of pixel values

• Minority: to get the less represented pixel value

• Majority: to get the most represented pixel value

• Variety: to count the number of distinct pixel values

Figure 20.40: Zonal statistics dialog
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CHAPTER 21

Ajuda e Suporte

21.1 Listas de Discurssão

QGIS is under active development and as such it won’t always work like you expect it to. The preferred way to
get help is by joining the qgis-users mailing list. Your questions will reach a broader audience and answers will
benefit others.

21.1.1 Usuários QGIS

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

21.1.2 Lista fossgis-talk

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

21.1.3 Desenvolvedor QGIS

Se você é um desenvolvedor enfrentando problemas de natureza mais técnica, você pode querer se juntar a lista
de discussão qgis-desenvolvedor aqui: http://lists.osgeo.org/mailman/listinfo/qgis-developer

21.1.4 qgis-ux

A dedicated mailing list where people can chime in and collect and discuss QGIS related UX (User Experience) /
usability issues.

http://lists.osgeo.org/mailman/listinfo/qgis-ux

21.1.5 Atualizações QGIS

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit
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21.1.6 QGIS-trac

Esta lista fornece uma notificação de email relacionado a gerenciamento de projetos, incluindo re-
latórios de bugs, tarefas e solicitações de recursos. Você pode se inscrever para esta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-trac

21.1.7 Equipe da Comunidade QGIS

Esta lista trata de temas como a documentação, ajuda de contexto, guia do usuário, experiência online incluindo
sítios, blog, listas de discussão, fóruns e esforços de tradução. Se você gosta de trabalhar com o guia do usuário,
esta lista é um bom ponto de partida para fazer suas perguntas. Você pode se inscrever para esta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

21.1.8 Equipe de lançamento QGIS

Esta lista inclui tópicos como o processo de lançamento, pacotes binários para vários Sistemas Opera-
cionais e anúncios de novos lançamentos para o mundo em geral. Você pode se inscrever nesta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

21.1.9 Tradução do QGIS

This list deals with the translation efforts. If you like to work on the translation of the website, manuals or the
graphical user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list
at: http://lists.osgeo.org/mailman/listinfo/qgis-tr

21.1.10 Aprendizado QGIS

This list deals with QGIS education efforts. If you would like to work on QGIS education ma-
terials, this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

21.1.11 Comitê Diretor QGIS

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

21.2 IRC

Nós também marcamos presença no IRC - visite-nos acessando o canal # qgis em irc.freenode.net. Por favor,
aguarde pela resposta de sua pergunta. Como muitas pessoas no canal estão fazendo outras atividades isso pode
levar um tempo para para perceberem sua pergunta. Se perder a discussão no IRC, não tem problema! Nós
registamos toda a discussão, portanto é fácil estar atualizado. Vá a http://qgis.org/irclogs and read the IRC-logs.

Suporte comercial para o QGIS também está disponível. Verifique o website http://qgis.org/en/commercial-
support.html for more information.
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21.3 Rastreador de Erros

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.

Por favor tenha em atenção que o seu erro pode nem sempre ter a prioridade que deseja (vai depender da severi-
dade). Alguns erros podem requer esforços significativos de programadores para remediar e a mão-de-obra nem
sempre está disponível para isso.

Solicitações de recursos também podem ser enviadas usando o mesmo sistema de mensagem de erros. Por favor,
certifique-se de ter selecionado o tipo de recurso.

If you have found a bug and fixed it yourself, you can submit either a Pull Request on the Github QGIS Project
(prefered) or a patch also. The lovely redmine ticketsystem at http://hub.qgis.org/projects/quantum-gis/issues has
this type as well. Check the Patch supplied checkbox and attach your patch before submitting your bug.
One of the developers will review it and apply it to QGIS. Please don’t be alarmed if your patch is not applied
straight away – developers may be tied up with other commitments.

Note that if you supply a Pull Request, your change would be more likely be merged into the source code!

21.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

21.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

21.6 Wiki

E finalmente, nós mantemos uma página WIKI em http://hub.qgis.org/projects/quantum-gis/wiki onde você pode
encontrar uma variedade de informações úteis relacionada com o desenvolvimentos do QGIS, planos de lança-
mento, links para sites de transferência, mensagens de dicas de tradução entre outros. Visite, lá temos boas
explicações!
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CHAPTER 22

Apêndice

22.1 Licença Pública Geral GNU

Versão 2, Junho 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

É permitido a todos copiar e distribuir uma cópia desta documento da licença, porém não é permitido alterar esta.

Preâmbulo

As licenças de muitos software são desenvolvidas para restringir sua liberdade de compartilhá-lo e mudá-lo. Con-
trária a isso, a Licença Pública Geral GNU pretende garantir sua liberdade de compartilhar e alterar software
livres – garantindo que o software será livre e gratuito para os seus usuários. Esta Licença Pública Geral aplica-se
à maioria dos software da Free Software Foundation e a qualquer outro programa cujo autor decida aplicá-la.
(Alguns outros software da FSF são cobertos pela Licença Pública Geral de Bibliotecas, no entanto.) Você pode
aplicá-la também aos seus programas.

Quando falamos em softwares livres, nos referimos a liberdade, não preço. Nossa Licença Publica Geral é proje-
tada para garantir: que você tenha liberdade de compartilhar cópias do software livre (e cobrar por este serviço, se
desejar) que você recebeu o código fonte ou pode adquirir se quiser; que você possa modificar o software ou usar
partes dele em novos softwares livres; que você saiba que pode fazer tais coisas.

Para proteger os seus direitos nós precisamos fazer restrições que proibem qualquer pessoa a negar a você tais
direitos ou a pedir que se renda a eles.Estas restriçoes se traduzem em certas responsabilidades para você, se você
distribuir ou modificar cópias do software.

Por exemplo, se você distribuir cópias de determinado programa, seja ele gratis ou por uma taxa, você deve dar
aos beneficiários todos os direitos que você tem. Você deve garantir que eles também recebam ou possam acessar
o código fonte. E você deve mostrar a eles estes termos para que eles saibam seus direitos.

Nós protegemos seus direitos com dois passos: (1) direitos autorais do software, e (2) oferecemos a você esta
licença que lhe dá a permissão legal para copiar, distruibuir e/ou modificar o software.

Também, para a proteção nossa e de cada autor, nós queremos garantir que todos compreendam que não há garantia
para este software livre. Se o software for modificado por outra pessoa e passado adiante, os beneficiários devem
saber que oque eles tem não é o software original, para que, qualquer problema introduzido por outros não reflita
na reputaçao do autor original.

Por fim, qualquer programa livre é constantemente ameaçado por patentes de softwares. Nós queremos evitar o
risco de que redistribuidores de um programa livre obtenham licenças individuais, fazendo assim do programa
proprietário. Para prevenir isso, nós deixamos claro que qualquer patente deve ser licenciada para o uso livre de
todas as pessoas.

Seguem os precisos termos e condições para cópia, ditribuiçao e modificaçao. TERMOS E CONDIÇÕES PARA
CÓPIA, DISTRIBUIÇAO E MODIFICAÇÃO

0. Esta licença se aplica a qualquer programa ou outro trabalho que contenha um aviso inserido pelo detentor
dos direitos autorais informando que o mesmo pode ser distribuído sob as condições desta Licença Pública
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Geral.O “Programa” abaixo refere-se a qualquer programa ou trabalho, e “trabalho baseado no Programa”
significa tanto o Programa em si como quaisquer trabalhos derivados, de acordo com a lei de direitos au-
torais: isto quer dizer um trabalho que contenha o Programa ou parte dele, tanto originalmente ou com
modificações, e/ou tradução para outros idiomas. (Doravante o processo de tradução está incluído sem
limites no termo “modificação”.) Cada licenciado é mencionado como “você”.

Atividades outras que a cópia, a distribuição e modificação não estão cobertas por esta Licença; elas estão
fora de seu escopo. O ato de executar o Programa não é restringido e o resultado do Programa é coberto ape-
nas se seu conteúdo contenha trabalhos baseados no Programa (independentemente de terem sido gerados
pela execução do Programa). Se isso é verdadeiro depende do que o programa faz.

1. Você pode copiar e distribuir cópias fiéis do código-fonte do Programa da mesma forma que você o recebeu,
usando qualquer meio, deste que você conspícua e apropriadamente publique em cada cópia um aviso de
direitos autorais e uma declaração de inexistência de garantias; mantenha intactas todos os avisos que se
referem a esta Licença e à ausência total de garantias; e forneça a outros recebedores do Programa uma
cópia desta Licença, junto com o Programa.

Você pode cobrar uma taxa pelo ato físico de transferir uma cópia e pode, opcionalmente, oferecer garantia
em troca de pagamento.

2. Você pode modificar sua cópia ou cópias do Programa, ou qualquer parte dele, assim gerando um trabalho
baseado no Programa, e copiar e distribuir essas modificações ou trabalhos sob os termos da seção 1 acima,
desde que você também se enquadre em todas estas condições:

(a) Você tem que fazer com que os arquivos modificados levem avisos proeminentes afirmando que você
alterou os arquivos, incluindo a data de qualquer alteração.

(b) Você tem que fazer com que quaisquer trabalhos que você distribua ou publique, e que integralmente
ou em partes contenham ou sejam derivados do Programa ou de suas partes, sejam licenciados, inte-
gralmente e sem custo algum para quaisquer terceirose, sob os termos desta Licnça.

(c) Se qualquer programa modificado normalmente lê comandos interativamente quando executados, você
tem que fazer com que, quando iniciado tal uso interativo da forma mais simples, seja impresso ou
mostrado um anúncio de que não há qualquer garantia (ou então que você fornece a garantia) e que
os usuários podem redistribuir o programa sob estas condições, ainda informando os usuários como
consultar uma cópia desta Licença. (Exceção: se o Programa em si é interativo mas normalmente não
imprime estes tipos de anúncios, seu trabalho baseado no Programa não precisa imprimir um anúncio.)

Estas exigências aplicam-se ao trabalho modificado como um todo. Se seções identificáveis de tal trabalho
não são derivadas do Programa, e podem ser razoavelmente consideradas trabalhos independentes e sepa-
rados por si só, então esta Licença, e seus termos, não se aplicam a estas seções quando você distribui-las
como trabalhos em separado. Mas quando você distribuir as mesmas seções como parte de um todo que
é trabalho baseado no Programa, a distribuição como um todo tem que se enquadrar nos termos desta Li-
cença, cujas permissões para outros licenciados se estendem ao todo, portanto também para cada e toda
parte independente de quem a escreveu.

Desta forma, esta seção não tem a intenção de reclamar direitos os contestar seus direitos sobre o trabalho es-
crito completamente por você; ao invés disso, a intenção é a de exercitar o direito de controlar a distribuição
de trabalhos, derivados ou coletivos, baseados no Programa.

Adicionalmente, a mera adição ao Programa de outro trabalho não baseado no Programa (ou de trabalho
baseado no Programa) em um volume de armazenamento ou meio de distribuição não faz o outro trabalho
parte do escopo desta Licença.

3. Você pode copiar e distribuir o Programa (ou trabalho baseado nele, conforme descrito na Seção 2) em
código-objeto ou em forma executável sob os termos das Seções 1 e 2 acima, desde que você faça um dos
seguintes:

(a) O acompanhe com o código-fonte completo e em forma acessível por máquinas, que tem que ser
distribuído sob os termos das Seções 1 e 2 acima e em meio normalmente utilizado para o intercâmbio
de software; ou,

(b) O acompanhe com uma oferta escrita, válida por pelo menos três anos, de fornecer a qualquer um, com
um custo não superior ao custo de distribuição física do material, uma cópia do código-fonte completo
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e em forma acessível por máquinas, que tem que ser distribuído sob os termos das Seções 1 e 2 acima
e em meio normalmente utilizado para o intercâmbio de software; ou,

(c) O acompanhe com a informação que você recebeu em relação à oferta de distribuição do código-
fonte correspondente. (Esta alternativa é permitida somente em distribuição não comerciais, e apenas
se você recebeu o programa em forma de código-objeto ou executável, com oferta de acordo com a
Subseção b acima.)

O código-fonte de um trabalho corresponde à forma de trabalho preferida para se fazer modificações. Para
um trabalho em forma executável, o código-fonte completo significa todo o código-fonte de todos os módu-
los que ele contém, mais quaisquer arquivos de definição de “interface”, mais os “scripts” utilizados para se
controlar a compilação e a instalação do executável. Contudo, como exceção especial, o código-fonte dis-
tribuído não precisa incluir qualquer componente normalmente distribuído (tanto em forma original quanto
binária) com os maiores componentes (o compilador, o “kernel” etc.) do sistema operacional sob o qual o
executável funciona, a menos que o componente em si acompanhe o executável.

Se a distribuição do executável ou código-objeto é feita através da oferta de acesso a cópias de algum lugar,
então ofertar o acesso equivalente a cópia, do mesmo lugar, do código-fonte equivale à distribuição do
código-fonte, mesmo que terceiros não sejam compelidos a copiar o código-fonte com o código-objeto.

4. Você não pode copiar, modificar, sub-licenciar ou distribuir o Programa, exceto de acordo com as condições
expressas nesta Licença. Qualquer outra tentativa de cópia, modificação, sub-licenciamento ou distribuição
do Programa não é valida, e cancelará automaticamente os direitos que lhe foram fornecidos por esta Li-
cença. No entanto, terceiros que de você receberam cópias ou direitos, fornecidos sob os termos desta
Licença, não terão suas licenças terminadas, desde que permaneçam em total concordância com ela.

5. Você não é obrigado a aceitar esta Licença já que não a assinou. No entanto, nada mais o dará permissão
para modificar ou distribuir o Programa ou trabalhos derivados deste. Estas ações são proibidas por lei, caso
você não aceite esta Licença. Desta forma, ao modificar ou distribuir o Programa (ou qualquer trabalho
derivado do Programa), você estará indicando sua total aceitação desta Licença para fazê-los, e todos os
seus termos e condições para copiar, distribuir ou modificar o Programa, ou trabalhos baseados nele.

6. Cada vez que você redistribuir o Programa (ou qualquer trabalho baseado nele), os recebedores adquirirão
automaticamente do licenciador original uma licença para copiar, distribuir ou modificar o Programa, su-
jeitos a estes termos e condições. Você não poderá impor aos recebedores qualquer outra restrição ao
exercício dos direitos então adquiridos. Você não é responsável em garantir a concordância de terceiros a
esta Licença.

7. Se, em conseqüência de decisões judiciais ou alegações de infringimento de patentes ou quaisquer outras
razões (não limitadas a assuntos relacionados a patentes), condições forem impostas a você (por ordem
judicial, acordos ou outras formas) e que contradigam as condições desta Licença, elas não o livram das
condições desta Licença. Se você não puder distribuir de forma a satisfazer simultaneamente suas obri-
gações para com esta Licença e para com as outras obrigações pertinentes, então como conseqüência você
não poderá distribuir o Programa. Por exemplo, se uma licença de patente não permitirá a redistribuição,
livre de “royalties”, do Programa, por todos aqueles que receberem cópias direta ou indiretamente de você,
então a única forma de você satisfazer a ela e a esta Licença seria a de desistir completamente de distribuir
o Programa.

Se qualquer parte desta seção for considerada inválida ou não aplicável em qualquer circunstância particular,
o restante da seção se aplica, e a seção como um todo se aplica em outras circunstâncias.

O propósito desta seção não é o de induzi-lo a infringir quaisquer patentes ou reivindicação de direitos de
propriedade outros, ou a contestar a validade de quaisquer dessas reivindicações; esta seção tem como único
propósito proteger a integridade dos sistemas de distribuição de software livres, o que é implementado pela
prática de licenças públicas. Várias pessoas têm contribuído generosamente e em grande escala para os
software distribuídos usando este sistema, na certeza de que sua aplicação é feita de forma consistente; fica
a critério do autor/doador decidir se ele ou ela está disposto a distribuir software utilizando outro sistema, e
um licenciado não pode impor esta escolha.

Esta seção destina-se a tornar bastante claro o que se acredita ser conseqüência do restante desta Licença.

8. Se a distribuição e/ou uso do Programa são restringidos em certos países por patentes ou direitos autorais,
o detentor dos direitos autorais original, e que colocou o Programa sob esta Licença, pode incluir uma limi-
tação geográfica de distribuição, excluindo aqueles países de forma a tornar a distribuição permitida apenas
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naqueles ou entre aqueles países então não excluídos. Nestes casos, esta Licença incorpora a limitação
como se a mesma constasse escrita nesta Licença.

9. A Free Software Foundation (Fundação do Software Livre) pode publicar versões revisadas e/ou novas da
Licença Pública Geral de tempos em tempos. Estas novas versões serão similares em espírito à versão atual,
mas podem diferir em detalhes que resolvem novos problemas ou situações.

A cada versão é dada um número distinto. Se o Programa especifica um número de versão específico desta
Licença que se aplica a ele e a “qualquer nova versão”, você tem a opção de aceitar os termos e condições
daquela versão ou de qualquer outra versão publicada pela Free Software Foundation. Se o programa não
especifica um número de versão desta Licença, você pode escolher qualquer versão já publicada pela Free
Software Foundation.

10. Se você pretende incorporar partes do Programa em outros programas livres cujas condições de distribuição
são diferentes, escreva ao autor e solicite permissão. Para o software que a Free Software Foundation detém
direitos autorais, escreva à Free Software Foundation; às vezes nós permitimos exceções a este caso. Nossa
decisão será guiada pelos dois objetivos de preservar a condição de liberdade de todas as derivações do
nosso software livre, e de promover o compartilhamento e reutilização de software em aspectos gerais.

AUSÊNCIA DE GARANTIA

11. PELO PROGRAMA SER LICENCIADO SEM ÔNUS, NÃO HÁ QUALQUER GARANTIA PARA O
PROGRAMA, NA EXTENSÃO PERMITIDA PELAS LEIS APLICÁVEIS. EXCETO QUANDO EX-
PRESSADO DE FORMA ESCRITA, OS DETENTORES DOS DIREITOS AUTORAIS E/OU TER-
CEIROS DISPONIBILIZAM O PROGRAMA “NO ESTADO”, SEM QUALQUER TIPO DE GARAN-
TIAS, EXPRESSAS OU IMPLÍCITAS, INCLUINDO, MAS NÃO LIMITADO A, AS GARANTIAS
IMPLÍCITAS DE COMERCIALIZAÇÃO E AS DE ADEQUAÇÃO A QUALQUER PROPÓSITO. O
RISCO TOTAL COM A QUALIDADE E DESEMPENHO DO PROGRAMA É SEU. SE O PROGRAMA
SE MOSTRAR DEFEITUOSO, VOCÊ ASSUME OS CUSTOS DE TODAS AS MANUTENÇÕES,
REPAROS E CORREÇÕES.

12. EM NENHUMA OCASIÃO, A MENOS QUE EXIGIDO PELAS LEIS APLICÁVEIS OU ACORDO
ESCRITO, OS DETENTORES DOS DIREITOS AUTORAIS, OU QUALQUER OUTRA PARTE QUE
POSSA MODIFICAR E/OU REDISTRIBUIR O PROGRAMA CONFORME PERMITIDO ACIMA,
SERÃO RESPONSABILIZADOS POR VOCÊ POR DANOS, INCLUINDO QUALQUER DANO EM
GERAL, ESPECIAL, ACIDENTAL OU CONSEQÜENTE, RESULTANTES DO USO OU INCAPACI-
DADE DE USO DO PROGRAMA (INCLUINDO, MAS NÃO LIMITADO A, A PERDA DE DADOS
OU DADOS TORNADOS INCORRETOS, OU PERDAS SOFRIDAS POR VOCÊ OU POR OUTRAS
PARTES, OU FALHAS DO PROGRAMA AO OPERAR COM QUALQUER OUTRO PROGRAMA),
MESMO QUE TAL DETENTOR OU PARTE TENHAM SIDO AVISADOS DA POSSIBILIDADE DE
TAIS DANOS.

QGIS Qt exceções a GPL

Em adição, excepcionalmente, a Equipe de Desenvolvimento QGIS dá a permissão de linkar o código deste
programa com a biblioteca QT, inclusa, mas não limitada as seguintes versões (ambas gratuitas e comerciais):Qt /
Não-Comercial do Windows, Qt / Windows, Qt/X11, Qt / Mac, e Qt / Embedded (ou com versões modificadas do
Qt que usam a mesma licença do Qt) e distribuir combinações relacionadas, incluindo os dois. Você deve obedecer
a GNU General Public License em todos os aspectos para todo o código usado em outra Qt. Se você modificar
este arquivo, você pode estender essa exceção para a sua versão do arquivo, mas você não é obrigado a fazê-lo. Se
você não quiser fazer isso, exclua essa declaração exceção de sua versão.

22.2 GNU Licença de Documentação Gratuíta

Versão 1.3, 3 de Novembro de 2008

Direitos Autorais 2000, 2001, 2002, 2007, 2008 Free Software Foundation (Fundação do Software Livre)

http://fsf.org/

Qualquer pessoa tem permissão para copiar e distribuir cópias fiéis deste documento de licença, mas modifica-lo
não é permitido.
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Preâmbulo

O objetivo desta licença é produzir um manual, compêndio, ou outro documento funcional e útil. “Grátis” no
sentido de liberdade: para garantir a todos a efetiva liberdade de copiar e distribui-la com ou sem modificações,
comercialmente ou não.Secundariamente esta licença preserva ao autor e editor uma maneira de ter crédito pelo
seu trabalho, embora não sejam considerados responsaveis por modificações feitas por outros.

Esta licença é uma espécie de “copyleft”, oque significa que trabalhos derivativos do documento devem ser livres
no mesmo sentido. Ela complementa a GNU (Licença Publica Geral), que é uma licença copyleft projetada para
softwares livres.

Criamos esta Licença para que seja usada em manuais para programas livres, porque programas livres precisam
de documentação livre: um programa livre deveria vir com manuais que ofereçam as mesmas liberdades que o
programa oferece. Mas esta Licença não está limitada a manuais de programas de computador; ela pode ser usada
para qualquer trabalho de texto, independentemente do assunto ou se é publicado como um livro impresso. Nós
recomendamos esta Licença principalmente para trabalhos cujo propósito é instrução ou referência.

1. APPLICABILITY AND DEFINITIONS

Esta licença se aplica a qualquer manual ou outro trabalho, em qualquer meio, que contenha uma nota introduzida
pelo detentor dos direitos autorais dizendo que o documento pode ser distribuído sob os termos desta. Tal nota
garante uma licença mundial, livre de royalties, de duração ilimitada, para usar este trabalho sob as condições aqui
colocadas. O “Documento”, abaixo, se refere a qualquer tal manual ou trabalho. Qualquer membro do público é
um licenciado, e será tratado por “você”. Você aceita a licença se copiar, modificar ou distribuir o trabalho de um
modo que necessite de permissão de acordo com a lei de direitos autorais.

Uma “Versão Modificada” do Documento se refere a qualquer trabalho contendo o Documento ou uma parte deste,
quer seja copiado sem modificações, quer com modificações e/ou traduzido para outra língua.

Uma “Seção Secundária” é um apêndice com nome ou uma seção inicial do Documento que trata exclusivamente
da relação dos editores ou autores do Documento com seu assunto geral (ou temas relacionados) e não contém
nada que possa estar diretamente dentro do assunto geral. Assim, se o Documento é em parte um livro- texto de
matemática, uma Seção Secundária não pode explicar nada de matemática. Tal relação pode ser uma conexão
histórica com o assunto ou com temas relacionados, ou tratar de questões legais, comerciais, filosóficas, éticas ou
políticas com relação a eles.

“Seções Invariantes” são certas Seções Secundárias cujos títulos são designados como sendo de Seções invariantes
na nota que afirma que o Documento é publicado sob esta Licença. Se uma seção não se encaixa na definição acima
de Secundária, então não se permite que seja designada como Invariante. O Documento pode não conter nenhuma
Seção Invariante. Se o documento não identificar quaisquer Seções Invariantes, então não há nenhuma.

“Textos de Capa” são certas passagens de texto que são listada como Textos de Capa Frontal ou Texto de Quarta
Capa, na nota que afirma que o Documento é publicado sob esta Licença. Um Texto de Capa Frontal pode ter no
máximo 5 palavras, e um Texto de Quarta Capa pode ter no máximo 25 palavras.

Uma cópia “Transparente” do Documento significa uma cópia que pode ser lida pelo computador, representada
em um formato cuja especificação esteja disponível ao público geral, que seja apropriada para a imediata revisão
do documento usando-se editores de texto genéricos ou (para imagens compostas de pixeis) programas gráficos
genéricos ou (para desenhos) algum editor de desenhos amplamente disponível, e que seja apropriado para in-
clusão em formatadores de texto ou para tradução automática para uma variedade de formatos apropriados para
inclusão em formatadores de texto. Uma cópia feita em outro formato de arquivo Transparente cuja marcação, ou
ausência desta, foi manipulada para impedir ou desencorajar modificação subseqüente pelos leitores não é Trans-
parente. Um formato de imagem não é Transparente se usado em lugar de qualquer quantidade substancial de
texto. Uma cópia que não é “Transparente” é chamada “Opaca”.

Exemplos de formatos apropriados para cópias Transparentes incluem ASCII puro sem marcação, formato de
entrada Texinfo, LaTex, SGML ou XML usando um DTD publicamente disponível, e HTML padrão simples,
PostScript ou PDF projetados para modificação por humanos. Exemplos de formatos de imagem transparentes
incluem PNG, XCF e JPG. Formatos Opacos incluem formatos proprietários que podem ser lidos e editados
somente por processadores de texto proprietários, SGML ou XML para os quais o DTD e/ou ferramentas de
processamento não são largamente disponibilizadas, e HTML, Postscript ou PDF gerados automaticamente com
propósito apenas de saída por alguns processadores de texto.
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“Página de Título” significa, para um livro impresso, a própria página do título, além das páginas subseqüentes
necessárias para conter, de forma legível, o material que esta Licença requer que apareça na página do título. Para
trabalhos em formatos que não têm uma página de título assim, “Página de Título” significa o texto próximo à
ocorrência mais proeminente do título do trabalho, precedendo o início do corpo do texto.

O “publicador” é qualquer pessoa ou entidade que distribua cópias do Documento para o público.

Uma seção “Intitulada XYZ” significa uma sub-unidade com nome do Documento cujo título ou é precisamente
XYZ ou contém XYZ em parênteses seguindo o texto que traduz XYZ em outra língua. (Aqui XYZ representa
o nome de uma seção específica mencionado acima, tal como “Agradecimentos”, “Dedicatória”, “Apoio”, ou
“Histórico”.) “Preservar o Título” de uma seção assim quando você modifica o Documento significa que ela
continua sendo uma seção “Intitulada XYZ” de acordo com esta definição.

O Documento pode incluir Notas de Garantia em seguida à nota que afirma que esta Licença se aplica ao Docu-
mento. Estas Notas de Garantia são tidas como inclusas por referência nesta Licença, mas somente com relação
às notas de garantia: qualquer outra implicação que estas Notas de Garantia possam ter é anulada e não tem efeito
algum no conteúdo desta Licença.

2. VERBATIM COPYING

Você pode copiar e distribuir o Documento em qualquer meio, comercialmente ou não-comercialmente, desde que
esta licença, as notas de direitos autorais (copyright), e a nota de licença afirmando que esta Licença se aplica ao
Documento sejam reproduzidas em todas as cópias, e que você não inclua outras condições, quaisquer que sejam,
às condições desta Licença. Você não pode usar de medidas técnicas para obstruir ou controlar a leitura ou cópia
futura das cópias que você fizer ou distribuir. Contudo, você pode aceitar compensação em troca das cópias. Se
você distribuir um número suficientemente grande de cópias, você deve também respeitar as condições na seção
3.

Você pode também emprestar cópias, sob as mesmas condições acima mencionadas, e você também as pode
mostrar publicamente.

3. COPYING IN QUANTITY

Se você publicar cópias impressas (ou cópias em um meio que normalmente tem capas impressas) do documento,
em número maior que 100, e a nota de licença do Documento requer Textos de Capa, você deve encadernar as
cópias em capas que carreguem, de forma clara e legível, todos estes Textos de Capa: Textos de Capa Frontal na
capa frontal, e Textos de Quarta Capa na quarta capa. Ambas as capas devem também identificar, de forma clara
e legível, você como o editor das cópias. A capa frontal deve apresentar o título completo com todas as palavras
deste igualmente proeminentes e visíveis. Você pode adicionar outro material nas capas. Cópias com mudanças
limitadas às capas, desde que preservando o título do Documento e satisfazendo estas condições, podem ser
tratadas como cópias literais em outros aspectos.

Se os textos necessários a qualquer uma das capas são demasiado volumosos para serem incluídos de forma
legível, você deve colocar os primeiros listados (quantos couberem razoavelmente) na própria capa, e continuar o
resto nas páginas adjacentes.

Se você publicar ou distribuir cópias Opacas do Documento em número maior que 100, você deve ou incluir uma
cópia Transparente legível por computador juntamente com cada cópia Opaca, ou dizer em, ou juntamente com,
cada cópia Opaca um endereço de rede a partir do qual o público geral possa acessar e obter, usando protocolos
de rede públicos padrão, uma cópia Transparente completa do Documento, livre de material adicionado. Se você
decidir pela segunda opção, você deve seguir passos razoavelmente prudentes, quando começar a distribuir as
cópias Opacas em quantidade, para garantir que esta cópia transparente permanecerá acessível no local indicado
por pelo menos um ano após a última vez que você distribuir uma cópia Opaca (diretamente ou através de seus
agentes ou distribuidor) desta edição ao público.

É solicitado, mas não exigido, que você contate os autores do Documento muito antes de redistribuir qualquer
número grande de cópias, para dar a eles uma chance de lhe fornecer uma versão atualizada do Documento.

4. MODIFICATIONS

Você pode copiar e distribuir uma Versão Modificada do Documento sob as condições das seções 2 e 3 acima,
desde que você forneça a Versão Modificada estritamente sob esta Licença, com a Versão Modificada no papel de
Documento, permitindo assim a distribuição e modificação da Versão Modificada a quem quer que possua uma
cópia desta. Além disso, você deve executar os seguintes procedimentos na Versão Modificada:
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1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. Liste na Página de Título, como autores, uma ou mais pessoas ou entidades responsáveis pela autoria ou
modificações na Versão Modificada, juntamente com pelo menos cinco dos autores principais do Docu-
mento (todos seus autores principais, se houver menos que cinco), a menos que estes lhe desobriguem desta
exigência.

3. Mencione na Página de Título o nome do editor da Versão Modificada, como seu editor.

4. Preserve todas as notas de direitos autorais (copyright) do Documento.

5. Adicione uma nota apropriada de direitos autorais para suas modificações, adjacente às outras notas de
direitos autorais.

6. Inclua, imediatamente após as notas de direitos autorais, uma nota de licença dando ao público permissão
para usar a Versão Modificada sob os termos desta Licença, na forma mostrada no Adendo abaixo.

7. Preserve naquela nota de licença a lista completa de Seções Invariantes e Textos de Capa requeridos dados
na nota de licença do Documento.

8. Inclua uma cópia inalterada desta Licença.

9. Preserve a seção intitulada “Histórico”, preserve seu título, e adicione a esta um item mencionando pelo
menos o título, ano, novos autores, e editor da Versão Modificada conforme incluído na Página de Título.
Se não houver uma seção intitulada “Histórico” no Documento, crie uma mencionando o título, ano, autores
e editor do Documento como mostrado na Página de Título, em seguida adicione um item descrevendo a
Versão Modificada como mencionado na sentença anterior.

10. Preserve o endereço de rede, se algum, dado no Documento para acesso público a uma cópia Transparente
deste e, da mesma maneira, os endereços de rede dados no Documento para versões prévias nas quais este
se baseia. Estes podem ser colocados na seção “Histórico”. Você pode omitir um endereço de rede para um
trabalho que foi publicado pelo menos quatro anos antes do Documento em si, ou se o editor original da
versão à qual o endereço se refere der permissão.

11. Para qualquer seção intitulada “Agradecimentos” ou “Dedicatória”, preserve o título da seção, e preserve
dentro da seção toda a substância e tom de cada um dos agradecimentos e/ou dedicatórias lá mencionados.

12. Preserve todas as Seções Invariantes do Documento, inalteradas no seu texto e títulos. Números de seção
ou o equivalente não são considerados parte dos títulos das seções.

13. Apague qualquer seção intitulada “Apoio”. Tal seção não ser incluída na Versão Modificada.

14. Não modifique o título de qualquer seção a ser intitulada “Apoio” ou que resulte em conflito com título de
qualquer Seção Invariante.

15. Preserve any Warranty Disclaimers.

Se a Versão Modificada incluir novas seções iniciais ou apêndices que sejam qualificados como Seções Se-
cundárias, e não contiver material copiado do Documento, você pode, a seu critério, tornar algumas dessas ou
todas essas seções em invariantes. Para fazer isso, adicione seus títulos à lista de Seções Invariantes na nota de
licença da Versão Modificada. Estes títulos devem ser distintos de quaisquer outros títulos de seções.

Você pode incluir uma seção intitulada “Apoio”, dado que ela contenha nada além de apoio recebido para sua
Versão Modificada por várias fontes – por exemplo, notas do revisor ou de que o texto foi aprovado por uma
organização como a definição autoritativa de um padrão.

Você pode adicionar uma passagem de até cinco palavras como Texto de Capa Frontal, e uma passagem de até
25 palavras como Texto de Quarta Capa, ao fim da lista de Textos de Capa na Versão Modificada. Somente
uma passagem de Texto de Capa Frontal e uma de Texto de Quarta Capa pode ser adicionado por (ou através
de arranjos feitos por) uma entidade qualquer. Se o Documento já incluir um texto de capa para a mesma capa,
previamente incluído por você ou por arranjo feito pela mesma entidade em cujo nome você está agindo, você não
pode adicionar outro; mas você pode substituir o antigo, com permissão explícita do editor anterior, que o incluiu.

O(s) autor(es) e editor(es) do Documento, por esta Licença, não dão permissão para seus nomes serem usados
para publicidade ou defesa ou apoio implícito para qualquer Versão Modificada.
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5. COMBINING DOCUMENTS

Você pode combinar o documento com outros documentos publicados sob esta Licença, sob os termos definidos
na seção 4 acima para versões modificadas, desde que você inclua na combinação todas as Seções Invariantes de
todos os documentos originais, sem modificações, e as liste como Seções Invariantes de seu trabalho combinado,
na sua nota de licença, e que você preserve todas as Notas de Garantia.

O trabalho combinado somente precisa conter uma cópia desta Licença, e múltiplas Seções Invariantes idênticas
podem ser substituídas por uma única cópia. Se houver múltiplas Seções Invariantes com o mesmo nome, porém
com conteúdos diferentes, torne o título de cada uma destas seções único, adicionando ao fim dele, entre parên-
teses, o nome do autor ou editor original desta seção, se conhecido, ou então um número único. Faça o mesmo
ajuste nos títulos de seção na lista de Seções Invariantes na nota de licença do trabalho combinado.

Na combinação, você deve combinar quaisquer seções intituladas “Histórico” nos vários documentos originais,
formando uma seção intitulada “Histórico”; do mesmo modo, combine quaisquer seções intituladas “Agradeci-
mentos”, e quaisquer seções intituladas “Dedicatória”. Você deve apagar todas as seções intituladas “Apoio”.

6. COLLECTIONS OF DOCUMENTS

Você pode fazer uma coleção consistindo do Documento e outros documentos publicados sob esta Licença, e
substituir as cópias individuais desta Licença, nos vários documentos, por uma única cópia a ser incluída na
coleção, desde que você siga as regras desta Licença para cópias literais de cada documento em todos os outros
aspectos.

Você pode extrair um único documento desta coleção, e distribuí-lo individualmente sob esta Licença, desde que
você insira uma cópia desta Licença no documento extraído, e siga esta Licença em todos os outros aspectos com
relação à cópia literal do documento.

7. AGGREGATION WITH INDEPENDENT WORKS

Uma compilação do Documento ou seus derivados com outros documentos ou trabalhos separados e indepen-
dentes, dentro de ou junto a um volume de um meio de armazenagem ou distribuição, configura um “agregado” se
os direitos autorais resultantes da compilação não forem usados para limitar os direitos legais dos usuários desta
além do que os trabalhos individuais permitem. Quando o Documento é incluído em um agregado, esta Licença
não se aplica aos outros trabalhos no agregado que não forem, por sua vez, derivados do Documento.

Se o requerimento do Texto de Capa da seção 3 for aplicável a estas cópias do documento, então, se o Documento
for menor que metade do agregado inteiro, os Textos de Capa do Documento podem ser colocados em capas que
encerrem o Documento dentro do agregado, ou o equivalente eletrônico das capas se o Documento estiver em
formato eletrônico. Do contrário, eles devem aparecer como capas impressas que envolvam o agregado inteiro.

8. TRANSLATION

Uma tradução é considerada como sendo um tipo de modificação, então você pode distribuir traduções do Docu-
mento sob os termos da seção 4. A substituição de Seções Invariantes por traduções requer permissão especial dos
detentores dos direitos autorais, embora você possa incluir traduções de algumas ou todas as Seções Invariantes
juntamente às versões originais destas. Você pode incluir uma tradução desta Licença, e todas as notas de licença
no Documento, e qualquer Nota de Garantia, desde que você também inclua a versão original em Inglês desta
Licença e as versões originais das notas de licença e garantia. Em caso de discordância entre a tradução e a versão
original desta Licença ou nota de licença ou garantia, a versão original prevalecerá.

Se uma seção no Documento for intitulada “Agradecimentos”, “Dedicatória”, ou “Histórico”, o requerimento
(seção 4) de Preservar seu Título (seção 1) tipicamente exigirá a mudança do título em si.

9. TERMINATION

Você não pode copiar, modifica, sub-licenciar, ou distribuir o Documento à exceção do modo expressamente
provido por esta Licença. Qualquer outra tentativa de copiar, modificar, sub-licenciar ou distribuir o Documento é
anulada, e implicará em término automático de seus direitos sob esta Licença.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.
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Além disso, sua licença de um detentor dos direitos autorais é permanentemente reinstalada se o detentor nofiticar
você da violação por motivos razoáveis, esta é a primeira vez que você recebeu noticias da violação desta licença
de qualquer detentor e você remedia a violaçao anteriormente a 30 dias após ter recebido a notícia.

O término dos seus direitos sobre esta seção nao finaliza a licença de partes que receberam cópias de você sobre
esta licença. Se seus direitos terminaram a não foram permanentemente reinstalados, o recebimento de uma cópia
ou parte do mesmo material nao dá a você o direito de usá-lo.

10. FUTURAS REVISÕES DESTA LICENÇA

A Fundação do Software Livre pode publicar novas, revisadas versões do GNU de tempos em tempos. A nova
versão será similar a presente versão, mas pode diferir em detalhes para encaminhar novos problemas ou preocu-
pações. Veja http://www.gnu.org/copyleft/.

Para cada versão da Licença é dado um número de versão distinto. Se o Documento especificar que uma versão
particular desta Licença “ou qualquer versão posterior” se aplica a ele, você tem a opção de seguir os termos e
condições tanto daquela versão específica, ou de qualquer versão posterior que tenha sido publicada (não como um
rascunho) pela Free Software Foundation. Se o Documento não especificar um número de versão desta Licença,
você pode escolher qualquer versão já publicada (não como rascunho) pela Free Software Foundation. Se o
Documento especificar que um procurador pode decidir quais versões futuras desta licença pode ser usada, uma
afirmação pública do procurador de aceitação de uma versão permanentemente autoriza você a escolher essa
versão para o documento.

11. RELICENCIAMENTO

“Massive Multiauthor Collaboration Site” (ou “Site MMC”) significa que qualquer servidor da World Wide Web
que publica trabalhos protegidos por direitos autorais e também oferece facilidades importantes para qualquer
pessoa para editar essas obras. Um wiki público que qualquer um pode editar, está um exemplo de um servidor. A
“Massive Multiauthor Collaboration” (ou “MMC”) contidos no site significa que qualquer conjunto de trabalhos
protegidos por direitos autorais, assim, publicado no site da MMC.

“CC-BY-SA” significa Creative Commons Attribution-Share Alike 3.0 publicado pela Creative Commons Corpo-
ration, uma corporação sem fins lucrativos com sede principal em San Francisco, Califórnia, bem como futuras
versões de copyleft da licença publicada pela mesma organização.

“Incorporar”significa publicar ou republicar um Documento, por inteiro ou em partes, como parte de outro docu-
mento.

O MMC é “elegível para um novo licenciamento” se está licenciado sob esta Licença, e se todas as obras que foram
publicadas pela primeira vez sob esta licença em outro lugar que este MMC e, posteriormente, incorporadas no
todo ou em parte para o MMC, (1) não tinha textos cobertos ou seções invariantes, e (2) foram assim incorporados
antes de 1 de novembro de 2008.

O operador de um site MMC pode republicar uma MMC contido no site sob CC-BY-SA no mesmo local, a
qualquer momento, antes de 1 de agosto de 2009, desde que o MMC é elegível para um novo licenciamento.

ADDENDUM: Como usar esta Licença em seus documentos

Para usar esta Licença num documento que você escreveu, inclua uma cópia da Licença no documento e ponha as
seguintes notas de copyright e licenças logo após a página de título:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Se você tiver Seções Invariantes, Textos de Capa Frontal e Textos de Capa Traseira, substitua a linha”com ...
Textos” por esta:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.
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Se você tiver Seções Invariantes, sem Textos de Capa, ou alguma outra combinação dos três, mesclar essas duas
alternativas para se adequar a situação.

Se o documento contiver exemplos não triviais de código de programas, nós recomendamos a publicação desses
exemplos em paralelo sob a sua escolha de licença de software livre, como a GNU General Public License, para
permitir seu uso em software livre.
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